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iii

முகப்புரை

மனித நாகரீக வளர்ச்சியின் மிக உயர்ந்த கண்டுபிடிப்பு “கணிப்பொறிகள்”.  கணிப்பொறிகள் 
நமது அன்றாட வாழ்வின் ஒவ்வொரு நிலையிலும், நீக்கமற நிறைந்து காணப்படுகிறது.  

இன்று வாழும் யுகம் “கணிப்பொறி யுகம்” இந்த யுகத்தில் கணிப்பொறி பற்றிய அறிவு 
இன்றியமையாத ஒன்றாகும்.  எவர் ஒருவர், கணிப்பொறியை இயக்கும் அடிப்படை அறிவை 
பெற்றிருக்கவில்லைய�ோ அவர் எத்தனை பட்டங்கள் பெற்றிருப்பினும் கல்லாதவர் என்றே 
கருதப்படுவர்.  அந்தளவிற்கு கணிப்பொறி கற்றல் அதி முக்கியத்துவம் வாய்ந்தது.  நாட்டின் 
வளர்ச்சி இளைஞர்களின் கைகளில்தான் உள்ளது.  ஒவ்வொரு இளைஞரும் கணிப்பொறி 
அறிவை பெறவேண்டியது அவசியமாகும்.  இதனை மனதில் க�ொண்டே இந்தப் பாடப்புத்தகம் 
வடிவமைக்கப்பட்டுள்ளது.

CorelDRAW  நிறுவனங்களில் உபய�ோகிக்கப்படும் வடிவமைப்பு, ல�ோக�ோக்கள் மற்றும் 
பலமல்டிமீடியா ப�ொருட்களை உருவாக்குவதற்காக பயன்படுத்தப்படுகிறது. இதை நன்கு 
புரிந்துக�ொண்ட  ஒரு நபரால்    நிறுவனங்களுக்கான வலைத்தள வடிவமைத்தல் மற்றும் 
மல்டிமீடியா வேலைகளை செய்ய முடியும்.

Adobe Flash என்பது கார்ட்டூன்களை உருவாக்கும�ொரு அடிப்படை மென்பொருள். திரைப்படம் 
மற்றும் அனிமேஷன் ப�ோன்ற த�ொழில்கள் புதுமையான உயிரூட்டமுள்ள  கார்ட்டூன்களை 
உருவாக்க  நீண்ட காலமாக ஃப்ளாஷ் மென்பொருளை  மட்டுமே  நம்பியுள்ளது.

PageMaker என்பது பக்க வடிவமைப்பு மற்றும் புத்தகம் தயாரித்தல் ப�ோன்ற  ந�ோக்கத்திற்காகப் 
பயன்படுத்தப்படும் ஒரு முக்கிய மென்பொருளாகும்.

Adobe InDesign மென்பொருள் டெஸ்க்டாப் பப்ளிஷிங் செயல்பாட்டிற்கு  உதவுகிறது.

AutoCAD கிட்டத்தட்ட அனைத்து ப�ொறியாளர்களாலும் பயன்படுத்தப்படும் மென்பொருளாகும். 
இது  பல்வேறு இயந்திரங்களின் பாகங்கள், மின்சுற்று வடிவமைத்தல், மாதிரி தயாரித்தல் 
ப�ோன்ற வடிவமைப்புகளுக்கு உதவுகிறது.
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தேர்வை எதிர்கொள்ள மாதிரி வினா தாள் பயன்படுகிறது. மாதிரி வினாத்தாள் 

கணிசமான ச�ொற்களின் விளக்கம் கலைச் ச�ொற்கள்

புரிதல் மற்றும் பயன்பாடு சார்ந்த வகைகளின் கீழ் 
மாணவர்கள் அணுகல்.மதிப்பீடு 

இணைய இணைப்பு, டிஜிட்டல் ஆதாரங்கள் மேலும் 
புத்துணர்ச்சி பெறுவதற்கு இணையதள முகவரி 

கூடுதல் வாசிப்பிற்கான த�ொடர்புடைய புத்தகங்களின் 
பட்டியல் குறிப்பு 

சிறந்த புரிதலுக்கான அலகு காட்சி விளக்கங்கள் தகவல் வரைகலை 

எந்த நேரத்திலும் எங்கும் வாசிப்பதை எளிதாக்குவதற்கு 

கற்றலின் ந�ோக்கங்கள் சுருக்கமாக அலகு 
உள்ளடக்கங்களை விவரிக்கின்றன. இது மாணவரால் பெற்ற 
அறிவை வெளிப்படுத்துகிறது. 

கற்றலின் ந�ோக்கங்கள் 

மாணவர்களை ஊக்கப்படுத்தி சுவாரஸ்யமான தகவல்கள் 
அலகு குறித்து மேலும் தகவல் பெற வேண்டும். 

சிறந்த புரிதலுக்கான அலகுகளை அடிப்படையாக க�ொண்ட 
திறன் சார்ந்த செயல்பாடுகள். மாணவர்களின் செயல்பாடு 

ஆசிரியரின் 
செயல்பாடு 

திறனை அதிகரிக்க ஆசிரியரால் நடத்தப்படும் புதுமையான 
த�ொழில் நுட்பம் 

புத்தகத்தை 
பயன்படுத்துவது 

எப்படி ? 

வடிவமைத்தல், தையல் மற்றும் வடிவமைப்பு, வடிவமைப்பின் 
க�ோட்பாடுகளின் நுட்பத்தை சித்தரிக்கும் கருத்துரு 
வரைப்படங்கள் 

கருத்துப்படம் 

துறையின் வெற்றிகரமான மாணவர்களின் சுருக்கமான 
குறிப்பு 

தனியாள் ஆய்வு 

வெற்றிகரமாக நிறைவு செய்யப்படும் வேலைவாய்ப்பின் 
பட்டியல்

வாழ்க்கை 
வழிகாட்டல் 

iv
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vபாடம் 05  PHP செயற்கூறுகள் மற்றும் அணிகள்

வாழ்வியல் வழிகாட்டி

Adobe 
PageMaker

Adobe 
InDesign

CorelDraw Adobe Flash AutoCAD

Work for specialized design as part of  
a collaborative team or as self employed

SPECIALIZED IN GRAPHIC AREAS
Advertisements & Marketing Communications Materials. 
Typography, Desktop Publishing, Web Designing, Branding & Advertising.  Email Blasts 
& Newsletters Interface or Uses Experience Design, Logos, Product Packaging, Book 
Designing, Print Or Web Productions.

COURSE WORKS 
Studio Art, Principles Of Design, Commercial Graphics, Visual Communications, Web 
Designing, Advertising & Graphics – Related Computer Technology, Computer Graphics & 
Design Software Programs.

JOB OFFERS
●	 Industrial Designer
●	 Fashion Designer
●	 Crafts & Designer
●	 Multimedia Artists & Animators
●	 Film & video Editors

●	 Print production
●	 Flash Developers 
●	 Graphic Designers
●	 Print & Digital Designers 

v
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01பாடம்

அட�ோப் பேஜ்மேக்கர்

 கற்றலின் ந�ோக்கங்கள்
●	 டெஸ்க்டாப் பப்பிளிசிங் (Desktop publishing) என்றால் என்ன என்பதைக் கற்றுக் க�ொள்ளுதல்.
●	 பேஜ்மேக்கரைப் பயன்படுத்தி ஆவணங்கள் உருவாக்குதல்.
●	 உரைத்தொகுதியை உருவாக்குதல்.
●	 உரைத்தொகுதியின் அளவை மாற்றுதல்.
●	 மைக்ரோசாஃப்ட் வேர்டு (Microsoft Word) ப�ோன்ற பிற மென்பொருளில் இருக்கும் உரையை 

பேஜ்மேக்கர் ஆவணத்தில் செருகுதல்.
●	 உரையை வைக்க உரைத்தொகுதிக்கு பதிலாக சட்டங்களைப் பயன்படுத்துதல்.

1.1  �டெஸ்க்டாப் பப்பிளிசிங்  
(Desktop publishing)

இந்நாட்களில் டெஸ்க்டாப் பப்பிளிசிங் 
(Desktop publishing) என்ற வார்த்தைகள் 
அதிக அளவில் பயன்படுத்தப்படுவதைப் 
பார்க்க முடிகிறது.  டெஸ்க்டாப் 
பப்பிளிசிங் என்றால் என்ன?  டெஸ்க்டாப் 
பப்பிளிசிங் (சுருக்கமாக DTP) என்பது 
DTP மென்பொருளைப் பயன்படுத்தி 

ஆவணங்களுக்கான பக்கங்களை 
வடிவமைப்பு (Page Layout) செய்வதாகும்.

இன்றைய மென்பொருள் 
சந்தையில் கிடைக்கும் புகழ்பெற்ற DTP 
மென்பொருள்களுள் சில. 

அட�ோப் பேஜ்மேக்கர் (Adobe 
PageMaker), அட�ோப் இன்டிசைன் 
(Adobe InDesign), குவார்க் எக்ஸ்பிரஸ் 
(QuarkXPress) ப�ோன்றவை.

படம் 1.1  பலவகையான பக்க வடிவமைப்பு மென்பொருள்கள்
1
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பாடம் 01  அட�ோப் பேஜ்மேக்கர்2

உரைகளையும், படங்களையும் 
அடுத்தடுத்தும், மேலும் கீழுமாகவும் 
என எங்கு வேண்டுமானாலும் நீங்கள் 
நினைத்தபடி வைக்கலாம்.

1.3  �பேஜ்மேக்கரைத்  
திறத்தல்

விண்டோஸ் 7 இயக்க அமைப்பில், Start > 
All Programs > Adobe > PageMaker 7.0 > 
Adobe PageMaker 7.0 என்ற வரிசையில் 
கிளிக் செய்து அட�ோப் பேஜ்மேக்கரைத் 
திறக்கலாம்.

அட�ோப் பேஜ்மேக்கர் சன்னல் திரை 
படம் 1.2 இல் காட்டியுள்ளவாறு திறக்கும்.

1.2  அட�ோப் பேஜ்மேக்கர் ஓர் அறிமுகம்
அட�ோப் பேஜ்மேக்கர் என்பது ஒரு 
பக்க வடிவமைப்பு மென்பொருளாகும்.  
இது அச்சிடுவதற்கு ஏற்ற வகையில் 
ஆவணங்களை வடிவமைக்கப் 
பயன்படுகிறது.  இதைப் பயன்படுத்தி சிறிய 
வணிக அட்டை முதல் பெரிய புத்தகம் 
வரை அனைத்தையும் வவைமைக்கலாம்.

பக்க வடிவமைப்பு மென்பொருளில் 
உள்ள கருவிகள், ஆவணத்தில் எளிதாக 
உரை மற்றும் வரைகலை வடிவங்களை 
சேர்க்க உதவுகின்றன.  உதாரணமாக, 
பேஜ்மேக்கரைப் பயன்படுத்தி, ஒவ்வொரு 
பக்கத்திலும் கட்டுரைகள் மற்றும் 
படங்களை வைத்து ஒரு செய்திமடலை 
(Newsletter) உருவாக்க முடியும்.

படம் 1.2  அட�ோப் பேஜ்மேக்கர் சன்னல் திரை
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3பாடம் 01  அட�ோப் பேஜ்மேக்கர்

புதிய ஆவணத்தை உருவாக்க,
1.	 பட்டிப்பட்டையில் File > 

New என்பதைக் கிளிக் 
செய்ய வேண்டும் அல்லது 
விசைப்பலகை மூலம் 
Ctrl + N என்பதை அழுத்த 
வேண்டும்.  இப்பொழுது படம் 
1.3 இல் காட்டப்பட்டுள்ளவாறு 
Document Setup உரையாடல் 
பெட்டி த�ோன்றும்.

2.	 இந்த உரையாடல் பெட்டியில் 
புதிய ஆவணத்திற்குத் 
தேவையான அளவுகளை 
உள்ளீடு செய்ய வேண்டும்.

3.	 பிறகு OK ப�ொத்தானை 
அழுத்த வேண்டும். 
இப்பொழுது படம் 1.4 இல் 
காட்டியுள்ளவாறு Untitled – 1 
என்ற பெயரில் புதிய ஆவணம் 
திறக்கப்பட்டிருக்கும்.

படம் 1.3  Document Setup உரையாடல் பெட்டி

Title Bar
Menu Bar

Tool Bar

Black 
Border

Margins

(Margins appear as 
dotted or pink lines.)

Ruler

Tool Box

Vertical scroll bar

PageMaker Page
Pasteboard

Horizontal scroll bar

(The 
pasteboard 

stores items for 
later use.)

Pages

படம் 1.4  பேஜ்மேக்கர் ஆவண சன்னல் திரை

1.4  �புதிய ஆவணத்தை உருவாக்குதல்
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பாடம் 01  அட�ோப் பேஜ்மேக்கர்4

கருப்பு நிற எல்லைக் க�ோட்டின் உள்ளே இருப்பது ஒரு ஆவணத்தின் பக்கம் ஆகும்.  
கருப்பு நிற எல்லைக் க�ோட்டிற்கு வெளியில் உள்ள பகுதி ஒட்டுப்பலகை (Pasteboard) 
என அழைக்கப்படுகிறது.  ஒட்டுப்பலகையில் வைக்கப்படும் எதுவும் ஆவணத்தை அச்சிடும் 
ப�ோது அச்சில் வராது.  ஆவணத்தை வடிவமைப்பதற்குத் தேவையானவற்றை வைத்துக் 
க�ொள்ளும் ஒரு தற்காலிக இடமாக ஒட்டுப்பலகையைப் பயன்படுத்தலாம்.

பேஜ்மேக்கர் ஆவண சன்னல் திரையில் உள்ள முதன்மைப் பகுதிகளான தலைப்புப் 
பட்டை, பட்டிப் பட்டை, கருவிப்பட்டை, அளவுக�ோல், திரை உருளல் பட்டை மற்றும் 
உரைப்பகுதி ஆகியவற்றைப் பற்றி கீழே காண்போம்.

தலைப்புப் பட்டை (Title bar)

படம் 1.5  தலைப்புப் பட்டை

இது சன்னல் திரையின் மேல் பகுதியில் உள்ளது.  இதன் இடது ஓரத்தில் மென்பொருளின் 
பெயர் மற்றும் ஆவணத்தின் பெயர் இடம் பெற்றிருக்கும்.  வலது ஓரத்தில் சிறிதாக்குப் 
ப�ொத்தான், பெரிதாக்குப் ப�ொத்தான், மூடு ப�ொத்தான் ப�ோன்ற கட்டுப்பாட்டு ப�ொத்தான்கள் 
இடம்பெற்றிருக்கும்.

படம் 1.5 இல் தலைப்புப் பட்டையின் இடது ஓரத்தில் Adobe PageMaker 7.0 என்னும் 
மென்பொருளின் பெயரையும், அதைத் த�ொடர்ந்து Untitled-1 என்னும் ஆவணத்தின் 
க�ொடாநிலைப் பெயரையும் காணமுடிகிறது.  பயனர் உரிய பெயரைக் க�ொடுத்து 
ஆவணத்தை சேமிப்பதன் மூலம் Untitled-1 என்னும் பெயரை மாற்றிக் க�ொள்ள முடியும்.

சிறிதாக்குப் ப�ொத்தானை அழுத்துவதன் மூலம் சன்னல் திரை சிறிய ப�ொத்தானாக 
மாறி பணிப்பட்டைக்கு வந்துவிடும்.

பெரிதாக்குப் ப�ொத்தான், ஆவணம் திரை முழுவதும் நிரம்பும் வகையில் பெரிதாக்கப் 
பயன்படுகிறது.

மூடு ப�ொத்தான் ஆவணத்தை மூடுவதற்குப் பயன்படுகிறது.
பட்டிப்பட்டை (Menu bar)

படம் 1.6  பட்டிப்பட்டை

இந்தப் பட்டை File, Edit, Layout, Type, Element, Utilities, View, Window, Help ப�ோன்ற 
பட்டிகளைக் க�ொண்டுள்ளது.  ஒரு பட்டியில் கிளிக் செய்தால் பல கட்டளைகள் மற்றும் 
துணைப்பட்டிகளுடன் கூடிய கீழ்விரி பட்டியல் த�ோன்றும்.
கருவிப்பட்டை (Toolbar)
கருவிப்பட்டையில் உள்ள ஒரு ப�ொத்தான் மீது சுட்டியை வைக்கும் ப�ோது, அதை பற்றிய 
சிறிய உரை திரையில் த�ோன்றும்.  அதற்கு ‘Tool Tip’ என்று பெயர்.

படம் 1.7  கருவிப்பட்டை
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5பாடம் 01  அட�ோப் பேஜ்மேக்கர்

கருவிப்பெட்டி (Toolbox)
கீழே உள்ள படம் 1.8 பேஜ்மேக்கர் கருவிப்பெட்டியைக் காட்டுகிறது.

Pointer Tool

Rotating Tool

Line Tool

Rectangle Tool

Ellipse Tool

Polygon Tool

Hand Tool

Text Tool

Cropping Tool

Constrained Line Tool

Rectangle Frame Tool

Ellipse Frame Tool

Polygon Frame Tool

Zoom Tool

படம் 1.8  கருவிப்பெட்டி

கருவிப்பெட்டியின் தலைப்புப் பட்டையில் கிளிக் செய்து அழுத்திப் பிடித்து அதை நகர்த்தலாம்.  
கருவிப்பெட்டியில் கிளிக் செய்து அதில் உள்ள கருவியைத் தேர்ந்தெடுக்கலாம்.

கருவிப்பெட்டி திரையில் த�ோன்றாவிட்டால், பட்டிப்பட்டையில் Window > Show tools 
என்பதைக் கிளிக் செய்து பெறலாம்.

கருவிப்பெட்டியை மறைக்க, பட்டிப்பட்டையில் Window > Hide tools என்பதைக் 
கிளிக் செய்து மறைக்கலாம்.

அட்டவணை 1.1 �க ருவிப்பெட்டியிலுள்ள கருவிகளுக்கான  
விசைப்பலகை குறுக்கு வழிகள்

வ.எண் கருவிகள் (Tools) விசைப்பலகை குறுக்கு வழி
1. பாயின்டர் டூல் (Pointer Tool) F9
2. ர�ொட்டேடிங் டூல் (Rotating Tool) Shift + F2
3. லைன் டூல் (Line Tool) Shift + F3
4. ரெக்டாங்கல் டூல் (Rectangle Tool) Shift + F4
5. எலிப்ஸ் டூல் (Ellipse Tool) Shift + F5
6. பாலிகான் டூல் (Polygon Tool) Shift + F6
7. ஹேண்ட் டூல் (Hand Tool) Shift + Alt + Drag Left mouse button
8. டெக்ஸ்ட் டூல் (Text Tool) Shift + Alt + F1
9. கிராப்பிங் டூல் (Cropping Tool) Shift + Alt + F2
10. கன்ஸ்ட்ரெய்ன்டு லைன் டூல் (Constrained Line Tool) Shift + Alt + F3
11. ரெக்டாங்கல் ஃபிரேம் டூல் (Rectangle Frame Tool) Shift + Alt + F4
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பாடம் 01  அட�ோப் பேஜ்மேக்கர்6

அட்டவணை 1.2 க ருவிப்பெட்டி பணிக்குறிகள் மற்றும் அதன் பயன்கள்
கருவியின் பெயர் கருவிப் பெட்டியிலுள்ள 

பணிக்குறி
சுட்டுக்குறி பயன்

பாயின்டர் டூல் உரை மற்றும் வரைகலைப் 
படங்களைத் தேர்ந்தெடுக்க, நகர்த்த, 
அளவை மாற்ற

டெக்ஸ்ட் டூல் உரையை உள்ளிட, தேர்ந்தெடுக்க, 
பதிப்பிக்க

ர�ொட்டேடிங் டூல் ப�ொருள்களை தேர்ந்தெடுக்க மற்றும் 
சுழற்ற

கிராப்பிங் டூல் வரைகலைகளை ஒழுங்கமைக்க

லைன் டூல் நேர்கோடு வரைய

கன்ஸ்ரெய்ன்டு 
லைன் டூல்

கிடைமட்டமாகவும், செங்குத்தாகவும் 
க�ோடுகள் வரைய

ரெக்டாங்கல் டூல் சதுரம் மற்றும் செவ்வகம் வரைய

ரெக்டாங்கல் ஃபிரேம் 
டூல்

உரை மற்றும் வரைகலைகளை 
வைப்பதற்கான செவ்வகங்களை 
வரைய

எலிப்ஸ் டூல் வட்டம் மற்றும் நீள்வட்டம் வரைய

எலிப்ஸ் ஃபிரேம் டூல் உரை மற்றும் வரைகலைகளை 
வைப்பதற்கான நீள்வட்டங்களை 
வரைய

பாலிகான் டூல் பலக�ோணங்கள் வரைய

பாலிகான் ஃபிரேம் 
டூல்

உரை மற்றும் வரைகலைகளை 
வைப்பதற்கான பல க�ோணங்களை 
வரைய

ஹேண்ட் டூல் பக்கத்தை திரை உருளல் செய்ய

ஜும் டூல் பக்கத்தின் அளவை பெரிதாக்கியும், 
சிறிதாக்கியும் பார்க்க.
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7பாடம் 01  அட�ோப் பேஜ்மேக்கர்

முடிவிலும் நுழைவு விசையை (Enter 
Key) அழுத்த வேண்டியதில்லை.  ஒரு 
காலி வரி வேண்டுமென்றால�ோ அல்லது 
ஒரு பத்தியின் முடிவில�ோதான் நுழைவு 
விசையை அழுத்த வேண்டும்.

1.6  �ஆவணத்தில் உள்ள உரையைப் 
பதிப்பித்தல் (Editing Text in the 
Document)

ஆவணத்தில் உள்ள உரையில் 
மாற்றங்கள் செய்வது உரை பதிப்பித்தல் 
(Text Editing) எனப்படும்.  உரையை 
சேர்த்தல், நீக்குதல், பிழை திருத்துதல், 
நகர்த்துதல் மற்றும் நகலெடுத்தல் ப�ோன்ற 
செயல்கள் உரை பதிப்பித்தலில் அடங்கும்.

1.6.1	 உரையை தேர்ந்தெடுத்தல்
சுட்டி அல்லது விசைப்பலகை மூலம் 
உரையை தேர்ந்தெடுக்கலாம்.
சுட்டி மூலம் உரையைத் தேர்ந்தெடுத்தல்
சுட்டியின் மூலம் உரையைத் தேர்ந்தெடுக்க 
கீழ்க்கண்ட வழிமுறைகளைப் 
பின்பற்றவும்.

1.	 செருகும் புள்ளியை தேர்ந்தெடுக்க 
உரைத்தொகுதியின் த�ொடக்கத்தில் 
வைக்கவேண்டும்.

2.	 சுட்டியின் இடது ப�ொத்தானை 
அழுத்திப் பிடித்தவாறு உரையின் 
மீது நகர்த்த வேண்டும்.

3.	 தேவையான உரை 
தேர்ந்தெடுக்கப்பட்டவுடன் சுட்டியை 
அழுத்துவதை விட்டுவிட வேண்டும்.

4.	 இப்பொழுது உரை உயர்த்திக் 
காட்டப்பட்டிருக்கும்.

தேர்ந்தெடுக்க அழுத்த வேண்டியவை
ஒரு 
வார்த்தை

I-beam சுட்டுகுறி மூலம் 
இருமுறை கிளிக் செய்ய 
வேண்டும்.

ஒரு பத்தி I-beam சுட்டுகுறி மூலம் 
மூன்று முறை கிளிக் செய்ய 
வேண்டும்.

திரை உருளல் பட்டை (Scroll bars)
ஆவணத்தை மேலும் கீழுமாகவும், இடது 
மற்றும் வலது புறமாகவும் நகர்த்துவதை 
திரை உருளல் செய்தல் (Scrolling) 
என்கிற�ோம்.  ஆவணத்தை மேலும் 
கீழுமாக நகர்த்த செங்குத்துத் திரை 
உருளல் பட்டையும், இடது மற்றும் வலது 
புறமாக நகர்த்த கிடைமட்டத் திரை 
உருளல் பட்டையும் பயன்படுகிறது.
அளவுக�ோல்கள் (Rulers)
பேஜ்மேக்கர் ஆவணத்தின் மேல் மற்றும் 
இடது ஓரத்தில் இரண்டு அளவுக�ோல்கள் 
உள்ளன.

1.	 அளவுக�ோலை திரையில் காண்பிக்க, 
பட்டிப்பட்டையில் View > Show Rulers 
என்பதைக் கிளிக் செய்ய வேண்டும்.

2.	 அளவுக�ோலை மறைக்க, 
பட்டிப்பட்டையில் View > Hide Rulers 
என்பதைக் கிளிக் செய்ய வேண்டும்.

1.5  �ஆவணத்தில் உரையை 
உள்ளிடுதல் (Entering Text in the 
Document)

பேஜ்மேக்கர் ஆவணத்தில் 
உரைத்தொகுதியின் (Text block) 
உள்ளே உரையை உள்ளிட வேண்டும்.  
உரைத்தொகுதியை உருவாக்க 
டெக்ஸ்ட் டூலை (Text Tool) பயன்படுத்த 
வேண்டும்.  டெக்ஸ்ட் டூலை பயன்படுத்தி 
உரைத்தொகுதியை உருவாக்கியபின் 
அதில் உரையை நேரடியாக தட்டச்சு 
செய்யலாம்.  உரையை தட்டச்சு செய்யும் 
ப�ோது விட்டுவிட்டுத் த�ோன்றும் நெடும்பட்டை 
ஒன்று வலது புறமாக நகர்ந்து க�ொண்டே 
செல்லும்.  அதற்கு செருகும் புள்ளி என்று 
பெயர்.  உரையை தட்டச்சு செய்யும் ப�ொழுது 
உரையானது உரைத்தொகுதியின் 
ஓரத்தைத் த�ொட்டவுடன், தானாகவே 
மடிந்து அடுத்த வரிக்குச் செல்லும். 
உரைத்தொகுதியின் ஒவ்வொரு வரி 
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	 	 (அல்லது)
3.	 செருகும் புள்ளியை அழிக்க 

வேண்டிய எழுத்தின் வலது புறம் 
வைக்க வேண்டும்.

4.	 விசைப்பலகையில் backspace 
விசையை அழுத்த வேண்டும்.

உரைத் த�ொகுதிகளை அழிக்க
1.	 அழிக்க வேண்டிய உரைத் 

த�ொகுதியை தேர்ந்தெடுக்க 
வேண்டும்.

2.	 விசைப்பலகையில் Delete அல்லது 
Backspace விசையை அழுத்த 
வேண்டும் அல்லது பட்டிப்பட்டையில் 
Edit > clear என்பதைக் கிளிக் செய்ய 
வேண்டும்.

கட்டளை (Undo)
இறுதியாக நாம் பயன்படுத்திய 
கட்டளையை (செயலை) திரும்பப் பெற 
Undo கட்டளை பயன்படுகிறது.  இதை 
செயல்படுத்த பட்டிப்பட்டையில் Edit>Undo 
என்பதைக் கிளிக் செய்ய வேண்டும் 
அல்லது விசைப்பலகையில் Ctrl + Z 
என்பதை அழுத்த வேண்டும்.

உரையை நகலெடுத்தல் மற்றும் 
நகர்த்துதல்
பேஜ்மேக்கர் ஆவணத்தில் உரையை 
ஓரிடத்தில் இருந்து மற்றொரு இடத்திற்கு 
நகலெடுத்து ஒட்டுவதற்கு Copy மற்றும் 
Paste கட்டளைகள் பயன்படுகிறது.

1.	 Copy கட்டளையானது, 
தேர்தெடுக்கப்பட்ட உரையின் 
நகலை உருவாக்குகிறது.  
ஏற்கனவே உள்ள மூல உரையில் 
எந்த மாற்றமும் செய்வதில்லை.

2.	 Paste கட்டளையானது, 
நகலெடுக்கப்பட்ட உரையை 
செருகும் புள்ளி உள்ள இடத்தில் 
ஒட்டுகிறது.

விசைப்பலகை மூலம் உரையை 
தேர்ந்தெடுத்தல்
விசைப்பலகை மூலம் உரையைத் 
தேர்ந்தெடுக்க கீழ்க்கண்ட 
வழிமுறைகளைப் பின்பற்றவும்.

1.	 செருகும் புள்ளியை தேர்ந்தெடுக்க 
வேண்டிய உரையின் த�ொடக்கத்தில் 
வைக்க வேண்டும்.

2.	 Shift விசையை அழுத்தியவாறு 
நகர்வுப் ப�ொத்தான்களைப் 
பயன்படுத்தி உரையைத் 
தேர்ந்தெடுக்க வேண்டும்.

3.	 உரை தேர்ந்தெடுக்கப்பட்டவுடன் 
Shift விசையை அழுத்துவதை 
விட்டுவிட வேண்டும்.

தேர்ந்தெடுக்க அழுத்த 
வேண்டியவை

ஒரு எழுத்து இடது புறமாக Shift + ←

ஒரு எழுத்து வலது புறமாக Shift + →

ஒரு வரி மேலே Shift + ↑

ஒரு வரி கீழே Shift + ↓

வரியின் இறுதி வரை Shift + End

வரியின் த�ொடக்கம் வரை Shift + Home

ஆவணம் முழுவதும் Ctrl + A

1.6.2 	 உரையை அழித்தல்
ஒரு ஆவணத்தில் உள்ள ஓர் 
எழுத்து அல்லது வார்த்தை அல்லது 
உரைத்தொகுதியை எளிமையாக அழிக்க 
முடியும்.

எழுத்தை அழிக்க
1.	 செருகும் புள்ளியை அழிக்க 

வேண்டிய எழுத்தின் இடது புறம் 
வைக்க வேண்டும்.

2.	 விசைப்பலகையில் Delete விசையை 
அழுத்த வேண்டும்.
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உரையை நகலெடுத்தல்
தேர்தெடுக்கப்பட்ட உரையை நகலெடுத்து, 
தேவையான இடத்தில் ஒட்ட முடியும்.

உரையை நகலெடுத்து ஒட்டுதல்
1.	 நகலெடுக்க வேண்டிய உரையை 

தேர்ந்தெடுக்க வேண்டும்.
2.	 பட்டிப் பட்டையில் Edit > Copy 

என்பதைக் கிளிக் செய்ய வேண்டும் 
(அல்லது) விசைப்பலகையில் Ctrl 
+ C என்பதை அழுத்த வேண்டும்.  
(அல்லது) சுட்டெலியின் வலது 
ப�ொத்தானைக் கிளிக் செய்து 
வரும் பட்டியலில் Copy என்பதைத் 
தேர்ந்தெடுக்க வேண்டும்.

3.	 உரையை ஒட்ட வேண்டிய 
இடத்திற்கு செருகும் புள்ளியை 
நகர்த்த வேண்டும்.

4.	 பட்டிப் பட்டையில் Edit > Paste 
என்பதைக் கிளிக் செய்ய வேண்டும். 
(அல்லது) விசைப்பலகையில் Ctrl 
+ V என்பதை அழுத்த வேண்டும். 
(அல்லது) சுட்டெலியின் வலது 
ப�ொத்தானைக் கிளிக் செய்து வரும் 
பட்டியலில் Paste என்பதைத் 
தேர்ந்தெடுக்க வேண்டும்.

விசைப்பலகை குறுக்கு வழிகள்
Ctrl + C ® நகலெடுக்க
Ctrl + V ®  ஒட்ட

1.7  உரைத்தொகுதி (Text Block)
உரைத்தொகுதியானது நாம் தட்டச்சு 
செய்த உரையைய�ோ அல்லது 
ஒட்டிய உரையைய�ோ அல்லது வேறு 
ஆவணத்திலிருந்து க�ொண்டுவரப்பட்ட 
உரையைய�ோ க�ொண்டிருக்கும்.

3.	 உரையை ஓரிடத்தில் இருந்து 
மற்றொரு இடத்திற்கு நகர்த்துவதற்கு 
Cut மற்றும் Paste கட்டளை 
பயன்படுகிறது.  Cut கட்டளையானது 
தேர்ந்தெடுக்கப்பட்ட உரையை 
வெட்டுகிறது.

4.	 Paste கட்டளையானது, வெட்டப்பட்ட 
உரையை செருகும் புள்ளி உள்ள 
இடத்தில் ஒட்டுகிறது.

உரையை நகர்த்துதல்
தேர்ந்தெடுக்கப்பட்ட உரையை வெட்டி, 
தேவையான இடத்தில் ஒட்ட முடியும்.

உரையை வெட்டி ஒட்டுவதற்கு
1.	 நகர்த்த வேண்டிய உரையை 

தேர்ந்தெடுக்க வேண்டும்.
2.	 பட்டிப் பட்டையில் Edit > Cut என்பதை 

கிளிக் செய்ய வேண்டும் (அல்லது) 
விசைப்பலகையில் Ctrl + X என்பதை 
அழுத்த வேண்டும்.  (அல்லது) 
சுட்டெலியின் வலது ப�ொத்தானைக் 
கிளிக் செய்து வரும் பட்டியலில் Cut 
என்பதைத் தேர்ந்தெடுக்க வேண்டும்.

3.	 உரையை ஒட்ட வேண்டிய 
இடத்திற்கு செருகும் புள்ளியை 
நகர்த்த வேண்டும்.

4.	 பட்டிப் பட்டையில் Edit > Paste 
என்பதைக் கிளிக் செய்ய வேண்டும்.  
(அல்லது) விசைப்பலகையில் Ctrl 
+ V என்பதை அழுத்த வேண்டும்.  
(அல்லது) சுட்டெலியின் வலது 
ப�ொத்தானைக் கிளிக் செய்து வரும் 
பட்டியலில் Paste என்பதைத் 
தேர்ந்தெடுக்க வேண்டும்.

விசைப்பலகை குறுக்கு வழிகள்
Ctrl + X ® வெட்ட
Ctrl + V ® ஒட்ட
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உரைத்தொகுதியை இரண்டு வழிகளில் உருவாக்கலாம்:
1.	 ஆவணப் பக்கத்தில் அல்லது ஒட்டுப்பலகையில் டெக்ஸ்ட் டூலைக் கிளிக் செய்து 

இழுத்து, அதில் தட்டச்சு செய்வதன் மூலம் உரைத்தொகுதியை உருவாக்கலாம்.
2.	 ஒரு காலியான ஆவணப் பக்கத்தில�ோ அல்லது பத்தியில�ோ (Column) உரையேற்றப்பட்ட 

(Loaded Text) பணிக்குறியைக் கிளிக் செய்வதன் மூலம் உரைத்தொகுதியை 
உருவாக்கலாம்.

1.7.1	 டெக்ஸ்ட் டூலைக் க�ொண்டு உரைத்தொகுதியை உருவாக்குதல்
1.	 கருவிப் பெட்டியிலிருந்து டெக்ஸ்ட் டூலை (T) தேர்ந்தெடுக்கவும்.  சுட்டெலியின் 

சுட்டுகுறியானது I-beam ஆக மாறும்.

படம் 1.9  I-beam

2.	 ஒரு காலியான ஆவணப் பக்கத்தில�ோ அல்லது பத்தியில�ோ கிளிக் செய்யவும்.  இப்பொழுது 
அந்த ஆவணப் பக்கம் அல்லது பத்தியின் அகலத்திற்கு ஒரு உரைத்தொகுதி உருவாகிறது.  
க�ொடாநிலையாக செருகும் புள்ளி உரைத்தொகுதியின் இடது ஓரத்தில் இருக்கும்.

படம் 1.10  உரைத்தொகுதி
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11பாடம் 01  அட�ோப் பேஜ்மேக்கர்

3.	 இப்பொழுது தேவையான உரையை தட்டச்சு செய்யவும்.  பாய்ன்டர் டூலை கிளிக் 
செய்து உரையின் மீது கிளிக் செய்யும் வரை உரைத்தொகுதியின் ஓரங்கள் தெரியாது.

படம் 1.11  டெக்ஸ்ட் டூலைக் க�ொண்டு உரைத்தொகுதியை உருவாக்குதல்

1.7.2	 உரைத்தொகுதியை நகர்த்துதல்
உரைத்தொகுதியை அதன் வடிவத்தை மாற்றாமல் தேவையான இடத்திற்கு நகர்த்த, 
சுட்டுகுறியை உரைத்தொகுதியில் கிளிக் செய்து இழுத்து நகர்த்த வேண்டும்

படம் 1.12  உரைத்தொகுதியை நகர்த்துதல்
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பாடம் 01  அட�ோப் பேஜ்மேக்கர்12

1.7.3	 உரைத்தொகுதியின் அளவை மாற்றுதல்
பாய்ன்டர் டூல் மூலம் உரைத்தொகுதியில் கிளிக் செய்தால், உரைத்தொகுதியின் 
எல்லைகள் தெரியும்.  அதாவது உரைத்தொகுதியின் மேலும் கீழும் இரண்டு கைப்பிடிகள் 
த�ோன்றும்.  இதற்கு விண்டோஸேட்ஸ் (windowshades) என்று பெயர்.  கைப்பிடியின் இரு 
முனைகளிலும் கறுப்பு நிற கட்டங்கள் த�ோன்றும்.  இவை உரைத்தொகுதியின் அளவை 
மாற்றுவதற்குப் பயன்படுகின்றன.

படம் 1.13  விண்டோஸேட்ஸ் (Windowshades)

உரைத்தொகுதியின் அளவை மாற்ற
1.	 பாய்ன்டர் டூலைக் கிளிக் செய்யவும்.
2.	 உரைத்தொகுதியின் கீழ்ப்புறத்தில் இடது அல்லது வலது பக்க கைப்பிடியைக் கிளிக் 

செய்து இழுக்கவும்.
	 சுட்டியை அழுத்துவதை விட்டவுடன், உரையானது உரைத்தொகுதியின் புதிய 

அளவிற்கு ப�ொருந்துமாறு மாறியிருக்கும்.

படம் 1.14  உரைத்தொகுதியின் அளவை மாற்றுதல்
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13பாடம் 01  அட�ோப் பேஜ்மேக்கர்

3.	 விண்டோஸேடின் கீழ்ப்புறத்தில் உள்ள சிவப்பு முக்கோணம், உரைத்தொகுதியின் 
வெளியில் தெரிவதைவிட அதிகமான உரை உள்ளே மறைந்திருக்கிறது என்பதைக் 
காட்டுகிறது.  கைப்பிடியை கீழே இழுப்பதன் மூலம் மறைந்திருக்கும் உரையைப் 
பார்க்கலாம்.

படம் 1.15  விண்டோஸேடின் கீழ்ப்புறத்தில் உள்ள சிவப்பு முக்கோணம்

1.7.4	 உரைத்தொகுதியை இரண்டாகப் பிரித்தல்
1.	 செருகும் புள்ளியை கீழ்ப்பக்கம் உள்ள கைப்பிடியில் கிளிக் செய்து மேல்நோக்கி 

இழுக்கவும்.  சுட்டியை அழுத்துவதை விட்டவுடன் கீழ்ப்பக்க கைப்பிடி சிவப்பு நிற 
முக்கோணத்துடன் த�ோன்றும்.

படம் 1.16  கீழ்ப்பக்க கைப்பிடியில் உள்ள சிவப்பு நிற முக்கோணம்
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பாடம் 01  அட�ோப் பேஜ்மேக்கர்14

2.	 மறுபடியும் அதில் கிளிக் செய்தால் அது உரையேற்றப்பட்ட (Loaded text) பணிக்குறியாக 
மாறும்.

படம் 1.17  உரையேற்றப்பட்ட (loaded text) பணிக்குறி

3.	 இப்பொழுது தேவையான இடத்தில் கிளிக் செய்தால், அந்த இடத்தில் மற்றொரு 
உரைத்தொகுதி த�ோன்றும்.

படம் 1.18  உரைத்தொகுதியை இரண்டாகப் பிரித்தல்

1.7.5	 பிரிக்கப்பட்ட உரைத்தொகுதிகளை மீண்டும் இணைத்தல்
பிரிக்கப்பட்ட இரண்டு உரைத்தொகுதிகளை மீண்டும் ஒன்றாக இணைப்பதற்கு:

1.	 செருகும் புள்ளியை இரண்டாவது உரைத்தொகுதியின் கீழ்ப்பக்க கைப்பிடியில் கிளிக் 
செய்து அதன் மேல்பகுதி வரை இழுக்கவும்.

2.	 பிறகு செருகும் புள்ளியை முதல் உரைத்தொகுதியின் கீழ்ப்பக்க கைப்பிடியில் கிளிக் 
செய்து கீழ்நோக்கி தேவையான அளவிற்கு இழுக்கவும்.  இப்பொழுது பிரிக்கப்பட்ட 
இரண்டு உரைத்தொகுதிகளும் ஒன்றாக இணைக்கப்பட்டுவிடும்.
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15பாடம் 01  அட�ோப் பேஜ்மேக்கர்

1.7.6	 பிற மென்பொருள்களில் தயாரிக்கப்பட்ட க�ோப்புகளை பேஜ்மேக்கரில் 
செருகுதல் (Placing or Importing Text)

MS-Word ப�ோன்ற பிற மென்பொருள்களில் இருக்கும் உரைகளை பேஜ்மேக்கர் 
ஆவணத்தில் செருக முடியும்.

1.	 பட்டிப்பட்டையில் File > Place என்பதைக் கிளிக் செய்ய வேண்டும்.  Place உரையாடல் 
பெட்டி த�ோன்றும்.

படம் 1.19  File பட்டியில் உள்ள Place தேர்வு

2.	 செருக வேண்டிய உரை உள்ள ஆவணத்தைத் தேர்ந்தெடுக்க வேண்டும்.

படம் 1.20  Place உரையாடல் பெட்டி

XII CompTech_Tamil version CHAPTER 01.indd   15 12/01/2022   14:57:28

www.tntextbooks.in



பாடம் 01  அட�ோப் பேஜ்மேக்கர்16

பயனர் கட்டுப்பாட்டு உரைப்பாய்வு 
(Manual text flow)
●	 உரையேற்றப்பட்ட (Loaded text) 

பணிக்குறியை உரையை வைக்க 
வேண்டிய இடத்தில் கிளிக் செய்து 
தேவையான அளவிற்கு இழுத்துவிட 
வேண்டும்.

●	 இப்பொழுது உரை நாம் வரையறுத்த 
உரைத்தொகுதிக்குள் வந்திருக்கும்.  
இந்த உரைத்தொகுதிக்குள் உரை 
முழுவதும் வைக்க முடியவில்லை 
எனில், கீழ்ப்பக்க விண்டோஸேடில் 
சிவப்பு நிற முக்கோணம் த�ோன்றும்.  
இதில் கிளிக் செய்தால் மறுபடியும் 
உரையேற்றப்பட்ட (Loaded text) 
பணிக்குறி த�ோன்றும்.

3.	 Place உரையாடல் பெட்டியில் 
உள்ள Open ப�ொத்தானைக் கிளிக் 
செய்ய வேண்டும்.  இப்பொழுது 
சுட்டுக்குறியானது உரையேற்றப்பட்ட 
(loaded text ) பணிக்குறியாக 
மாறி இருக்கும்.

4.	 இந்த உரையை இடுவதற்கு ஒரு 
உரைத்தொகுதியை உருவாக்க 
வேண்டும். (அல்லது) அந்த ஆவணத்தின் 
ஒரு காலிப்பக்கத்தில் கிளிக் செய்தால் 
அப்பக்கத்தில் அவ்வுரை இடம்பெறும்.

	 நாம் செருக வேண்டிய உரை ஒரு 
பக்கத்தைவிட அதிகமாக இருந்தால், 
அதை பல பக்கங்களில் வைக்க 
பேஜ்மேக்கர் அனுமதிக்கிறது.  இதை 
தானமைவாகவ�ோ அல்லது பயனர் 
கட்டுப்பாட்டில�ோ அமைக்கலாம்.

படம் 1.21  கீழ்ப்பக்க விண்டோஸேடில் உள்ள சிவப்பு நிற முக்கோணம்
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17பாடம் 01  அட�ோப் பேஜ்மேக்கர்

●	 இப்பொழுது புதிய உரைத்தொகுதியை உருவாக்கி அதில் கிளிக் செய்ய வேண்டும்.
●	 இந்த செயல்முறையை சிவப்பு நிற முக்கோணம் மறையும் வரை அல்லது செருக 

வேண்டிய உரை உள்ளவரை திரும்பத் திரும்ப செய்ய வேண்டும்.

படம் 1.22  உரைத்தொகுதிகள்

இதே ப�ோன்று ஒரு பக்கத்தில் உரையை செருக வேண்டுமெனில் பக்கத்தின் 
மேற் பகுதியில் உரையேற்றப்பட்ட (Loaded text) பணிக்குறியை வைத்து கிளிக் செய்ய 
வேண்டும்.  உரையானது அப்பக்கம் முழுவதும் நிரம்பும்.  ஒரு பக்கத்தைவிட அதிகமான 
உரை இருந்தால், கீழ்ப்பகுதியில் உள்ள விண்டோஸேடில் சிவப்பு நிற முக்கோணம் 
த�ோன்றும்.  இதைக் கிளிக் செய்தால் உரையேற்றப்பட்ட (Loaded text) பணிக்குறி மறுபடியும் 
த�ோன்றும்.  இப்பொழுது பட்டிப் பட்டையில் Layout > Insert Pages என்பதைக் கிளிக் செய்து 
புதிய பக்கத்தை உருவாக்கி, பக்கத்தின் மேல் பகுதியில் உரையேற்றப்பட்ட (Loaded text) 
பணிக்குறியைக் கிளிக் செய்ய வேண்டும்.

இதை செருக வேண்டிய உரை உள்ளவரை திரும்பத் திரும்ப செய்ய வேண்டும்.

தானமைவு உரைப்பாய்வு (Automatic text flow)
உரையை ஏற்றுவதற்கு (importing) முன்பு, பட்டிப் பட்டையில் Layout > Autoflow என்பதைக் 
கிளிக் செய்ய வேண்டும்.  பின்னர் உரையை ஏற்ற வேண்டும்.  இப்பொழுது உரையேற்றப்பட்ட 
(Loaded text) பணிக்குறி சற்று வேறுபட்டு squiggly arrow ( ) வாகத் த�ோன்றும்.

இப்பொழுது உரையேற்றப்பட்ட (Loaded text) பணிக்குறியை பக்கத்தின் மேல் 
பகுதியில் கிளிக் செய்தால், உரையானது தானமைவாக தேவையான அளவிற்கு 
அடுத்தடுத்தப் பக்கங்களில் நிரப்பப்படும்.
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1.8  பேஜ்மேக்கர் ஸ்டோரி
பேஜ்மேக்கர் ஸ்டோரி (story) என்பது 
செய்தித்தாளில் வரும் கட்டுரையை 
ஒத்ததாகும்.  செய்தித்தாளின் முதல் 
பக்கத்தில் பல்வேறுபட்ட செய்திகளுக்கான 
கட்டுரைகள் இருக்கும்.  அதன் த�ொடர்ச்சி 
வேறு பக்கங்களில் இருக்கும்.  இதே 
ப�ோல பேஜ்மேக்கர் ஆவணத்தில் பல 
ஸ்டோரிகள் ஒரே பக்கத்தில் இருக்கலாம்.  
அதன் த�ொடர்ச்சி வேறு பக்கங்களில் 
இருக்கலாம்.

1.9  �த�ொடர்புள்ள உரைத்தொகுதிகள் 
(threading text blocks)

பேஜ்மேக்கரில் உள்ள எல்லா 
உரைகளும் உரைத்தொகுதி என்று 
அழைக்கப்படும் கலன்களின் உள்ளே 
வைக்கப்பட்டிருக்கும்.

ஒரு உரைத்தொகுதியிலுள்ள 
உரையானது மற்றொரு 
உரைத்தொகுதிக்குள் செல்லுமாறு, 
ஒரு உரைத்தொகுதியை மற்றொரு 
உரைத்தொகுதியுடன் இணைக்கவ�ோ 
அல்லது த�ொடர்புபடுத்தவ�ோ முடியும்.  
இவ்வாறு த�ொடர்புபடுத்தப்பட்டிருக்கும் 
உரைத்தொகுதிகளுக்கு த�ொடர்புள்ள 
உரைத்தொகுதிகள் (Threading text blocks) 
என்று பெயர்.

உரைத்தொகுதிகளுக்கு இடையே 
உள்ள உரையை இணைக்கும் 
செயல்முறைக்கு த�ொடர்புபடுத்தப்பட்ட 
உரை (threading text) என்று பெயர்.  ஒன்று 
அல்லது அதற்கு மேற்பட்ட த�ொடர்புள்ள 
உரைத்தொகுதிகள் வழியாக பாயும் உரை 
ஸ்டோரி (story) எனப்படும்.

உரை ஏற்றப்பட்ட 
பணிக்குறியில் உள்ள உரையை 
உரைத்தொகுதிகளுக்கிடையே பாயச் 
செய்வதற்கு மேற்குறிப்பிட்ட இரண்டு 
வழிகளில் ஒன்றை பின்பற்றலாம்.

உரை ஏற்றப்பட்ட பணிக்குறியை 
நீக்குவதற்கு கருவிபெட்டியில் உள்ள 
பாய்ன்டர் டூலை கிளிக் செய்ய வேண்டும்.  
இதனால் அதில் உள்ள உரை அழியாது.

த�ொடர்புள்ள உரைத்தொகுதி 
என்பதை மேல் அல்லது கீழ்ப்பக்க 
கைப்பிடியிலுள்ள உள்ள கூட்டல் 
குறியீட்டின் மூலம் அறிந்து க�ொள்ளலாம்.

த�ொடர்பற்ற உரைத்தொகுதி 
என்பது மற்ற உரைத்தொகுதிகளுடன் 
இணைக்கப்படாமல் தனியாக இருக்கும்.  
இந்த த�ொகுதியின் மேல் மற்றும் கீழ்ப்பக்க 
கைப்பிடியில் எந்தக் குறியீடும் இருக்காது.

படம் 1.23  த�ொடர்பற்ற உரை

படம் 1.24  த�ொடர்புள்ள உரை
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படம் 1.25  த�ொடர்புள்ள உரைத்தொகுதிகள்

1.9.1	 த�ொடர்புள்ள 
உரைத்தொகுதியை த�ொடர்பற்ற 
உரைத்தொகுதியாக்குதல்

செய்முறை 1
தனி உரைத்தொகுதியாக மாற்ற வேண்டிய 
உரைத்தொகுதியை பாயின்டர் டூல் மூலம் 
தேர்ந்தெடுக்க வேண்டும்.  பட்டிப்பட்டையில் 
Edit > Cut என்பதைக் கிளிக் செய்தால் 
உரைத்தொகுதி மறைந்துவிடும்.  பின்னர் 
Edit > Paste என்பதைக் கிளிக் செய்ய 
வேண்டும்.  இப்பொழுது மறுபடியும் அந்த 
உரைத்தொகுதி அதே இடத்தில் த�ோன்றும்.  
ஆனால் அது தனி உரைத்தொகுதியாக 
மாற்றப்பட்டிருக்கும்.

எச்சரிக்கை
தனி உரைத்தொகுதியாக மாற்ற வேண்டிய 
த�ொகுதி ஒரு ஸ்டோரியின் நடுவில் இருந்தால், 
அதாவது மூன்று உரைத்தொகுதிகளில் 
இரண்டாவதாக இருந்தால், முதல் த�ொகுதியும் 
மூன்றாவது த�ொகுதியும் நேரடியாக 
இணைக்கப்பட்டுவிடும்.

செய்முறை 2
த�ொடர்பற்ற உரைத்தொகுதியாக மாற்ற 
வேண்டிய உரைத்தொகுதியை பாயின்டர் 
டூல் மூலம் தேர்வு செய்ய வேண்டும்.  
டெக்ஸ்ட் டூலைக் கிளிக் செய்து அந்த 
த�ொகுதியிலுள்ள உரை முழுவதையும் 
தேர்ந்தெடுக்க வேண்டும்.  பிறகு பட்டிப் 
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2.	 அதைப் பயன்படுத்தி ஒரு சட்டம் 
வரைய வேண்டும்.  அச்சட்டம் தேர்வு 
செய்யப்பட்டுள்ளதை உறுதி செய்து 
க�ொள்ள வேண்டும்.

3.	 பட்டிப்பட்டையில் File பட்டியை 
தேர்வு செய்ய வேண்டும்.

4.	 பிறகு Place என்பதைக் கிளிக் செய்ய 
வேண்டும். Place உரையாடல் பெட்டி 
த�ோன்றும்.

5.	 செருக வேண்டிய உரை உள்ள 
ஆவணத்தை தேர்வு செய்ய 
வேண்டும்.

6.	 Open ப�ொத்தானைக் கிளிக் செய்ய 
வேண்டும்.

7.	 உரையை செருக வேண்டிய 
சட்டத்தில் கிளிக் செய்ய வேண்டும்.  
உரையானது சட்டத்தில் 
செருகப்பட்டுவிடும்.

பட்டையில் Edit > Cut என்பதைக் கிளிக் 
செய்தால் உரைத்தொகுதி மறைந்துவிடும்.  
இப்பொழுது செருகும் புள்ளியை ஏற்கனவே 
உள்ள த�ொடர்புள்ள உரைத்தொகுதியில் 
கிளிக் செய்து Edit > Paste என்பதைக் கிளிக் 
செய்ய வேண்டும்.  இப்பொழுது உரை 
அந்த த�ொகுதியில் சேர்க்கப்பட்டிருக்கும்.

1.10  சட்டத்தில் உரையை வைத்தல்
உரையை வைக்க உரைத் 
த�ொகுதிகளுக்கு பதிலாக சட்டங்களையும் 
பயன்படுத்தலாம்.

சட்டத்தில் உரையை வைக்க
1.	 கருவிப்பெட்டியில் உள்ள செவ்வகம் 

அல்லது நீள்வட்டம் அல்லது 
பலக�ோணம் ஃபிரேம் டூல்களில் 
ஏதேனும் ஒன்றின் மீது கிளிக் செய்ய 
வேண்டும்.

படம் 1.26  சட்டத்தில் உரையை வைத்தல்
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2.	 முதல் சட்டத்தை கிளிக் செய்து 
தேர்ந்தெடுக்க வேண்டும்.

3.	 கீழ்ப்பக்க கைப்பிடியிலுள்ள உள்ள 
சிவப்பு முக்கோணத்தைக் கிளிக் 
செய்ய வேண்டும்.

4.	 பின்னர் இரண்டாவது சட்டத்தைக் 
கிளிக் செய்ய வேண்டும்.  உரை 
இரண்டாவது சட்டத்தில் விரியும்.

1.10.1	 உரை உள்ள சட்டங்களுக்கு  
இணைப்பை ஏற்படுத்துதல்

மிகப்பெரிய அளவிலான உரைத் 
த�ொகுப்பினை ஒற்றை சட்டத்திற்குள் 
ப�ொருத்துவது கடினம்.  இது ப�ோன்ற 
சமயங்களில் ஒன்றிற்கு மேற்பட்ட 
சட்டங்களை இணைப்பதன் மூலம் முழு 
உரைப்பகுதியையும் காட்ட முடியும்.
உரை உள்ள சட்டங்களை இணைக்க

1.	 சட்டத்திற்கான கருவியைப் 
பயன்படுத்தி இரண்டாவது சட்டம் 
வரைய வேண்டும்.

●	 �பேஜ்மேக்கர் ஆவணத்தில் தட்டச்சு செய்யப்படும் உரைகள், வரையப்படும் 
அல்லது தருவிக்கப்படும் வரைகலைகள் ப�ொருள் (object) என 
அழைக்கப்படும்.

●	 ப�ொருள் ஆவணப் பக்கத்தில�ோ அல்லது ஒட்டுப்பலகையில�ோ இருக்கலாம்.
●	 உரையானது உரைத்தொகுதியில�ோ அல்லது சட்டங்களில�ோ இருக்கலாம்.

படம் 1.27  உரை உள்ள சட்டங்களுக்கு இணைப்பை ஏற்படுத்துதல்
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1. 10. 2	 உரைத்தொகுதியிலுள்ள உரையை சட்டத்திற்கு மாற்றுதல்
உரைத்தொகுதியில் உரையை உருவாக்கிய பின் அதை சட்டத்திற்கு மாற்ற கீழ்க்கண்ட 
வழிமுறைகளை பின்பற்ற வேண்டும்.

1.	 பேஜ்மேக்கரில் உள்ள ஃபிரேம் டூல்களில் ஏதேனும் ஒன்றைப் பயன்படுத்தி சட்டம் 
ஒன்றை வரைய வேண்டும்.

2.	 சட்டத்திற்குள் செருக வேண்டிய உரைத்தொகுதியைத் தேர்ந்தெடுக்க வேண்டும்.
3.	 Shift விசையை அழுத்திக் க�ொண்டு சட்டத்தைக் கிளிக் செய்ய வேண்டும்.  இப்பொழுது 

இரண்டு ப�ொருள்களும் தேர்ந்தெடுக்கப்பட்டிருக்கும்.
4.	 பட்டிப் பட்டையில் Element > Frame > Attach Content என்பதைக் கிளிக் செய்ய 

வேண்டும்.
5.	 இப்பொழுது உரையானது சட்டத்திற்குள் த�ோன்றும்.

படம் 1.28  உரைத்தொகுதியிலுள்ள உரையை சட்டத்திற்கு மாற்றுதல்

1. 10. 3	 சட்டத்தில் உள்ள உரையைப் 
பிரித்தல்

சட்டத்திற்குள் இணைக்கப்பட்ட உரையை 
தனியே பிரிக்க முடியும்.

சட்டத்திலிருந்து உரையை பிரிக்க
1.	 பாயின்டர் டூல் மூலம் சட்டத்தைக் 

கிளிக் செய்ய வேண்டும்.
2.	 பட்டிப் பட்டையில் Element >Frame 

> Delete content என்பதைக் கிளிக் 
செய்ய வேண்டும்.  இப்பொழுது 
சட்டத்தில் உரை இருக்காது.

1.11  �ஆவணத்தை சேமித்தல்,  
மூடுதல் மற்றும் திறத்தல்

1. 11. 1	 ஆவணத்தை சேமித்தல்
பிற்கால பயன்பாட்டிற்காக உங்கள் 
ஆவணத்தை சேமித்து வைத்துக் க�ொள்ள 
முடியும்.  சேமித்த ஆவணத்தை பின்னர் 
பார்க்கவும் பதிப்பாய்வு செய்யவும் முடியும்.  
சேமிக்கப்பட்ட ஆவணத்தை மற்ற 
கணிப்பொறிகளிலும் பயன்படுத்தலாம்.

XII CompTech_Tamil version CHAPTER 01.indd   22 12/01/2022   14:57:34

www.tntextbooks.in



23பாடம் 01  அட�ோப் பேஜ்மேக்கர்

File>Save அல்லது Ctrl+S அல்லது 
Save பணிக்குறியைக் ( ) கிளிக் 
செய்யவும். ஆவணம் ஏற்கனவே 
சேமித்த பெயரிலேயே சேமிக்கப்படும்.

1. 11. 2	 சேமிக்கப்பட்ட  
ஆவணத்தை வேறு  
பெயரில் அல்லது வேறு 
இடத்தில் சேமித்தல்

சேமிக்கப்பட்ட ஆவணத்தை வேறு 
பெயரில் அல்லது வேறு இடத்தில் சேமிக்க 
Save As கட்டளையைப் பயன்படுத்தலாம்.   
Save As கட்டளை ஆவணத்தின் புதிய 
நகலை உருவாக்குகிறது.  அதனால் 
ஆவணத்தின் இரண்டு பதிப்புகள் 
இருக்கும்.  ஆவணத்தின் இரண்டு 
பதிப்புகளும் தனித்தனியாக இருக்கும்.  
அதாவது ஒரு ஆவணத்தில் ஏதேனும் 
மாற்றம் செய்தால் மற்றொரு ஆவணத்தில் 
எந்த மாற்றத்தையும் ஏற்படுத்தாது. 

சேமிக்கப்பட்ட ஆவணத்தை வேறு 
பெயரில் அல்லது வேறு இடத்தில் சேமிக்க

1.	 பட்டிப் பட்டையில் File>Save As 
என்பதைக் கிளிக் செய்ய வேண்டும்.  
(அல்லது) விசைப்பலகையில் 
Shift+Ctrl+S என்ற சாவி 
சேர்மானத்தை அழுத்த வேண்டும்.  
இப்பொழுது Save Publication 
உரையாடல் பெட்டி திரையில் 
த�ோன்றும்.

2.	 உரைப்பெட்டியில் புதிய பெயரை 
தட்டச்சு செய்ய வேண்டும் அல்லது 
புதிய இடத்தை தேர்ந்தெடுக்க 
வேண்டும்.

3.	 பிறகு save ப�ொத்தானை அழுத்தி 
ஆவணத்தை சேமிக்க வேண்டும்.

முதல் முறையாக ஆவணத்தை 
சேமிக்கும் ப�ோது கீழ்க்கண்ட 
வழிமுறைகளைப் பின்பற்ற வேண்டும்.

1.	 படிப்பட்டையில் File>Save 
என்பதைக் கிளிக் செய்ய வேண்டும் 
அல்லது கருவிப்பட்டையில் Save 
பணிக்குறியைக் கிளிக் செய்ய 
வேண்டும் அல்லது விசைப்லகையில் 
Ctrl+S என்ற சாவி சேர்மானத்தை 
அழுத்த வேண்டும்.  படம் 1.29 இல் 
காட்டியுள்ளவாறு Save Publication 
உரையாடல் பெட்டி திரையில் 
த�ோன்றும்.

படம் 1.29  Save Publication உரையாடல் பெட்டி

2.	 File name உரைப்பெட்டியில் 
ஆவணத்தின் பெயரை தட்டச்சு 
செய்ய வேண்டும்.

3.	 பிறகு save ப�ொத்தானை அழுத்தி 
ஆவணத்தை சேமிக்க வேண்டும்.  
இப்பொழுது ஆவணம் சேமிக்கப்பட்டு, 
ஆவணத்தின் பெயர் தலைப்புப் 
பட்டையில் தெரியும்.

4.	 ஒரு முறை பெயரிட்டு சேமித்த 
ஆவணத்தை, மறுமுறை சேமிக்கும் 
ப�ொழுது பெயரிட வேண்டியதில்லை.   
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	 படம் 1.31 இல் காட்டியுள்ளவாறு 
Open publication உரையாடல் பெட்டி 
திரையில் த�ோன்றும்.

படம் 1.31  Open publication உரையாடல் பெட்டி

2.	 திறக்க வேண்டிய ஆவணத்தின் 
பெயரை   File name உரைப்பெட்டியில் 
தட்டச்சு செய்ய வேண்டும் அல்லது 
பெயர்ப்பட்டியலில் இருந்து ஒன்றைத் 
தேர்ந்தெடுக்க வேண்டும்.

3.	 பிறகு Open ப�ொத்தானைக் கிளிக் 
செய்ய வேண்டும்.  இப்பொழுது 
தேவையான ஆவணம் 
திறக்கப்பட்டிருக்கும்.

1.12  ஆவணத்தை மூடுதல்
ஆவணத்தை சேமித்த பின்பும், பயனர் 
த�ொடர்ந்து பணிபுரியும் வகையில் 
ஆவணம் திறந்திருக்கும்.  பணி முடிந்த 
பிறகு பயனர் ஆவணத்தை சேமித்து மூட 
வேண்டும்.

ஆவணத்தை சேமித்த பின் 
மூடுவதற்கு பட்டிப்பட்டையில் File>Close 
என்பதைக் கிளிக் செய்ய வேண்டும்.  
(அல்லது) விசைப்பலகையில் Ctrl+W 
என்பதை அழுத்த வேண்டும்.

1.13  ஆவணத்தை திறத்தல்
சேமித்து மூடப்பட்ட ஆவணத்தை திறக்க 
கீழ்க்கண்ட வழிமுறைகளை பின்பற்ற 
வேண்டும்.

1.	 பட்டிப்பட்டையில் File>Open 
என்பதைக் கிளிக் செய்ய வேண்டும்.  
(அல்லது) கருவிப்பட்டையில் Open 
பணிக்குறியைக் ( ) கிளிக் செய்ய 
வேண்டும்.  (அல்லது) விசைப்பலகையில் 
Ctrl + O என்னும் சாவி சேர்மானத்தை 
அழுத்த வேண்டும்.

படம் 1.30  சேமிக்கப்பட்ட ஆவணத்தை வேறு பெயரில் அல்லது வேறு இடத்தில் சேமித்தல்
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1.15  �ஆவணத்தை திரை உருளல் 
செய்தல்

பேஜ்மேக்கரில், ஆவணத்தை மேலும் கீழும் 
நகர்த்துவதற்கும், இடது மற்றும் வலது 
புறமாக நகர்த்துவதற்கும் என இரண்டு 
திரை உருளல் பட்டைகள் உள்ளன.  
மற்ற ச�ொற்செயலிகளில் இருக்கும் திரை 
உருளல் பட்டையிலிருந்து, பேஜ்மேக்கர் 
திரை உருளல் பட்டை வேறுபடுகிறது.  
ஆவணத்தில் பல பக்கங்கள் இருந்தாலும் 
தற்போது இருக்கும் பக்கத்தை மட்டுமே 
திரை உருளல் செய்கிறது.  வலது 
பக்கத்தில் உள்ள திரை உருளல் பட்டை 
மூலம் ஆவணத்தை மேலும் கீழுமாக திரை 
உருளல் செய்ய முடியும்.  கீழ்ப்பக்கத்தில் 
உள்ள திரை உருளல் பட்டை மூலம் 
ஆவணத்தை இடது மற்றும் வலது புறமாக 
திரை உருளல் செய்ய முடியும்.

திரை உருளல் செய்யும் முறைகள்
1.	 இடது மற்றும் வலது புறமாக திரை 

உருளல் செய்ய, கீழ்ப்பக்க திரை 
உருளல் பட்டையில் உள்ள இடது 
மற்றும் வலது அம்புக்குறிகளைக் 
கிளிக் செய்ய வேண்டும்.

2.	 மேல் மற்றும் கீழ்ப்புறமாக திரை 
உருளல் செய்ய, வலது பக்க திரை 
உருளல் பட்டையில் உள்ள மேல் 
மற்றும் கீழ் அம்புக்குறிகளைக் கிளிக் 
செய்ய வேண்டும்.

3.	 ஆவணத்தை குறிப்பிட்ட 
த�ொலைவிற்கு திரை உருளல் 
செய்ய, திரை உருளல் பெட்டிகளைப் 
பயன்படுத்தலாம்.

1.16  �ஜும் டூல் மூலமாக பெரிதாக்குதல் 
மற்றும் சிறிதாக்குதல்

ஜும் டூல் (Zoom Tool) மூலமாக ஆவணத்தின் 
எந்தவ�ொரு பகுதியையும் பெரிதாக்கியும் 
(magnify), சிறிதாக்கியும் (reduce) காட்ட 
முடியும்.  ஜூம் டூலை இருமுறை கிளிக் 

1.14  �ஆவணத்தின் பல பகுதிகளுக்குச் 
செல்லுதல்

சுட்டி அல்லது விசைப்பலகையின் மூலம் 
செருகும் புள்ளியை ஆவணத்தின் பல 
பகுதிகளுக்கும் நகர்த்த முடியும்.

சுட்டியின் மூலம் செருகும் புள்ளியை 
நகர்த்துவதற்கு, சுட்டுகுறியை தேவையான 
இடத்திற்கு நகர்த்தி, சுட்டியின் இடது 
ப�ொத்தானைக் கிளிக் செய்ய வேண்டும்.  
செருகும் புள்ளி அந்த இடத்திற்கு வந்துவிடும்.  
சுட்டியின் சுட்டுக்குறியும், செருகும் புள்ளியும் 
வெவ்வேறானவை என்பது குறிப்பிடத்தக்கது.

விசைப்பலகை மூலம் செருகும் 
புள்ளியை நகர்த்துவதற்கு அம்புக்குறி 
விசைகள் மற்றும் சாவி சேர்மானங்களைப் 
பயன்படுத்த வேண்டும்.

அட்டவணை 1.1 இல் ப�ொதுவான 
நகர்வு விசைகள் க�ொடுக்கப்பட்டுள்ளன.  
கூட்டல் குறியானது இரண்டு விசைகளை 
சேர்த்து அழுத்த வேண்டும் என்பதைக் 
குறிக்கிறது.

அட்டவணை 1.1 � விசைப்பலகை – நகர்வுப் 
ப�ொத்தான்கள்

நகர்த்துதல் அழுத்த 
வேண்டிய 
சாவிகள்

ஒரு எழுத்து இடதுபுறமாக Left Arrow

ஒரு எழுத்து வலதுபுறமாக Right Arrow

ஒரு வார்த்தை இடதுபுறமாக Ctrl+Left Arrow

ஒரு வார்த்தை வலதுபுறமாக Ctrl+Right Arrow

ஒரு வரி மேலே Up Arrow

ஒரு வரி கீழே Down Arrow

வரியின் இறுதிக்கு End

வரியின் த�ொடக்கத்திற்கு Home

ஒரு பத்தி மேலே Ctrl+Up Arrow

ஒரு பத்தி கீழே Ctrl+Down Arrow
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இப்பொழுது அப்பகுதி மட்டும் 
பெரியதாகக் காட்டப்படும்.

ஆவணத்தின் பகுதியை பெரிதாக்கவும், 
சிறிதாக்கவும் பயன்படும் மற்றொரு வழி
ஆவணத்தின் பகுதியைப் பெரிதாக்க 
Ctrl+Spacebar என்னும் விசைப்பலகை 
குறுக்கு வழியையும், சிறிதாக்க 
Ctrl+Alt+Spacebar என்னும் விசைப்பலகை 
குறுக்கு வழியையும் பயன்படுத்த வேண்டும்.

படம் 1.32  ஜும் டூல் மூலமாக பெரிதாக்குதல்

1.17  ஆவணத்தை வடிவூட்டல்
எழுத்துக்களின் வகை, நிறம், பாணி 
ப�ோன்ற ப�ொதுவான பண்புகளை மாற்றக் 
கூடிய செயலுக்கு வடிவூட்டல் என்று 
பெயர்.  ஒரு குறிப்பிட்ட பாணியிலுள்ள 
எழுத்துக்கள், எண்கள் மற்றும் குறியீடுகள் 

செய்து ஆவணப் பக்கத்தின் உண்மையான 
அளவையும், Alt ப�ொத்தானுடன் சேர்த்து 
இருமுறைக் கிளிக் செய்து ஆவணப் 
பக்கம் சன்னல் திரையுடன் ப�ொருந்தும் 
அளவையும் பெற முடியும்.
ஜும் டூல் மூலமாக பெரிதாக்க மற்றும் 
சிறிதாக்க

1.	 ஜும் டூலை தேர்ந்தெடுக்க வேண்டும்.  
	 இப்பொழுது ஜும் டூல் ஆனது கூட்டல் 

குறியுடன் கூடிய ஒரு பூதக்கண்ணாடி 
ப�ோன்று த�ோன்றும்.  இந்தக் கூட்டல் 
குறி, ஆவணத்தின் பகுதியைப் 
பெரிதாக்கிக் காட்டும் என்பதைக் 
குறிக்கிறது.

2.	 (பூதக்கண்ணாடியின் மையத்தில் 
கழித்தல் குறி இருந்தால் அது 
ஆவணத்தின் பகுதியை 
சிறிதாக்கிக் காட்டும்) ஜும் 
டூலை பெரிதாக்குவதிலிருந்து 
சி றி தாக்   கு வ த ற் கு ம் , 
சி றி தாக்   கு வ தி லி ரு ந் து 
பெரிதாக்குவதற்கும் மாற்றுவதற்கு 
Ctrl விசையை அழுத்த வேண்டும்.

	 பெரிதாக்கி அல்லது சிறிதாக்கிப் பார்க்க 
வேண்டிய இடத்தின் மையத்தில் 
பூதக்கண்ணாடியை வைத்து 
கிளிக் செய்ய வேண்டும்.  ஆவணம் 
நமக்குத் தேவையான அளவிற்கு 
பெரிதாகும்வரை அல்லது சிறிதாகும் 
வரை கிளிக் செய்து க�ொண்டே 
இருக்க வேண்டும்.  பெரிதாக்குவதும் 
சிறிதாக்குவதும் அதன் எல்லையைத் 
த�ொட்டவுடன் பூதக்கண்ணாடியின் 
மையத்தில் எந்தக் குறியீடும் இருக்காது.

ஒரு பக்கத்தின் ஒரு பகுதியை கிளிக் 
செய்து இழுத்துப் பெரிதாக்குதல்

1.	 ஜும் டூலை தேர்ந்தெடுக்க வேண்டும்.
2.	 பெரிதாக்கப்பட வேண்டிய 

பகுதியை சுட்டியால் கிளிக் செய்து 
இழுத்து தேர்ந்தெடுக்க வேண்டும்.  
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செய்து, எழுத்திற்குத் தேவையான 
நிறத்தை தேர்ந்தெடுக்க வேண்டும்.

●	 Bold, Italic, Underline தேர்வுப் 
பெட்டிகளில் கிளிக் செய்து 
உரையை தடிமனாகவும், 
சாய்வாகவும், அடிக்கோடிட்டும் 
காட்டலாம்.

4.	 பிறகு OK ப�ொத்தானைக் கிளிக் 
செய்ய வேண்டும்.

படம் 1.33  Character Specifications உரையாடல் 
பெட்டி

1.17.2	 Control palette மூலம் எழுத்து 
வடிவூட்டல்

ஏராளமான வடிவூட்டல்களைச் செய்யும் 
ப�ோது கண்ட்ரோல் பேலட் (Control Palette) 
மிகவும் பயனுள்ளதாக இருக்கிறது.  நாம் 
தேர்ந்தெடுக்கும் ப�ொருளைப் ப�ொறுத்து, 
அதன் காரணிகள் மாறுபடும்.

கண்ட்ரோல் பேலட் திரையில் 
தெரியவில்லை எனில் கீழ்க்கண்ட 
வழிமுறைகளைப் பின்பற்றவும்.

1.	 பட்டிப்பட்டையில் Window>Show 
Control Palette என்பதைக் கிளிக் 
செய்யவும். (அல்லது)

2.	 விசைப்பலகையில் Ctrl +’ என்ற 
சாவி சேர்மானத்தை அழுத்தவும்.  
இப்பொழுது கண்ட்ரோல் பேலட் 
திரையில் தெரியும்.

ப�ோன்றவற்றின் த�ொகுப்பிற்கு எழுத்து 
வகை (font) என்று பெயர்.  ஒரு எழுத்து 
வகை மற்ற எழுத்து வகைகளிலிருந்து 
வேறுபட்டிருக்கும்.

1. 17. 1	 Character Specifications 
உரையாடல் பெட்டி மூலம் 
எழுத்து வடிவூட்டல்

உரையை ஒரு குறிப்பிட்ட வடிவில் 
காண்பிப்பதை எழுத்து வடிவூட்டல் 
என்கிற�ோம்.  எழுத்து வடிவூட்டல் என்பது 
உரையின் பண்புகளான தடிமன், சாய்வு, 
அடிக்கோடு, எழுத்து வகை, அளவு, நிறம் 
ஆகியவற்றை உள்ளடக்கியதாகும்.

எழுத்து வடிவூட்டல் செய்வதற்கான 
வழிமுறைகள்

1.	 வடிவூட்டல் செய்ய வேண்டிய 
உரையை தேர்ந்தெடுக்க வேண்டும்.

2.	 பட்டிப்பட்டையில் Type>Character 
என்பதைக் கிளிக் செய்ய வேண்டும்.  
(அல்லது)  Ctrl+T என்னும் 
விசைப்பலகை குறுக்கு வழியைப் 
பயன்படுத்த வேண்டும்.  இப்பொழுது 
Character Specifications உரையாடல் 
பெட்டி திரையில் த�ோன்றும்.

3.	 உரையாடல் பெட்டியில் தேவையான 
மாற்றங்களைச் செய்ய வேண்டும்.
●	 Font கீழிறங்கு பட்டிப் பெட்டியின் 

அம்புக்குறியைக் கிளிக் செய்து, 
தேவையான எழுத்து வகையை 
தேர்ந்தெடுக்க வேண்டும்.

●	 Font Size கீழிறங்கு பட்டிப் 
பெட்டியின் அம்புக்குறியைக் கிளிக் 
செய்து, தேவையான எழுத்தின் 
அளவைத் தேர்ந்தெடுக்க 
வேண்டும.

●	 Font color கீழிறங்கு பட்டிப் 
பெட்டியின் அம்புக்குறியைக் கிளிக் 
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Character Control Palette மூலம் எழுத்துக்களின் பண்புகளை மாற்றியமைத்தல் 
1.	 தேவையான உரையைத் தேர்ந்தெடுக்கவும்.
2.	 Character Control Palette இல் தேவையான மாற்றங்களைச் செய்யவும்.

Bold

Font

Italic

Small Caps

Font Size

Underline

Leading Horizontal 
Scale

Tracking

Baseline  
Shift

படம் 1.34  Character Control Palette

Font Size: 60pt

Font:  
Arial Black 
Bold 

Underlined

Small 
Caps

Italic

படம் 1.35  Character Control Palette மூலம் எழுத்துக்களின் பண்புகளை மாற்றியமைத்தல்
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1.17.3	 உரையின் நிறத்தை 
மாற்றுதல்

உரையின் நிறத்தை எளிதாக மாற்றி 
அமைக்க முடியும்.  கருப்பு நிறம் அல்லாமல் 
மற்ற நிறங்களைப் பயன்படுத்தும் ப�ோது 
பார்ப்பதற்கு அழகாக இருக்கும்.

எழுத்துக்களுக்கு வண்ணமிட
1.	 வண்ணமிட வேண்டிய 

உரையைத் தேர்வு செய்ய 
வேண்டும்.

2.	 பட்டிப்பட்டையில் Window>Show 
Colors என்பதைக் கிளிக் செய்ய 
வேண்டும்.  இப்பொழுது Colors 
palette த�ோன்றும்.  அதில் 
தேவையான வண்ணத்தைக் 
கிளிக் செய்ய வேண்டும்.  
எழுத்துக்கள் நாம் தேர்ந்தெடுத்த 
வண்ணத்திற்கு மாறி இருக்கும். 

படம் 1.36  உரையின் நிறத்தை மாற்றுதல்

1.18  வரைபடம் (Drawing)
பேஜ்மேக்கரில் பல வகையான படம் 
வரையும் கருவிகள் உள்ளன.  லைன் டூல் 
(line tool), ரெக்டாங்கல் டூல் (Rectangle 
tool), எலிப்ஸ் டூல் (Polygon tool) மற்றும் 
பாலிகான் டூல் (Polygon tool) ஆகியவை 

முதன்மையான நான்கு படம் வரையும் 
கருவிகளாகும்.

1.18.1	 க�ோடுகள் வரைதல்
பேஜ்மேக்கரில் இரண்டு வகையான 
க�ோடு வரையும் கருவிகள் உள்ளன.  
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ஒரு புள்ளிக் க�ோடு வரைய  
(To Draw a Dotted line)

1.	 கருவிப் பெட்டியிலுள்ள லைன் 
டூலில் இருமுறை கிளிக் செய்யவும்.  
Custom Stroke உரையாடல் பெட்டி 
த�ோன்றும்.

படம் 1.38  Custom Stroke உரையாடல் பெட்டி

2.	 Stroke style கீழிறங்கு பட்டிப்பெட்டியில் 
தேவையான க�ோட்டின் வகையைத் 
தேர்ந்தெடுக்கவும்.

படம் 1.39  Stroke style கீழிறங்கு பட்டிப்பெட்டி

3.	 பிறகு OK ப�ொத்தானைக் 
கிளிக் செய்யவும்.  இப்பொழுது 
சுட்டுக்குறியானது crosshair ஆக 
மாறும்.

4.	 திரையில் கிளிக் செய்து இழுத்து, 
புள்ளிக் க�ோட்டை வரையலாம்.

5.	 சுட்டியை அழுத்துவதை 
விட்டவுடன், க�ோடு வரையப்பட்டு 
தேர்ந்தெ      டு க்கப்ப    ட் டி ரு க் கு ம் .  
அதன் இருபுறமும் அளவு மாற்றும் 
கைப்பிடிகள் இருக்கும். 

	 தேவையானால் க�ோட்டில் உள்ள 
கைப்பிடியை கிளிக் செய்து இழுத்து 
க�ோட்டின் அளவை மாற்றிக் 
க�ொள்ளலாம்.

ஒரு கருவி எந்த திசையிலும் நேர்கோடு 
வரையப் பயன்படுகிறது.  மற்றொரு 
கருவி 45 டிகிரி க�ோண அளவில் மட்டுமே 
நேர்கோடு வரையப் பயன்படுகிறது.  
அந்தக் கருவிகளின் மீது இருமுறை கிளிக் 
செய்து அதன் பண்புகளை மாற்றலாம்.  

ஒரு நேர் க�ோடு வரைய
1.	 கருவிப் பெட்டியிலிருந்து லைன் 

டூலை தேர்ந்தெடுக்க வேண்டும்.  
சுட்டுக்குறியானது crosshair ஆக 
மாறும்.

2.	 திரையில் தேவையான இடத்தில் 
கிளிக் செய்து இழுக்க வேண்டும்.

3.	 சுட்டியை அழுத்துவதை விட்டவுடன், 
ஒரு க�ோடு வரையப்பட்டு 
தேர்ந்தெடுக்கப்பட்டிருக்கும்.  அந்தக் 
க�ோட்டின் இருபுறமும் அதன் 
அளவை மாற்றக்கூடிய கைப்பிடிகள் 
இருக்கும். 

	 தேவையானால் க�ோட்டில் உள்ள 
கைப்பிடியை கிளிக் செய்து இழுத்து 
க�ோட்டின் அளவை மாற்றிக் 
க�ொள்ளலாம்.

படம் 1.37  ஒரு நேர் க�ோடு
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2.	 திரையில் கிளிக் செய்து இழுக்க 
வேண்டும்.

3.	 சுட்டியை அழுத்துவதை 
விட்டவுடன், செவ்வகம் அல்லது 
நீள்வட்டம் வரையப்பட்டு 
தேர்ந்தெடுக்கப்பட்டிருக்கும்.

4.	 Shift விசையை அழுத்திக் 
க�ொண்டு ரெக்டாங்கல் டூலைப் 
பயன்படுத்தினால் சதுரம் 
வரையப்படும்.

	 Shift விசையை அழுத்திக் க�ொண்டு 
எலிப்ஸ் டூலைப் பயன்படுத்தினால் 
வட்டம் வரையப்படும்.

வட்டமுனை செவ்வகம் வரைதல்
வட்டமுனை செவ்வகம் வரைய

1.	 கருவிப் பெட்டியிலுள்ள ரெக்டாங்கல் 
டூலில் இருமுறை கிளிக் செய்யவும்.  
Rounded Corners உரையாடல் 
பெட்டி த�ோன்றும்.

	 அதிலிருந்து தேவையான முனை 
வகையைத் தேர்ந்தெடுக்கவும்.

2.	 பிறகு OK ப�ொத்தானைக் 
கிளிக் செய்யவும்.  இப்பொழுது 
சுட்டுக்குறியானது crosshair ஆக 
மாறும்.

படம் 1.40  ஒரு புள்ளிக் க�ோடு

1.18.2	 செவ்வகம் அல்லது நீள்வட்டம் 
வரைதல் (Drawing Rectangles 
or Ellipses) 

பேஜ்மேக்கர் ஆவணத்தில் க�ோடு 
வரைவதைப் ப�ோன்றே செவ்வகமும், 
நீள்வட்டமும் வரைய முடியும்.

செவ்வகம் அல்லது நீள்வட்டம் வரைய
1.	 கருவிப் பெட்டியிலிருந்து ரெக்டாங்கல் 

அல்லது எலிப்ஸ் டூலை தேர்ந்தெடுக்க 
வேண்டும்.  சுட்டுக்குறியானது 
crosshair ஆக மாறும்.

படம் 1.41  செவ்வகம் அல்லது நீள்வட்டம் வரைதல் – சதுரம் அல்லது வட்டம் வரைதல்
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1.18.4	 பாலிகான் டூலை பயன்படுத்தி 
நட்சத்திரம் வரைதல்

நட்சத்திரம் வரைய
1.	 கருவிப் பெட்டியிலிருந்து பாலிகான் 

டூலை தேர்ந்தெடுக்க வேண்டும்.  
சுட்டுக்குறியானது crosshair ஆக மாறும்.

2.	 திரையில் தேவையான இடத்தில் 
கிளிக் செய்து இழுக்க வேண்டும்.

3.	 சுட்டியை அழுத்துவதை 
விட்டவுடன், ஒரு பலக�ோணம் 
வரையப்பட்டிருக்கும்.

4.	 பட்டிப்பட்டையில் Element > Polygon 
Settings என்பதைத் தேர்ந்தெடுக்கவும்.

படம் 1.44  Element பட்டியிலுள்ள Polygon settings

5.	 இப்பொழுது Polygon Settings 
உரையாடல் பெட்டி த�ோன்றும்.

படம் 1.45  Polygon settings உரையாடல் பெட்டி

3.	 திரையில் தேவையான இடத்தில் 
கிளிக் செய்து இழுத்து வட்டமுனை 
செவ்வகத்தை வரையலாம்.

4.	 சுட்டியை அழுத்துவதை விட்டவுடன், 
ஒரு செவ்வகம் வரையப்பட்டிருக்கும்.  
Shift விசையை அழுத்திக் க�ொண்டு 
வரைந்தால் வட்ட முனை சதுரம் 
கிடைக்கும்.

படம் 1.42  வட்ட முனை செவ்வகம் வரைதல்

1.18.3	 பலக�ோணம் வரைதல்
பலக�ோணம் வரைய

1.	 கருவிப் பெட்டியிலிருந்து பாலிகான் 
டூலை தேர்ந்தெடுக்க வேண்டும்.  
சுட்டுக்குறியானது crosshair ஆக 
மாறும்.

2.	 திரையில் தேவையான இடத்தில் 
கிளிக் செய்து இழுக்க வேண்டும்.

3.	 சுட்டியை அழுத்துவதை 
விட்டவுடன், ஒரு பலக�ோணம் 
வரையப்பட்டிருக்கும்.

படம் 1.43  பலக�ோணம் வரைதல்
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2.	 Star inset மதிப்பு 25% 
	 பக்கங்களின் எண்ணிக்கை 25

மேற்கண்ட அளவுகளுக்கு கீழே 
க�ொடுக்கப்பட்டுள்ள நட்சத்திர வடிவம் 
த�ோன்றும்.

படம் 1.48  25 பக்கங்கள் மற்றும் 25% inset 
மதிப்புடன் கூடிய ஒரு நட்சத்திரம்

3.	 Star inset மதிப்பு 35% 
	 பக்கங்களின் எண்ணிக்கை 70

மேற்கண்ட அளவுகளுக்கு கீழே 
க�ொடுக்கப்பட்டுள்ள நட்சத்திர வடிவம் 
த�ோன்றும்.

படம் 1.49  70 பக்கங்கள் மற்றும் 35% inset 
மதிப்புடன் கூடிய ஒரு நட்சத்திரம்

1.18.5	 வடிவத்திற்கு நிறம் மற்றும் 
பாங்குகளை நிரப்புதல்

செவ்வகத்திற்கு நிறம் நிரப்புதல்
1.	 ரெக்டாங்கல் டூலைப் பயன்படுத்தி 

செவ்வகம் வரைய வேண்டும்.
2.	 செவ்வகத்தை தேர்ந்தெடுக்க 

வேண்டும்.

6.	 அதிலுள்ள Number of sides 
உரைப்பெட்டியில் 5 என உள்ளிடவும்.

7.	 Star inset உரைப்பெட்டியில் 50% 
என உள்ளிடவும். 

8.	 பிறகு OK ப�ொத்தானை அழுத்தவும்.  
இப்பொழுது திரையில் ஒரு 
நட்சத்திரம் தெரியும்.

படம் 1.46  ஒரு நட்சத்திரம்

�Star inset சதவீதம் பலக�ோண 
வடிவத்தை உள்புறமாக 
இழுத்து நட்சத்திர வடிவத்தைக் 
க�ொடுக்கிறது.

க�ொடுக்கப்பட்ட அளவுகளுக்கு 
நட்சத்திரம் வரைதல்

1.	 Star inset மதிப்பு 50% 
	 பக்கங்களின் எண்ணிக்கை 15

மேற்கண்ட அளவுகளுக்கு கீழே 
க�ொடுக்கப்பட்டுள்ள நட்சத்திர வடிவம் 
த�ோன்றும்.

படம் 1.47  15 பக்கங்கள் மற்றும் 50% inset 
மதிப்புடன் கூடிய ஒரு நட்சத்திரம்
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1.19  பக்கங்களில் வேலை செய்தல்
பேஜ்மேக்கர் மென்பொருள் அதிக 
அளவில் பக்கங்களை த�ொகுப்பதற்குப் 
பயன்படுத்தப்படுகிறது.  ஒரு பெரிய 
ஆவணத்தில் புதிய பக்கங்களை 
சேர்க்கவும், ஏற்கனவே இருக்கும் 
பக்கங்களை நீக்கவும், பக்கங்களை 
நகர்த்தவும், வரிசைப்படுத்தவும் 
பேஜ்மேக்கர் பயன்படுகிறது. 

1.19.1	 ஒரு குறிப்பிட்ட பக்கத்திற்குச் 
செல்லுதல்

ஒரு ஆவணத்தின் பல பகுதிகளுக்குச் 
செல்ல பேஜ்மேக்கரில், பல வழிமுறைகள் 
உள்ளன.

செய்முறை 1
ஒரு பக்கத்திலிருந்து மற்றொரு பக்கத்திற்குச் 
செல்ல விசைப்பலகையில் Page Up மற்றும்  
Page Down விசைகளைப் பயன்படுத்தலாம்.  
இது நாம் அடிக்கடி பயன்படுத்தக்கூடிய 
உலவுதல் முறையாகும்.

செய்முறை 2
திரையின் இடது கீழ் ஓரத்திலுள்ள 
பக்கத்திற்கான பணிக்குறியைக் 
கிளிக் செய்தும் ஆவணத்தின் ஒரு 
பக்கத்திலிருந்து மற்ற பக்கத்திற்குச் 
செல்லலாம்.  பார்க்க வேண்டிய பக்கத்தின் 
பணிக்குறியைக் கிளிக் செய்தால் அந்தப் 
பக்கம் திரையில் காட்டப்படும்.

செய்முறை 3 
Go to page உரையாடல் பெட்டியைப் 
பயன்படுத்துதல்

ஆவணத்தின் ஒரு குறிப்பிட்ட பக்கத்திற்குச் 
செல்ல 

1.	 பட்டிப் பட்டையில் Layout > Go to 
page என்பதைக் கிளிக் செய்யவும். 
அல்லது விசைப்பலகையில்  
Alt+Ctrl+G என்பதைக் அழுத்தவும். 

3.	 பட்டிப்பட்டையில் Window>show 
colors என்பதைக் கிளிக் செய்யவும்.  
(அல்லது) விசைப்பலகையில் Ctrl +J 
என்பதை அழுத்தவும்.  இப்பொழுது 
Colors palette த�ோன்றும்.

4	 அதில் தேவையான நிறத்தைக் 
கிளிக் செய்யவும்.

5.	 அந்த நிறத்தால் செவ்வகம் 
நிரப்பப்படும்.

படம் 1.50  Window பட்டியிலுள்ள Show colors 
தேர்வு

படம் 1.51  வடிவங்களுக்கு நிறம் நிரப்புதல்
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படம் 1.54  Layout பட்டியிலுள்ள  Insert Page  
தேர்வு

3.	 Insert Page உரையாடல் பெட்டி 
த�ோன்றும். 

படம் 1.55  Insert Page உரையாடல் பெட்டி

4.	 Insert உரைப்பெட்டியில் சேர்க்க 
வேண்டிய பக்கங்களின் 
எண்ணிக்கையை உள்ளிடவும். 

5.	 தற்போதைய பக்கத்திற்கு பின்பு 
புதிய பக்கத்தைச் சேர்க்க,   page(s) 
கீழிறங்குப் பட்டியில்  ‘after’ 
என்பதைக் கிளிக் செய்யவும்.

6.	 Insert ப�ொத்தானை அழுத்தவும்.
7.	 இப்பொழுது புதிய பக்கங்கள் 

சேர்க்கப்பட்டிருக்கும்.

1.19.3	 பக்கங்களை நீக்குதல் 
Remove pages உரையாடல் பெட்டி 
மூலம் தேவையில்லாத பக்கங்களை நீக்க 
முடியும். 

1.	 பட்டிப்பட்டையில் Layout > Remove 
pages என்பதைக் கிளிக் செய்யவும்.

படம் 1.52  Layout பட்டியிலுள்ள  Go to page 
தேர்வு

2.	 இப்பொழுது  Go to page உரையாடல் 
பெட்டி த�ோன்றும்.

படம் 1.53  Go to page உரையாடல் பெட்டி

3.	 அந்த உரையாடல் பெட்டியில் 
தேவையான பக்கத்தின் எண்ணை 
உள்ளிடவும்.

4.	 பிறகு OK ப�ொத்தானை அழுத்தினால் 
நமக்குத் தேவையான பக்கம் 
திரையில் த�ோன்றும்.

1.19.2	 பக்கங்களை செருகுதல்
ஒரு ஆவணத்தில் பல பக்கங்களை 
சேர்க்க முடியும்.  தற்போதைய பக்கத்திற்கு 
முன்பும், பின்பும், இரு பக்கங்களுக்கு 
இடையிலும் புதிய பக்கங்களை சேர்க்க 
முடியும்.  புதிய பக்கங்களை சேர்க்கும் 
ப�ோது, பேஜ்மேக்கர் தானாகவே பக்க 
எண்களை மாற்றிக் க�ொள்ளும்.

பக்கங்களை சேர்க்க
1.	 சேர்க்க வேண்டிய பக்கத்திற்கு 

முதல் பக்கத்தில் கிளிக் செய்யவும்.
2.	 பட்டிப்பட்டையில் Layout > Insert 

Pages என்பதைக் கிளிக் செய்யவும். 
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க�ொண்டிருக்கின்றன.  மேலும் அவைகள் 
Column guides, Ruler guides மற்றும் Margin 
guides ஐயும் க�ொண்டுள்ளன. 

மாஸ்டர் பக்கத்தில் வைக்கப்படும் 
எந்த உறுப்படியையும் ஒரு ஆவணப் 
பக்கத்தில் இருந்து தேர்ந்தெடுக்க 
முடியாது.  மற்ற பக்கங்களைப் ப�ோலவே 
மாஸ்டர் பக்கங்களிலும் ப�ொருள்களை 
உருவாக்கலாம், திருத்தலாம் மற்றும் 
நீக்கலாம்.  ஆனால் இவை அனைத்தையும் 
மாஸ்டர் பக்கங்களிலிருந்து மட்டும்தான் 
செய்ய வேண்டும்.

ஒரு ஆவண சாளரத்தின் கீழ் 
இடது மூலையில் மாஸ்டர் பக்கங்களைக் 
குறிக்கும் ஒரு பணிக்குறியைக் காணலாம்.   
L மற்றும் R எழுத்துக்கள்  (L- இடது 
மற்றும்  R- வலது என்பதைக் குறிக்கிறது) 
எதிரெதிர் பக்கம் க�ொண்ட மாஸ்டர் பக்க 
பணிக்குறியைக் குறிக்கப் பயன்படுகிறது.  
ஒற்றைப் பக்க மாஸ்டர் பணிக்குறியைக் 
குறிக்க R  மட்டுமே பயன்படுத்தப்படுகிறது.

படம் 1.58  மாஸ்டர் பக்கப் பணிக்குறி

1.20.1	 மாஸ்டர் பக்கத்தில் பக்க 
எண்களை சேர்த்தல்

அனைத்துப் பக்கங்களிலும் பக்க 
எண்களை உருவாக்க

1.	 Master pages பணிக்குறியில் கிளிக் 
செய்ய வேண்டும்.

2.	 இப்பொழுது டெக்ஸ்ட் டூலைக் கிளிக் 
செய்தால் செருகும் புள்ளி I-beam 
ஆக மாறும்.

படம் 1.56  Layout பட்டியிலுள்ள   Remove pages 
தேர்வு

2.	 Remove pages உரையாடல் பெட்டி 
த�ோன்றும்.

படம் 1.57  Remove pages உரையாடல் பெட்டி

3.	 நீக்க வேண்டிய பக்கங்களின் 
த�ொடக்க எண்ணையும், முடிவு 
எண்ணையும் க�ொடுக்க வேண்டும்.

4.	 பிறகு OK ப�ொத்தானைக் கிளிக் செய்ய 
வேண்டும்.  இப்பொழுது தேவையற்ற 
பக்கங்கள் நீக்கப்பட்டுவிடும்.

1.20  மாஸ்டர் பக்கங்கள் (Master Pages)
மாஸ்டர் பக்கத்தில் வைக்கப்படும் 
எந்தவ�ொரு ப�ொருளும் ஆவணத்தில் 
உள்ள அனைத்துப் பக்கங்களிலும் 
த�ோன்றும்.  அடுத்தடுத்த பக்கங்களில் 
நீங்கள் மீண்டும் அதே ப�ொருள்களை 
உருவாக்க வேண்டிய அவசியமில்லை.  
அதனால் நேரத்தின் அளவு குறைகிறது.

மாஸ்டர் பக்கங்கள் ப�ொதுவாக 
ல�ோக�ோக்கள் (logos) பக்க எண்கள், 
தலைப்புகள் மற்றும் அடிக்குறிப்புகளைக் 
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3.	 பக்க எண் இட வேண்டிய இடது மாஸ்டர் பக்கத்தைக் கிளிக் செய்ய வேண்டும்.
4.	 Ctrl+Alt+P என்பதை அழுத்த வேண்டும்.
5.	 இடது மாஸ்டர் பக்கத்தில் பக்க எண் ‘LM’ எனத் த�ோன்றும்.
6.	 இதே ப�ோன்று பக்க எண் இட வேண்டிய வலது மாஸ்டர் பக்கத்தைக் கிளிக் செய்ய 

வேண்டும்.
7.	 Ctrl+Alt+P  என்பதை அழுத்த வேண்டும்.
8.	 வலது மாஸ்டர் பக்கத்தில் பக்க எண் ‘RM’ எனத் த�ோன்றும். மற்ற பக்கங்களில் 

சரியான பக்க எண்கள் தெரியும்.

படம் 1.59  மாஸ்டர் பக்கத்தில் பக்க எண்களை சேர்த்தல்

1.20.2	 மாஸ்டர் பக்கத்திலுள்ள ப�ொருள்களை மறைத்தல்
மாஸ்டர் பக்கத்தில் உள்ள ப�ொருள்கள், ஒரு குறிப்பிட்ட பக்கத்தில் தெரியாமல் மறைக்க  
View>Display Master items என்பதைக் கிளிக் செய்ய வேண்டும்.  (வழக்கமாக இதில்  
குறியீடு இருக்கும்.)

படம் 1.60  View பட்டியிலுள்ள Display Master items

1.20.3	 Master pages palette டைக் காண்பித்தல்
மாஸ்டர் பக்கத்தில் செய்யக்கூடிய அனைத்துக் கட்டளைகளையும் Master pages Palette 
ஒழுங்குப்படுத்துகிறது. Master Pages palette டைக் காண்பிக்க:

1.	 பட்டிப்பட்டையில் Windows>Show Master Pages என்பதைக் கிளிக் செய்ய வேண்டும்.  
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1.20.4	 மாஸ்டர் பக்கம் உருவாக்குதல்
பேஜ்மேக்கரில் உருவாக்கப்படும் 
அனைத்து ஆவணங்களிலும் க�ொடா 
நிலையாக ‘Document Master’ என்ற 
பெயரில் மாஸ்டர் பக்கம் இருக்கும்.  ஒருசில 
நேரங்களில் ஒன்றுக்கு மேற்பட்ட மாஸ்டர் 
பக்கங்கள் தேவைப்படலாம்.  

ஒரு ஆவணத்தில் ஒன்றுக்கு 
மேற்பட்ட மாஸ்டர் பக்கங்களை 
உருவாக்கும் ப�ோது, ஒவ்வொரு பக்கமும் 
தலைப்புகள், அடிக்குறிகள், பக்க எண்கள், 
சட்டங்கள் மற்றும் இதர உறுப்புகளின் 
த�ொகுப்பைக் க�ொண்டிருக்கும்.  

புதிய மாஸ்டர் பக்கத்தை 
உருவாக்கும் ப�ோது, அதன் பெயர் மற்றும் 
ஓர அளவுகளை உள்ளிட வேண்டும்.
புதிய மாஸ்டர் பக்கத்தை உருவாக்க,

1.	 Master Pages Palette இல்  New Master 
Page பணிக்குறியைக் கிளிக் செய்ய 
வேண்டும்.  இப்பொழுது New Master 
Page  உரையாடல் பெட்டி த�ோன்றும். 

2.	 அதில் Name என்னும் 
உரைப்பெட்டியில் மாஸ்டர் பக்கத்தின் 
பெயரை உள்ளிட வேண்டும்.

3.	 Margins மற்றும் Column Guides 
பகுதிகளில் தேவையான 
மாற்றங்களை செய்ய வேண்டும்.

4.	 பிறகு OK ப�ொத்தானை அழுத்தவும்.  
புதிய மாஸ்டர் பக்கம், Master Pages 
Palette இல் த�ோன்றும். 

படம் 1.63  புதிய மாஸ்டர் பக்கப் பணிக்குறி

படம் 1.61  Window பட்டியிலுள்ள Show Master 
Pages

2.	 Master pages Palette திரையில் 
த�ோன்றும்.

New Master 
Pages icon

Master Pages tab Master Pages List

Pop-up Menu

Page Delete  
Icon

படம் 1.62  Master Pages Palette
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	 ஒன்றிற்கு மேற்பட்ட பக்க எண்கள் 
காற்புள்ளி (,) மூலம் பிரிக்கப்பட 
வேண்டும். (எ.கா 5, 7, 9) 

	 த�ொடர்ச்சியான பக்கங்களை அச்சிட  
hyphen(-) பயன்படுத்த வேண்டும்.  
(எ.கா 10-17 என்று க�ொடுத்தால் பக்க 
எண் 10திலிருந்து 17 வரை உள்ள 
பக்கங்களை அச்சிடும்.)

	 ஒரு குறிப்பிட்ட பக்கத்திலிருந்து 
ஆவணத்தின் இறுதி வரை அச்சிட, 
அச்சிட வேண்டிய த�ொடக்க பக்க 
எண்ணைக் க�ொடுத்து  hyphen(-) 
க�ொடுக்க வேண்டும். (எ.கா.5-) 
தனித்தனி பக்க எண்களை காற்புள்ளி 
(,) மூலம் பிரித்தும், த�ொடர்ச்சியான 
பக்கங்களை hyphen (-) மூலமும் 
க�ொடுத்து ஒரே நேரத்தில் அச்சிட 
முடியும்.  (எ.கா 5, 9,15-26) 

	 Print: Print கீழிறங்குப் பட்டிப்பெட்டியில்  
Odd pages என்பதைத் தேர்ந்தெடுத்து 
ஒற்றைப்படை பக்க எண் உடைய 
பக்கங்களை மட்டும் அச்சிட முடியும்.  
அதே ப�ோன்று Even pages என்பதைத் 
தேர்ந்தெடுத்து இரட்டைப்படை பக்க 
எண் உடைய பக்கங்களை மட்டும் 
அச்சிட முடியும்.
●	 Copies உரைப்பெட்டியில் 

தேவையான நகல்களின் 
எண்ணிக்கையை உள்ளிட 
வேண்டும்.

●	 Collate என்னும் தேர்வுப் 
பெட்டியை தேர்வு செய்யலாம் 
அல்லது தேர்வு செய்யாமலும் 
இருக்கலாம்.

	 ஐந்து பக்கங்கள் க�ொண்ட ஒரு 
ஆவணத்தை நான்கு நகல்கள் 
அச்சிட வேண்டுமெனில்,

	 இப்பொழுது  collate என்னும் 
தேர்வுப் பெட்டி தேர்வு செய்யாமல் 
இருந்தால், முதல் பக்கம் நான்கு 

படம் 1.64  New Master Page  உரையாடல் பெட்டி

1.21  ஆவணத்தை அச்சிடல் 
1.	 பட்டிப்பட்டையில் File>print 

என்பதைக் கிளிக் செய்யவும். 
(அல்லது)  Ctrl+P என்னும் 
விசைப்பலகை குறுக்கு வழியைப் 
பயன்படுத்தவும்.  Print Document 
உரையாடல் பெட்டி த�ோன்றும்.

2.	 அதில் கீழ்க்கண்ட மாற்றங்களை 
செய்யவும்.
●	 Printer கீழிறங்குப் 

பட்டிப்பெட்டியில் அச்சுப்பொறியை 
தேர்ந்தெடுக்கவும்.

●	 அச்சிட வேண்டிய பக்கங்களைக் 
குறிப்பிட   Pages பகுதியில் 
கீழ்க்கண்டவற்றில் ஏதேனும் 
ஒன்றைத் தேர்ந்தெடுக்கவும்.

	 All: இந்த விருப்பம் ஆவணத்தில் 
உள்ள அனைத்துப் பக்கங்களையும் 
அச்சிடும்.

	 Ranges: இந்த விருப்பத்தில் 
பக்க எண்களைக் க�ொடுத்து 
ஒரு பக்கத்தைய�ோ அல்லது 
த�ொடர்ச்சியான பல பக்கங்களைய�ோ 
அச்சிடலாம்.
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நகல்கள் அச்சிட்ட பிறகு, இரண்டாவது பக்கம் நான்கு நகல்கள் அச்சிடும்.  இதே 
ப�ோன்று ஐந்தாவது பக்கம் வரை அச்சிடும்.  ஆனால்  collate என்னும் தேர்வுப் பெட்டி 
தேர்வு செய்திருந்தால் முதலில் ஒன்றிலிருந்து ஐந்து பக்கங்கள் வரை த�ொடர்ச்சியாக 
அச்சிடும்.  அதன் பிறகு மறபடியும் ஒன்றிலிருந்து ஐந்து பக்கங்கள் வரை த�ொடர்ச்சியாக 
அச்சிடும்.  இதே ப�ோன்று நான்கு நகல்களும் அச்சிடப்படும்.

3.	 இறுதியாக Print ப�ொத்தானை அழுத்தவும்.

படம் 1.65  print document உரையாடல் பெட்டி

நினைவில் க�ொள்க

●	 டெஸ்க்டாப் பப்பிளிசிங் (சுருக்கமாக DTP) என்பது DTP மென்பொருளைப் பயன்படுத்தி 
ஆவணங்களுக்கான பக்கங்களை வடிவமைப்பு (page Layout) செய்வதாகும். 

●	 புகழ்பெற்ற DTP மென்பொருள்களுள் சில அட�ோப் பேஜ்மேக்கர்  (Adobe PageMaker), 
அட�ோப் இன்டிசைன் (Adobe InDesign), குவார்க் எக்ஸ்பிரஸ்  (QuarkXPress) 
ப�ோன்றவை.

●	 அட�ோப் பேஜ்மேக்கர் என்பது ஒரு பக்க வடிவமைப்பு மென்பொருளாகும்.  இது 
அச்சிடுவதற்கு ஏற்ற வகையில் ஆவணங்களை வடிவமைக்கப் பயன்படுகிறது.

●	 கருப்பு நிற எல்லைக் க�ோட்டிற்கு வெளியில் உள்ள பகுதி ஒட்டுப்பலகை  (Pasteboard)  
என அழைக்கப்படுகிறது.

●	 ஆவணத்தில் உள்ள உரையில் மாற்றங்கள் செய்வது உரை பதிப்பித்தல் (Text 
Editing) எனப்படும்.

பாடம் 01  அட�ோப் பேஜ்மேக்கர்40
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Header (தலைப்பு) ஒவ்வொரு பக்கத்தின் மேற்பகுதியிலும் மீண்டும் மீண்டும் வரும் உரை 

Footer (அடிக்குறிப்பு) ஒவ்வொரு பக்கத்தின் கீழ்ப்பகுதியிலும் மீண்டும் மீண்டும் வரும் உரை

Symbol (அடையாளம்) பேஜ்மேக்கர் ஆவணத்தில் செருகப்படும் ஒரு குறியீடு அல்லது சிறப்பு 
குறியீடு

Margins (ஓரம்) ஆவணத்திலுள்ள உரைக்கும் பக்கத்தின் விளிம்பிற்கும் இடைப்பட்ட 
பகுதி

Orientation ஒரு ஆவணத்தை எந்த திசையில் (நீளவாக்கில் அல்லது அகலவாக்கில்) 
அச்சிட வேண்டும் எனக் குறிப்பது

Menu (பட்டி) கட்டளைகளின் பட்டியல்

Editing (பதிப்பித்தல்) உரையில் செய்யப்படும் மாற்றங்கள்

Undo இறுதியாகக் க�ொடுத்த கட்டளையைத் திரும்பப் பெறல்

Redo Undo கட்டளையைத் திரும்பப் பெறல்

●	 உரைத்தொகுதியானது நாம் தட்டச்சு செய்த உரையைய�ோ அல்லது ஒட்டிய 
உரையைய�ோ அல்லது வேறு ஆவணத்திலிருந்து க�ொண்டு வரப்பட்ட உரையைய�ோ 
க�ொண்டிருக்கும்.

●	 ஒரு உரைத்தொகுதியிலுள்ள உரையானது மற்றொரு உரைத்தொகுதிக்குள் 
செல்லுமாறு, ஒரு உரைத்தொகுதியை மற்றொரு உரைத்தொகுதியுடன் 
இணைக்கவ�ோ அல்லது த�ொடர்புபடுத்தவ�ோ முடியும்.  இவ்வாறு 
த�ொடர்புபடுத்தப்பட்டிருக்கும் உரைத்தொகுதிகளுக்கு த�ொடர்புள்ள 
உரைத்தொகுதிகள்  (Threading text blocks) என்று பெயர்.

●	 உரைத்தொகுதிகளுக்கு இடையே உள்ள உரையை இணைக்கும் செயல்முறைக்கு 
த�ொடர்புபடுத்தப்பட்ட உரை (threading text) என்று பெயர்.

●	 ஒன்று அல்லது அதற்கு மேற்பட்ட த�ொடர்புள்ள உரைத்தொகுதிகள் வழியாக பாயும் 
உரை ஸ்டோரி (story) எனப்படும்.

●	 மாஸ்டர் பக்கத்தில் வைக்கப்படும் எந்தவ�ொரு ப�ொருளும் ஆவணத்தில் உள்ள 
அனைத்துப் பக்கங்களிலும் த�ோன்றும்.

●	 மாஸ்டர் பக்கங்கள் ப�ொதுவாக ல�ோக�ோக்கள் (logos), பக்க எண்கள், தலைப்புகள் 
மற்றும் அடிக்குறிப்புகளைக் க�ொண்டிருக்கின்றன.

●	 மாஸ்டர் பக்கத்தில் வைக்கப்படும் எந்த உறுப்படியையும் ஒரு ஆவணப் பக்கத்தில் 
இருந்து தேர்ந்தெடுக்க முடியாது.
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	 அ) Ctrl+A 
	 ஆ) Ctrl +B 
	 இ) Ctrl+C
	 ஈ) Ctrl+W
6.	 _________ கருவி ஆவணத்தின் 

ஒரு பகுதியைப் பெரிதாக்கிப் பார்க்கப் 
பயன்படுகிறது.

	 அ) Text tool  
	 ஆ) Line tool 
	 இ) Zoom tool  
	 ஈ) Hand tool
7.	 பெட்டிகள் வரைவதற்குப் பயன்படும் 

கருவி _________
	 அ) Line
	 ஆ) Ellipse 
	 இ) Rectangle  
	 ஈ) Text
8.	 Place கட்டளை _________ 

பட்டியில் இடம்பெற்றிருக்கும்.
	 அ) File
	 ஆ) Edit
	 இ) Layout
	 ஈ) Window
9.	 முழு ஆவணத்தைத் தேர்ந்தெடுக்க 

விசைப்பலகையில் _________ 
குறுக்கு வழி சாவி சேர்மானத்தை 
அழுத்த வேண்டும்.

	 அ) Ctrl+A 
	 ஆ) Ctrl +B 
	 இ) Ctrl+C
	 ஈ) Ctrl+D

பகுதி – அ 
	 I. 	� சரியான விடையைத் 

தேர்ந்தெடுத்து எழுதுக
1.	 DTP என்பதன் விரிவாக்கம் 

_________
	 அ) Desktop Publishing 
	 ஆ) Desktop publication 
	 இ) Doctor to Patient 	
	 ஈ) Desktop Printer
2.	 _________ என்பது ஒரு DTP 

மென்பொருளாகும். 
	 அ) Lotus 1-2-3
	 ஆ) PageMaker
	 இ) Maya
	 ஈ) Flash
3.	 எந்த பட்டியில் New கட்டளை 

இடம்பெற்றுள்ளது?
	 அ) File menu
	 ஆ) Edit menu
	 இ) Layout menu   
	 ஈ) Type menu
4.	 Page Maker சன்னல் திரையில் கருப்பு 

நிற எல்லைக் க�ோட்டிற்கு வெளியில் 
இருக்கும் பகுதி _________ என 
அழைக்கப்படும்.

	 அ) page  
	 ஆ) pasteboard
	 இ) blackboard  
	 ஈ) dashboard
5.	 PageMaker ஆவணத்தை 

மூடுவதற்கான விசைப்பலகை 
குறுக்கு வழி _________
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	 இ) Paste	 -	 (iii) Ctrl+X
	 ஈ) Undo	 -	 (iv) Ctrl+C
19.	கீழ்க்கண்டவற்றில் ப�ொருந்தாத 

ஒன்றைத் தேர்ந்தெடு.
	 i. � Adobe PageMaker, QuarkXPress, 

Adoble InDesign, Audacity
	 ii. � File, Edit, Layout, Type, Zip
	 iii. � Pointer Tool, Line Tool, Hide Tool, 

Hand Tool
	 iv.  Bold, Italic, Portrait, Underline.
20.	கீழ்க்கண்டவற்றில் சரியான 

கூற்றைத் தேர்ந்தெடு.
	 i.  அ) �சுட்டியின் மூலம் மட்டுமே 

உரையைத் தேர்ந்தெடுக்க 
முடியும்.

	   ஆ) �சுட்டி மற்றும் 
விசைப்பலகையின் மூலம் 
உரையைத் தேர்ந்தெடுக்க 
முடியும்.

	 ii. � அ) �DTP  என்பதன் விரிவாக்கம் 
Desktop publishing. 

	   ஆ) �DTP  என்பதன் விரிவாக்கம் 
Desktop publication.

21.	கீழ்க்கண்டவற்றில் சரியான 
இணையைத் தேர்ந்தெடு.

	 i.  அ) Edit Cut
	    ஆ) Edit New
	 ii.  அ) Undo Copy
	    ஆ) Undo Redo 

பகுதி – ஆ 
II.	   �மூன்று வரிகளில் விடையளிக்கவும்  

1.	 Desktop publishing என்றால் என்ன?
2.	 DTP மென்பொருள்களுக்கு 

எடுத்துக்காட்டுகள் தருக.
3.	 பேஜ்மேக்கர் மென்பொருளை 

திறப்பதற்கான வழிமுறைகளைக் 
கூறு.

10.	எழுத்து வடிவூட்டல் 
கீழ்க்கண்டவற்றில் எந்த 
பண்புகளைப் பெற்றிருக்கும்?

	 அ) Bold
	 ஆ) Italic
	 இ) Underline 
	 ஈ) All of these
11.	உரையை பதிப்பிக்க பயன்படும் 

கருவி எது?
	 அ) Text tool
	 ஆ) Type tool 
	 இ) Crop tool  
	 ஈ) Hand tool
12.	PageMaker இல் ஆவணத்தை 

அச்சிடப் பயன்படும் விசைப்பலகை 
குறுக்கு வழி _________

	 அ) Ctrl+A 
	 ஆ) Ctrl +P
	 இ) Ctrl+C
	 ஈ) Ctrl+V
13.	அட�ோப் பேஜ்மேக்கர் என்பது 

_________ மென்பொருளாகும்.
14.	_________ பட்டை பேஜ்மேக்கர் 

ஆவணத்தின் மேல்பகுதியில் 
இருக்கும்.

15.	ஆவணத்தை மேலும் கீழுமாகவும், 
இடது மற்றும் வலது புறமாகவும் 
நகர்த்துவதை _________ 
என்கிற�ோம்.

16.	_________ கருவி வட்டம் 
வரைவதற்குப் பயன்படுகிறது.

17.	_________ பட்டியைக் கிளிக் 
செய்து Insert Pages விருப்பத்தைப் 
பெறலாம்.

18.	ப�ொருத்துக.
	 அ) Cut	 -	 (i) Ctrl+Z
	 ஆ) Copy	 -	 (ii) Ctrl+V
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3.	 பேஜ்மேக்கரில் உள்ள 
ஏதேனும் மூன்று கருவிகளின் 
குறும்படங்களையும், அதன் 
பயன்களையும் கூறு.

4.	 பிரிக்கப்பட்ட உரைத்தொகுதியை 
எவ்வாறு சேர்ப்பாய்?

5.	 உரை உள்ள சட்டங்களை எவ்வாறு 
இணைப்பாய்?

6.	 மாஸ்டர் பக்கத்தின் பயன் என்ன?
7.	 மாஸ்டர் பக்கத்தில் பக்க எண்களை 

எவ்வாறு சேர்ப்பாய்?

பகுதி – ஈ 
IV.	  �ஒரு பக்க அளவில் 

விடையளிக்கவும்
1.	 பேஜ்மேக்கர் கருவிப்பெட்டியிலுள்ள 

கருவிகளைப் பற்றி விவரி.
2.	 சட்டத்தில் உரையை வைப்பதற்கான 

வழிமுறைகளைக் கூறு.
3.	 உரைத்தொகுதியிலுள்ள உரையை 

சட்டத்திற்கு எவ்வாறு மாற்றுவாய்?
4.	 பாலிகான் டூலைப் பயன்படுத்தி 

ஒரு நட்சத்திரம் வரைவதற்கான 
வழிமுறைகளைக் கூறு.

4.	 பேஜ்மேக்கர் மென்பொருளில் 
ஒரு புதிய ஆவணத்தை எவ்வாறு 
திறக்கலாம்?

5.	 ஒட்டுப்பலகை என்றால் என்ன?
6.	 பேஜ்மேக்கரில் உள்ள பட்டிப்பட்டை 

பற்றி குறிப்பு எழுதுக.
7.	 எலிப்ஸ் டூல் மற்றும் எலிப்ஸ் ஃபிரேம் 

டூல் வேறுபடுத்துக.
8.	 உரை பதிப்பித்தல் என்றால் என்ன?
9.	 உரைத்தொகுதி என்றால் என்ன?
10.	த�ொடர்புள்ள உரைத்தொகுதி 

என்றால் என்ன?
11.	த�ொடர்புள்ள உரை என்றால் என்ன?
12.	பேஜ்மேக்கரில் புதிய பக்கங்களை 

எவ்வாறு செருகலாம்?

பகுதி – இ 
III.  	� ஒரு பத்தியளவில் 

விடையளிக்கவும்  
1.	 பேஜ்மேக்கர் என்றால் என்ன?  அதன் 

பயன்களை கூறு.
2.	 பேஜ்மேக்கரில் உள்ள ஏதேனும் 

மூன்று கருவிகளையும் அதன் 
விசைப்பலகை குறுக்கு வழிகளையும் 
கூறு.
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02பாடம்

அட�ோப் இன்டிசைன் CC 2019  
(Adobe Indesign CC 2019)

 கற்றலின் ந�ோக்கங்கள்
●	 InDesign-ல் புதிய ஆவணத்தைத் த�ொடங்குதல்.
●	 கருவிக, ஆவணத்திரைகள், ஒட்டுப்பலகை (Paste board) மற்றும் தட்டுக்கள் (Palettes) ஆகியவற்றுடன் 

வேலை செய்தல்.
●	 ஆவணத்தின் உருப்பெருக்கத்தை (Magnification) மாற்றுதல்.
●	 ஆவணங்களில் பயணித்தல் (Navigate)/
●	 சட்டங்களுடன் (frames) வேலை செய்தல்.
●	 தருவித்தல் (importing) மற்றும் உரை பதிப்பித்தல் (Editing text).

2.1  அறிமுகம்
Adobe InDesign CC 2019 என்பது ‘Adobe 
Creative Clud’ குடும்பத்தின் மென்பொருள் 
நிரலின் ஒரு பகுதியாகும்.

InDesign என்பது பக்க வடிவ 
அமைவு மென்பொருள் நிரலாகும்.  
இது வடிவமைப்பிற்கும் மற்றும் 
வலையில் அச்சிடுவதற்கு அல்லது 
பயன்படுத்துவதற்கான ஆவணங்களை 
உருவாக்குவதற்கும் பயன்படுகிறது.  
எளிய வணிக அட்டை முதல் பெரிய 
புத்தகம் வரை எதை வேண்டுமானாலும் 
நீங்கள் உருவாக்கலாம்.  வலை 
வடிவமைப்பாளராக நாம் ஒரு த�ொழிலை 
ந�ோக்கி வேலை செய்தால் InDesign பற்றிய 
அறிவு நமக்கு கட்டாயம் தேவை.

2.2  �பக்க வடிவமைவு மென்பொருள் 
பற்றி புரிந்துக�ொள்ளுதல்

Adobe InDesign ஒரு பக்க வடிவமைவு 
மென்பொருள் நிரலாகும்.  ஆவணப் 
பக்கங்களில் உரை மற்றும் 
வரைகலையின் நிலைப்பாட்டை 
எளியதாக்க அனுமதிக்கும் கருவிகளை பக்க 
அமைவு மென்பொருள் க�ொண்டுள்ளது.  
எடுத்துக்காட்டாக, InDesign-னைப் 
பயன்படுத்தி, ஒவ்வொரு பக்கத்திலும் 
கட்டுரைகள் (articles) மற்றும் படங்களை 
உள்ளடக்கிய செய்திமடலை (News Letter) 
நீ உருவாக்கலாம்.  இதில் படங்கள் மற்றும் 
உரைகளை ஒன்றுக்கொன்று அடுத்தடுத்த 
இடத்தில் வைக்கலாம்.  ஒன்றன் 
மேல் ஒன்றாக வைக்கலாம் அல்லது 
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வரைகலையை உருவாக்குதல் மற்றும் 
இருத்துதல்
InDesign-ல் எளிய வரைகலையை 
வடிவக்கருவிகள் மற்றும் பேனா 
கருவியைப் பயன்படுத்தி உருவாக்கலாம்.  
InDesign ஆவணத்தில் மற்ற நிரல்களான 
illustrator மற்றும் photpshop ஆகியவற்றில் 
இருந்து எடுத்துக்காட்டுகள் மற்றும் 
புகைப்படங்கள் ஆகியவற்றையும் 
இருத்தலாம்.

பல நிறங்களில் இருந்து தேர்வு செய்தல்
InDesign-ல் பல வண்ண மாதிரிகள் 
உள்ளன.  அவை ஸ்வாட்சஸ் (Swatches) 
என அழைக்கப்படும்.  இதிலிருந்து 
வண்ணங்களைத் தேர்வு செய்யலாம்.  
அச்சிடப்பட்ட ப�ொருட்களுக்கு பயன்படும் 
அடிப்படை நிறங்கள் Swatches பலகத்தில் 
உள்ளது.  குறிப்பிட்ட அல்லது சிறப்பு 
தேவைகளுக்கான மற்ற வண்ண 
நூலகங்களும் இதில் உள்ளன.

எடுத்துக்காட்டாக, வலையில் 
உருவாக்கப்படும் ஆவணங்களுக்கான 
வலை வண்ணங்களின் நூலகமும் 
உள்ளது.

எளிதாக ப�ொருள்களைப் ப�ொருத்துதல்
InDesign நீங்கள் துல்லியமாக உரை 
மற்றும் வரைகலையைப் ப�ொருத்த 
பல நிறப்பம்சங்களை வழங்குகிறது. 
ப�ொருளை கட்டத்தில் அல்லது அளவு 
வழிகாட்டி (ruler guide)யில் இருத்த முடியும்.  
ஒரு ப�ொருளின் உயரம், அனலம், சுழற்சி 
க�ோணம் மற்றும் செங்குத்து, கிடைமட்ட 
இட அமைவு ஆகியவற்றை வரையறுக்க 
மாற்றுப்பலகம் (Transform panel) மற்றும் 
கட்டுப்பாட்டுப் பலகம் (Control panel) 
பயன்படுகிறது.  இசைவுப் பலகமானது 
ப�ொருளை மேல், கீழ், மைய அல்லது 

ஒன்றுக்கொன்று அருகில் வைக்கலாம் – 
இதைப்போல் எங்கு வேண்டுமானாலும் 
மாற்றி அமைத்துக்கொள்ளலாம்.  
நீங்கள் காகிதத்தில் விரும்புவதை 
அல்லது தேவைப்படுவதை கற்பனை 
செய்கிறீர்கள�ோ, அதை நீங்கள் 
InDesign-ல் அதன் கருவிகள் மற்றும் 
அம்சங்களைத் தெரிந்துக்கொண்டு 
அதனை உருவாக்கலாம்.

படம் 2.1 

2.3  �InDesign-னைப் 
பயன்படுத்தி பின்வருவன 
நிறைவேற்றப்படுகிறது

உரையை உருவாக்குதல் மற்றும் 
வைத்தல்

நீங்கள் உரையை InDesign-ல் உருவாக்கி, 
பிறகு வடிவூட்டம் செய்யலாம்.  எழுத்துவகை 
மற்றும் எழுத்துவகை அளவு ஆகியவற்றைத் 
தேர்ந்தெடுப்பது மட்டுமல்லாமல், 
உரையின் நிறத்தை மாற்றலாம், 
ஒவ்வொரு எழுத்திற்கும் இடையேயுள்ள 
இடைவெளியைக் கட்டுப்படுத்தலாம்.  
மற்றொரு பயன்பாட்டில் இருந்து உரையை 
இருத்தி வைக்கலாம்.  எடுத்துக்காட்டாக 
InDesign ஆவணத்தில் Ms-Word 
ஆவணத்தை இருத்தி வைக்கலாம்.
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பயன்படுத்த முடியும்.  எடுத்துக்காட்டாக, 
InDesign ஆவணத்தை Flash Player file 
(SWF) அல்லது Flash Professional CS5 
(FLA) க�ோப்பாக மாற்றம் செய்யலாம்.

2.4  �Adobe InDesign CC யைத் 
த�ொடங்குதல்

1.	 Start ® All programs ® Adobe 
Indesign CC 2019 என்பதை தேர்வு 
செய்யவும் (அல்லது) திரைமுகப்பில் 
உள்ள InDesign குறுக்கு வழியைத் 
தேர்வு செய்யவும்.

படம் 2.2  த�ொடக்கப்பட்டி (Start Menu) Copy the 
same figure

2.	 “Welcom to InDesign” என்ற சன்னல் 
திரை திறக்கப்படும்.  இப்பொழுது 
Create New  ப�ொத்தானைக் கிளிக் 
செய்யவும்.

ஓரங்களில் இசைவு மற்றும் பகிர்வு 
செய்வதற்கு அனுமதிக்கிறது.

உருப்பொருள்களைச் சேமித்தல்
InDesign ல் பணிபுரியும் ப�ொழுது மீண்டும் 
பயன்படுத்த வேண்டிய மற்றும் எளிதாக 
அணுகக்கூடிய உரு ப�ொருள்களை 
சேமிக்கும் கலன்களாக நூலகங்கள் 
உள்ளன.  நிறுவனத்தின் முத்திரைகள், 
சட்ட வாசகங்கள் மற்றும் த�ொடர்பு 
தகவல்கள் ப�ோன்றவை ஒரு நூலகத்தில் 
உருப�ொருள்களை சேமிப்பதற்கான நல்ல 
உதாரணங்கள் ஆகும்.  நூலகங்கள் 
பலகங்களைப் ப�ோலவே உள்ளன.  
ஆனால் அவைகள் .indl நீட்சிப் பெயருடன் 
சேமிக்கப்பட்ட InDesign ஆவணமாகும்.  
நூலகங்கள் ஒரு InDesign ஆவணத்துடன் 
மட்டும் இணைக்கப்படவில்லை ஆனால் 
அவை அனைத்து InDesign ஆவணங்களுடன் 
திறக்கப்பட்டு பயன்படுத்தப்படலாம்.

ஊடாடும் (Interactive) ப�ொத்தான்களை 
உருவாக்குதல் மற்றும் மீத்தொடுப்பு 
(hyperlink)
ஒரு ஆவணத்தில் கிளிக் செய்யக்கூடிய 
பகுதிகளை வடிவமைப்பதற்காக 
ப�ொத்தான்கள் மற்றும் மீத்தொடுப்புகளை 
InDesign-ல் பயன்படுத்தலாம்.  இது ஒரு 
வலைப்பக்கம், மற்றொரு க�ோப்பு அல்லது 
ஆவணத்தில் உள்ள மற்றொரு பக்கத்துடன் 
இணைக்கப்படும்.  Adobe PDF (Portable 
Document Format) ஆவணம் அல்லது வலை 
ஆவணம் ப�ோன்று InDesign ஆவணத்தை 
மாற்றுவதற்கு மீத்தொடுப்பு மற்றும் 
ஊடாடும் ப�ொத்தான்கள் உருவாக்கப்பட்டு 
பயன்படுத்தப்படுகின்றன.

ஆவணத்தை மாற்றுதல் (Export Document)
InDesign ஆவணத்தை க�ோப்பு வகையாக 
மாற்றம் செய்து மற்றொரு நிரலில் 
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படம் 2.3  Welcom to Indesign சன்னல்

3.	 இப்பொழுது New Document window புதிய ஆவண சன்னல் திறக்கப்படும்.

படம் 2.4  புதிய ஆவண சன்னல் Copy the same figure

புதிய ஆவணத்தை உருவாக்கும் ப�ொழுது New Document உரையாடல் பெட்டியில் 
பல தேர்வுகளை ப�ொருத்துவதற்கான வாய்ப்பு கிடைக்கும்.  புதிய ஆவணத்தில் அடிப்படை 
தேர்வுகளை ப�ொருத்துவதற்கு.
●	 New Document உரையாடல் பெட்டியில் Category தத்தலில் உள்ள print, web அல்லது 

Mobile ஐ தேர்வு செய்யவும்.
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படம் 2.5  New Document உரையாடல் பெட்டி Copy the sae figure

பின்வரும் தேர்வுகளை ஏற்கனவே தேர்வுசெய்யப்பட்ட த�ொகுதியில் குறிப்பிடவும்.
Width and Hight : ஆவணத்தின் அளவை குறிப்பிடுகிறது.
Units: ஆவணத்தை அளவிடுவதற்கான அலகைக் குறிப்பிடுகிறது.
Orientation : ஆவணத்திற்கான பக்க வடிவமைப்பை (Landscape or Portrait) குறிப்பிடுகிறது.
Pages : ஆவணத்தில் உருவாக்கப்படும் பக்கங்களின் எண்ணிக்கையை குறிப்பிடுகிறது.
Facing Pages: ஒரு பக்கத்தை மட்டுமே உடைய ஆவணத்தை உருவாக்குவதற்கு 
எடுத்துக்காட்டாக விளம்பரங்கள், சுவர�ொட்டிகள், அல்லது துண்டு பிரசுரங்கள் – 
ஆகியவற்றுக்கு Facing Pagesஐ Turn off செய்ய வேண்டும்.  புத்தகங்கள் மற்றும் இதழ்கள் 
ஆகியவற்றுக்கு Facing Pages ஐ Turn on செய்ய வேண்டும்.  ஏனெனில், இவை வலது, 
இடது அல்லது முன், பின் என இரு பக்கங்களையும் க�ொண்டிருக்கும்.
Start #: எந்த எண்ணில் ஆவணம் த�ொடங்குகிறது என்பதைக் குறிப்பிடுகிறது.  
தேர்ந்தெடுக்கப்பட்ட Facing Pages உடன் இரட்டைப் படை எண்களை (அதாவது 
2) என்பதைக் குறிப்பிட்டால் ஆவணத்தின் முதல் பரவல் இரண்டு பக்க பரவலுடன் 
த�ொங்குகிறது.
Primary Text Frame: முதன்மை பக்கத்தில் (Master Page) முக்கிய உரையைச் சேர்க்க 
(Primary text) இந்தத் தேர்வை தேர்ந்தெடுக்கவும்.
Columns: ஆவணத்தில் சேர்க்கப்பட வேண்டிய நெடுவரிசைகளின் (Column) 
எண்ணிக்கையைக் குறிப்பிட பயன்படுகிறது.
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Column Gutter: நெடுவரிசைகளுக்கு இடையே உள்ள இடைவெளியின் அளவைக் 
குறிப்பிட உதவுகிறது.
Margins: ஆவணத்தின் ஒவ்வொரு பக்கத்திற்கும் ஒரு அளவை குறிப்பிட பயன்படுகிறது.  
பல்வேறு பக்கங்களுக்கு பல்வேறு மதிப்புகளைப் பயன்படுத்துகிறது.  Chain பணிக்குறியை 
கிளிக் செய்வதன் மூலம் அளவுகளை பிரிக்க முடியும்.
Bleed and Slug: ஆவணத்தின் ஒவ்வொரு பக்கத்தினுடனே Bleed and Sug இருப்பிடத்தை 
குறிப்பிடுகிறது.  Chain பணிக்குறியை கிளிக் செய்வதன் மூலம் அளவுகளை பிரிக்க 
முடியும்.
4.	 முன்பே இருத்தப்பட்ட அமைப்புகள�ோடு ஆவணத்தைத் திறக்க Create 

ப�ொத்தான்களைக் கிளிக் செய்யவும்.

படம் 2.6  ஆவண சன்னல் Copy the same figure

2.5  InDesign பணித்தளத்தை ஆராய்தல்
பணித்தளம் என்பது பணி உருவாக்கப்படும் இடம் ஆகும்.  பணித்தளம் ஒரு முடிக்கப்பட 
வேண்டிய தயாரிப்புகளை உருவாக்கும் இடம் ஆகும்.  இது ஒரு ஓவியர் ஓவியத்தை 
உருவாக்குவது ப�ோல உள்ளது.  முதல் முறையாக InDesignஐ த�ொடங்கும் ப�ோது 
தானமைவாக இடம் பெறும் பணித்தளம் “Essentials” எனப்படும்.  இது மேலே கட்டுப்பாட்டுப் 
பலகம், இடப்புறம் கருவிப்பலகம் ஆகியவற்றுடன் InDesign சன்னல் திரையில் த�ோன்றும்.  
திரையில் த�ோன்றும் சன்னல்கள் மற்றும் பலகங்கள் ஆகியவற்றின் அமைப்பே பணித்தளம் 
எனப்படும். InDesign பணித்தளம் பின்வரும் பகுதிகளை சிறப்பம்சமாகக் க�ொண்டுள்ளது.  
ஆவண சன்னல் (Document Window), ஒட்டு பலகை (Paste Board), கட்டுப்பாட்டுப் பலகம் 
(Control Panel), கருவிப் பலகம் (Tools panel).

படம் 2.7 “Essentials” எனப்படும் தானமைவு பணித்தளத்தை காண்பிக்கிறது.
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படம் 2.7  Essentials பணித்தளம்

InDesign CC 2019 எண்ணற்ற முன் வரையறுக்கப்பட்ட பணித்தளங்களை வழங்குகிறது.  
அவை பல்வேறு வகையான பணிகளுக்காக தனிப்பயனாக்கப்பட்டது.  InDesign-ல் 
ஒவ்வொரு பணித்தளமும் ஒத்த செயல்பாடுகளுடன் கூடிய பலகங்களை (Panel) ஒன்றாக 
ஒரே குழுவாக வடிவமைக்கப்பட்டுள்ளது.  எடுத்துக்காட்டுக்காக, அச்சுக்க்லை (Typography) 
பணித்தளம் பல வகைகள் மற்றும் அச்சுக்கலை சார்ந்த பலகங்களைக் (வகையுடன் 
பணி செய்ய பயனுள்ளதாகும்.) காண்பிக்கிறது.  பயன்பாட்டு பட்டையிலுள்ள (Application 
bar) சன்னலைக் கிளிக் செய்து, பணித்தளத்தைச் சுட்டிக்காட்டி, பணித்தளத்தைத் 
தேர்ந்தெடுப்பதன் மூலம் ஒரு பணித்தளத்திலிருந்து வேற�ொரு பணித்தளத்திற்கு மாறலாம்.
பயன்பாட்டு பட்டை (Application bar)
இது பணித்தளத்திற்கு மேல் உள்ளது.  இதில் பல பட்டிகள் (menu) உள்ளன.  ஒரு பட்டியைத் 
திறக்க, பயன்பாட்டு பட்டையில் உள்ள பட்டியின் பெயரைக் கிளிக் செய்யவும்.  ஒவ்வொரு 
பட்டியும் பட்டிவகைய�ோடு த�ொடர்புடைய கட்டளைகளைப் பட்டியலிடும் பட்டிப்பெயர்களின் 
வலதுப்புறத்தில் பணித்தளமும் மற்றும் View தேர்வுகளும் உள்ளன.
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படம் 2.8  பயன்பாட்டு பட்டை Copy from Eng

கட்டுப்பாட்டு பலகம் (Control panel)
கட்டுப்பாட்டுப் பலகம் பயன்பாட்டு 
பட்டைக்குக் கீழே மற்றும் கிடைமட்ட 
ரூலர்க்கு மேலே நேரடியாக அமைந்துள்ளது.  
ஆவணங்களில் அதைத் தேர்ந்தெடுப்பது 
என்பதைப் ப�ொறுத்து கட்டுப்பாட்டு பலகத்தில் 
உள்ள தேர்வுகள் மாறும் எடுத்துக்காட்டாக 
உரை மீது செருகும் புள்ளி த�ோன்றும் 
ப�ோது, உரைத்தேர்வுகளைக் கட்டுப்பாட்டு 
பலகத்தில் காணலாம்.  வரைகலை 
ப�ொருளைத் தேர்ந்தெடுக்க கருப்புநிற 
தேர்ந்தெடுப்பு கருவியைப் (black selection 
tool) பயன்படுத்தினால், வரைகலையைக் 
கையாள்வதற்கான பல்வேறு தேர்வுகளைக் 
காணலாம்.

ஆவணத் தத்தல் (Document tab)
ஆவணத் தத்தல், கிடைமட்ட ரூலர்க்கு 
மேல்பகுதியில் உள்ளது.  இது ஆவணத்தின் 
பெயர், உருப்பெருக்கத்தின் நிலை 
(Magnification) மற்றும் மூடு ப�ொத்தான் 
ஆகியவற்றைக் க�ொண்டுள்ளது.  ஒன்றிற்கு 
மேற்பட்ட ஆவணங்கள் திறந்திருந்தால், 
ஒவ்வொரு ஆவணத்திற்கும் ஒரு தத்தல் 
த�ோன்றும் மற்றும் ஆவணத் தத்தல்கள் 
கிடைமட்ட வரிசையில் த�ோன்றும்.  
ஆவணத் தத்தலை கிளிக் செய்து, அந்த 
ஆவணத்தைச் சன்னல்திரையில் 
காணலாம்.  முழுமையான 
சன்னல்திரையில் ஆவணத்தைத் திறக்க, 

ஆவணத் தத்தலை கிளிக் செய்து இழுத்து 
குழுவை விட்டு வெளியேற்ற வேண்டும்.

கருவிகள் பலகம் (Tools Panel)
InDesign-ல் இருக்கும் அனைத்து 
கருவிகளும் இந்த கருவிகள் பலகத்தில் 
இருக்கின்றன.  ப�ொருளை உருவாக்கும் 
கருவிகள் (Rectanglel கருவி) ப�ொருளை 
உருமாற்றும் (Transforming) கருவிகள் 
(Rotate கருவி), பக்க காட்சியை மாற்றுதல் 
மற்றும் பணித்தளத்திற்கு செல்லுதல் 
கருவிகள் (Zoom கருவி மற்றும் Hand 
கருவி) ஆகிய கருவிகள் உள்ளன.  சில 
கருவிகளின் கீழ் வலது மூலையில் ஒரு 
சிறிய முக்கோணம் இருக்கும். மேலும் 
கூடுதலான கருவிகள் அந்த கருவியின் கீழ் 
உள்ளன.  என்பதை இந்த முக்கோணம் 
குறிக்கும்.  கிளிக் செய்து அழுத்தி பிடிப்பதன் 
மூலம் மறைந்திருக்கும் கருவிகளைக் 
காணலாம்.

பலகங்கள் (Panels)
பலகங்கள் என்பது தேர்ந்தெடுக்கப்பட்ட 
ப�ொருள்களுடன் வேலை செய்வதற்கான 
தேர்வுகளைக் க�ொண்ட சிறிய 
சன்னல்கள் ஆகும்.  ப�ொத்தான்களைக் 
கிளிக் செய்தும், பட்டியல்களில் இருந்து 
உருப்படிகளைத் தேர்ந்தெடுத்தும், 
அல்லது பலகம் பட்டியில் கட்டளையைப் 
பயன்படுத்துவதன் மூலமும் பலகங்களில் 
விருப்பத்தேர்வைச் செய்யலாம்.  
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ஆவணத்தில் எது இயங்கு பக்கம் 
(active page) என்பதை நிலைமைப்பட்டி 
காண்பிக்கிறது.

2.6  �ஆவணத்திற்கு பெயரிடுதல் மற்றும் 
சேமித்தல் (Naming and Saving a 
Document)

செய்த வேலையைச் சேமிப்பது மிக 
முக்கியமானதாகும்.  ஏனெனில் நீங்கள் 
உருவாக்கிய எதையும் இழக்காமல் 
இருக்கலாம்.  ஆவணத்தைச் சேமிக்க, 
பயன்பாட்டு பட்டியிலுள்ள File மீது கிளிக் 
செய்து, பிறகு Save வைக் கிளிக் செய்யவும்.  
முதன்முறையாக ஒரு புதிய ஆவணத்தைச் 
சேமிக்கும் ப�ொழுது, Save as dialog box 
திறக்கும், ஆவணத்திற்கு பெயரிடுமாறு 
கேட்கும், அதை சேமிப்பதற்கான 
இருப்பிடத்தைத் தேர்ந்தெடுக்கவும்.

சேமிக்கப்பட்டபின், புதிய 
க�ோப்பின் பெயரைத் த�ொடர்ந்து InDesign 
க�ோப்புபெயரின் நீட்டிப்பான .inddயுடன் 
ஆவணத்தை ஒரு தனிப்பட்ட பெயரில் 
சேமிக்க வேண்டும்.

படம் 2.9  File பட்டி copy from Eng

பணித்தளத்தின் வலது பக்கத்தில் 
பலகங்கள் நிலைத்திருக்கின்றன.  அவை 
ஒரு பெயர் மற்றும் குறும்படம் (icon) மூலம் 
அடையாளம் காணப்படுகின்றன.

ஆவணச் சன்னல்
திறக்கப்பட்ட InDesign ஆவணத்தின் 
மையப்பகுதியைக் குறிப்பதே ஆவணச் 
சன்னல் ஆகும்.  இது கருப்பு நிற 
எல்லையினால் (border) சூழப்பட்டுள்ள் 
ஒரு துண்டு காகிதத்தைப் ப�ோல் 
ஒத்திருக்கிறது.  கருப்புநிற எல்லையானது 
பக்க எல்லையைக் குறிக்கும்.

ஒட்டுப்பலகை (Pasteboard)
ஒட்டுப்பலகை என்பது ஆவணச் 
சன்னலைச் சுற்றியுள்ள சாம்பல் நிறப்பகுதி 
ஆகும்.  ஒரு பக்கத்தில் அவற்றைச் 
செருகுவதற்கு முன்பு ஒட்டுப்பலகையில் 
உருப்படிகளை வைக்கலாம்.  நீங்கள் 
வேலை செய்து க�ொண்டிருக்கும் 
உறுப்புகளின் தற்காலிக சேமிப்பிற்காக 
ஒட்டுப்பலகையின் பகுதிகளைப் 
பயன்படுத்தலாம்.  அந்த பக்கத்திலிருந்து 
உறுப்புகளைக் கிளிக் செய்து இழுத்து விட 
வேண்டும் மற்றும் உனக்கு தேவைப்படும் 
வரை அவை ஒட்டுப்பலகையில் தங்கி 
இருக்கும்.

ரூலர்கள்
ஆவணச் சன்னல் மற்றும் ஒட்டுப்பலகை 
பகுதியின் மேல்புறத்திலும் கீழ்புறத்திலும் 
கிடைமட்ட மற்றும் செங்குத்து ரூலர்கள் 
உள்ளன.  ப�ொருள்களை அளவிடுவதற்கும் 
நிலைநிறுத்துவதற்கும் இவை 
பயன்படுகின்றன.

நிலைமைப்பட்டி (Status bar)
பணித்தளத்தின் கீழ்ப்பகுதியில் 
நிலைமைப்பட்டி உள்ளது.  ஆவணத்தில் 
அந்த நேரத்தில் என்ன நடககிறது என்ற 
நிலையை, நிலைமைப்பட்டி உங்களுக்கு 
அளிக்கிறது.  உதாரணமாக, பல பக்க 

XII CompTech_Tamil version CHAPTER 02.indd   53 12/01/2022   14:58:16

www.tntextbooks.in



பாடம் 02  அட�ோப் இன்டிசைன் CC 201954

படம் 2.10  Save as உரையாடல் பெட்டி copy the same figure

2.7  �ஏற்கனவே உள்ள ஆவணத்தைத் திறத்தல்
File பட்யில் உள்ள Open தேர்வு செய்யும் ப�ொழுத�ோ அல்லது Ctrl+O வை அழுத்தும் ப�ொழுத�ோ 
InDesign, Open a File என்ற உரையாடல் பெட்டியை காண்பிக்கிறது.  பார்க்க படம் 2.11 

தேவையான ஆவணத்தை தேர்ந்தெடுக்கவும்.  பின் Open ப�ொத்தானை கிளிக் 
செய்யவும்.  InDesign தேர்ந்தெடுக்கப்பட்ட ஆவணத்தை புதிய சன்னலில் திறக்கும்.

படம் 2. 11   Open a File உரையாடல் பெட்டி
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2.9  கருவிப் பலகத்தை பயன்படுத்துதல்
தேர்ந்தெடுப்புக் கருவி ( )
இது ப�ொருள்களை அல்லது 
ப�ொருள்களின் த�ொகுதியை 
தேர்ந்தெடுக்கப் பயன்ப்டுகிறது.  V என்ற 
ப�ொத்தானை அழுத்தி இந்தக் கருவியை 

2.8  கருவிப்பலகம் (Tools Panel)
கருவிப்பலகம், தேர்ந்தெடுப்புக்கருவிகள் 
(Selection tools), அடிப்படை வடிவங்களை 
வரைவதற்கான கருவிகள், வரைதல் 
மற்றும் புதுப்பித்தல் கருவிகள் (Drawing 
and editing) பரிமாற்றல் கருவிகள் 
(Transformation tools) உரை பதிப்பித்தல் 
கருவிகள் (text editing tools) நகர்தல் 
கருவிகள் (Navigation tools) ப�ொருள் 
வடிவமைப்புக் கருவிகள் (Obvject formatting 
tools) ப�ோன்றவற்றைக் க�ொண்டுள்ளது.  
தானமைவாக கருவிப்பலகம், கட்டுப்பாட்டுப் 
பலகத்திற்கு கீழே உள்ளது.  ஆவண 
சன்னலின் இடது புறம் உள்ள கருவிப் 
பலகத்தில் அனைத்து கருவிகளும் 
காணப்படும்.  கருவிப்பலகத்தில் கிளிக் 
செய்யாமல் ஏதேனும் ஒரு கருவியின் மீது 
செருகும் புள்ளியை வைக்கும் ப�ொழுது tool 
tip த�ோன்றும்.  இதன் அதன் பெயர் மற்றும் 
குறுக்கு வழி சாவி அடைப்புக்குறிக்குள் 
த�ோன்றும்.  அந்த கருவியை இயக்க அதை 
கிளிக் செய்ய வேண்டும் அல்லது குறுக்குவழி 
சாவியை தட்டச்சு செய்யவேண்டும்.  
கருவிப் பலகத்தில் அனைத்து கருவிகளும் 
த�ோன்றுவதில்லை பல கருவிகள் 
மறைந்துள்ளன.  உற்று ந�ோக்கினால் 
பத்து கருவிகளில் சிறிய வெள்ளை 
முக்கோணமானது வலது கீழ் மூலையில் 
த�ோன்றும்.  இந்த முக்கோணங்கள் பல 
கருவிகள் அதன் உள்ளே மறைந்துள்ளதை 
குறிக்கிறது.

மறைந்துள்ள கருவிகளை 
அணுகுவதற்கு, கருவிப்பலகத்தில் 
உள்ள திரையில் தெரியும் கருவியை 
தேர்ந்தெடுத்து கிளிக் செய்ய வேண்டும்.  
பின்னர், மறைக்கப்பட்ட கருவிகளின் 
பட்டி த�ோன்றும், சிறிய வெள்ளை 
சதுரமானது பட்டியின் கருவிப்பெயரின் 
இடது பக்கத்தில் த�ோன்றும்.  இது கருவி 
கருவிப்பலகத்தில் தற்போது திரையில் 
தெரிவதைக் குறிக்கிறது.

Selection Tool (V, Escape)

Direct Selection Tool (A)

Page Tool (Shift+P)

Gap Tool (U)

Content Collector Tool (B)

Type Tool (T)

Line Tool (\)

Pen Tool (P)

Pencil Tool (N)

Rectangle Frame Tool (F)

Rectangle Tool (M)

Scissors Tool (C)

Free Transform Tool (E)

Gradient Swatch Tool (G)

Gradient Feather Tool (Shift+G)

Note Tool

Eyedropper Tool (I)

Hand Tool (H)

Zoom Tool (Z)

Swap Fill and Stroke (Shift+X)

Stroke(X)

Formatting affects text 

Apply None (Num /, /)

Viewing Mode (W)

Default Fill and Stroke (D)

Fill (X)

Formatting affects container (J)

படம் 2.12  In Design CC கருவி பலகம்
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சிறிய வெள்ளைச் சதுரமானது 
கருவிப் பெயரின் இடது பக்கத்தில் 
த�ோன்றும் சிறிய வெள்ளைச் 
சதுரமானது கருவிப் பலகத்தில் 
தற்போது திரையில் கருவி 
தெரிவதைக் குறிக்கிறது.

குறிப்பு	
குறுக்கு வழி சாவிகள் வடிவ 
எழுத்துணர்வை பெற்றிருக்கவில்லை.  
அதாவது ‘P’ ஐ அழுத்தினால், Caps lock 
ப�ொத்தான் On அல்லது Off எதுவாக 
இருந்தாலும் நாம் பேனா கருவிக்கு 
மாறலாம்.

படம் 2.13  In Design CC கருவி பலகம்
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தேர்ந்தெடுக்கலாம்.  (உரையில் செருகும் புள்ளி இல்லாத ப�ோது).  கருவிப் பலகத்தில் வேறு 
ஏதேனும் ஒரு கருவி தேர்ந்தெடுக்கப்பட்டால் Ctrl ப�ொத்தானை அழுத்தி தற்காலிகமாக 
தேர்ந்தெடுப்புக் கருவிக்கு மாறலாம்.  Shift+Click ஐ தேர்ந்தெடுத்து கூடுதல் ப�ொருள்களை 
நமது தேர்ந்தெடுப்பில் சேர்க்கலாம்.  அல்லது ஏற்கனவே உள்ள தேர்ந்தெடுப்பில் இருந்து 
ப�ொருள்களை நீக்கலாம். 

Ctrl+கிளிக் மறைந்து 
இருக்கும் ப�ொருளைத் 

தேர்ந்தெடுக்க 

Click on a object Shift + கிளிக் கூடுதல் ப�ொருளை சேர்ப்பதற்கு 

படம்2.14

Ctrl+ கிளிக் ஒரு ப�ொருளின் 
பின்னால் மறைந்து இருக்கம் மற்ற 
ப�ொருள்களைத் தேர்ந்தெடுக்க 
அனுமதிக்கிறது.  இது நெரிசலான 
அமைப்பில் வேலை செய்யும் ப�ோது விலை 
மதிப்பற்ற நுட்பமாக இருக்கிறது.

நேரடி தேர்வு கருவி (Direct Selection tool)  ( )
இது ஒரு குழுவில் இருந்து ஒரே ஒரு 
ப�ொருளை தேர்ந்தெடுக்க 

(A வை அழுத்தவும்) உதவுகிறது.   
(Group கட்டளை மூலம் பல்வேறு தனித்தனி 
ப�ொருள்கள் குழுவாக சேர்ந்துள்ளன).  
அல்லது ஒரு ப�ொருளின் பாதையில் 
ஒன்று அல்லது பல புள்ளிகளைத் 
தேர்ந்தெடுக்கிறது.  

பக்கக்கருவி (page Tool) ( )
ஒரு ஆவணத்தின் உள்ளே பல்வேறு 
பக்க அளவுகளை உருவாக்க பக்கக்கருவி 
பயன்படுகிறது.

வெவ்வேறு பக்க அளவுகளை உருவாக்க,
Shift + P யை பக்க கருவீயைத் 
தேர்ந்தெடுக்க கிளிக் செய்யவும்.  

இப்பொழுது கட்டுப்பாட்டுப் 
பக்கத்தில் (Control Page) உள்ள தேர்வைப் 
பயன்படுததி பக்க அமைவை மாற்றவும்.  

படம் 2.15  பக்கக்கருவி
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இடைவெளி கருவி (Gap Tool) ( )
இந்த இடைவெளிக்கருவி (Gap Tool) ப�ொருள்களுக்கு இடையே உள்ள இடைவெளியை 
சரிசெய்யப் பயன்படுகிறது.  இந்தக் கருவியைத் தேர்ந்தெடுக்க U  என்ற ப�ொத்தானை 
அழுத்தவும்.  

ப�ொருள்களுக்கு இடையே சுட்டியை வைக்கவும்.  வரிசைப்படுததப்பட்ட 
ப�ொருள்களுக்கு இடையே உள்ள இடைவெளியை மாற்ற சுட்டியை இழுக்கவும்.  இரண்டு 
அருகருகே உள்ள ப�ொருள்களுக்கு இடையே உள்ள இடைவெளியை நகர்த்த Shift+drag  
ப�ொத்தானை பயன்படுத்த வேண்டும்.   Ctrl+drag ப�ொத்தான் இடைவெளியை நகர்த்துவதற்கு 
பதிலாக இடைவெளியின் அளவை மாற்றி அமைக்க பயன்படுகிறது.  Alt+drag ப�ொத்தான 
இடைவெளியையும், ப�ொருளையும் ஒரே திசையில் நகர்த்த பயன்படுகிறது. Ctrl+Alt+drag 
ப�ொத்தான் இடைவெளியை மாற்றி அமைத்து ப�ொருளை நகர்த்த பயன்படுகிறது.   Shift 
ப�ொத்தானை எதனுடன் இணைத்தாலும் அது அருகருகே உள்ள இரு ப�ொருள்களை 
பாதிக்கிறது.  

 படம் 2.16  இடைவெளி கருவி

உள்ளடக்கத்தை சேகரிக்கும் கருவி (content collector tool)( )
இந்தக்கருவியை தேர்ந்தெடுத்து ப�ொருள்கள் அல்லது கதைகளை திரையின் கீழ் உள்ள 
உள்ளடக்க சேகரிப்பானில் சேர்க்கவும்.  பிறகு உள்ளடக்க வைப்பான் கருவியைப் 
பயன்படுத்தி உள்ளடக்க சேகரிப்பானில் உள்ள ப�ொருள்களை வேறு ஒரு அமைப்பில�ோ 
அல்லது ஆவணத்தில�ோ நகல் எடுக்கலாம் அல்லது இணைக்கலாம்.  B என்ற ப�ொத்தானை 
அழுத்தி உள்ளடக்க சேகரிப்பான் மற்றும் உள்ளடக்க வைப்பான் ஆகிய இரு கருவிகளுக்கு 
இடையே மாறிக் க�ொள்ளலாம்.

படம் 2.17  உள்ளடக்க சேகரிப்பான் கருவியைப் பயன்படுத்துதல்
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வளைந்த மற்றும் மூலைகளைக் க�ொண்ட 
பாதைகள்)  P ப�ொத்தானை அழுத்தி 
இந்தக் கருவியைத் தர்வு செய்யலாம்.  
இணைக்கப்பட்ட புள்ளிகளின் வரிசைகளை 
உருவாக்குவதற்கு கிளிக் செய்து 
இழுக்கவும்.  இது வரி அல்லது வடிவத்தை 
நமது விருப்பத்திற்கு வரைகிறது.

பேனா கருவிக்குக் கீழே, த�ொகுப்புப் 
புள்ளியை சேர்க்கும் கருவி, த�ொகுப்புப் 
புள்ளியை நீக்கும் கருவி, மற்றும் திரைமாற்றப் 
புள்ளி கருவி ஆகியன உள்ளன.

த�ொகுப்புப் புள்ளியை சேர்க்கும் கருவி  
(Add Anchor Point tool)  ( )
தேர்ந்ததெடுக்கப்பட்ட பாதையில் இந்தக் 
கருவியைக் கிளிக் செய்யும் ப�ொழுது 
InDesign பாதையில் உள்ள இடத்தில் ஒரு 
புள்ளியைச் சேர்க்கிறது.

த�ொகுப்புப் புள்ளியை நீக்கும் கருவி  
(Delete Anchor Point tool) ( )
தேர்ந்தெடுக்கப்பட்ட பாதையில் உள்ள ஒரு 
புள்ளியில் இந்தக் கருவியை கிளிக் செய்யும் 
ப�ொழுது InDesign இதை நீக்குகிறது.

திசை மாற்றப் புள்ளி கருவி (Convert 
Direction Point tool) ( )
இந்தக் கருவியை தேர்ந்தெடுக்கப்பட்ட 
பாதையில் உள்ள புள்ளியில் கிளிக் 
செய்தால், InDesign அந்தப் புள்ளியை வேறு 
ஒரு புள்ளியாக மாற்றுகிறது.  அதாவது, 
கிளிக் செய்த புள்ளி மூலைப் புள்ளியாக 
இருந்தால் InDesign அதை வளைந்த 
புள்ளியாக மாற்றுகிறது.  அது வளைந்த 
புள்ளியாக இருந்தால் மூலைப் புள்ளியாக 
மாற்றுகிறது.  இந்தக் கருவியை புள்ளியின் 
திசையை கையாள்வதை சரி செய்கிறது.

தட்டச்சு கருவி  (Type Tool) ( )
இந்தக் கருவி உரையை உள்ளிடவும் 
மற்றும் பதிப்பாய்வு செய்யவும் பயன்படுகிறது.  
ஒரு உரைச்சட்டத்தை உருவாக்குவதற்கு 
தட்டச்சு கருவியை தேர்ந்தெடுத்து ஆவண 
சன்னல் திரையில் அந்தக் கருவியை 
இழுக்கவும்.  தட்டச்சு கருவியை தேர்ந்தெடுக்க 
T ப�ொத்தானை அழுத்தவும்.  

பாதை தட்டச்சு கருவி (Path type tool) ( )
ஒரு பாதையில் உரையை உள்ளிடவும் 
மற்றும் பதிப்பாய்வு செய்யவும் இந்தக் கருவி 
பயன்படுகிறது.  (Adobe ல் இது “Type on a 
pth” என்றழைக்கப்படுகிறது).  பாதையில் 
உரையை சேர்க்க பாதை தட்டச்சு கருவியை 
தேர்ந்தெடுத்து அந்த கருவியை பாதையின் 
மீது கிளிக் செய்யவும்.  பாதையில் ஒரு ஒளிரும் 
உரை செருகும் புள்ளி த�ோன்றும்.  இந்தப் 
புள்ளியில், நாம் உள்ளிடும் உரையானது 
அந்த பாதை ஓட்டத்தில் அமையும்.  Shift + T 
என்ற ப�ொத்தானை அழுத்தி பாதை தட்டச்சு 
கருவியைத் தேர்ந்தெடுக்கலாம்.

குறிப்பு கருவி (Note tool) ( )
இந்தக் கருவி உரைக்கு அச்சிடத் 
தேவையில்லாத குறிப்புகளை சேர்க்க 
உதவுகிறது.  உரையில் உள்ள குறிப்புக் 
கருவியைக் கிளிக் செய்தால், InDesign 
அந்த உரைக்குத் தேவையான குறிப்பை 
உள்ளிட ஒரு சன்னல் திரையைக் 
காண்பிக்கும் அல்லது ஆவணத்தில் உள்ள 
முன் அல்லது பின் குறிப்பிற்குத் தாவும்.

பேனா கருவி (Pen tool)  ( )
இந்தக் கருவி நேரான மற்றும் வளைந்த 
வரி பகுதிகளைக் க�ொண்ட பாதைகளை 
வரைவதற்குப் பயன்படுகிறது.  (அதாவது, 
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வரையப் பயன்படுகிறது.  Shift-ஐ அழுத்தி 
வரிக் கருவியை இழுத்தால் வரையப்பட்ட 
வரிகள் நிபந்தனைகளுக்குட்பட்டு 
0-450, மற்றும் 900 க�ோணங்களாக 
மாறும்.  ‘ \ ’ என்ற ப�ொத்தானை அழுத்தி 
வரிக்கருவியைத் தேர்ந்தெடுக்கலாம்.

நீள்வட்டக் கருவி (Ellipse Tool) ( )
இந்தக் கருவி நீள்வட்டம் மற்றும் 
வட்டங்களை வரைகிறது.  நீள்வட்டம் 
வரைய கிளிக் செய்து இழுக்கவும்.  
வட்டத்தை வரைய Shift ப�ொத்தானை 
அழுத்திக் க�ொண்டு இழுக்கவும்.

செவ்வகக் கருவி (Rectangle Tool) ( )
இந்தக் கருவி சதுரம் மற்றும் செவ்வகத்தை 
வரைகிறது.  செவ்வகத்தை வரைய கிளிக் 
செய்து இழுக்கவும்.  அந்த செவ்வகத்தை, 
சதுரமாக மாற்ற Sift ப�ொத்தானை அழுத்திக் 
க�ொண்டு இழுக்கவும்.  (சுட்டிப் ப�ொத்தானை 
விடும் வரை Shift ப�ொத்தானை அழுத்த 
வேண்டும்.

செவ்வகத்திற்கு வளைந்த முனைகள் 
தேவைப்படின் செவ்வகத்தை இந்தக் 
கருவியைப் பயன்படுத்தி வரைந்துவிட்டு 
பிறகு ‘Corner’ தேர்வை ‘Object’ பட்டியில் 
இருந்து பெறலாம்.  ‘Corner options’ 
உரையாடல் பெட்டி த�ோன்றும்.  ‘Corner 
Options’ உரையாடல் பெட்டி பல்வேறு 
மூலை வடிவ தேர்வுகளை வழங்குகிறது.

படம் 2.18  ப�ொருள்பட்டி 

பென்சில் கருவி (Pencil tool) ( )
இந்தக் கருவி கையால் வரையும் 
பாதையை உருவாக்குகிறது.  அந்த 
கருவியை இழுக்கும் ப�ோது அது செருகும் 
புள்ளியை பின் த�ொடரும் ஒரு பாதையை 
உருவாக்குகிறது.  தானாகவே புள்ளிகளை 
வைக்கிறது.  மற்றும் கட்டுப்பாட்டு 
கையாளுதலை சரி செய்கிறது.  பென்சில் 
கருவியைப் பயன்படுத்தி வரைந்த பாதை 
தவறாக இருப்பின் InDesign-ல் உள்ள மற்ற 
எந்தவ�ொரு கருவியைப் பயன்படுத்தியும் 
சரி செய்யலாம்.  இந்தக் கருவியில் மேலும் 
இரண்டு கருவிகளை பயன்படுத்தலாம்.

சீரமைக்கும் கருவி (Smooth tool)  ( )
முதலில் பாதையைத் தேர்ந்தெடுத்து 
அதன் மீது இந்தக் கருவியை இழுக்கவும்.  
இப்போது பாதை சீராக இருக்கும்.  
இன்னமும் சீராக வில்லையெனில் 
மீண்டும் இந்தக் கருவியை அந்தப் பாதை 
மீது இழுக்கவும்.  இது புள்ளிகளை சரி 
செய்து கட்டுப்பாட்டை கையாண்டு ஒரு 
வரி பிரிவில் இருந்து மற்றொரு வரிக்கு 
மாற்றுகிறது.  இந்த முறையில் இது 
புள்ளிகளை நீக்குகிறது.  இதே முறையை 
மீண்டும் மீண்டும் செய்தால் இரண்டு 
புள்ளிகளுக்கு இடையே ஒரு எளிய வரி 
த�ோன்றும்.

அழிப்பான் கருவி (Eraser tool) ( )
இது வரிப்பிரிவுகள் மற்றும் புள்ளிகளை 
அழிக்கிறது.  இதைப் பயன்படுத்துவதற்கு 
பாதையைத் தேர்ந்தெடுத்து அந்தப் 
பாதையின் பகுதியில் இந்தக் கருவியை 
இழுக்கவும்.  மற்றும் இந்தக் கருவி 
எங்கெல்லாம் இழுக்கப்படுகிறத�ோ 
அங்குள்ள வரிப்பிரிவுகள் மற்றும் புள்ளிகள் 
அழிக்கப்படுகின்றன.

வரிக் கருவி (Line tool) ( )
இது இரண்டு மூலைப்புள்ளிகளை 
உடைய நேர் க�ோட்டுப் பாதைகளை 
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படம் 2.21  பலக�ோணம்

2.10  பெரிதாக்குதல் (Zooming)
InDesign-ல் உள்ள சில பணிகளுக்கு, 
ஒரு ப�ொருளை அல்லது ப�ொருளின் ஒரு 
பகுதியை உயர் உருப்பெருக்கம் அல்லது 
பெரிதாக்குதல் மூலம் பார்வையிடுதல் 
தேவைப்படுகிறது.

ஒரு ஆவணத்தில் உள்ள ஒரு 
ப�ொருளை பெரிதாக்கி (Zoom in) உற்று 
ந�ோக்க பெரிதாக்குதல் அனுமதிக்கிறது.  
அந்தப்பொருளை (Zoom out) சிறியதாக்கி 
விலகிச் சென்று பார்க்க சிறிதாக்குதல் 
பயன்படுகிறது.  ஆவணத்தில் உள்ள் 
அனைத்தையும் ஒரே நேரத்தில் காண 
இது பயன்படுகிறது.  ஆவணங்களைப் 
பார்வையிட 5% முதல் 4000% வரை 
உருப்பெருக்கலாம் அல்லது குறைக்கலாம்.  
உருப்பெருக்கத்தை மாற்றுவதற்கான பல 
தேர்வுகள் உள்ளன.

பெரிதாக்குதல் மற்றும் 
சிறிதாக்குதலை பின்வருமாறு செய்யலாம்.
●	 பெரிதாக்கு கருவி
●	 View பட்டியில் உள்ள Zoom 

கட்டளைகள் Zoom in, Zoomout, Fit 
page in window, Fit Spread in window, 
Actual SizeSpread in windo, Actual 
Size மற்றும் Entire Pasteboard.

●	 பயன்பாட்டுப் பட்டையின் இடது 
பக்கத்தில் உள்ள Zoom level மேல் 
மீட்புப் பட்டி.

படம் 2.19  Corner options உரையாடல் பெட்டி

பலக�ோணக்கருவி
இந்தக்கருவி சமநிலை பலக�ோணங்களை 
வரைய பயன்படுகிறது.  அதாவது ஐங்கோணம், 
அறுக�ோணம் மற்றும் சமதசக�ோணம்.  
பலக�ோணங்கள் என்பது குறைந்தது மூன்று 
பக்கங்களை உடைய மூடப்பட்ட ஒரு வடிவியல் 
ப�ொருளாகும்.  அனைத்துப் பக்கங்களும் ஒரே 
நீளத்தை க�ொண்டிருக்குமானால் இவை 
சமமாக கருதப்படுகின்றன.

பல க�ோணக்கருவி நட்சத்திர 
வடிவத்தை வரைவதற்கு பயன்படுகிறது.  
நட்சத்திர வடிவத்தை வரைவதற்கு கருவிப் 
பலகத்தில் உள்ள பலக�ோணக் கருவியை 
இரட்டை கிளிக் செய்யவும் Polygon Setings 
உரையாடல் பெட்டி த�ோன்றும்.

(பார்க்க படம் 2.10).  “Number of 
fields” என்ற புலத்தில் தேவையான 
பக்கங்களின் எண்ணிக்கையை 
உள்ளிடவும்.  பலக�ோணம், நட்சத்திர 
பலக�ோணமாக அமைய விரும்பினால், 
“Star Inset field”-ல் சதவீதத்தை (0 முதல் 
99 சதவீதம்) உள்ளீடவும். பலக�ோணம், 
நட்சத்திர பலக�ோணமாக அமைய 
விருப்பமில்லையெனில் “Star Insetfied”-ல் 
100 சதவீதத்தை உள்ளீடு செய்யவும்.

படம் 2.20  Polygon setings உரையாடல் பெட்டி
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ZOOM கருவியைப் பயன்படுத்துதல்
இந்தக்கருவி புதுப்பித்தல் செயல்பாட்டின் ப�ோது ஆவணத்தின் பார்வையை பெரிதாக்க 
அல்லது சிறிதாக்க பயன்படுகிறது.

ஆவணத்தின் காட்சியைப் பெரிதாக்க
கருவிப் பலகத்தில் உள்ள பெரிதாக்கு கருவியை தேர்ந்தெடுத்து, பெரிதாக்க வேண்டிய 
பகுதியில் இதை இருத்தவும்.  பெரிதாக்கு கருவியின் நடுவில் + குறி த�ோன்றும்.  ஒற்றை 
சுட்டி கிளிக்கானது அடுத்த நிலை உருப்பெருக்கத்திற்கு மாற்றும்.  மீண்டும் ஒரு முறை 
பெரிதாக்கும்.  அந்தப்பக்கம் கிளிக் செய்த இடத்தின் மையப்பகுதியில் த�ோன்றும்.

படம் 2.22  View பட்டி

கூடுதலாக, Marquee வை Zoom கருவியுடன் பெரிதாக்க விரும்பும் பகுதியில் இழுத்து 
விடமுடியும்.  பெரிதாக்கப்படும் இடத்தின் சதவிகிதம் marqueeவின் இடத்தைப் ப�ொருத்து 
அமையும்.  Marquee சிறியதாக இருந்தால் பெரிதாக்கப்படும் அளவு நிறைய இருக்கும்.

View கட்டளைகளை பயன்படுத்துதல்
தேர்ந்தெடுத்தல் விளைவுகள்
View ® Zoom In அடுத்த முன் அமைப்பை பெரிதாக்கும் சதவிகிதம்.

View ® Zoom out முந்தைய முன் அமைப்பை குறிப்பிட்ட சதவிகிதம் குறைத்து 
பின்வாங்குவது.

View ® Actual Size ஆவணத்தை 100% காண்பித்தல்.

View ® Fit page in window பார்வையிடும் அளவைப் ப�ொருத்து திரையின் அளவை ப�ொருத்துதல்.

View ® Fit spread in window சன்னலில் இலக்கு பரவுதலைக் காண்பிக்கும்.

View ® Entire pasteboard தற்போதைய பக்கத்தைக் காண்பிப்பது அல்லது ஆவண சன்னலில் 
காணக்கூடிய பரவல் மற்றும் ஒட்டுப்பலகை.
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Zoom-ன் மேல் மீட்புப்பட்டியை 
பயன்படுத்துதல்
மேல் மீட்புப் பட்டியிலிருந்து பெரிதாக்கு 
சதவிகிதத்தை தேர்ந்தெடுக்கவும்.  Zoom 
நிலைப் பெட்டியில் சதவிகிதத்தையும் 
தட்டச்சு செய்யலாம்.

விசைப் பலகையைப் பயன்படுத்துதல்
●	 Ctrl + = அழுத்தவும் - பெரிதாக்குதல்
●	 Ctrl + - அழுத்தவும் - சிறிதாக்குதல்
●	 Ctrl + 1 பக்கத்தை அதன் சரியான 

அளவில் காணுதல்
●	 Ctrl + 2 பக்கத்தை 200% அளவில் 

காணுதல்
●	 Ctrl + 0 ஆவண சன்னலில் முழு 

பக்கத்தையும் ப�ொருத்துதல்
●	 Alt + Ctrl + ஆவண சன்னலில் முழு 

பரவலையும் ப�ொருத்துதல்
●	 Ctrl + Spacebar (or)
●	 Ctrl + Alt + Spacebar தற்காலிகமாக 

Zoom கருவியை அணுகுதல்  
(பெரிதாக்க அல்லது சிறிதாக்க)

2.11  பக்கங்களில் உலாவுதல்
ஒரு புத்தகத்திற்கு இதழுக்கு அல்லது 
பிரசுரங்களுக்கு அமைப்பை உருவாக்கும் 
ப�ோது, பல பக்கங்களைக் க�ொண்ட 
ஆவணத்தை உருவாக்குவ�ோம்.  பரவல் 
என்பது ஒன்றுக்கு ஒன்று எதிராக உள்ள 
இரு பக்கங்களாகும்.  பல பக்கங்களைக் 
க�ொண்ட ஆவணத்தில் இடது பக்கம் 
மற்றும் வலது பக்கம் ஆகும்.

ஆவணத்தின் பக்கங்களில் அல்லது 
பரவல்களில் உலாவுவதற்கு பல வழிகள் 
உள்ளன.

1.	 Layout பட்டியில் உள்ள Go to 
page கட்டளை நாம் எந்த விருப்பப் 
பக்கத்திற்கு செல்ல வேண்டும�ோ 
அந்த பக்கத்திற்கு செல்ல உதவுகிறது.

படம் 2.23  Laout பட்டியில் Goto page தேர்வு

படம் 2.24  Goto page உரையாடல் பெட்டி

2.	 ஆவண சன்னலில் கீழே மற்றும் 
வலது பக்கங்களில் உள்ள உருள் 
பட்டைகளைப் பயன்படுத்தி அல்லது 
ஆவண சன்னலின் கீழே இடது 
மூலையில் உள்ள Page பட்டியில் 
இருந்து pageஐ தேர்ந்தெடுப்பதன் 
மூலம் ஆவணத்தில் உலாவலாம்.
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படம் 2.25  உருள் பட்டைகள்

3.	 ஆவணத்தின் கீழே First Spread, Previous spread, Next spread மற்றும் Last spread 
ப�ொத்தான்கள் உள்ளன.  படம் 2.26ல் காண்பிக்கப்பட்டவாறு மேலே உள்ளவற்றை 
கிளிக் செய்து பரவலாக உலாவ முடியும்.

படம் 2.26  Page ப�ொத்தான் மற்றும் Page பட்டி

ஆவண சன்னலில் 
கீழ் மற்றும் வலது பக்க 
உருளல் பட்டைகள்
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2.12  �கருவிப் பலகத்தை திறத்தல் மற்றும் மூடுதல்
கருவிப் பலகத்தை திறக்க மற்றும் மூட
●	 Window ® Tools ஐத் தேர்ந்தெடுத்த கருவிப் பலகத்தை மூடலாம்.  இதை மீண்டும் 

திறக்க Window ® Tools ஐ மறுபடியும் தேர்ந்தெடுக்கவும்.  அல்லது
●	 Tab சாவியை அழுத்தி கருவிப்பலகத்தில் உள்ள அனைத்து திறந்த பலகங்களையும் 

மூடலாம்.  அந்த பலகங்களை மீண்டும் திறக்க Tab சாவியை மீண்டும் அழுத்தவும்.  
மிதவை கருவிப் பலகத்தை மூடுவதற்கு Close பெட்டியையும் கிளிக் செய்யலாம்.

படம் 2.27  window பட்டியில் உள்ள Tools தேர்வு

Tool Box Close Icon
படம் 2.28  மிதவை கருவிப் பலகம்
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2.13  உரையுடன் வேலை செய்தல் (Working with text)
InDesign – ல் முக்கியமான இரண்டு வகை Type கருவிகள் உள்ளன.  அவை Type 
மற்றும் Type on a path.  Type கருவி, ஆவணத்தில் உரையை சேமிப்பதற்கான செவ்வக 
உரைச்சட்டகத்தை உருவாக்கப் பயன்படுகிறது.  Type on a path கருவி, பாதையின் 
உட்புற அல்லது வெளிப்புற விளிம்பில் உரையைச் சேர்க்கப் பயன்படுகிறது.  Type கருவி 
மட்டுமில்லாமல் Frame கருவியில் உள்ள செவ்வகம் (Rectangle), நீள்வட்டம் (Ellipse), 
மற்றும் பலக�ோணம் (Polygon) ப�ோன்றவற்றையும் ஒரு ஆவணத்தில் உரையைச் சேர்க்கப் 
பயன்படுத்தலாம்.  Minion Pro Regular என்பது தானமைவு எழுத்து வகையாகும்.  

Type கருவிகளைப் பயன்படுத்துதல்
1.	 கருவி பலகத்தில் உள்ள Type கருவியை தேர்வு செய்யவும்.

●	 தனியாக பிரிக்கக் கூடிய பலகத்தை உருவாக்குவதற்கு கருவி பலகத்தின் வலது 
புறத்தில் உள்ள அம்புகுறியை கிளிக் செய்யவும்.

2.	 பின்வரும் ஏதேனும் ஒரு Type கருவியை தேர்வு செய்யவும்.
●	 Type – உரைச்சட்டகத்தை உருவாக்குகிறது.
●	 Type on a path – திறந்த அல்லது மூடப்பட்ட பாதையின் வெளிப்புற விளிம்பின் 

உரையை உருவாக்குகிறது.
3.	 Type கருவியில் உரைச்சட்டகத்தை வரைய அதை இழுக்கவும்.  Type on a path 

கருவியில் பாதையின் மேல் கிளிக் செய்யவும்.
4.	 சில உரைகளை தட்டச்சு செய்யவும்.

படம் 2.29  Type மற்றும் Type on a path.  
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மூலையில் உள்ள Page பட்டியில் 
இருந்து pageஐ தேர்ந்தெடுப்பதன் 
மூலம் ஆவணத்தில் உலாவலாம்.
கருவிப் பலகத்தில் தேர்வு அல்லது 

உரைச்சட்டத்தின் க�ொள்ளளவிற்கு 
அதிகமான உரையை தட்டச்சு செய்தால், 
overflow குறியீடு (ஒரு சதுரத்திற்குள் 
சிறிய சிவப்பு+குறி) செவ்வகப் பெட்டியின் 
விளிம்பில் த�ோன்றும்.  அப்போது, உரைச் 
சட்டத்தை உரை தெரிவதற்காக வேறு 
வடிவத்திற்கு மாற்றலாம்.  அல்லது வேறு 
ஒரு உரைச் சட்டத்திற்கு இணைப்பை 
உருவாக்கலாம்.  

Overflow குறியீடு த�ோன்றினால் 
உரைச்சட்டகத்தின் தேர்வை நீக்கி, 
கருவிப் பலகத்தில் உள்ள தேர்வுக் 
கருவியைத் தேர்வு செய்யவும் பின்னர் 
உரைச்சட்டக்த்தின் ஒரு மூலையை 
இழுக்கவும்.

படம் 2.30  உரைசட்டகம்

2. 13. 1	 உரைப்பெட்டிகளை 
உருவாக்குதல்

உரைச்சட்டங்கள் என்றும் அழைக்கப்படும் 
உரைப்பெட்டிகள் உரையின் கலன்கள் 
ஆகும்.  நாம் உரைப்பெட்டியை 
உருவாக்கும்போது, ஒளிரும் செருகும் 
புள்ளியானது பெட்டியின் இடது மேல் 
மூலையில் த�ோன்றும்.  அது தட்டச்சு செய்ய 
தயாராக உள்ளது என்பதைக் காட்டும்.  
உரைப் பெட்டியின் அளவைப் ப�ொருத்து 
கிடைமட்டமாக ப�ொருந்தக்கூடிய 
உரையின் அளவு அமையும்.  ஏனெனில், 
உரையானது உரைப்பெட்டியின் வலது 
ஓரத்தை அடைந்தவுடன் அது தானாகவே 
மடிந்து அடுத்த வரிக்கு வந்துவிடும்.  ‘Place’ 
கட்டளையைப் பயன்படுத்தி InDesign 
ஆவணத்தில் வேறு ஒரு க�ோப்பிலிருந்து 
உரையை நகல் எடுத்து ஓட்டலாம்.  அல்லது 
உரைக்கோப்பை இருத்தலாம்.

உரைச்சட்டத்தில் தட்டச்சு உருவாக்குதல்
தட்டச்சு கருவியின் மூலம், நமக்கு 
தேவைப்படும் அளவில் செவ்வக 
உரைப்பெட்டியை உருவாக்கலாம்.

1.	 கருவிப்பலகத்தில் இருந்து தட்டச்சு 
கருவியை தேர்ந்தெடுக்கவும்.

2.	 தேவைப்படும் அளவில் இழுத்து 
சவ்வக உரைப்பெட்டியை 
உருவாக்கவும்.  ஒரு ஒளிரும் செருகும் 
புள்ளியானது உரைச்சட்டத்தில் 
த�ோன்றும்.

	 இப்பொழுது தட்டச்சு செய்ய 
ஆரம்பிக்கலாம்.  உரையானது 
தானாகவே மடிந்து அந்த 
உரைச்சட்டத்தின் வடிவத்திற்கு 
அமைகிறது.  புதுவரியைத் த�ொடங்க 
‘Enter’ ப�ொத்தானை அழுத்தவும்.

3.	 ஆவண சன்னலில் கீழே மற்றும் 
வலது பக்கங்களில் உள்ள உருள் 
பட்டைகளைப் பயன்படுத்தி அல்லது 
ஆவண சன்னலின் கீழே இடது 
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2. 13. 2	 சட்டகக் கருவிகளைப் பயன்படுத்தி தட்டச்சு உருவாக்குதல் (Frame Tools)
ஆவணத்தில் உரையைச் சேர்ப்பதற்கு தட்டச்சுக் கருவியுடன் சட்டகக் கருவியான – 
செவ்வகம், நீள்வட்டம் மற்றும் பலக�ோணங்களையும் பயன்படுத்தலாம்.  ஆவணத்தில் 
ஒரு செவ்வக வடிவத்திற்கு பதிலாக ஒழுங்கற்ற வடிவங்களை உரை சேமிப்பதற்கு 
உருவாக்கலாம்.  பல க�ோண சட்டகக் கருவியும் நட்சத்திர வடிவத்தில் தட்டச்சு செய்ய 
உருவாக்கப்படுகிறது.  

செவ்வக அல்லது நீள்வட்ட சட்டகத்தை தட்டச்சு செய்ய உருவாக்குதல்.   (Rectangle or elliptical 
frame) 

1.	 கருவிப் பலகத்தில் செவ்வகம்/நீள்வட்டம்/பலக�ோணம் ஏதேனும் ஒன்றைத் தேர்வு 
செய்யவும்.

2.	 தேவைப்படும் அளவில் செவ்வகம்/நீள்வட்டம்/பலக�ோணம் இழுத்து உருவாக்கவும்.
	 சரியான அளவுக்கு சட்டகத்தை உருவாக்க, வெற்று இடத்தில் கிளிக் செய்த உடனே 

செவ்வகம்/நீள்வட்டம்/பலக�ோணம் ஏதேனும் ஒரு உரையாடல் பெட்டி த�ோன்றும்.  
அதில் நமக்குத் தேவையான அகலம் மற்றும் உயரத்தை குறிப்பிட்டு OK ப�ொத்தானை 
அழுத்த வேண்டும்.

3.	 கருவிப் பலகத்தில் தட்டச்சு கருவியைத் தேர்வு செய்யவும்.  சட்டகத்தில் கிளிக் 
செய்து ஏதேனும் உரையைத் தட்டச்சு செய்யவும்.  உரையானது தானாகவே மடிந்து 
சட்டகத்திற்கு ஏற்ற வடிவத்தில் மாறும்.  புது வரியைத் த�ொடங்க ‘Inter’ ப�ொத்தானை 
அழுத்தவும்.

	 Overflow குறியீடு த�ோன்றினால் உரைச்சட்டகத்தின் தேர்வை நீக்கி, தேர்வுக் 
கருவியை கருவிப் பலகத்தில் இருந்து தேர்வு செய்து உரைச்சட்டகத்தில் ஒரு 
மூலையில் இழுக்கவும்.

படம் 2.31  செவ்வகம் / நீள்வட்டம் / பலக�ோண சட்டகத்தில் தட்டச்சு செய்தல்.
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2. 13. 3	 பாதையில் தட்டச்சு உருவாக்குதல்
ஒரு பாதைக் கருவியில் தட்டச்சு செய்வதன் மூலம், ஒரு பாதையின் உள் அல்லது வெளிப்புற 
விளிம்பில் தட்டச்சு சேர்க்கலாம்.  பாதையின் ஏதேனும் ஒரு பக்கத்தில் உரையைச் 
சேர்க்கலாம்.  ஆனால் இரண்டு பக்கங்களிலும் சேர்க்க முடியாது.  முதலில் உரையை உள் 
பக்க பாதையில் சேர்த்திருந்தால் அதை பிறகு வெளிப்பக்கமாக நகர்த்திக் க�ொள்ளலாம்.  
ஒரு பாதையில் உரையைத் தேர்ந்தெடுக்கும் ப�ோது, அடைப்புக்குறிக்குள் த�ோன்றும்.  அதன் 
நிலையைச் சரிசெய்து உரையைச் சரிசெய்யலாம்.

பாதையில் தட்டச்சு உருவாக்குதல்
1.	 கருவிப் பலகத்தில் பாதைக்கருவியில் உள்ள தட்டச்சை தேர்வு செய்யவும்.
2.	 தட்டச்சை சேர்க்க பாதையின் விளிம்பில் கிளிக் செய்யவும். (திறந்து அல்லது மூடி) 

உரைச் சட்டகத்தில் ஒரு ஒளிரும் செருகும் புள்ளி த�ோன்றும்.  ப�ொருளில் உள்ள 
எல்லை நீக்கப்படும்.

	 ஏதேனும் உரையைத் தட்டச்சு செய்யவும்.  உரை தானாகவே மடிந்து உரைச் 
சட்டகத்திற்கு ஏற்றவாறு அமையும்.  ‘Enter’ ப�ொத்தானை அழுத்த வேண்டியதில்லை.

3.	 ப�ொருளின் விளிம்பில் தட்டச்சு த�ோன்றும்.  எல்லைகளை நீக்கிவிட்டு அதன் வடிவத்தில் 
உறுதியாக அமைகிறது.

	 Overflow குறியீடு த�ோன்றினால் உரைச்சட்டகத்தின் தேர்வை நீக்கி, தேர்வுக் 
கருவியை கருவிப்பலகத்தில் இருந்து தேர்வு செய்து உரைச்சட்டகத்தில் ஒரு 
மூலையில் இழுக்கவும்.

	 தேர்வுக்கருவியை தேர்வு செய்யவும் அல்லது தட்டச்சு கருவியை மீண்டும் தேர்வு 
செய்யவும். 
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படம் 2.32  பாதையில் தட்டச்சு உருவாக்குதல்
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ஆவணத்தில் உரையை இருத்துவதற்கு 
பின்வரும் படிநிலைகளை பின்பற்றுக.

1.	 பட்டிப்பட்டையில் இருந்து File → 
Place ஐ தேர்வு செய்க.

2.	 Place உரையாடல் பெட்டி த�ோன்றும்.
3.	 இருத்தப்பட வேண்டிய உரைக் 

க�ோப்பை தேர்வு செய்து place 
உரையாடல் பெட்டியின் வலது 
பக்கத்தில் உள்ள Open ப�ொத்தானை 
கிளிக் செய்யவும்.

4.	 செருகும் புள்ளி செறிவூட்டப்பட்ட 
உரை செருகும் புள்ளியாக 
மாறுகிறது.  இது ஆவணத்தில் உரை 
செருகுவதற்கு தயாராக உள்ளது 
என்பதை தெரிவிக்கிறது.  

5.	 உரையை இருத்துவதற்கு கிளிக் 
செய்யவும் (அதே பக்கத்தில் 
செருகுவதற்கு) அல்லது 
புதிய உரைச்சட்டகத்தை 
உருவாக்குவதற்கு கிளிக் செய்து 
இழுக்கவும்.

6.	 உரையை உரைச்சட்டகத்தில் 
இருத்த முடியவில்லை எனில், 
ஒரு சிவப்பு+குறியானது, 
உரைசட்டகத்தின் கீழ் வலது 
எல்லையில் Overflow குறியீடாக 
த�ோன்றும்.

7.	 இந்த Overflow குறியீட்டை 
கிளிக் செய்தால் மீதமுள்ள உரை 
செருகும் புள்ளியில், கூடுதல் 

2. 13. 4	 உரையைத் தருவித்தல் (Import 
Text)

0InDesign ஆவணத்தில் வேறு ஒரு 
ஆவணத்தின் உரையை சேர்க்க 
விரும்பினால் ‘Place’ கட்டளையைப் 
பயன்படுத்த வேண்டும்.  பின்வரும் 
உரைவடிவங்களிலிருந்து உரையைத் 
தருவிக்கலாம்.  Plain T Text (TXT) Rich 
Text Format (RTF), Microsoft word 
(Doc or Docx) or Microsoft Excel (Xls 
or XLSX).   File பட்டியில் உள்ள  place 
கட்டளையைப் பயன்படுத்தி உரையைத் 
தருவிக்கும் ப�ொழுது  InDesign புதிய 
உரைச்சட்டகம் அல்லது ஏற்கனவே உள்ள 
உரைச்சட்டகத்தில் உரையை இருத்த 
அனுமதிக்கிறது.  

படம் 2.33 (a)  File பட்டியில் உள்ள Place தேர்வு

படம் 2.33 (b)   Place உரையாடல் பெட்டி படம் 2.33 (c)  செறிவூட்டப்பட்ட 
உரை செருகும் புள்ளி

படம் 2.33 (d)  உரைச்சட்டகம்
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உரைச்சட்டகத்தில் உரையைச் சேர்ப்பதற்காக ஏற்றப்படுகிறது.  உரையானது கிளிக் 
செய்யும் ப�ொழுது இருத்தப்படும்.  கிளிக் செய்து இழுத்தால் புதிய உரைச்சட்டகம் 
கூடுதல் உரையுடன் உருவாக்கப்படும்.  புதிய உரைச்சட்டகம் முன்னர் உள்ள 
உரைச்சட்டகத்துடன் இணைக்கப்படும்.  இவ்வாறு இணைக்கப்படும் ப�ோது 
உரைசட்டகத்தின் அளவு அல்லது உரையின் வடிவூட்டல் உரையானது இரண்டு 
சட்டகங்களுக்கு மாற்றப்பட்டால் இடையே எளிதாக நகர்கிறது.

படம் 2.33 (e)  Overflow குறியீடு

படம் 2.34  உரைச்சட்டகம்
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2. 13. 5	 உரையை தட்டச்சு செய்தல் மற்றும் தேர்ந்தெடுத்தல்
InDesign – ல் உரையில் பணி செய்வதற்கு முன்னால், உரை தேர்வு செய்யப்பட வேண்டும்.  
உரைச்சட்டகத்தில் முழு உரை அல்லது எழுத்தைய�ோ தேர்வு செய்யலாம்.  தேர்ந்தெடுப்பு 
கருவிகள் (தேர்ந்தெடுப்பு மற்றும் நேரடி தேர்ந்தெடுப்பு) எழுத்துக்கள் மற்றும் அதன் ப�ொருட்கள் 
இரண்டையும் தேர்ந்தெடுக்க அனுமதிக்கிறது.  தட்டச்சு கருவிகள் உரைச்சட்டகத்தில் 
உள்ள ப�ொருள்களைத் தவிர்த்து எழுத்துக்களை மட்டும் தேர்ந்தெடுக்க பயன்படுகிறது.  
உரைச்சட்டகத்தில் உரையைச் சேர்க்கும் ப�ொழுது ‘Enter’ ப�ொத்தானை அழுத்தினால் புதிய 
பத்தி உருவாக்கப்படும்.  வரி முறிவை  (line break) விரும்பினால்  Shift+Enter ஐ அழுத்தவும்.

உரைத் தேர்ந்தெடுப்புகள்
தேர்ந்தெடுத்தல் செய்ய வேண்டியவை 

ஒரு வார்த்தை வார்த்தையின் மேல் இரட்டை கிளிக் செய்க

ஒரு வரி வரியின் ஏதேனும் ஒரு வார்த்தையில் மூன்று 
கிளிக் செய்க

ஒரு பத்தி பத்தியில் உள்ள ஏதேனும் ஒரு வார்த்தையின் 
மீது நான்கு முறை கிளிக் செய்க.

முழு கதை கதையில் உள்ள ஏதேனும் ஒரு வார்த்தையில் 
ஐந்து முறை கிளிக் செய்க.

முழு கதை Ctrl + A

செருகும் புள்ளிக்கு வலது பக்கத்தில் உள்ள ஒரு எழுத்து Shift + →

செருகும் புள்ளிக்கு இடது பக்கத்தில் உள்ள ஒரு எழுத்து Shift + ←

செருகும் புள்ளிக்கு மேல் ஒரு வரி Shift + ↑

செருகும் புள்ளிக்கு கீழ் ஒரு வரி Shift + ↓

செருகும் புள்ளிக்கு வலது பக்கத்தில் ஒரு வார்த்தை Shift + Ctrl + →

செருகும் புள்ளிக்கு இடது பக்கத்தில் ஒரு வார்த்தை Shift + Ctrl + ←

செருகும் புள்ளிக்கு மேலே ஒரு பத்தி Shift + Ctrl+ ↑

செருகும் புள்ளிக்கு கீழே ஒரு பத்தி Shift + Ctrl + ↓

2. 13. 6	 உரையின் எழுத்து வகை மற்றும் எழுத்து அளவை மாற்றுதல்
உரையின் எழுத்து வகை மற்றும் எழுத்து அளவை மாற்றுவதற்கு, ஆவணத்தின் 
த�ோற்றத்தை கட்டுப்பாட்டு தட்டுகளை பயன்படுத்தி மேம்படுத்த வேண்டும்.   உரை 
தேர்ந்தெடுக்கப்படும் ப�ொழுது, கட்டுப்பாட்டு தட்டுகள் எழுத்து வடிவூட்டல் கட்டுப்பாடுகளைக் 
காண்பிக்கும்.  
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உரையின் எழுத்து வகையை மாற்றுதல்
1.	 வேறு எழுத்து வகைக்கு மாற்றப்பட வேண்டிய உரையைத் தேர்வு செய்க.
2.	 கட்டுப்பாட்டுத் தட்டில் உள்ள Font  கீழ்விரிப்பட்டியலை கிளிக் செய்தால் அந்த பட்டியலில் 

உள்ள எழுத்து வகைகளைக் காண்பிக்கும்.
3.	 பயன்படுத்த விரும்புகிற எழுத்து வகையை கிளிக் செய்யவும்.  தேர்ந்தெடுக்கப்பட்ட 

உரை புதிய எழுத்து வகையாக மாற்றம் பெறும்.
4.	 தேர்ந்தெடுக்கப்பட்ட பகுதியின் வெளியே கிளிக் செய்தால் தேர்ந்தெடுக்கப்பட்ட உரை 

விடுவிக்கப்படும்.
Character formatting 
controls

Font drop down list 
box

படம் 2.35  உரை வடிவூட்டல் கட்டுப்பாடுகள்

உரையின் எழுத்து அளவை மாற்றுதல்
1.	 எழுத்து அளவு மாற்றப்பட வேண்டிய உரையை தேர்ந்தெடுக்கவும்.
2.	 கட்டுப்பாட்டு தட்டில், எழுத்து அளவு கீழ் விரிப்பட்டியலை கிளிக் செய்தால் அதில் உள்ள 

எழுத்து அளவுகளைக் காண்பிக்கும்.
3.	 தேவையான எழுத்து அளவை கிளிக் செய்யவும்.
4.	 தேர்ந்தெடுக்கப்பட்ட  உரையானது புது எழுத்து அளவிற்கு மாறும்.
5.	 தேர்ந்தெடுக்கப்பட்ட பகுதியின் வெளியே கிளிக் செய்தால் தேர்ந்தெடுக்கப்பட்ட உரை 

விடுவிக்கப்படும்.
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Font size drop down 
box

படம் 3.36  எழுத்து அளவு கீழ்விரிப்பட்டியல்

2. 13. 7	 உரையை தடிக்க, சாய்ந்த 
அல்லது தடித்த சாய்ந்த 
பாணியாக மாற்றுதல்

ஆவணத்தில் உள்ள தகவல்களை 
மேம்படுத்துவதற்கு, உரையை தடித்த 
அல்லது சாய்ந்த அல்லது தடித்த சாய்ந்த 
எழுத்தாக மாற்றம் செய்யலாம்.

1.	 தடித்த, சாய்ந்த, தடித்தசாய்ந்த 
உரையாக மாற்றப்பட வேண்டிய 
உரையை தேர்வு செய்க.

2.	 கட்டுப்பாட்டுத் தட்டுகளில், எபத்துப் 
பாணிகளின் பட்டியலை த�ோன்றச் 
செய்வதற்கு 

3.	 கட்டுப்பாட்டுத் தட்டுகளில், 
எபத்துப் பாணிகளின் பட்டியலை 
த�ோன்றச் செய்வதற்கு Font Style 
கீழ்விரிப்பட்டியல் பெட்டியை கிளிக் 
செய்யவும்.

4.	 பயன்படுத்தப்பட வேண்டிய 
எழுத்துப்பாணியை கிளிக் செய்யவும்.  
தேர்வு செய்யப்பட்ட உரையானது 
புதிய எழுத்து பாணியில் மாற்றம் 
அடையும்.

5.	 தேர்ந்தெடுக்கப்பட்ட பகுதியின் 
வெளியே கிளிக் செய்தால் 

தேர்ந்தெடுக்கப்பட்ட உரை 
விடுவிக்கப்படும்.

Font style drop down list box

படம் 2.37  Font Style கீழ்விரி பட்டியல் பெட்டி
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படம் 2.38  உரையின் வண்ணத்தை மாற்றுதல்

2. 13. 8	 உரையின் வண்ணத்தை 
மாற்றுதல்

ஆவணத்தில் உள்ள முக்கிய தலைப்புகள் 
அல்லது தகவல்கள் ப�ோன்றவை 
படிப்பவரின் கவனத்தை ஈர்ப்பதாக 
இருப்பதற்கு உரையின் வண்ணத்தை 
மாற்றம் செய்ய வேண்டும். 

1.	 வண்ணம் மாற்றப்பட்ட வேண்டிய 
உரையை தேர்ந்தெடுக்கவும்.

2.	 அதில் உள்ள வண்ணங்களை 
காண்பிக்க ஸ்வாட்சஸ்   (Swatches) 
பணிக்குறியை கிளிக் செய்க.

3.	 அது த�ோன்றவில்லை எனில்,   
window → colour → swatches ஐ 
கிளிக் செய்க.  அல்லது F5 வை 
அழுத்துக.

4.	 ஏதேனும் ஒரு வண்ணத்தை 
தேர்ந்தெடுக்கவும்.

5.	 உரை அந்த வண்ணத்தில் 
த�ோன்றும்.
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Superscript
Subscript

படம் 2.39  எழுத்துக்களை மேல�ொட்டு அல்லது 
கீழ�ொட்டாக மாற்றுதல்.

2.14  பத்தி வடிவூட்டல்
பத்திகள் என்பன, ‘Enter’ ப�ொத்தானை 
அழுத்தி உருவாக்கப்படும் இடைவெளிகளால் 
பிரிக்கப்பட்ட உரை வரிகளாகும்.  
எடுத்துக்காட்டாக,  Monday வை தட்டச்சு 
செய்து பின்  Enter ப�ொத்தானை அழுத்தி 
அதன்பின்  Tuesday என தட்டச்சு செய்தால் 
இரண்டு பத்திகள் (ஒவ்வொரு வரியிலும்) 
உருவாக்கப்படும்.  உரையைப் ப�ோலவே, 
பத்திகளையும்   leading மற்றும்  alignment  
என்ற பத்தியின் பண்புகளை மாற்றுவதன் 
மூலம் வடிவூட்டல் செய்ய முடியும். 

2. 13. 9	 எழுத்துக்களை மேல�ொட்டாக 
அல்லது கீழ�ொட்டு மாற்றுதல் 
(Superscript Subscript) 

கட்டுப்பாட்டு தட்டில், இருந்து உரையை 
கீழ�ொட்டு அல்லது மேல�ொட்டாக மாற்ற

1.	 கீழ�ொட்டு அல்லது மேல�ொட்டாக 
மாற்றப்பட வேண்டிய எழுத்தை 
தேர்ந்தெடுக்கவும்.

2.	 கட்டுப்பாட்டுத் தட்டில் உள்ள 
ஏதேனும் ஒரு ப�ொத்தானைக் கிளிக் 
செய்யவும்.

	 மேல�ொட்டு ( ) 
	 கீழ�ொட்டு ( )
3.	 தேர்வு செய்யப்பட்ட எழுத்து 

தேவைப்படும் படி மாறும்.

அட்டவணையானது கட்டுப்பாட்டுப் பலகம் மற்றும் பத்திப் பலகத்தில் உள்ள பத்தி இசைவு 
ப�ொத்தான்களை விளக்குகிறது.

இசைவின் வகை விளக்கம்

 இடது இசைவு உரைபெட்டியின் இடது எல்லையில் அனைத்து வரிகளும் 
சீரமைக்கப்படும்

 

மைய இசைவு உரைபெட்டியின் இடது மற்றும் வலது எல்லைக்களுக்கிடையே 
மையப்படுத்தப்படும்.

 

வலது இசைவு உரைபெட்டியின் வலது எல்லையில் அனைத்து வரிகளும் 
சீரமைக்கப்படும்.

 

இறுதி வரி மட்டும் இடது 
இசைவுடன் கூடிய 
நேர்த்தி இசைவு

உரை சட்டகத்தின் வலது மற்றும் இடது என இரு 
எல்லைகளுக்கிடையே சமமாக பகிர்ந்து, வரிகள் சீரமைக்கப்படும்.  
பத்தியின் இறுதி வரி மட்டும் இடது எல்லையில் அமைந்திருக்கும்.
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Leading
இரண்டு வகையான வரிகளுக்கு 
இடையே உள்ள இடைவெளியின் 
அளவைக் குறிக்கும். 

Alignment
பத்தியானது, உரைப்பெட்டியின் இடது 
மற்றும் வலது பக்கங்களுக்கு இடையே 
உள்ள கிடைமட்ட பரவலை குறிக்கிறது. 

2.15  �புல்லட்கள் மற்றும் எண்களைச் 
சேர்த்தல்

பட்டியலின் கவனத்தை ஈர்க்க, 
உருப்படிகளை புல்லட்கள் அல்லது 
எண்களைக் க�ொண்டு வடிவமைத்தலே 
மிகச் சிறந்த வழியாகும்.  புல்லட்கள் 
என்பது சிறிய வட்ட அல்லது சதுரம் குறியீடு 
ஆகும்.  இதை பத்தி த�ொடங்குவதற்கு 
முன்பு செருக வேண்டும்.  புல்லட்கள் 
ப�ொதுவாக வரிசைப்படுத்தப்படாத 
பட்டியலின் உருப்படிகளுக்காக 

இறுதி வரி மட்டும் வலது 
இசைவுடன் கூடிய 
நேர்த்தி இசைவு

உரைசட்டகத்தின் வலது மற்றும் இடது என இரு 
எல்லைகளுக்கிடையே சமமாக பகிர்ந்து, வரிகள் சீரமைக்கப்படும்.  
பத்தியின் இறுதி வரி மட்டும் வலது எல்லையில் அமைந்திருக்கும்.

இறுதி வரி மட்டும் மைய 
இசைவுடன் கூடிய 
நேர்த்தி இசைவு

உரை சட்டகத்தின் வலது மற்றும் இடது என இரு 
எல்லைகளுக்கிடையே சமமாக பகிர்ந்து வரிகள் சீரமைக்கப்படும்.  
பத்தியின் இறுதிவரி மட்டும் மைய இசைவில் இருக்கும்.

நேர்த்தி இசைவு 
(அனைத்து வரிகளும்)

உரைசட்டகத்தின் வலது மற்றும் இடது என இரு 
எல்லைகளுக்கிடையே சமமாக பகிர்ந்து, வரிகள் சீரமைக்கப்படும்.

முனையை ந�ோக்கிய 
இசைவு

இடது மற்றும் வலது பக்கங்களில் பயன்படுத்தப்படும், 
உரைப்பெட்டியின் இடது பக்கத்திலுள்ள உரை வலது 
இசைவாகவும், வலது பக்கம் மீது பாயும் எந்த உரையும் இடது 
இசைவாகவும் இருக்கும்.

முனையிலிருந்து 
விலகும் இசைவு

இடது மற்றும் வலது பக்கங்களில் பயன்படுத்தப்படும்.  
உரைபெட்டியின் இடது பக்கத்திலுள்ள உரை இடது  
பக்கத்திலுள்ள உரை இடது இசைவாகவும், வலது பக்கம் மீது 
பாயும் எந்த உரையும் வலது இசைவாகவும் இருக்கும்.

பயன்படுத்தப் படுகிறது.  குறிப்பிட்ட 
வரிசை தேவை எனில், புல்லட்களுக்குப் 
பதிலாக எண்களைப் பயன்படுத்தலாம்.  
எண் வரிசை பட்டியலில் உருப்படிகளை 
நகர்த்தினால�ோ, செருகினால�ோ, அல்லது 
நீக்கினால�ோ, InDesign பட்டியலுக்கு 
த�ொடர்ச்சியாக புது எண்களை அளிக்கும்.

ஒரு பத்திக்கு புல்லட்கள் அல்லது 
எண்களைச் சேர்த்தல்

1.	 புல்லட்கள் அல்லது எண்கள் 
சேர்க்க விரும்பும் பத்தியைத் 
தேர்ந்தெடுக்கவும்.

2.	 Type > Bulleted & Numbered Lists 
யைத் தேர்ந்தெடுக்கவும், பிறகு Apply 
Bullets  அல்லது Apply Numbers 
யைக் கிளிக் செய்யவும்.

	 Bullets and Numbering 
உரையாடல் பெட்டியில் இறுதியாக 
பயன்படுத்திய அமைப்பை உரைக்கு 
செயல்படுத்தப்படும்.
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2.16  �ப�ொருள்களுடன் வேலை செய்தல் 
(Working with objects) 	

InDesign ஆவணத்திலுள்ள உரை அல்லது 
வரைகலை உறுப்புகளான நிழற்படங்கள், 
வண்ணத் த�ொகுதி மற்றும் எளிய 
க�ோடுகள் கூட ப�ொருள்கள் எனப்படும்.   
InDesign உள்ள அனைத்து ப�ொருள்களும் 
சட்டகத்திற்குள் இருக்கும்.  ஒரு ப�ொருளின் 
சட்டகத்தைத் தேர்ந்தெடுக்கும் ப�ோது படம் 
2.42 ல் காட்டியுள்ளவாறு, அதன் கைப்பிடி 
உயர்த்திக் காட்டப்படும்.  InDesingn 
ல் வேலை செய்யும் ப�ொழுது, உனது 
ஆவணப் பக்கங்களில் சேர்ப்பதற்காக 
பல வகையான ப�ொருள்கள் உள்ளன.  
வரைகலையான புகைப்படம் மற்றும் 

படம் 2.40  Type பட்டி படம் 2.41  புல்லட் பட்டியல்

விளக்கப்படம் ஆகியவை ஒரு வகை 
வடிவங்கள், க�ோடுகள், உரைபெட்டிகள்,  
MS-Excel, வரைபடம் மற்றும் MS-Word 
அட்டவணை ப�ோன்றவை பிற வகைகள் 
ஆகும்.   InDesign லுள்ள ப�ொருள்களை 
பல கருவிகள் பலகங்கள் மற்றும் 
பட்டி கட்டளைகளைப் பயன்படுத்தி 
மாற்றம் செய்யலாம்.  உதாரணத்திற்கு 
ப�ொருளின் வடிவத்தை மாற்றலாம், 
ப�ொருளைச் சுழற்றலாம்  (rotate), அதற்கு 
வண்ணத்தைச் சேர்க்கலாம், மற்றபிற 
ப�ொருள்கள�ோடு குழுவாக்கலாம், 
அல்லது அதன் வெளிப்படைத்தன்மை  
(Transparency) அல்லது அமைவிடத்தைப் 
பக்கத்தில் மாற்றலாம்.
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படம் 2.42 (a)  ப�ொருள்கள் 

சட்டகத்தில் உள்ள மஞ்சள் 
நிற சதுர கைப்பிடி, 
சட்டகத்தின் மூலை 
விளைவுகளை உருவாக்கப் 
பயன்படுத்தப்படும் கூடுதல் 
கைப்பிடியாகும்.

படம் 2.42 (b)  ப�ொருள்கள்

2. 16. 1	 ப�ொருளை உருவாக்குதல்
சில நேரங்களில், நமது பதிப்பிற்கு 
தேவைப்படும் ஒரே வகை ப�ொருள் 
எளிய வடிவங்களாகும். வடிவங்கள் 
ஆவணத்தைப் பார்ப்பதற்கான 
ஆர்வத்தைச் சேர்க்கின்றன. இது உரைக்கு 
பின்னணி யாவும் பணியாற்றுகிறது.  
வடிவங்களை உருவாக்கும் கருவிகள் 
Rectangle, Ellipse  மற்றும் polygon ப�ோன்ற 
கருவிகளைக் க�ொண்டுள்ளது.  ஒரு வடிவ 
கருவியைத் தேர்ந்தெடுக்க, கருவிகள் 
பலகத்தில் Rectangle கருவி (தற்பொழுது 
தேர்ந்தெடுத்த வடிவ கருவி) மீது கிளிக் 
செய்து சுட்டெலி ப�ொத்தானை அழுத்தி 

பிடித்தவாறே, நாம் பயன்படுத்த விரும்பும் 
வடிவ கருவியைத் தேர்ந்தெடுக்கலாம். 
வடிவ கருவி தேர்ந்தெடுக்கப்பட்ட பின், 
ஆவணத்தில் அதை இழுப்பதன் மூலம் 
கைமுறையாக (manually) வடிவத்தை 
உருவாக்கலாம்.  அல்லது ஆவணத்தில் 
கிளிக் செய்து  shapes உரையாடல் 
பெட்டியைத் திறந்து அதன் அமைப்பை 
வரையறுக்கவும்.  வடிவத்தை நிரப்பி 
எல்லைக்கு (stroke) நிறத்தைச் சேர்க்க 
ஸ்வாட்ச் (swatch) பலகம் பயன்படுகிறது.  
எல்லை பலகம் (stroke panel) பயன்படுத்தி 
எல்லையின் அடர்த்தியையும்  (thickness) 
பாணியையும்  (style)  மாற்றமுடியும்.
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2. 16. 2	 வரைகலை சட்டகத்தை உருவாக்குதல்
வரைகலை சட்டகம் வரைகலை ப�ொருளடக்கத்தை இருத்தி வைக்கும்.   உரை சட்டகத்தை 
சாதாரண வரைகலை சட்டகத்திலிருந்து வேறுபடுத்தலாம்.  ஏனெனில், வரைகலை 
சட்டகங்கள் அச்சிடப்படாத ‘X’ என்பதை அதன் நடுவில் காண்பிக்கும்.

வரைகலை சட்டகங்கள் பிற மென்பொருள் நிரல்களில் உள்ள படங்களைத் 
தருவித்துக்கொள்ள பயன்படுகிறது.

  InDesign ல் தருவிக்கப்பட்ட அனைத்து படங்களும் வரைகலை சட்டகங்களின் 
உள்ளே இருக்கும்.  வரைகலை சட்டகங்களை வரைவதற்கு கருவிகள் பலகம் மூன்று 
கருவிகளைக் க�ொண்டுள்ளது.

Ellipse சட்டகம் இந்த கருவியைப் பயன்படுத்தி நீள்வட்ட (oval) மற்றும் வட்ட (round)  
-சட்டகங்களை உருவாக்கலாம்.

Rectangle சட்டகம் இந்த கருவியைப் பயன்படுத்தி செவ்வக மற்றும் சதுர சட்டகங்களை 
உருவாக்கலாம்.

Polygon சட்டகம் இந்த கருவியைப் பயன்படுத்தி சமபக்க பலக�ோண (equilateral polygon) 
சட்டகங்களை உருவாக்கலாம்.  

Ellipse சட்டகம்	 Rectangle சட்டகம்	 Polygon சட்டகம் 

Rectangle  சட்டகத்தை உருவாக்குதல்
1.	 கருவிகள் பலகத்தில் Rectangle சட்டக கருவீ மீது கிளிக் செய்யவும்.  (அல்லது) 

விசைப்பலகையில் ‘F’ விசையை அழுத்தவும்.
2.	 Rectangle சட்டக கருவி சுட்டியைப் பக்கத்தில் நிலைநிறுத்தவும்.  
3.	 Rectangle சட்டகத்தை த�ோராயமான அளவு மற்றும் வடிவத்தில் உருவாக்க,  rectangle 

சட்டக்கருவியை இழுத்து விடவும்.
Rectangle சட்டகத்தை உருவாக்கிய பின்னர், சுட்டெலி ப�ொத்தானை விடுவித்தால், நாம் 

உருவாக்கிய சட்டகம் செயல்படும்.   Selection கருவி முன்னதாகவே தேர்ந்தெடுக்கப்பட்டால் 
சட்டகத்தை அதனுடைய எல்லை பெட்டியினுள் (Bounding box)  காண்பிக்கும்.  இந்த பெட்டி 
எட்டு அளவை மாற்றும் கைப்பிடிகளைக் க�ொண்டுள்ளது.  இந்த கைப்பிடிகள் எல்லை பெட்டி 
அல்லது சட்டகத்தின் வடிவம் அல்லது அளவை மாற்றுவதற்கு உதவி புரிகிறது.
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படம் 2.43  Rectangle சட்டகத்தை உருவாக்குதல்

2. 16. 3	 வரைகலை சட்டகத்தில் படத்தைச் செருகுதல்
வரைகலை சட்டகம் பிற மென்பொருள் நிரலில் உள்ள படங்களைத் தருவிக்க பயன்படுகிறது.  
சட்டகத்தில் படங்களைச் செருகலாம். 

1.	 வரைகலை சட்டகத்தை உருவாக்கு
2.	 File > Place என்பதைத் தேர்ந்தெடுக்கவும். Place உரையாடல் பெட்டி த�ோன்றும்.
3.	 சட்டகத்தில் செருக விரும்பும் படத்தைக் கண்டுபிடித்து தேர்ந்தெடுக்கவும்.
4.	 Open மீது கிளிக் செய்யவும்.

படம் 2.44  வரைகலை சட்டகத்தில் படத்தைச் செருகுதல்
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ப�ொருளை உருமாற்றம் செயவதற்கு 
முன்பு, அதை மாற்றும் குறிப்பு புள்ளியைத் 
(reference point) தேர்ந்தெடுக்கவும்.  இந்த 
புள்ளியைத் த�ொடக்கப்புள்ளி என்கிற�ோம்.  
இந்த புள்ளியில்தான் தேர்ந்தெடுக்கப்பட்ட 
ப�ொருள், உருமாற்றத்தின் ப�ோது

உருமாற்றத்தின் அடிப்படைகள் 
(Transformation Basics)
InDesign ல் ஒரு ப�ொருளை 
உருமாற்றுவதற்கு பல வழிகள் உள்ளன.   
Selection கருவியைப் பயன்படுத்தி 
ப�ொருளைத் தேர்ந்தெடுக்கவும். பிறகு
●	 ப�ொருளை அளவிடுவதற்கு 

தேர்ந்தெடுப்பு கைப்பிடியை 
இழுத்துவிடவும்.  (அந்த ப�ொருளின் 
ப�ொருளடக்கம் தேவையில்லை) 

●	 கருவிகள் பலகத்திலிருந்து உருமாற்ற 
கருவியைத் தேர்ந்தெடுத்து, 
உருமாற்றத்தின் மையத்தை அமைத்து 
(தேவை எனில்), கருவியை இழுக்கவும்.

2. 16. 4	 ப�ொருள்களை உருமாற்றுதல்   
(Transforming an object)

உருமாற்றுதல் என்ற ச�ொற்கூறு 
ப�ொருளை நகர்த்தும் அளவிடும் சாய்க்கும்  
(Skew) அல்லது சுழற்றும் (rotate) செயலை 
விவரிக்க பயன்படுத்தப்படுகிறது.  

ஏதேனும் ஒன்றை நாம் 
உருமாற்றம் செய்யும்போது அதன் 
த�ோற்றத்தை  (appearance) நாம் 
மாற்றுகிற�ோம்.  உதாரணமாக ப�ொருளின் 
உண்மையான அளவை அதன் பாதி 
அளவாக மாற்ற, ப�ொருளை 450 யில் 
சுழற்றலாம் அல்லது 50% க்கு அளவிடலாம்.   
InDesign உள்ள உருமாற்ற கட்டளைகள் 
பின்வருமாறு  Move, Scale, Rotate, Shear 
மற்றும் flip ஆகும்.  உருமாற்ற பலகம் 
அல்லது கட்டுப்பாட்டு பலகத்திலுள்ள 
ப�ொத்தான்களைப் பயன்படுத்தியும் 
ப�ொருள்களை உருமாற்றம் செய்யலாம்.  
ப�ொருளின் நீளம், அகலம் மற்றும் அதன் 
அமைவிடத்தைப் பக்கத்தில் மாற்றலாம்.  

படம் 2.45  ப�ொருளை உருமாற்றுதல்
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●	 உருமாற்ற பலகம் அல்லது கட்டுப்பாட்டு பலகம் த�ோன்றும்.  மதிப்புகளை உருமாற்றம் 
செய்ய விரும்பும் த�ொடர்புடைய பலகபுலத்தில் (panel field) உள்ளிடவும்.  அல்லது 
மேல் மீட்பு பட்டிய�ோடு த�ொடர்புடைய புலத்திலிருந்து முன்னமைக்கப்பட்ட மதிப்பைத் 
தேர்ந்தெடுக்கவும். (preset values)

படம் 2.46  ப�ொருளை சுழற்றுதல்

●	 உருமாற்ற பலகப்பட்டி அல்லது கட்டுப்பாட்டு பலகப்பட்டியிலிருந்து முன்னமைக்கப்பட்ட 
(preset) சுழற்றும் அல்லது பிரதிபலிக்கும் தேர்வுகளில் ஒன்றைத் தேர்ந்தெடுக்கவும்.

●	 கருவிப்பெட்டியிலுள்ள ஏதேனும் ஒரு உருமாற்ற கருவியின் மீது இரட்டைக் கிளிக் 
செய்து, த�ொடர்புடைய உருமாற்ற உரையாடல் பெட்டியைத் த�ோன்றச் செய்யலாம்.  
(உதாரணமாக, Rotate கருவியை இரட்டைக் கிளிக் செய்தால்  Rotation உரையாடல் 
பெட்டி த�ோன்றும்)

●	 Free Tranform கருவியைத் தேர்ந்தெடுத்து, ப�ொருளைச் சுற்றி கருவியை இழுத்து 
விடவும்.

●	 விசைப்பலகை குறுக்குவழியை அழுத்தவும்.

உருமாற்றம் செய்வதற்கான சரியான அல்லது சிறந்த வழி என்று எதுவும் இல்லை.  
பல முறைகளில் இதை ச�ோதனை செய்து எது சிறந்தது என்று பார்க்கவும்.  
சூழ்நிலையைப்பொறுத்து,  நாம் வழிமுறைகளை மாற்றுவ�ோம் (மற்றும் நமது மனநிலை) 

மூலைகள் மற்றும் எல்லைகளை மாற்றுதல்
In Design – ல் ‘Corner options’ உரையாடல் பெட்டியைப் பயன்படுத்தி, செவ்வக வடிவத்தின் 
மூலைகளை மாற்றம் செய்யலாம். இது ஐந்து வகையான மூலைகளை வழங்குகிறது. 
(அதாவது Rounded மற்றும் bevelled) பெரும்பான்மையான உரையாடல் பெட்டியைப் 
ப�ோன்று, உரையாடல் பெட்டியை மூடுவதற்கு முன்பு, தேர்ந்தெடுத்த ப�ொருளின் அமைப்பை 
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முன்காட்சியாகக் காணலாம். மூலைகளுக்கு செய்யப்படும் மாற்றங்களைச் சிறப்பாக 
பார்ப்பதற்கு தடித்த எல்லை பரிந்துரைக்கப்படுகிறது. எல்லை பலகத்தில் எல்லையின் 
தடிமனை (அடர்த்தி) மாற்றலாம். 

படம் 2.47  Object பட்டி

செவ்வகத்தின் மூலையை மாற்றுதல்
1.	 செவ்வகத்தை வரைந்து அதனை 

தேர்ந்தெடுக்கவும்.
2.	 எல்லை பலகத்தில் எல்லையின் 

தடிமனை (அடர்த்தியினை) மாற்றவும்.
3.	 Object → corner options என்பதைத் 

தேர்வு செய்க.  Corner options 
உரையாடல் பெட்டி த�ோன்றும்.

4.	 ப�ொருத்தமான மூலை அளவு மற்றும் 
வடிவத்தைக் க�ொடுக்கவும்.

2.17  ஆவணத்தை அச்சிடுதல்
Ctrl மற்றும் p ப�ொத்தானை ஒன்றாக 
அழுத்தும்போது, ‘print’ உரையாடல் 
பெட்டி த�ோன்றும்.  இந்த உரையாடல் 
பெட்டியில் பல சிறப்பம்சங்கள் உள்ளன.  
அவற்றை எட்டு சாளரங்களாகப் (pane) 
பிரிக்கப்பட்டுள்ளது: General, Setup, 
Marks and Bleeds, output, Graphics, color 
Management, Advanced மற்றும் Summary 

படம் 2.48  மூலைகளின் தேர்வுகள்
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படம் 2.49  File பட்டி

படம் 2.50  Print உரையாடல் பெட்டி
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அல்லது இறுதியில் வர விரும்பினால், 
Reverse order தேர்வுப்பெட்டியை தேர்வு 
செய்யவும்.  இது Indesign கடைசிப் 
பக்கத்தை முதலில் அச்சிட்டு பின்னர் 
பின்புறமாக முதல் பக்கம் வரை அச்சிடுமாறு 
செய்கிறது. 

Page Ranges 
All pages தேர்வை தேர்வு செய்து 
அனைத்து பக்கத்தையும் அச்சிடலாம்.  
குறிப்பிட்ட பக்கங்களை அச்சிடுவதற்கு 
range தேர்வினை தேர்வு செய்யவும்.  Range 
புலத்தில் பக்கங்களின் எண்ணிக்கையை 
பின்வரும் அட்டவணையில் 
காட்டியுள்ளவாறு உள்ளிடவும்.

அச்சிட உள்ளிட எ.கா.

த�ொடர்ச்சியான 
பக்கங்களின் 
எண்கள்

முதல் பக்கம் 
– கடைசி 
பக்கம்

12-21

குறிப்பிட்ட பக்கம் 
வரை

கடைசி 
பக்கம் 

-5

ஒரு பக்கத்திலிருந்து 
ஆவணத்தின் இறுதி 
வரை

முதல் 
பக்கம்-

5-

த�ொடர்ச்சியற்ற 
பக்கங்கள்

பக்கம், பக்கம் 1, 3

கலப்பு பக்கங்கள் பக்கம், 
த�ொடர்ச்சி

-3 
6-9, 12, 
15- 

பிரிவு வாரியான 
பக்கங்கள்

பிரிவு :பக்கம் sec1:1 
Sec2:5

Sequence:
ஒற்றைப்படை மற்றும் இரட்டைப்படை 
பக்கங்களை அச்சிடுவதற்கு, All pages 
தேர்வினை sequence மேல்மீட்புப் பட்டியில் 
இருந்து தேர்ந்தெடுக்கவும். இரட்டைப்படை 
எண்களை உடைய பக்கங்களை 
அச்சிடுவதற்கு  even pages only என்ற 
தேர்வினை தேர்வு செய்யவும்.  ஒற்றைப்படை 

அச்சுப்பொறிகள்
Print உரையாடல் பெட்டியில், முதலில் 
கணினியில் நிறுவப்பட்டிருக்கும் 
அச்சுப்பொறிகளின் பட்டியலை 
printer மேல்மீட்புப்பட்டியில் இருந்து 
தேர்வுசெய்யவும்.  ஒரு அச்சுப்பொறியை 
தேர்ந்தெடுக்கும் ப�ொழுது, In Design 
அச்சுப்பொறிக்கான இயக்கியை தேடி, அந்த 
அச்சுப்பொறியுடன் த�ொடர்புடைய PPD (Post 
Script Printer Description) க�ோப்பு உள்ளதா 
எனப் பார்த்து, PPD பட்டியில் grayed out 
எனக் காண்பிக்கும். PPD இல்லையெனில், 
PPD பட்டியில் காலியாக இருக்கும். 

General:
Print உரையாடல் பெட்டியின் General 
சாளரம், அச்சிடுவதற்கான அடிப்படை 
சிறப்பம்சங்களைக் க�ொண்டுள்ளது.  
அச்சிட விரும்பும் பக்கம்,  நகல்களின் 
எண்ணிக்கை, அச்சுப்பொறியிலிருந்து 
வெளியேறும் விதம். (பார்க்க படம் 2.50)

நகல்கள் (Copies)
அச்சிடப்பட வேண்டிய பக்கத்தின், நகல்கள் 
எண்ணிக்கையை Copies புலத்தில் 
உள்ளிடவும்.  9999 நகல்கள் வரை அச்சிட 
முடியும்.

Collate 
Collate தேர்வை தேர்வுசெய்யும் ப�ொழுது, 
InDesign குறிப்பிட்ட எண்ணிக்கையிலான 
பக்கங்களை வரிசையாக அச்சிடுகிறது.  
இது தாமதமாகவே அச்சிடும்.  ஒரு 
பக்கத்தை பலமுறை அச்சிடும் ப�ொழுது, 
அச்சுப்பொறி அந்தப் பக்கத்தை ஒருமுறை 
மட்டுமே செயல்படுத்தும். (அந்த முதல் 
நகலை வைத்தே மற்ற நகல்கள் 
அச்சிடப்படுகின்றன).

Reverse order
பல பக்கங்கள் உடைய ஆவணத்தை 
அச்சிடும் ப�ொழுது, முதல் பக்கம் முதலில் 
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குறிப்பிடத் தேவையில்லை.  InDesign  
ஆவணத்தில் உள்ள அனைத்து Master 
பக்கங்களையும் அச்சிடும்.

Print Blank Pages
மூன்று பக்கங்களை க�ொண்ட 
ஆவணத்தில் பக்கம் 2– ல் ஏதும் இல்லை 
எனில் இந்த ஆவணத்தை அச்சிடும் 
ப�ொழுது என்ன நடக்கும்? தானாகவே 
பக்கம் 1 மற்றும் 3 மட்டுமே அச்சிடப்படும்.  
உங்களுக்கு வெற்று பக்கமான 2வது 
பக்கத்தையும் அச்சிட விரும்பினால் நீங்கள் 
print Blank pages தேர்வு பெட்டியினை 
கிளிக் செய்து தேர்வு செய்ய வேண்டும்.

எண்களை உடைய பக்கங்களை 
அச்சிடுவதற்கு  odd pages only  என்ற தேர்வினை 
தேர்வு செய்யவும்.  All pages தேர்வில் உள்ளீடு 
செய்யப்பட்ட பக்க எண்ணிக்கையை இந்தத் 
தேர்வுகள் பாதிக்கும்.

Print Master pages 
சில நேரங்களில் ஆவணத்தின் 
பக்கங்களை அச்சிடுவதற்கு பதிலாக 
Master பக்கத்தை அச்சிடுவதற்கான 
தேவை இருக்கும். அதற்கு, Print  Master  
pages என்ற தேர்வுப் பெட்டியை தேர்வு 
செய்ய வேண்டும். இதை செய்யும் 
ப�ொழுது, பக்கங்களின் எண்ணிக்கையை 

கட்டுபாட்டு பலகம் இரண்டு ப�ொத்தான்களை க�ொண்டுள்ளது.  இந்த ப�ொத்தான்கள் 
எழுத்துக்களை வடிவூட்டுதல் மற்றும் பத்திகளை வடிவூட்டுதல் ஆகியவற்றிற்கு இடையே 
மாறி செல்ல அனுமதிக்கின்றது.  இந்த இரண்டு ப�ொத்தான்களும் பலகத்தின் இடது பக்க 
ஓரத்தில் இருக்கும்.   ‘A’ என்ற எழுத்து க�ொண்ட ப�ொத்தான் எழுத்து வடிவூட்டுதல் கட்டுபாட்டு 

ப�ொத்தானுக்கும் இந்த ப�ொத்தானை கிளிக் செய்வதன் மூலம் எழுத்து வடிவூட்டல் விருப்பங்களான 
எழுத்து அளவு, மேல�ொட்டு மற்றும் அனைத்தும் பெரிய எழுத்து ப�ோன்றவை கட்டுப்பாட்டு பலகத்தின் 
இடது பக்கத்தில் த�ோன்றும்.   J என்ற குறியீடு க�ொண்ட ப�ொத்தான் பத்தி வடிவூட்டுதல் கட்டுப்பாட்டு 
ப�ொத்தானாகும்.  இந்த ப�ொத்தானை கிளிக் செய்வதன் மூலம் பத்தியினை வடிவூட்டும் விருப்பங்களான 
இசைவுகள் மற்றும் உள்தள்ளவ் ப�ோன்றவை கட்டுப்பாட்டு பலகத்தின் இடது பக்கத்தில் த�ோன்றும். 

●	 உள்தள்ளல் (Indent) என்பது உரைக்கும் மற்றும் அதன் ஓரத்திற்கும் அல்லது சட்டகத்தின் 
எல்லைக்கும் இடையே ஆன வெற்றிடம்  (blank space) ஆகும்.
●	 Drop cap என்பது ஒருவடிவமைப்பு உறுப்பாகும்.  அதில் பத்தியின் முதல் எழுத்து அல்லது 

எழுத்துக்கள் அளவில் பெரிதாக்கப்பட்டு ஒரு காட்சி விளைவினை உருவாக்குகின்றன.
●	 பரவல் என்பது ஒன்று சேர்த்து காண்பதற்காக வடிவமைப்பட்ட பக்கங்களின் த�ொகுப்பு ஆகும்.  

பரவலில் எளிய வகை இருபக்க பரவல்   (spread) ஆகும்.  உதாரணமாக நீங்கள் இந்த புத்தகத்தை 
படிக்கும் ப�ொழுது நீங்கள் பார்த்து க�ொண்டிருப்பதாகும். 

●	 ஒன்று அல்லது அதற்கு மேற்பட்ட சட்டகத்தில் உள்ள த�ொடர்ச்சியான உரை கதை (story)  எனப்படும்.
●	 InDesign ல் உள்ள ஒவ்வொரு உரை பகுதியும் ஒரு உரைச்சட்டகத்தினுள் இருக்கும்.  இந்த 

சட்டகத்தை நகர்த்த முடியும்.  அதாவது அதனை தேர்வு செய்ய முடியும் மற்றும் நீங்கள் விரும்பு 
எந்த  இடத்திற்கும் நகர்த்த முடியும்.  நீங்கள் அதன் அளவை மாற்றலாம்.  வடிவத்தை மாற்றலாம்.  
அதனை சுழற்றலாம். ஒரு வண்ணம் க�ொண்டு நிரப்பலாம்.  அதன் மீது நிழலை வைக்கலாம்.  
நீங்கள் உரைசட்டகத்தை பல தனித்தனி சட்டகங்களாக பிரிக்க முடியும் மற்றும் இவ்வாறு பிரித்த 
சட்டகங்களை த�ொடர்புபடுத்தி கதையினை இந்த தனித்தனி சட்டகங்களிடையே த�ொடர்ச்சியாக 
ஒட்ட செய்யலாம்.
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நினைவில் க�ொள்க

●	 InDesign என்பது பக்க வடிவமைப்பு (page layout) மென்பொருள் நிரலாகும்.  இது 
ஆவணங்களை வடிவமைக்கவும் மற்றும் தயாரிக்கவும் உதவுகின்றது.  இவ்வகை 
ஆவணங்களை அச்சிட முடியும் அல்லது வலையகத்தில் பயன்படுத்த முடியும்.

●	 உங்கள் வேலை எங்கு உருவாக்கப்படுகின்றத�ோ அதனை பணித்தளம் 
என்கிற�ோம்.  பணித்தளங்கள் ப�ொதுவாக முழுமையாக்கப்பட்ட தயாரிப்புகளை 
உருவாக்குவதற்காகவே ஒரு பகுதியினை (area) க�ொண்டிருக்கும்.  இது ஓவியர் 
ஓவியத்தை வரைவதற்காக பயன்படுத்தும் திரை ப�ோன்றதாகும்.

●	  InDesign ல் தானமைவு பணித்தளம் என்பது  Essentials என அழைக்கப்படுகிறது.
●	 பலகங்கள் என்பவை சிறிய சன்னல் திரைகளாகும்.  இவைகள் தேர்வு செய்யப்பட்ட 

ப�ொருள்களுடன் வேலை செய்வதற்கான விருப்பங்களை  (options) க�ொண்டிருக்கும்.
●	 ஆவண சன்னல் திரை என்பது திரையின் மையப்பகுதியாகும்.  இது திறந்த InDesingn 

ஆவணத்தை குறிக்கின்றது. 
●	 ஆவண சன்னல் திரையின் சுற்றிலும் உள்ள சாம்பல் நிற பகுதி ஒட்டு பலகை எனப்படும்.  

ப�ொருட்களை பக்கத்தில் சேர்ப்பதற்கு முன்பாக அவைகளை ஒட்டு பலகையில் நீங்கள் 
வைக்க முடியும். 

●	 பணித்தளத்தின் அடிப்பகுதியில் நிலைமை பட்டை இருக்கும்.  நிலைமை பட்டையானது 
ஒரு குறிப்பிட்ட நேரத்தில் ஆவணத்தில் என்ன நடந்து க�ொண்டிருக்கின்றது என்பதை 
பற்றிய விவரங்களை தருகின்றன.

●	 Tools பலகத்திலுள்ள எந்த கருவி மீதும் நீங்கள் சுட்டியின் அம்புகுறியினை வைக்கும் 
ப�ொழுது (கிளிக் செய்யாமல்) tooltip த�ோன்றும்.  இது அந்த கருவியின் பெயர் மற்றும் 
விசைப்பலகை குறுக்கு வழியினை அடைப்பு குறிகளுக்குள் காட்டும்.

●	 Page கருவியானது ஒரு ஆவணத்திற்குள் பல்வேறு பக்க அளவுகள் உருவாக்க 
உதவுகின்றது.

●	 பெரிதாக்கல் (Zooming) என்பது உங்கள் ஆவணத்திலுள்ள எந்த ப�ொருளையும் 
விரைவாக பெரிதாக்கவும் அல்லது ப�ொருளை மிக அருகில் க�ொண்டு வருவதற்கும் 
அனுமதிக்கிறது.

●	  InDesign ல் உள்ள view கட்டளையானது சிறிதாக்குதல் (zoom in), பெரிதாக்குதல் 
(zoom out), Actual size, Fit page in window, Fit spread in window, Entire paste board 
ப�ோன்றவற்றை க�ொண்டுள்ளது.

●	 மாற்றுதல் (Tranform) என்பது ஒரு ப�ொருளை நகர்த்துதல், அதனை அளவிடுதல், சாய்த்தல் 
அல்லது சுழற்றுதல் ப�ோன்ற செயல்பாடுகளை பற்றி விளக்குவதற்காக பயன்படுத்தப்படும் 
ஒரு ச�ொல்லாகும்.  மேற்கூறிய அனைத்தையும் நீங்கள் மாற்றுதல் அல்லது கட்டுபாட்டு 
பலகத்தில் செய்ய முடியும்.
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பணித்தளம் (workspace) InDesign னை த�ொடங்கிய பிறகு, திரையகத்தில் காணப்படும் சன்னல் 
திரைகள் மற்றும் தட்டுக்களின் அமைப்பு பணித்தளம் எனப்படும்.

ஒட்டு பலகை (paste board) ஆவணத்தை சுற்றிலும் காணப்படும் சாம்பல் நிற பகுதி ஒட்டு பலகை 
எனப்படும்.

இணைக்கப்பட்ட தட்டுகள் 
(Docting palettes)

ஒரு தட்டின் அடிப்புற ஓரத்தையும் மற்றொரு தட்டின் மேல்புற ஓரத்தையும் 
இணைப்பதாகும்.  இதன்மூலம் இரண்டு தட்டுகளையும் ஒன்றாக நகர்த்த 
முடியும்.

தட்டுக்களை குழுவாக்குதல் பணித்தளத்தின் இடத்தை சேமிப்பதற்காக பல தட்டுக்களை இணைத்து 
ஒற்றை தட்டு சன்னல் தியைக்கும் செயல்பாடு தட்டுக்களை குழுவாக்குதல் 
எனப்படும்.

பரவல் (spread) ஆவணத்தின் இரண்டு பக்கங்கள் ஒன்றை ஒன்று ந�ோக்கும் த�ொகுதியே 
பரவல் எனப்படும்.

கருவி பலகம் (Tools panel) InDesign ல் இருக்கும் அனைத்து கருவிகளையும் உள்ளடக்கிய ஒரு வெட்டி 
கருவி பலகம் எனப்படும்.

பக்க தட்டுகள் (pages 
palette)

ஒரு ஆவணத்தில் உள்ள ஒவ்வொரு பக்கத்திற்கும் பணிக்குறிகளை காட்டும் 
தட்டு ஆகும்.  இது ஆவண பக்ககளுக்குள் விரைவாக செல்ல உதவுகின்றது.

உலவுதல் தட்டு (Navigator 
palette)

ஒரு ஆவணத்தை பார்வையிடவும் மற்றும் ஆணவத்தின் பல பகுதிகளுக்கு 
செல்லவும் உதவும் ஒரு சிறப்பான வளமாகும்.

பக்கங்களை ந�ோக்குதல் 
(Facing pages) 

பத்திரிக்கைகளில் உள்ளது ப�ோன்று ஒன்றை ஒன்று ந�ோக்கும் இடது 
மற்றும் வலது பக்கங்களை க�ொண்ட ஒரு ஆவணமாகும்.

நெடுவரிசை இடைவெளி 
(Gatter) 

ஒரு பக்கத்தில் உள்ள நெடுவரிசைகளுக்கிடையேயான இடைவெளியினை 
குறிக்கும்.

Master pages பக்க வடிவமைப்பிற்கான முன்வடிவமைத்தலை க�ொண்டுள்ளது.  இதில் 
நெடுவரிசைகள் மற்றும் இருப்பிடங்கள் (place holder) இருக்கும்.

Guides ஒரு பக்கத்தின் மீதுள்ள கிடைமட்ட அல்லது செங்குத்தான க�ோடுகள் 
Guides ஆகும்.  இது ப�ொருட்களை பக்கத்தின் மீது ஒழுங்குபடுத்தி அமைக்க 
உதவுகின்றது.

மாற்றுதல் ஒரு ப�ொருளை அளவு மாற்றம், நகர்த்துதல், சாய்த்தல், அல்லது சுழற்றுதல் 
ஆகியவற்றை பயன்படுத்தி மாற்றம் செய்வதாகும்.

Overset text உரையினை த�ொகுதிகளாக்கி வரைப்பரப்பில் வைக்கும் ப�ொழுது, 
இடத்திற்காக காத்திருக்கும் உரையாகும்.

வரைபடம் Graphic வரைபடம் என்பது பக்கத்தின் மீதுள்ள ஒரு உறுப்பாகும்.  அது உரை அல்ல.  
நிரப்புதலுடன் கூடிய எளிய சதுரம் என வரைபடத்தை அழைக்கலாம்.

Bitmap படங்கள் நிரலில் உருவாக்கப்பட்ட படப்புள்ளிகளை க�ொண்ட படங்கள் எ.கா Adobe 
photoshop.  இவைகள் இலக்க புகைப்படங்களாக இருக்கலாம்.
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2.	 In Design –னுள்ள ஒவ்வொரு 
உரையின் துண்டுப் பகுதியும்

	 அ) உரைச் சட்டம் ( text frame )
	 ஆ) வடிவம் (shape)
	 இ) பிடிபலகை  (clipboard)
	 ஈ) ஏதும்மில்லை
3.	 ஆவணத்தை ச் சுற்றியுள்ள பகுதி
	 அ) ஒட்டுப்பலகை  ( paste board )
	 ஆ) வெள்ளைப் பகுதி  (white space)   
	 இ) வெற்றுப்பரப்பு  (empty space )    
	 ஈ) வெற்றிடம் (vaccum)

பகுதி – அ 
	 I. 	�ச ரியான விடையைத் 

தேர்ந்தெடுத்து எழுதுக
1.	 ஒன்று அல்லது அதற்கு மேற்பட்ட 

சட்டங்களை ஆக்கிரமித்திடுக்கும் 
த�ொடற்ச்சியான உரை

	 அ) கதை  (story)
	 ஆ) பத்தி (paragraph)  
	 இ) ப�ொருள் (object)
	 ஈ) தட்டு (plate )

வெக்டார் வரைகலை 
(vector graphic)

வெக்டார் வரைகலை என்பது வரையும் நிரலிலிருந்து எ.காAdobe Illustrator 
உருவாக்கப்பட்ட மற்றும் இறக்குமதி செய்யப்பட்ட விளக்கப்படமாகும். 

எல்லை பெட்டி (Bounding 
box) 

தேர்வு செய்யப்பட்ட வெளிச்சமான நீலநிற சட்டகம் எல்லைபெட்டி என 
அழைக்கப்படுகிறது.  எல்லை பெட்டி – எப்பொழுதும் செவ்வக வடிவமானது 
– வரைபடத்தின் கிடைமட்ட மற்றும் செங்குத்தான பரிணாமங்களை 
வரையறுக்கும் சட்டகமாகும்.

Gradient இரண்டு அல்லது அதற்கு மேற்பட்ட வண்ணங்களை குறிப்பிட்ட அளவில் 
கலப்பது Gradient எனப்படும்.

Linear gradient ஒரு நிறத்திலிருந்து இன்னொரு நிறத்திற்கு (அல்லது பல நிறங்களுக்கு) 
அடுத்தடுத்து செல்லும் நேர்கோடுகளின் வரிசை

Process colors Cyan, magenta, yellow மற்றும் black (CMYK) ஆகிய நிறங்களை மாறுபட்ட 
விகிதங்களில் கலந்துஉருவாக்கப்படும் நிறங்கள்

Radial gradient ப�ொது மைய வட்டங்களில் வரிசையில் த�ொடக்க நிறம் என்பது மையத்திலும் 
பிறகு முடிவு நிறம் ந�ோக்கி பரவுவதாகும்.

Spot color செயல்பாடற்ற மைகள் நிறுவனங்களால் தயாரிக்கப்படுகின்றன.  Spot 
color என்பது செயல்பாடு க�ொண்டு மையிலிருந்து தனியாக பிரிக்கப்பட்டு 
அச்சிடுவதற்காக தயாரிக்கப்பட்ட சிறப்பு முன்-கலந்த மையாகும். 

Swatches palette முன் வரையறுக்கப்பட்ட நிற ஸ்வாட்ச் க�ொண்ட தட்டுக்கள்

(Fill) ஒரு ப�ொருளுக்குள் உபய�ோகிக்கும் நிறம் நிரப்பு எனப்படும்.

(Stroke) ஒரு ப�ொருளின் எல்லைக்கோட்டிற்கு பயன்படுத்தப்படும் நிறம் எல்லை 
எனப்படும்.

வினாக்கள்
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9.	 இரண்டு அல்லது மூன்று 
வண்ணங்கள் படிப்ப்டியாக 
இணைத்து கலவை

	 அ) Gradient
	 ஆ) நிறக் கலவை (colormix)    
	 இ) color platte
	 ஈ)  எதுமில்லை
10.	நிறுவனங்களால் தயாரிக்க ப்படும் 

செயலற்ற
	 அ) Spot  நிறங்கள்
	 ஆ) நிறச் சாயம்    
	 இ) வண்ணப் பாணிகள்
	 ஈ) லேசர் இங்க்
11.	ஒரு ப�ொருளின் உள்ளே இடப்படும் 

வண்ணம்   
	 அ) நிரப்பு (fill)	 ஆ) எல்லை (stroke)  
	 இ) paint	 ஈ)  In- color
12.	ப�ொருளின் வெளிப்புறக் க�ோட்டில் 

இடப்படும் வண்ணம் 
	 அ) எல்லை (stroke)	 ஆ) நிரப்பு (fill)
	 இ) out – color	 ஈ)  paint 
13.	view கட்டளைகளை அதன் 

பயன்பாட்டுடன் ப�ொருத்துக
Zoomin அ)   ஆவணத்தை 100% 

சதவிதம் காண்பிக்க 
Zoomout ஆ)  அடுத்த 

முன்வடிவமைக்கப்பட்ட   
சதவிதத்திற்கு  உருப்பெருக்க 
செய்ய

Actual size இ) சன்னல் திரையில் 
இலக்கு பரவலை காண்பிக்க 

Fit page in 
window

ஈ) முந்தைய முன் 
வடிவமைக்கப்பட்ட 
சதவிதத்தை குரைத்தல் 
மற்றும் திரும்பப்பெறல்

Fit spread in 
window

உ) காட்ரியின் அளவை, 
திரையின் அளவிற்கு  
ப�ொருத்துவதற்காக 
அளவிடுதல்.

4.	 ஒன்றை ஒன்று பாற்கும் வகையில் 
அமைந்துள்ள இரணடு ஆவணப் 
பக்கங்களின் த�ொகுதி

	 அ) பரவல் (spread)
	 ஆ) க�ோப்புறை (folder)
	 இ) க�ோப்பு   (file)
	 ஈ) சட்டம்   (frame)

5.	 …………………என்பது  Indesign 
னுள்ள அனைத்துகருவிகளையும்  
க�ொண்டுள்ள பெட்டியாகும் 

	 அ)கருவி பலகம்
	 ஆ) காட்டுப்பாட்டுப் பலகம்  
	 இ) க�ொள்கலன்
	 ஈ) இல்லை
6.	 பக்கத்தின் இரண்டு 

நெடுவரிசைகளுக்கு ()  இஅடப்பட்ட 
பகுதி………….

	 அ)  Gatter
	 ஆ) வெற்றிடம்    
	 இ) வெற்றுப்பரப்பு
	 ஈ) உடுகள் (inter steller)
7.	 ஒரு பக்கத்தில் இடம்பெரும் 

உரைப்பகுதி அல்லது உறுப்பு
	 அ) வரைகலை (Graphics)
	 ஆ)திசையன்     ( vector )
	 இ)   scalar    
	 ஈ) ஒவ்வொன்றும் வரையாக 

இருக்கும்
8.	 ………….. என்று  Adobe 

Photoshop  ப�ோன்ற நிரல் மூல்ம் 
உருவாக்கப்படும் படப்புள்ளிகளைக்   
(pixels) க�ொண்ட நிழற்படங்கள்

	 அ) பிட்மேட்
	 ஆ) JPEG
	 இ) PNG
	 ஈ) இவை அனைத்தும்
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3.	 In Design   -ல் உள்ள  View 
கட்டளைகள் யாவை?

4.	 பெரிதாக்க்குதலுடன்       (Zooming)    
த�ொடர்புடைய சர்புகளுக்கான   
அனைத்து விசைப்பககை 
குற்க்குவழிகளை பற்றி எழுதுக

5.	 எழுத்துக்களை மேல�ொட்டு அல்லது 
கீழ�ோட்டு என  எவ்வாறு மாற்றுவாய்

6.	 ஒரு  ப�ொருளை  எப்படி 
உருவாககுவாய்   என விரிவாக 
விவரி

7.	 கருவி   பலகத்திலுள்ள வரபட 
சட்டங்கள் எத்தனை ? அவை யாவை 

பகுதி – ஈ 
IV.	  �ஒரு பக்க அளவில் 

விடையளிக்கவும்
1.	 InDesign-ல் புதிய ஆவனத்தை 

உ ரு வ ாக்  கு வ தற்கா    ன 
படிநிலைகளை எழுதுக

2.	 சிறு குறிப்பு எழுதுக 
	 பயன்பாட்டு பட்டை  (Application bar)
	 ஆவண  த�ொகுதி  (Documen Tab)
	 கருவி பலகம் (Tools pannel)
3.	 பாதையில் ஒரு வகையினை 

உருவாக்க படிநிலைகளை எழுதுக
4.	 ஆவணத்தில் உரையினை வைக்க 

படிநிலைகளை எழுதுக
5.	 வரைகலை சட்டத்தில்  எவ்வாறு 

படத்தை சேர்ப்பாயி படிநிலைகளை 
எழுதுக

பகுதி – ஆ 
II.	   �மூன்று வரிகளில் விடையளிக்கவும்  

1.	 Adobe  in Design   என்ன 
மென்பொருள்

2.	 எத்தனை வகையான க�ொடநிலை 
பக்க  அமைவுகள் உள்ளன? அவை 
எவை?

3	 Adobe  in Design  ல் பணிப்பகுதி    
என்றால் என்ன?

4.	 In Design   ஆவண சன்னல் திரையில் 
எது அவசியமானது.

5.	 In Design   -ல் pasteboard என்பது 
என்ன

6.	 Tool tip எப்பொது த�ோன்றும்
7.	 Paste tool –ன் பயன் என்ன 
8.	 Zoomins என்பது என்ன
9.	 Tools panel – ஐ திறக்க / மூட உள்ள 

படிநிலைகளை எழுதுக
10.	பந்தியில் எண் வரிசை மற்றும் 

புல்லட் குறியீடு உருவாக்க உதவும் 
படிநிலையை  எழுதுக 

பகுதி – இ 
III.  	� ஒரு பத்தியளவில் 

விடையளிக்கவும்  
1.	 கருவி பலகத்தை ( Tools panel ) பற்றி   

விரிவாக விளக்கவும்
2.	 கருவி பலகத்தில் (Tools panel)   

உள்ள ஏதேனும் 3 கருவிகளை பற்றி 
எழுதுக

மாணவர் செயல்பாடு

●	 Adobe In Designனை  பயன்படுத்தி உன் நன்பனுக்கு  அழகான   பிறந்தநாள் வாழ்த்து 
அட்டையை உருவக்கவும்

●	 Adobe In Designனை  பயன்படுத்தி   உம்ங்களது அனைத்து பாட பெயர்களையும் 
க�ொண்ட ஒரு  பக்கத்தை உருவாக்கி அதனை அழகு படுத்தவும்
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03பாடம்

க�ோரல்ட்ரா 2018 (CorelDRAW 2018)

 கற்றலின் ந�ோக்கங்கள்
●	 நெறிய வரைகலை மற்றும் பிட்மேப்ஸ்
●	 CorelDRAW 2018
●	 ஒரு புதிய ஆவணத்தை உருவாக்குதல்
●	 கருவிபெட்டியை அறிதல்
●	 வடிவங்களை வரைதல்

●	 Color Palette யை பயன்படுத்துதல்
●	 வடிவங்களின் அளவை மாற்றியமைத்தல்
●	 ப�ொருட்களை சுழற்றுதல்
●	 வரைபடத்தை சேமித்தல்
●	 ஆவணத்தை மூடுதல்

  CorelDRAW பற்றி
CorelDraw (Styled CorelDRAW) ஒரு 
நெறிய வரைகலை பயன்பாடு ஆகும். இது 
CorelCorporation ஆல் உருவாக்கப்பட்டு 
சந்தைப்படுத்தப்படுகிறது. CorelCorporation 
என்பது ஒரு கனடா நாட்டு மென்பொருள் 
நிறுவனம். CorelDRAW இன் அண்மை 
பதிப்பு CorelDraw Graphics Suite 2018 ஆகும். 
இது ஏப்ரல் 10, 2018 அன்று  வெளியிடப்பட்டது. 

CorelDraw என்பது உயர்தர 
வரைகலை சித்திரங்கள், ல�ோக�ோ 
வடிவமைப்பு மற்றும் பக்க அமைப்புகளை 

உருவாக்குவதற்கான பல்துறை 
வரைகலை பயன்பாடு ஆகும்.

  �நெறிய வரைகலை மற்றும் 
பிட்மேப்களை புரிந்துக�ொள்ளுதல்

கணிப்பொறி வரைகலையில் இரண்டு 
முக்கிய வகைகள் உள்ளன. அவை நெறிய 
வரைகலை (Vector Graphics) மற்றும் 
பிட்மேப் (Bitmaps).

நெறிய வரைகலை
நெறிய வரைகலை க�ோடுகள் மற்றும் 
வளைவுகளால்  உருவாக்கப்படுகின்றன. 
அவை கணித விளக்கங்கள் மூலம் 
உருவாக்கப்படுகின்றன. இந்த வரைகலை 
ல�ோக�ோக்கள் மற்றும் illustrations க்கு மிகவும் 
ஏற்றது. அவை தெளிவுத்திறன் சார்பற்ற 
(resolution independent) வரைகலை என்பதால் 
வேண்டிய அளவில் மாற்றலாம், அச்சிடலாம் 
மற்றும் எந்த தெளித்திறனிலும் விவரம் 
மற்றும் தரத்தை இழக்காமல் திரையிடலாம்.
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பாடம் 03  க�ோரல்ட்ரா 201894

JPEG மற்றும் TIFF ப�ோன்ற பிட்மேப் (ராஸ்டர் 
படங்கள்) க�ோப்புகளை நீங்கள் CorelDRAW 
க்கு இறக்குமதி செய்யலாம் மற்றும் அவற்றை 
உங்கள் வரைபடங்களில் சேர்க்கலாம்.

படம் 3.2  பிட்மேப் படங்கள் மற்றும் நெறிய 
படங்கள்

ஒரு பிட்மேப்பை உங்கள் பக்க வடிவமைப்பு 
மென்பொருளில் பெரிதாக்கினால், நீங்கள் 
அதன் தெளித்திறனை இழக்கலாம் அல்லது 
அது தெளிவில்லாமல் த�ோற்றமளிக்கும். 
உங்கள் பக்க வடிவமைப்பு மென்பொருளில் 
பிட்மேப்பை சுருக்கினால் விளைவு 
நன்றாக இருக்கும்.

CorelDRAW ச�ொற்கூறுகள்
CorelDRAW வை த�ொடங்குவதற்கு முன் 
நீங்கள் பின்வரும் ச�ொற்கூறுகளை நன்கு 
அறிந்திருக்க வேண்டும்.

பிட்மேப் 
பிட்மேப்கள் ராஸ்டெர் படங்கள் எனவும் 
அழைக்கப்படுகின்றன. அவை பிக்சல்கள் 
என்று அழைக்கப்படும் சிறிய சதுரங்களால் 
ஆனவை. ஒவ்வொரு பிக்சலும் படத்தின் 
ஒவ்வொரு இடத்துடன் இணைக்கப்பட்டு 
வண்ணங்களின் எண் மதிப்புகளை 
க�ொண்டிருக்கும்.

பிட்மேப்கள் ஒரு படத்தில் வண்ண 
மண்டலங்களை நன்றாக மீளுருவாக்கம் 
செய்கின்றன. எனவே அவை புகைப்படங்கள் 
மற்றும் எண்ம ஓவியங்களுக்கு (Digital 
Paintings) மிகவும் ப�ொருத்தமானவை.

பிட்மேப்கள் தெளித்திறன் 
சார்ந்த (resolution dependent) படங்கள் 
ஆகும். அதாவது அவை ஒரு குறிப்பிட்ட 
எண்ணிக்கையிலான பிக்சல்களை 
பிரதிநிதித்துவப்படுத்துகின்றன. அவை 
அவற்றின் குறிப்பிட்ட (actual) அளவுகளில் 
சரியாக இருக்கும், ஆனால் அளவு 
மாற்றப்படும் ப�ோத�ோ அல்லது மிகுந்த 
தெளித்திறனுடன் அச்சிடும் ப�ோது அவை 
தெளிவில்லாமல் த�ோற்றமளிக்கின்றன 
அல்லது படத்தின் தரத்தை இழக்கின்றன.

CorelDRAW பயன்படுத்தி நீங்கள் 
நெறிய வரைகலையை உருவாக்க முடியும். 

ச�ொற்கூறுகள் விளக்கம்
ப�ொருள் Object ப�ொருள் என்பது படம், வடிவம், க�ோடு, உரை, வளைவு, சின்னம், அல்லது 

அடுக்கு ப�ோன்ற வரைபடத்தின் ஒரு உறுப்பு.

வரைதல் வரைதல் என்பது நீங்கள் CorelDRAW வை பயன்படுத்தி தனிபயன் 
கலைப்படைப்பு, ல�ோக�ோக்கள், சுவர�ொட்டிகள், மற்றும் செய்திதாள்கள் 
ப�ோன்றவற்றை உருவாக்கும் ஒரு செயல் ஆகும். 

நெறிய 
வரைகலை

நெறிய வரைகலை என்பது கணித விளக்கங்களிலிருந்து உருவாக்கப்படும் 
ஒரு படம் ஆகும். இந்த கணித விளக்கங்கள் க�ோடுகளின் நிலைகள், நீளம் 
மற்றும் திசையை தீர்மானிக்கும்.

பிட்மேப் பிட்மேப் படங்கள் பிக்சல்கள் அல்லது புள்ளிகளின் கட்டங்களால் 
உருவாக்கப்படுகிறது.
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Docker Docker என்பது ஒரு குறிப்பிட்ட கருவி அல்லது பணிக்கு த�ொடர்புடைய 
கட்டளைகள் மற்றும் அமைப்புகளைக் க�ொண்டிருக்கும் ஒரு சாளரம் ஆகும்.

Flyout Flyout என்பது த�ொடர்புடைய கருவிகள் அல்லது பட்டி உருப்படிகளின் ஒரு 
குழுவைத் திறக்கும் ஒரு ப�ொத்தான் ஆகும்.

பட்டியல் பெட்டி  
List box

பட்டியல் பெட்டி ஒரு பயனர் கீழ் அம்புக்குறி ப�ொத்தானை கிளிக் செய்யும் 
ப�ோது விரியும் விருப்பங்களின் பட்டியல் ஆகும்.

Artistic text Artistic text என்பது நீங்கள் நிழல் (Shadows) ப�ோன்ற சிறப்பு 
விளைவுகளை க�ொடுக்ககூடிய ஒரு வகை உரை ஆகும்.

Paragraph text பத்தி உரையானது நீங்கள் வடிவூட்டல் விருப்பங்களைப் 
பயன்படுத்தக்கூடிய ஒரு உரை வகையாகும், மேலும் இதை பெரிய 
த�ொகுதிகளில் பதிப்பாய்வு செய்யலாம்.

Combo boxes Combo என்பது கிளிக் செய்ய கூடிய தேர்ந்தெடுப்பு ப�ொத்தான் க�ொண்ட 
ஒரு num box ஆகும். Combo boxes ல் ஒரு மதிப்பை உள்ளிடலாம் அல்லது 
இருக்கும் மதிப்பில் ஒன்றை தேர்ந்தெடுக்கலாம்.

Spinners இவை Combo boxes களுக்கு ஒத்தவை. இவை சுட்டியை பயன்படுத்தி 
அல்லது தட்டச்சு செய்வதன் மூலம் மதிப்புகளை குறிப்பிட முடியும்.

Pop-up menus Pop-up menu கட்டளைகளையும் விருப்பங்களையும் அணுக எந்த 
இடத்திலும் உங்கள் சுட்டியின் வலது ப�ொத்தானை கிளிக் செய்யவும்.

  CorelDRAW 2018 ஐ த�ொடங்குதல்
நீங்கள் CorelDRAW 2018 நேரடியாக 
உங்கள் கணினியின் திரைமுகப்பில் 
(Desktop) இருந்தோ அல்லது Windows 
த�ொடக்க பட்டியில் (Start Menu) இருந்தோ 
த�ொடங்கலாம்.

த�ொடக்கப் பட்டியை பயன்படுத்தல்
1.	 Start > All Programs >CorelDRAW 

Graphics Suite 2018 >CorelDRAW 
2018 என்பதை தேர்ந்தெடு

2.	 CorelDRAW 2018 - வரவேற்புத் 
திரை த�ோன்றும்.

குறுக்குவழியைப் பயன்படுத்துதல்
1.	 முதலில், CorelDRAW 2018 

குறுக்குவழி குறும்படத்தை 
கண்டறியவும். இது ஒரு 
வண்ணமயமான பலூன் வடிவ 

குறும்படம். அதன் கீழ் CorelDRAW 
2018 என்று குறிப்பிடப்பட்டிருக்கும்.

2.	 நீங்கள் அதை கண்டுபிடித்த பின், 
CorelDRAW 2018 சின்னத்தின் 
மீது சுட்டியை வைத்து, இரட்டை 
கிளிக் செய்து CorelDRAW 2018 ஐ 
திறக்கலாம் 

3.	 CorelDRAW 2018 - வரவேற்புத் 
திரை த�ோன்றும்.

படம் 3.3  CorelDRAW 2018 குறும்படம்
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CorelDRAW 2018 வரவேற்புத் திரை
வரவேற்பு திரை, த�ொடக்கத்தில் பயன்படுத்தப்படும் சில ப�ொதுவான விருப்பங்களை காட்டும்

நீங்கள் New Document கிளிக் 
செய்தால், அது ஒரு வெற்று 

ஆவணத்தை உருவாக்குகிறது, 
அதில் நீங்கள் ஒரு 

வரைகலையை வடிவமைக்க 
முடியும்.

நீங்கள் New From Template 
கிளிக் செய்தால், நீங்கள் 
ஒரு வரைகலையை 
முன் வடிவமைத்த பக்க-
வார்ப்புருக்கள் பட்டியலில் 
இருந்து தேர்வு செய்ய முடியும்.

OpenDocument கிளிக் 
செய்தால், ஏற்கனவே சேமித்த 
வரைகலை படக் க�ோப்பில் 
இருந்து தேர்ந்தெடுக்க உதவும் 
OpenDrawing உரையாடல் 
பெட்டி திறக்கும்.

படம் 3.4 CorelDRAW 2018 - வரவேற்புத் திரை

ஒரு புதிய ஆவணத்தை உருவாக்க
1.	 வரவேற்பு திரையில் New Document ப�ொத்தானை கிளிக் செய்யவும்.
2.	 இப்போது Create a New Document உரையாடல் பெட்டி த�ோன்றும். இது ஆவணத்தின் 

பல பண்புகளை உள்ளிட அனுமதிக்கிறது.
3.	 நீங்கள்  அதில் ஆவணத்திற்கு பெயரிடவும், பக்க அளவு அமைக்கவும், CMYK அல்லது 

RGB ப�ோன்ற நிற முறைமையைத் தேர்வு செய்யவும், வண்ண விரங்களையும் 
அமைக்கலாம்.

4.	 OK ப�ொத்தானைகிளிக் செய்யவும்
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படம் 3.5  New Document ப�ொத்தான்

படம் 3.6  Create a New Document உரையாடல் 
பெட்டி

படம் 3.7  Create a New Document உரையாடல் 
பெட்டி

படம் 3.8  Create a New Document உரையாடல் பெட்டி

ஆவணத்தின் பெயரை உள்ளிடவும்

உங்கள் ஆவணத்தின் பக்க 
அளவுகளை தேர்ந்தெடுக்கவும்
அங்குலங்கள், மில்லிமீட்டர்கள் 
அல்லது பிக்சல்கள் ப�ோன்ற உங்கள் 
ஆவணத்திற்கான அளவீட்டு அலகுகளைத் 
தேர்ந்தெடுக்கவும்

உங்கள் ஆவணத்தின் பக்க 
அமைப்பை (landscape அல்லது portrait) 
தேர்ந்தெடுக்கவும்.

ஆவணத்திற்கான பக்கங்களின் 
எண்ணிக்கையைத் தேர்ந்தெடுக்கவும்.

உங்கள் ஆவணத்தின் அகலத்தையும் 
உயரத்தையும் தேர்ந்தெடுக்கவும்.
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  CorelDRAW 2018 ஆவண சாளரம்
Create a New Document உரையாடல் பெட்டியில்  OK ப�ொத்தானை கிளிக் செய்த பிறகு 
படம் 3.9 ல் காட்டியவாறு CorelDRAWஆவண சாளரம் த�ோன்றும்

Title bar Maximize /  
Restore

Minimize

Close
Document Tab Menu bar Drawing Window

Property  
Bar

Standard  
Toolbar

To
ol

bo
x

Status bar
Document  
Navigator

Document  
Page border

Drawing Page Navigator Docker Color palette

படம் 3.9  CorelDRAWஆவண சாளரம்

எண் பகுதி விளக்கம்
1. தலைப்பு பட்டை

Title bar
தலைப்பு பட்டை என்பது தற்போது தேர்ந்தெடுக்கப்பட்ட வரைபடத்தின் 
தலைப்பு அறிவிக்கும் பகுதி.

2. பட்டிப் பட்டை
Menu bar

பட்டிப் பட்டை என்பது கீழ் விரி பட்டி விருப்ப தேர்வுகள் உள்ள பகுதி.
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3. செந்தர கருவிப்பட்டை
Standard Toolbar

செந்தர கருவிப்பட்டை என்பது பட்டி விருப்ப தேர்வுகள் மற்றும் பிற 
கட்டளைகளுக்கு குறுக்குவழிகளைக் க�ொண்ட நகற்றக் கூடிய 
பட்டையாகும்.

4. கருவிப்பெட்டி 
Toolbox

கருவிப்பெட்டி என்பது ப�ொருள்களை உருவாக்க, நிரப்ப மற்றும் 
மாற்றியமைக்க கருவிகள் க�ொண்ட ஒரு இணைக்கப்பட்ட பட்டை ஆகும்

5. பண்புப் பட்டை 
Property bar

பண்புப் பட்டை இயக்கத்தில் உள்ள கருவி அல்லது ப�ொருள் த�ொடர்பான 
கட்டளைகளுடன் ஒரு நீக்க கூடிய பட்டையாகும். உதாரணமாக, 
செவ்வக கருவி தேர்ந்தெடுக்கப்பட்டிருந்தால், செவ்வகத்தை 
உருவாக்கும் மற்றும் செவ்வகத்தைத் திருத்தும் கட்டளைகளை காட்டும்.

6. ஆவண கீற்று
Document tab

ஒவ்வொரு திறந்த ஆவணத்திற்கும் ஒரு கீற்று இருக்கும். இது நீங்கள் 
விரைவாக ஆவணங்களுக்கு இடையில் மாற அனுமதிக்கிறது.

7. வரைதல் சாளரம்
Drawing window

வரைதல் பக்கத்திற்கு வெளியே உள்ள பகுதி வரைதல் சாளரம் 
ஆகும். இது திரை உருளல் பட்டை (Scroll bar) மற்றும் பயன்பாட்டு 
கட்டுப்பாடுகளை எல்லையாக க�ொண்டிருக்கும். 

8. வரைதல் பக்கம் 
Drawing page

வரைதல் சாளரத்தின் உள்ளே உள்ள செவ்வக பகுதி வரைதல் பக்கம் 
என்று அழைக்கப்படுகிறது. இது ஆவண சாளரத்தின் அச்சிடத்தக்க பகுதி. 

9. ரூலர் 
Rulers

சாளரத்தில் இரண்டு ரூலர் இருக்கும். அவை  கிடைமட்ட ரூலர் மற்றும் 
செங்குத்து 
ரூலர். அவை ஒரு ஆவணத்தில் ப�ொருட்களின் அளவு மற்றும் நிலையை 
தீர்மானிக்கப் பயன்படுத்தப்படுகின்றன. 

10. டாக்கர் 
Docker

ப�ொதுவாக ஒரு முதன்மை சாளரத்தின் வலது முனையுடன் ஒட்டி 
இருப்பதால் இது டாக்கர் சாளரம் என்று அழைக்கப்படுகிறது. ஒரு 
நேரத்தில் இரண்டு அல்லது அதற்கு மேற்பட்ட டாக்கர் சாளரங்களை 
திறந்தால், இந்த சாளரங்கள் கீற்று நிலையில் அமையும், கீற்றுகளை 
கிளிக் செய்வதன் மூலம் விரும்பிய சாளரத்தை முன்னிலைப்படுத்தலாம்

11. ஆவண உலவி
Document navigator

ஆவண உலவி என்பது பயன்பாட்டு சாளரத்தின் கீழ் இடதுபுறம் 
உள்ள பகுதியாகும். இது புதிய பக்கங்களைச் சேர்ப்பதற்கு மற்றும் 
பக்கங்களுக்கிடையே  மாறுவதற்கும் கட்டுப்பாடுகளை க�ொண்டிருக்கும்.

12. உலவி
Navigator

உலவி என்பது சாளரத்தின் கீழ் வலது மூலையில் உள்ள ஒரு 
ப�ொத்தான் ஆகும். இது ஒரு வரைபடத்தின் பகுதிகளுக்கிடையே நகர்த்த 
உதவுவதற்கு சிறிய காட்சித் திரையைத் திறக்கும்.

13. வண்ணத் தட்டு 
Color palette

வண்ணத் தட்டு ஒரு நகர்த்த கூடிய பட்டி ஆகும். இது வண்ண 
பெட்டிகளை க�ொண்டிருக்கிறது. வண்ணத் தட்டில் நீங்கள் காணும் 
இந்த சிறிய சதுர பெட்டிகள் வெல் (Well) என்று குறிப்பிடப்படுகின்றன.

14. நிலைமைப் பட்டை
Status bar

நிலைமைப் பட்டை ஆவண சாரளத்தின் கீழே உள்ள பகுதி ஆகும். 
இது தேர்ந்தெடுத்த ப�ொருளின் பண்புகளான வகை, அளவு, நிறம், 
நிரப்பு வகை மற்றும் எல்லை ப�ோன்ற தகவலை காட்டுகிறது. மேலும் 
நிலைமைப் பட்டை ஆவண சாளரத்தில் சுட்டியின் தற்போதைய 
இடத்தையும் காட்டும்.

  செந்தரக் கருவிப்பட்டை
செந்தரக் கருவிப்பட்டியில் பல பட்டியல் கட்டளைகளை இயக்க உதவும் குறுக்குவழி 
ப�ொத்தான்கள் மற்றும் கட்டுப்பாடுகள் உள்ளன.
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படம் 3.10  செந்தரக் கருவிப்பட்டை
கருவி குறும்படம் விசைப்பலகை 

குறுக்குவழிச் சாவி
பயன்

1. New Ctrl + N புதிய வரைபடத்தைத் த�ொடங்க

2. Open Ctrl + O ஒரு வரைபடத்தை  திறக்க

3. Save Ctrl + S ஒரு வரைபடத்தை சேமிக்க

4. Print Ctrl + P ஒரு வரைபடத்தை அச்சிட

5. Cut Ctrl + X தேர்ந்தெடுத்த ப�ொருள்களை பிடிப்பலகையில்  
வெட்ட

6. Copy Ctrl + C தேர்ந்தெடுத்த ப�ொருள்களை பிடிப்பலகையில் 
நகலெடுக்க

7. Paste Ctrl +V பிடிப்பலகையின் உள்ளடக்கங்களை ஒரு 
வரைபடத்தில் ஒட்ட

8. Undo செயலைச் தவிர்க்க

9. Redo தவிர்க்கப்பட்ட செயலை மீண்டும் செய்ய

10. �Search 
Content

வரைகலை, புகைப்படங்கள் மற்றும் 
எழுத்துருக்களைத் தேட

11. Import Ctrl + I ஒரு வரைபடத்தை தரவிறகம் செய்ய

12. Export Ctrl + E ஒரு வரைபடத்தை பதிவேற்றம் செய்ய

13. �Publish to 
PDF

ஆவணத்தை PDF க�ோப்பு வடிவத்திற்கு மாற்ற

14. Zoom levels அளவை மாற்ற
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15. �Full- screen 
preview

F9 ஒரு ஆவணத்தின் முழு திரை 
முன்னோட்டத்தைக் காண

16. Show rulers ரூலரை காட்ட அல்லது மறைக்க

17. Show grid ஆவண கட்டங்களை காட்ட அல்லது மறைக்க

18. �Show guide 
lines

வழிகாட்டுதல்களை காட்ட அல்லது மறைக்க

19. Snap Off Alt + Q எல்லா முறிப்பையும் முடக்கவும். தேர்ந்தெடுத்த 
முறிப்பு விருப்பங்களை மீட்டமைக்க மீண்டும் 
கிளிக் செய்க

20. Snap To ப�ொருளை பக்க இசைவு செய்யும் முறையைத் 
தேர்ந்தெடுக்க

21. Options Ctrl + J உங்கள் பணியிட விருப்பத் தேர்வுகளை 
அமைக்க

22. �Application 
launcher

CorelDRAW பயன்பாடு த�ொடங்க

  பண்புப் பட்டை
பண்புப் பட்டை (Property bar) செந்தரகருவிப்பட்டிக்கு அடுத்து இருக்கும். இயக்க கருவிக்கு 
த�ொடர்புடைய ப�ொதுவான செயல்பாடுகளை இது காட்டுகிறது. இது கருவிப்பட்டியைப் ப�ோல 
த�ோன்றினாலும், கருவி அல்லது பணியைப் ப�ொருத்து பண்புகள் பட்டையின் உள்ளடக்கம் 
மாறுகிறது.

உதாரணமாக, நீங்கள் கருவிப்பெட்டியில் உரை கருவியைக் கிளிக் செய்தால், 
பண்புகள் பட்டை வடிவுட்டல், பத்தி இசைவு மற்றும் பதிப்பித்தல் கருவி ப�ோன்ற உரை 
த�ொடர்பான கட்டளைகளைக் காட்டும்.

படம் 3.11  உரையின் பண்புகள் பட்டை

கருவிப்பெட்டியில் நீங்கள் செவ்வக கருவியைக் கிளிக் செய்தால், பண்புகள் பட்டை 
செவ்வகம் த�ொடர்பான கட்டளைகளை மட்டுமே காட்டும்.
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படம் 3.12  செவ்வகத்தின் பண்புகள் பட்டை

கருவிப்பெட்டியில் நீங்கள் நீள்வட்ட கருவியைக் கிளிக் செய்தால், பண்புகள் பட்டை 
நீள்வட்டம் த�ொடர்பான கட்டளைகளை மட்டுமே காட்டும்.

படம் 3.13  நீள்வட்டத்தின் பண்புகள் பட்டை

  கருவிப் பெட்டியை ஆராய்தல்
கருவிப்பெட்டி என்பது பயன்பாட்டு சாளரத்தின் ஒரு பகுதி. இதில் படங்களை வரைவதற்கும் 
மற்றும் திருத்துவதற்கும் பல கருவிகள் உள்ளன. சில கருவிகள் நிலையாக த�ோன்றும், 
மற்றவை flyouts ல் குழுவாக்கப்பட்டிருக்கும். கருவிப்பெட்டியின் கீழ்-வலது மூலையில் 
உள்ள சிறிய flyouts அம்புக்குறியை கிளிக் செய்வதன் மூலம் நாம் flyouts கருவிகளைப் 
அனுக முடியும்.

கருவிப்பட்டை குறும்படம் விசைப்பலகை 
குறுக்குவழிச் சாவி

பயன்

Pick tool ப�ொருட்களை தேர்ந்தெடுத்தல் மற்றும் 
மாற்றுதல்

Shape Tool F10 ப�ொருட்களை வடிவமைத்தல்

Crop tool தேர்ந்தெடுத்த பகுதிக்கு வெளியே உள்ள 
பகுதிகளை நீக்க

Zoom tool Z பார்வை சாளரத்தை மாற்ற

Freehand tool F5 க�ோடுகள் / வளைவுகளை வரைதல்
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Artistic Media tool I கலை தூரிகை, தெளிப்பு மற்றும் calligraphic 
விளைவுகளை சேர்த்தல்

Rectangle tool F6 செவ்வகங்கள் / சதுரங்களை வரைதல்

Ellipse tool F7 நீள்வட்டங்கள் / வட்டங்கள் வரைதல்

Polygon tool Y பலக�ோணங்கள் வரைதல்

Text tool F8 கலை மற்றும் பத்தி இணை உரைகளை 
சேர்த்தல்

Dimension tool சாய்ந்த க�ோடுகளை வரைதல்

Straight-Line 
Connector tool

இரண்டு ப�ொருள்களை இணைக்க நேர் 
க�ோட்டை வரைதல்

Drop shadow tool ப�ொருட்களுக்கு பின்னால் அல்லது கீழே 
நிழல்கள் உருவாக்குதல்

Transparency tool தேர்ந்தெடுக்கப்பட்ட ப�ொருளுக்கு ஒளிபுகுமை 
தன்மையை அமைத்தல்

Color Eyedrop per 
tool

ஒரு ப�ொருளிலிருந்து நிரப்பு தேர்வை 
தேர்ந்தெடுத்தல்

Smart Fill tool நிரப்பு பண்புகளை அமைத்தல்

Flyout

Flyout Arrow

படம் 3.14  Flyout தேர்வுகள் மற்றும் Flyout அம்புக்குறி
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  Flyout ஐ ஆராய்தல்
கருவிப்பெட்டி குறிப்பிட்ட வரைதல் மற்றும் பதிப்பித்தல் பணிகளுக்குப் பயன்படுத்தக்கூடிய 
பல்வேறு வகையான கருவிகளைக் க�ொண்டுள்ளது. சில கருவிகள் வடிவங்களை 
வரைய பயன்படுகின்றன, மற்றும் பிற கருவிகள் ப�ொருள்களில் வண்ணங்கள் அல்லது 
க�ோட்டு வடிவங்கள் (patterns) நிரப்புவதற்கு பயன்படுத்தப்படுகின்றன. சில கருவிகள் 
Flyout களை க�ொண்டிருக்கும். அவை த�ொடர்புடைய கருவிகளின் குழுக்கள் ஆகும். ஒரு 
கருவிப்பெட்டியின் வலது-கீழ் மூலையில் உள்ள ஒரு சிறிய அம்புக்குறி அவை ஒரு Flyout ன் 
உறுப்பு என்பதை குறிக்கிறது. Flyout ல் கடைசியாக பயன்படுத்தப்பட்டகருவி ப�ொத்தானில் 
த�ோன்றும். Flyout அம்புக்குறியைக் கிளிக் செய்வதன் மூலம் Flyout கருவிகளை அணுகலாம்.

பின்வரும் அட்டவணையானது CorelDRAW கருவிப்பெட்டியில் flyouts மற்றும் 
கருவிகளின் விளக்கங்களை வழங்குகிறது.

கருவிகள் Flyout விளக்கம்

Pick tool Pick, Freehand Pick மற்றும் Free Transform 
கருவிகளை அணுக உதவுகிறது

Shape Tool (F10) Shape, Smooth, Smear, Twirl, Attract, Repel, 
Smudge மற்றும் Roughen கருவிகளை 
அணுக உதவுகிறது

Crop tool
Crop, Knife, Virtual Segment Delete மற்றும் 
Eraser கருவிகளை அணுக உதவுகிறது

Zoom tool (Z) Zoom மற்றும் Pan கருவிகளை அணுக 
உதவுகிறது

Rectangle tool (F6) Rectangle மற்றும் 3-Point Rectangle 
கருவிகளை அணுக உதவுகிறது
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Freehand tool (F5) Freehand, 2- Point Line, Bezier, Pen, 
B-Spline, Polyline, 3-Point Curve, Smart 
Drawing மற்றும் LiveSketch கருவிகளை 
அணுக உதவுகிறது.

Ellipse tool (F7) Ellipse மற்றும் 3-Point Ellipse கருவிகளை 
அணுக உதவுகிறது.

Polygon tool (Y) Polygon, Star, Complex Star, Impact 
tool, GraphPaper, Spiral, Basic Shapes, 
ArrowShapes, Flowchart Shapes, 
BannerShapes மற்றும் Callout Shapes 
கருவிகளை அணுக உதவுகிறது.

Text tool (F8) Text மற்றும் Table கருவிகளை அணுக 
உதவுகிறது. 

Interactive Fill tool Interactive Fill மற்றும் Mesh Fill கருவிகளை 
அணுக உதவுகிறது.
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Color Eyedropper 
Tool

Color Eyedropper மற்றும் Attributes 
Eyedropper கருவிகளை அணுக 
உதவுகிறது.

Drop Shadow Tool Drop Shadow, Contour, Blend, Distort, 
Envelope, Extrude, மற்றும் Block Shadow 
கருவிகளை அணுக உதவுகிறது.

Parallel Dimension 
tool

Parallel Dimension, Horizontal 
or Vertical Dimension, Angular 
Dimension, Segment Dimension 
மற்றும் 3-Point Callout 
கருவிகளை அணுக உதவுகிறது.

Straight-Line 
Connector tool

Straight-Line Connector, Right-
Angle Connector, Rounded 
Right-Angle Connector மற்றும் 
Anchor Editing கருவிகளை 
அணுக உதவுகிறது.

2.  வடிவங்களை வரைதல்
CorelDRAW நீல்வட்டம் (வட்டங்கள் உட்பட), செவ்வகம் (சதுரங்கள் உட்பட), பலக�ோனங்கள், 
நட்சத்திர வடிவங்கள் மற்றும் சில அடிப்படை வடிவங்களை வரைய வேறுபட்ட வடிவக் 
கருவிகளைக் க�ொண்டுள்ளது.

செவ்வகங்கள் மற்றும் சதுரங்கள் வரைதல்
ஒரு செவ்வகம் வரைதல்

1.	 ஒரு செவ்வகத்தை வரைய கருவிப்பட்டையில் இருந்து Rectangle கருவியை 
தேர்ந்தெடுக்கவும். சுட்டி சிறு சதுரத்தை க�ொண்ட crosshair சுட்டியாக மாறும். 

2.	 வரைதல் பகுதியில் எங்கும் வேண்டும�ோ அங்கு கிளிக் செய்து க�ொண்டே இழுக்கவும். 
நீங்கள் சுட்டியை இழுக்க, ஒரு செவ்வக த�ோன்றும். 
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2.	 இப்போது வரையும் பகுதியில் ctrl 
விசையை அழுத்திக் க�ொண்டே 
எங்கு சதுரம் வரைய வேண்டும�ோ 
அங்கு சுட்டியின் இடது ப�ொத்தானை 
கிளிக் செய்து க�ொண்டே நகர்த்த 
வேண்டும்.

3.	 நீங்கள் விரும்பும் அளவுடைய 
சதுரம் த�ோன்றியதும் சுட்டியின் 
ப�ொத்தானை அழுத்துவதை 
விட்டுவிடவும்.

படம் 3.17  சதுரம்

முனை வளைவான செவ்வகம் (Rounded 
rectangle) 
செவ்வகம் வரைந்த பின் நீங்கள் 
விரும்பினால் அதன் ஓரத்தை வளைவாக்க 
முடியும். நீங்கள் ஒரே நேரத்தில் அனைத்து 
ஓரங்களையும் அல்லது நீங்கள் விரும்பும் 
ஓரத்தை மட்டும் வளைவாக்க முடியும். 
ஓரங்களை சிறிது வளைவு ஆக்குவதன் 
மூலம் சிறிய மென்மையான வளைவாகவ�ோ 
அல்லது நன்கு வளைப்பதன் மூலம் 
கிட்டத்தட்ட வட்டமாக இருப்பது ப�ோன்றோ 
த�ோன்றச் செய்ய முடியும்.
செவ்வகத்தின் ஓரங்களை வளைவாக்க:

1.	 கருவிப்பட்டையில் Shape கருவி 
layout பகுதியிலிருந்து Shape Tool 
பணிக்குறியை தேர்ந்தெடுக்கவும் 
அல்லது  F10  விசையை அழுத்தவும்.

3.	 தேவையான அளவுள்ள செவ்வகம் 
த�ோன்றியவுடன் சுட்டி ப�ொத்தான் 
அழுத்துவதை விட்டுவிட வேண்டும். 

4.	 இப்போது ஒரு செவ்வகம் திரையில் 
த�ோன்றும்.

Rectangle Tool Cursor

படம் 3.15  ஒரு செவ்வகம் வரைதல்

படம் 3.16  செவ்வகம்

சுட்டியை அழுத்தி இழுக்கும் ப�ோது நீங்கள் 
நிலைமைப்பட்டை மற்றும் பண்புகள் 
பட்டையில் வரையப்படும் ப�ொருளின் 
இடம், நீள அகலம் ப�ோன்ற பண்புகளை 
காணலாம்.

சதுரம் வரைதல்
1.	 ஒரு சதுரம் வரைய கருவிப்பட்டையில் 

இருந்து Rectangle கருவியை 
தேர்ந்தெடுக்கவும். சுட்டி சிறு 
சதுரத்தை க�ொண்ட crosshair 
சுட்டியாக மாறும்.
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படம் 3.18 இ  வளைந்த ஓரங்களை உடைய 
செவ்வகத்தை உருவாக்குதல்

நீள்வட்டம்உருவாக்குதல்
1.	 நீள்வட்டம் வரைய (முட்டை 

வடிவம் எனவும் அழைக்கப்படும்) 
கருவிபட்டையில் Ellipse கருவியை  
தேர்ந்தெடுக்கவும். சுட்டியின் வடிவம் 
Crosshair குறியுடன் கீழ்ப்பகுதியில் 
நீள்வட்டம் க�ொண்டு குறியாக இருக்கும்.

2.	 இப்போது வரையும் பகுதியில் 
எங்கு நீள்வட்டம் வரைய 
வேண்டும�ோ அங்கு சுட்டியின் இடது 
ப�ொத்தானை அழுத்திக்.க�ொண்டே 
இழுக்கவேண்டும்.

3.	 நீள்வட்டம் நீங்கள் விரும்பும் வடிவை 
அடைந்தவுடன் சுட்டியின் ப�ொத்தானை 
அழுத்துவதை விட்டுவிடவும்.

படம் 3.19  நீள்வட்டம்

2.	 ஓரத்தை வளைவாக்க விரும்பும் 
செவ்வகத்தை தேர்ந்தெடுக்கவும். 
செவ்வகத்தின் ஓரத்தில் நான்கு 
கருப்பு சிறு சதுரம் த�ோன்றும்.

3.	 அனைத்து  ஓரங்களையும் 
ஒரே மாதிரியாக த�ோன்ற 
செய்ய அனைத்து ஓரங்களும் 
தேர்ந்தெடுக்கப்பட்டிருப்பதை உறுதி 
செய்து க�ொண்டபின் ஏதேனும் ஒரு 
முனையை இழுத்து தேவையான 
வளைவு ஏற்படும் வரை நகர்த்தவும்.

	 படம் 3.18 அ, படம் 3.18 ஆ மற்றும் 
படம் 3.18 இ காண்க

Four black nodes appear  
around the rectangle.

படம் 3.18 அ  செவ்வகத்தை சுற்றி உள்ள நான்கு 
கருப்பு முனையங்கள் 

படம் 3.18 ஆ 
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2.	 இப்போது வரையும் பகுதியில் எங்கு 
ஐங்கோணம் வரைய வேண்டும�ோ 
அங்கு சுட்டியின் இடது ப�ொத்தானை 
அழுத்தி பிடித்தவாறு நகர்த்த 
வேண்டும்.

3.	 நீங்கள் விரும்பும் வடிவமுடைய  
பலக�ோணம் உருவானவுடன் 
சுட்டியின் ப�ொத்தானை அழுத்துவதை 
விட்டு விடவும்.

4.	 வரைந்த பலக�ோணத்தின் 
பக்கங்களை அதிகரிக்க நீங்கள் 
வரைந்த பலக�ோணத்தை pick 
கருவி மூலம் தேர்ந்தெடுக்கவும்.

5.	 சுட்டியை பண்பு பட்டையில் உள்ள 
Number of Points on Polygon 
உரைப்பெட்டியில் கிளிக் செய்து 
தேவையான பக்கங்களின் 
எண்ணிக்கையை க�ொடுக்கவும்.

நீங்கள் பலக�ோணத்தின் பக்கங்களை 
முதலிலேயே க�ொடுத்துவிட்டு பின்பும் 
வரையலாம்.

Pentagon - a five-sided figure

படம் 3.21  ஐந்து பக்க பலக�ோணம்

Points or sides

படம் 3.22  ஆறு பக்க பலக�ோணம்

வட்டம் வரைதல் 
1.	 வட்டம் வரைய நீள்வட்ட Ellipse 

கருவியை கருவிபட்டையிலிருந்து 
தேர்ந்தெடுக்கவும். சுட்டியின் வடிவம் 
Crosshair குறியுடன் கீழ்ப்பகுதியில் 
நீள்வட்டம் க�ொண்டு குறியாக 
இருக்கும்.

2.	 இப்போது வரையும் பகுதியில் எங்கு 
வட்டம் வரவேண்டும�ோ அங்கு ctrl 
விசையை அழுத்தி வைத்தவாறு 
சுட்டியின் இடது ப�ொத்தானை 
இழுத்து நகர்த்த வேண்டும்.

3.	 நீங்கள் விரும்பும் வட்டவடிவம் 
த�ோன்றியவுடன் சுட்டியின் 
ப�ொத்தானை அழுத்துவதை 
விட்டுவிடவும்.

படம் 3. 20  வட்டம்

பலக�ோண உருவம் வரைதல்
1.	 பலக�ோண உருவம் வரைய 

(ஐங்கோணம் - ஐந்து பக்கம் 
உடைய உருவம் என்றும் 
அறியப்படுகிறது) polygon 
கருவியை கருவிபட்டையிலிருந்து 
தேர்ந்தெடுக்கவும். சுட்டியின் வடிவம் 
Crosshair குறியுடன் கீழ்ப்பகுதியில் 
பலக�ோணம் க�ொண்டு குறியாக 
இருக்கும்.
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சுருள் வரைதல்
இரண்டு வகையான சுருள் வகைகள் 
உள்ளன

1.	 சமசீர் சுருள் (Symmetrical spiral)
2.	 மடக்கை சுருள் (Logarithmic spiral)

சமசீர் சுருள் முறையில் சுருள் சம 
அளவில் விரிவடையும். எனவே 
ஒவ்வொரு சுழற்சியும் சம அளவுடைய 
சுருளை உருவாக்கும். மடக்கை 
சுருள் முறையில் சுழற்சி உருவாக்கும் 
சுருள்களுக்கிடையேன  தூரம் 
அதிகரித்தவாறே காணப்படும். 

நீங்கள் spial கருவியை க�ொண்டு 
பல அளவுகளில் சுருள்களை வரைய 
முடியும்.

சுருள் வரைய
1.	 பலக�ோண கருவியின் மீது அழுத்திப் 

பிடித்தவாரே இருந்தால் flyout பட்டி 
த�ோன்றி மேலும் பல கருவிகளை 
காட்டும்.

2.	 flyout  பட்டியில் உள்ள சுருள் (Sprial) 
கருவியை கிளிக் செய்யவும்.

3.	 நீங்கள் பண்பு பட்டையில் 
உள்ள சுருள் சுழற்சி பெட்டியில்  
எண்ணிக்கையை க�ொடுப்பதன் 
மூலம் தேவையான வட்டம் உடைய 
புதிய சுருள் அமைப்பை உருவாக்க 
முடியும்.

4.	 பின் பண்பு பட்டையில் கீழ்கண்ட 
ஏதேனும் ஒரு ப�ொத்தானை கிளிக் 
செய்யவும். 
●	 சமசீர் சுருள் (Symmetrical spiral)
●	 மடக்கை சுருள் (Logarithmic 

spiral)
	 சுழற்சியை வெளிப் புறமாக நகர்த்தும் 

ப�ோது சுருள் விரிவாக்க அளவுகளை 
மாற்ற விரும்பினால் spiral expansion 
slider ஐ நகர்த்தவும்.

நட்சத்திரம் வரைதல்
polygon கருவியின் கீழ்ப்பகுதியில் சிறிய 
அம்புக்குறி உள்ளது. இந்த அம்புகுறி  flyout. 
உள்ளதை உணர்த்துகிறது

நட்சத்திரம் வரைய
1.	 பலக�ோண கருவியின் மீது அழுத்திக் 

க�ொண்டே இருந்தால் flyout  பட்டி 
த�ோன்றி மேலும் பல கருவிகளை 
காட்டும்.

2.	 flyout பட்டியில் உள்ள நட்சத்திரக் 
கருவியை கிளிக் செய்யவும்.

3.	 வரையும் பகுதியில் எங்கு நட்சத்திரம் 
வர வேண்டும�ோ அங்கு சுட்டியின் 
இடது ப�ொத்தானை அழுத்தி 
பிடித்தவாறு இழுத்து நகர்த்தவும்

4.	 நட்சத்திர உருவம் உருவானவுடன் 
சுட்டியின் ப�ொத்தானை அழுத்துவதை 
விட்டு விடவும்.

Flyout menu

படம் 3.23  நட்சத்திர கருவி

Outline width

Points or sides

படம் 3.24  நட்சத்திரம் வரைதல்
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ஒரு முழுமையான சுழற்சியை குறிக்கும். 
சுழற்சி செல்லும் திசை சுட்டி நாம் முதலில் 
உருவாக்கும் உருவத்தை ப�ொருத்து முடிவு 
செய்யப்படுகிறது. இதை கீழ்க்காணும் 
படங்கள் மூலம் அறியலாம்.

படம் 3.27

படம் 3.28

கட்டங்கள் வரைதல்
Graph Paper கருவியை பயன்படுத்தி 
நீங்கள் குறிப்பிட்ட எண்ணிக்கை  வரிசை 
மற்றும் நெடுவரிசைகளை க�ொண்ட ஒரு 
கட்டகம் வரையலாம். கட்டகம் என்பது 
தனித்தனியாக பிரிக்கக் கூடிய பல 
செவ்வகங்கள் சேர்ந்த அமைப்பாகும்.

ஒரு கட்டகம் வரைய 
1.	 பலக�ோண கருவியின் மீது அழுத்திக் 

க�ொண்டே இருந்தால் flyout  பட்டி 
த�ோன்றி மேலும் பல கருவிகளை 
காட்டும்.

2.	 flyout  பட்டியில் உள்ள Graph Paper 
கருவியை கிளிக் செய்யவும்.

வரையும் சன்னல் திரையில் நமக்கு 
வேண்டிய அளவு உள்ள சுருள் வரும் வரை 
சுட்டியை கிடைமட்டமாக இழுக்கவும்.

படம் 3.25  சுருள் கருவி

Logarithmic 
spiralSymmetrical 

spiral

Logarithmic spiral

Symmetrical spiral

Spiral expansion slide (while using 
Logarithmic)

Outline width

Spiral revolutions

படம் 3.26  சமசீர் சுருள் (Symmetrical spiral) 
மற்றும்  மடக்கை சுருள் (Logarithmic spiral)

நீங்கள் உருவாக்கும் உருவம் சுருள் 
ஒன்று முதல் 100 வரையிலான 
சுழற்சியைக் க�ொண்டு இருக்க முடியும்.  
ஒவ்வொன்றும் மையப்புள்ளியை சுற்றி 
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Free hand முறையில் நேர்கோடு வரைதல்
ஒரு நேர்கோடு வரைதல்

1.	 Freehand பணிக்குரிய கிளிக் 
செய்யவும் அல்லது F5 விசையை 
அழுத்தவும். 

2.	 எங்கிருந்து க�ோடு வரைய 
வேண்டும�ோ அந்த இடத்திற்கு 
சுட்டியை நகர்த்தி கிளிக் செய்யவும். 

3.	 சுட்டியை க�ோடு முடிய வேண்டிய 
இடத்திற்கு நகர்த்தவும்.

	 நீங்கள் rubberband க�ோடு உங்கள் 
சுட்டியுடன் நகர்வதை கவனிக்கலாம். 

4.	 எங்கு க�ோடு முடிவடைய வேண்டும் 
அங்கு வந்தவுடன் சுட்டியை 
அழுத்துவதை விட்டு விடவும்.  க�ோடு 
வரையப் பட்டிருக்கும்.

Ending point

Click

Click

Starting Point

படம் 3. 30  rubberband க�ோடு

5.	 நீங்கள் முதல் க�ோட்டுடன் 
இணைந்த இரண்டாவது க�ோடு 
வரைய வேண்டுமெனில் த�ொடர்ந்து 
Freehand கருவி மூலம் கடைசியாக 
வரைந்த க�ோட்டியின் இறுதி 
புள்ளியில் கிளிக் செய்யவும்.

3.	 பண்புபட்டையில் உள்ள மேல் மற்றும் 
கீழ்ப் பகுதியில் நெடுவரிசை மற்றும் 
வரிசைகளின் எண்ணிக்கையை 
உள்ளிடவும்.   

	 மேல் பகுதியில் உள்ளிடப்படும் மதிப்பு 
நெடுவரிசை எண்ணிக்கையையும் கீழ்ப் 
பகுதியில் உள்ளிடப்படும் மதிப்பு வரிசை 
எண்ணிக்கையையும் குறிக்கும்.

4.	 வரையும் பகுதியில் எங்கு கட்டகம் 
த�ோன்ற வேண்டும�ோ அங்கு கிளிக் 
செய்யவும். 

5.	 சுட்டியை கிடைமட்டமாக இழுப்பதன் 
மூலம் வேண்டிய கட்டகம் வரைய 
முடியும்.

6.	 மையப் புள்ளியிலிருந்து 
வெளிப்புறமாக கட்டங்கள் வரைய 
shift விசையை  விசையை 
அழுத்தியவாறு நகர்த்த வேண்டும். 
கட்டங்களை சதுர வடிவல் அமைக்க 
Ctrl விசையை  விசையை 
அழுத்தியவாறு நகர்த்த வேண்டும்.

Columns and rows box

Graph Paper tool
படம் 3.29
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End arrowhead

Line styleStart arrowhead

Outline width

படம் 3.32  க�ோட்டில் அம்புக்குறி சேர்த்தல்

3  வண்ணத் தட்டை பயன்படுத்துதல்
வண்ணத் தட்டு CorelDRAW ன் சிறப்பு 
அமைப்பு ஆகும். இதை dock அல்லது 
undock செய்து பயன்படுத்தலாம்.

வண்ணத் தட்டு வண்ணங்களை பார்த்தல்
●	 நீங்கள் வண்ணத் தட்டில் பார்க்கும் 

சிறிய சதுர வண்ணங்கள் வெல்ஸ் 
(Wells) எனப்படும்.

●	 வண்ணத் தட்டு வெல்ஸ் த�ொகுப்பை 
திரை உருளல் செய்ய மேல் மற்றும் கீழ் 
பகுதியில் உள்ள அம்புக்குறியை கிளிக் 
செய்யவும்.

●	 சுட்டியின் இடது ப�ொத்தானை கிளிக் 
செய்து வண்ணத் தட்டு வெல்ஸின் ஒரு 
வண்ணதை மட்டும் உருளச் செய்ய 
முடியும். 

●	 சுட்டியின் வலது ப�ொத்தானை கிளிக் 
செய்வது Page Up and Page Down 
விசைக்குரிய பணியை செய்யும். நீங்கள் 
பார்க்கும் வண்ண த�ொகுதியின் ஒரு 
வரியை மேல் அல்லது கீழ் உருளை 
செய்யும்.

●	 நீங்கள் எந்த வண்ண வரிசை 
வேண்டும�ோ அதற்கு ஏற்ப வண்ண  
வெல்ஸின் மேலும் கிளிக் செய்து 
இழுத்து நகர்த்தலாம் மூலம் வண்ண 
வரிசை அமைப்பை மாற்றலாம்.

6.	 இரண்டாவது க�ோடு வரைய 
சுட்டியை நகர்த்தவும். நீங்கள் 
விரும்பும் இரண்டாவது க�ோட்டின் 
அமைப்பு உருவானவுடன் கிளிக் 
செய்யவும். படிநிலை 5 மற்றும் 
6 பலமுறை மீண்டும் மீண்டும் 
செய்வதன் மூலம் தேவையான 
க�ோடுகளை வரைய முடியும்.

	 நீங்கள் த�ொடக்கம் மற்றும் இறுதி 
என இரு புள்ளிகளில் கிளிக் செய்ய 
வேண்டும் என்பதை நினைவில் 
க�ொள்க.

Between any two nodes in a curve or line 
object is a “Segment”. There are two types 

of segments : Curves and lines.

Segment

Node

Node

படம் 3.31  Segments

க�ோட்டில் அம்புக்குறி சேர்த்தல்
க�ோட்டில் அம்புக்குறி சேர்க்க

1.	 Freehand கருவி மூலம் ஒரு க�ோடு 
வரையவும்.

2.	 க�ோட்டை தேர்ந்தெடுக்கவும்.
3.	 பண்புபட்டையில் உள்ள End 

Arrow head Selector கீழே இறங்கு 
பட்டிபெட்டியில் கிளிக் செய்யவும்.

4.	 பின் தேவையான அம்புக்குறி 
முனையை தேர்வு செய்யவும்.

இப்போது க�ோடு அம்புக்குறியுடன் 
த�ோன்றும். நீங்கள் க�ோட்டின் வடிவம் 
தடிமன் மற்றும் நிறம் ப�ோன்றவற்றை 
பண்புப் பட்டையின் மூலம் அமைக்கலாம். 
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●	 இவ்வாறு உருளச் செய்து நாம் சில வண்ண வரிசையை மட்டுமே பயன்படுத்த முடியும். 
இந்த வசதி ப�ோதுமானதாக இல்லாவிட்டால் Expand ப�ொத்தான் மூலம் அனைத்து 
வண்ணங்களையும் தற்காலிகமாக பார்க்க முடியும்.

●	 நீங்கள் உங்கள் வண்ணத்தை தேர்ந்தெடுத்தவுடன் வண்ணத்தட்டு தானாக பழைய 
நிலைக்கு சென்றுவிடும்.

●	 வண்ணத்தட்டு மிதவை பெட்டியாக இருக்கும் ப�ோது அதன் தலைப்பு பட்டியில் கிளிக் 
செய்து இழுத்து நகர்த்து வதன் மூலம் வண்ண தட்தை சன்னல் துறையில் எங்கு 
வேண்டுமானாலும் நகர்த்தலாம். அல்லது மறையச் செய்ய Close ப�ொத்தானை கிளிக் 
செய்ய வேண்டும்

●	 Window > Color Palettes என்பதை தேர்ந்தெடுத்து அதில் வண்ண தட்டை கிளிக் 
செய்தால் வண்ணத்தட்டு அது கடைசியாக இருந்த நிலையில் காட்டப்படும்.

Title bar

Well

Scroll down

Click-drag  
to move

Scroll up

Click to expand colour selection

Click the Close 
button to hide it 

from view.

Click to expand 
colour selection

படம் 3.33 

படம் 3.34 

படம் 3.35 

வண்ணத் தட்டின் தேர்வுகளை மாற்றுதல் 
வண்ணத்தட்டில் விருப்ப Flyout ப�ொத்தான் 
நிரப்புதல் மற்றும் ஓர வண்ணத்தை 
முடிவு செய்யும் வசதி ப�ோன்ற பல முக்கிய 
கட்டளை வசதியை க�ொண்டுள்ளது. 
(வலது மற்றும் இடது ப�ொத்தானை 
கிளிக் செய்வதன் மூலம் ப�ொருள்களுக்கு 
வண்ணங்களை சேர்ப்பதற்கு மாறாக) 
அல்லது வண்ணத்தட்டு எவ்வாறு த�ோன்ற 
வேண்டும் என்பதை கட்டுப்படுத்துகிறது.
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Outline Colour

Fill Colour

படம் 3.37  ப�ொருளுக்கு வண்ணம் நிரப்புதல்

4.  �ப�ொருளுடைய வடிவத்தின் 
அளவை மாற்றியமைத்தல்  
(Resizing shapes of objects)

வடிவத்தின் அளவை மாற்றியமைத்தல் 
என்பது வடிவத்தின் தற்போதைய 
அளவை சிறிதாகவ�ோ அல்லது 
பெரியதாகவ�ோ மாற்றி அமைப்பதாகும்.  
ப�ொருளின் வடிவத்தின் அளவை அதன் 
கைப்பிடிகளை (Handles) இழுப்பதின் 
மூலம் மாற்றலாம்.  ப�ொருளின் மையத்தை 
ந�ோக்கி நீங்கள் ப�ொருளின் கைப்பிடியை 
இழுக்கும்பொழுது, நீங்கள் ப�ொருளின் 
அளவை சிறிதாக்குகின்றீர்கள். மையத்தை 
விட்டு வெளியே இழுக்கும் ப�ொழுது 
நீங்கள் ப�ொருளின் அளவை பெரிதாக 
மாற்றுகின்றீர்கள்.

1.	 அளவை மாற்றவேண்டிய ப�ொருளை 
தேர்வு செய்யவும்.  ப�ொருளை 
சுற்றிலும் கைப்பிடிகள் (Handles) 
த�ோன்றும்.  சுட்டியின் அம்பு குறியை 
கைப்பிடி மீது வைக்கவும்.

2.	 ப�ொருளினுடைய வடிவத்தின் 
அளவை மாற்றுவதற்கு கைப்பிடி மீது 
கிளிக் செய்து இழுத்து விடவும்.

	 நீங்கள் மூலையில் உள்ள 
கைப்பிடியினை இழுக்கும் 
ப�ொழுது, நீங்கள் அளவை மாற்றும் 
ப�ொருளின் உயரம் மற்றும் அகலம் 

நீங்கள் எடிட் கட்டளை மூலம் 
வண்ணத் தட்டில் நிறம் மாற்ற 
வண்ணத்தட்டு பதிப்பான (எடிட்டர்) 
திறக்கவும் அல்லது குறிப்பிட்ட 
வண்ணத்தை தேர்வு செய்யவும் 
Show Color Names விருப்பத்தை 
தேர்ந்தெடுப்பதன் மூலம் வண்ணத்தை 
பெயருடன் காணலாம்.

Color palette options flyout arrow

படம் 3.36  வண்ணத் தட்டின் தேர்வுகளை 
மாற்றுதல்

நிரப்புதல் மற்றும் ஓர வண்ணத்தை முடிவு 
செய்தல்
எந்த ஒரு ப�ொருளிலும் வண்ணத்தை 
நிரப்ப:

1.	 Pick கருவியை பயன்படுத்தி 
ப�ொருளைத் தேர்ந்தெடுக்கவும்.

2.	 வண்ணத்தட்டில் ஏதாவது ஒரு 
வண்ணத்தை கிளிக் செய்யவும்.

3.	 தேர்ந்தெடுக்கப்பட்ட ப�ொருளுக்கு 
வண்ணங்கள் சேர்ந்திருக்கும்.

4.	 வண்ணத்தட்டில் உள்ள ஏதாவது 
ஒரு வண்ணத்தில் வைத்து வலது 
ப�ொத்தானைக் கிளிக் செய்யவும்.

5.	 தேர்ந்தெடுக்கப்பட்ட ப�ொருளின் 
வண்ணம் தேர்ந்தெடுக்கப்பட்ட 
வண்ணத்திற்கு மாறியிருக்கும்.
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3.	 தேர்வு செய்யப்பட்ட ப�ொருளை 
சுழற்றுவதற்கு சுற்றல் கைப்பிடிகளை 
கிளிக் செய்து அதனை கடிகார 
திசையில�ோ அல்லது கடிகாரத்திற்கு 
எதிர் திசையில�ோ இழுக்கவும்.

4.	 சுட்டெலி ப�ொத்தானை விட்டுவிடவும்.  
இப்பொழுது ப�ொருளானது 
சுழற்றப்பட்டிருக்கும்.

படம் 3.39  சுட்டெலியினை பயன்படுத்தி ஒரு 
ப�ொருளினை சுழற்றுதல்

Angle of Rotation பெட்டியை பயன்படுத்தி 
ஒரு ப�ொருளினை சுழற்றுதல்

1.	 எடு (Pick) கருவி க�ொண்டு 
ப�ொருளினை தேர்ந்தெடுக்கவும்.

2.	 பண்புகூறு பட்டையிலுள்ள (Proporty 
bar) Angle of rotation. பெட்டி மீது 
சுட்டெலியின் அம்புகுறியினை 
வைத்து அதனை கிளிக் செய்யவும்.

3.	 எந்த ப�ொருளை சுழற்ற வேண்டும�ோ 
அதனுடைய சுழற்றும் க�ோணத்தை 
Angle of Rotation உரை பெட்டியில் 
உள்ளிடவும்.

Angle of rotation text box

படம் 3.40  Angle of Rotation உரைபெட்டி 
க�ொண்டு ப�ொருளினை சுழற்றுதல்

ஆகியவற்றிற்கு இடையேயான 
விகிதத்தை பராமரிக்க முடியும்.  
ஆனால் நீங்கள் பக்கவாட்டில் 
அல்லது மேலுள்ள கைப்பிடியினை 
இழுக்கும் ப�ொழுது, நீங்கள் அளவை 
மட்டுமல்ல ப�ொருளின் வடிவத்தையும் 
மாற்றுகின்றீர்கள்.

Original

Resized using 
the corner 
handle

Resized using  
the side handle

படம் 3.38  ப�ொருட்களின் வடிவத்தின் அளவை 
மாற்றியமைத்தல்

5.  �ப�ொருட்களை சுழற்றுதல்  
Rotating Objects

ப�ொருளினை சுழற்றுதல் என்பது நீங்கள் 
குறிப்பிடும் க�ோணத்தில் அதனை 
கடிகாரத்திசையில�ோ அல்லது எதிர் 
திசையில�ோ திருப்புவதாகும்.

சுட்டெலியினை க�ொண்டு ப�ொருளினை 
சுழற்றுதல்.

1.	 எடு (Pick) கருவி க�ொண்டு 
ப�ொருளினை தேர்ந்தெடுக்கவும்.

2.	 ப�ொருளை மீண்டும் கிளிக் 
செய்யவும்.  கைப்பிடிகள் சிறிய 
கருப்பு சதுரத்திலிருந்து வளைந்த 
அம்புகுறிகளாக மாறும்.
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Undo (செய்ததை நீக்கு)  
அமைப்புகளை குறிப்பிட

1.	 பணிப்பட்டையில் Tools ® Options  
என்பதை தேர்வு செய்யவும்.

2.	 த�ோன்றும் திரையில் வகைகளின் 
பட்டியலிருந்து General என்பதை 
கிளிக் செய்யவும்.

3.	 Undo நிலைகள் பகுதியில் கீழ்கண்ட 
ஒன்று அல்லது இரண்டு பெட்டிகளில் 
ஒரு மதிப்பினை தட்டச்சு செய்யவும்.
●	 Regular - Undo கட்டளையினை 

வெக்டர் ப�ொருள்களுடன் 
பயன்படுத்தும் ப�ோது எத்தனை 
செயல்களை முந்தைய நிலைக்கு 
மாற்றலாம் எனபதை குறிப்பிடுகின்றது.

●	 Bitmap effects - bitmap 
விளைவுகளுடன் நீங்கள் 
பணியாற்றும் ப�ோது எத்தனை 
செயல்களை முந்தைய நிலைக்கு 
மாற்றலாம் என்பதனை 
குறிப்பிடுகின்றது.

	 நீங்கள் குறிப்பிடும் மதிப்பானது 
உங்கள் கணிப்பொறியின் நினைவக 
வளங்களை ப�ொறுத்து அமையும்.  
அதிகபட்சமான மதிப்புகளை நீங்கள் 
குறிப்பிட்டால் அதற்கான நினைவக 
வளங்களுக்கான தேவையும் 
அதிகமாக இருக்கும்.

படம் 3.41  Tools பணிப்பட்டையிலுள்ள 
விருப்பங்கள்

6.  �செய்ததை நீக்கு மற்றும் மறுபடியும் 
செய் (Undoing and Redoing)

நடப்பு அமர்வில் நீங்கள் முன்னர் செய்த 
செயல்பாடுகளை Corel Draw நினைவில் 
க�ொண்டிருக்கும்.  மிக சமீபத்தில் நீங்கள் 
செய்த செயலில் ஆரம்பித்து, நீங்கள் 
வரையும்பொழுது செய்த செயல்களை 
எல்லாம் உங்களால் Undo செய்ய 
முடியும்.  ஒரு செயலை Undo (செய்ததை 
நீக்கு) செய்வதினால் வரும் விளைவுகள் 
உங்களுக்கு பிடிக்கவில்லை எனில் 
நீங்கள் அதனை Redo (மறுபடியும் செய்) 
செய்து க�ொள்ளலாம்.  ஒரு வரைபடத்தின் 
கடைசியாக சேமிக்கப்பட்ட நிலைக்கு 
பின் செல்வது உங்களை ஒன்று அல்லது 
அதற்கு மேற்பட்ட செயல்களை நீக்க 
செய்யும், விரிவடைய செய்தல், நிரப்புதல், 
நகர்த்தல் மற்றும் சுழற்றுதல் ப�ோன்ற 
ப�ொருளின் மீது செய்யப்படும் குறிப்பிட்ட 
செயல்பாடுகள், ஒரு வலுவான காட்சி 
விளைவுகளை உருவாக்குவதற்காக  
மீண்டும் செய்யப்படுகின்றன.

Undo அமைப்புகளை 
தனிப்பயனாக்குவதன் மூலம், நம்மால் 
Undo அல்லது Redo செய்யகூடிய 
செயல்களின் எண்ணிக்கையை கூட்டவ�ோ 
அல்லது குறைக்கவ�ோ முடியும்.

To Undo, Redo and Repeat செயல்கள்
ஒரு செயலை Undo 
செய்ய

Edit > Undo தேர்வு 
செய்யவும் (கடைசி 
செயல்)

ஒரு செயலை Redo 
செய்ய

Edit > Redo தேர்வு 
செய்யவும்

வரைபடத்தின் 
கடைசியாக 
சேமிக்கப்பட்ட 
நிலைக்கு  
பின்செல்ல

File > Revert தேர்வு 
செய்யவும்

ஒரு செயலை மீண்டும் 
மீண்டும் செய்ய

Edit > Repeat தேர்வு 
செய்யவும்.
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Undo செய்வதற்கு எந்த செயலும் 
இல்லாவிட்டால�ோ இந்த கட்டளையானது 
சாம்பல் நிறமாக த�ோன்றும்.

Undo-னை பயன்படுத்திய 
உடனேயே Redo கட்டளை கிடைக்கும்.  
இது நீங்கள் தற்போது நீங்கிய செயலை 
மீண்டும் முன் நிலைக்கு க�ொண்டு செல்ல 
அனுமதிக்கும்.

7.  வரைபடத்தை சேமித்தல்
வரைபடம் சேமிக்க

1.	 பணிப்பட்டையிலிருந்து File > Save 
என்பதை தேர்வு செய்யவும்

2.	 Save Drawing உரையாடல் பெட்டி 
த�ோன்றும்.

3.	 Save Drawing உரையாடல் 
பெட்டியில்

	 File Name பட்டி பெட்டியில் க�ோப்பின் 
பெயரை தட்டச்சு செய்யவும்.

	 க�ோப்பினை  சேமிக்க வேண்டிய 
க�ோப்புறையை தேர்வு செய்யவும்.

	 வரைபடமானது Corel Draw-ன் 
முந்தைய பதிப்புகளுடன் 
இணக்கமாக செயல்பட 
வேண்டும் என்றால் Version பட்டி 
பெட்டியிலிருந்து தேவையான 
பதிப்பினை தேர்வு செய்யவும்.

	 வரைபடத்தை Corel Draw (CDR) 
க�ோப்பாக சேமிக்காமல் வெக்டர் 
க�ோப்பு வடிவமாக சேமிக்க Save as 
type-லிருந்து க�ோப்பு வடிவத்தை 
தேர்வு செய்யவும்.

படம் 3.44  File பட்டியிலுள்ள Save விருப்பம்

Shortcuts

To Undo an action, press Ctrl + Z.

To Redo an action Ctrl + Shift + Z.

படம் 3.42  விருப்பங்கள் (Options) உரையாடல் 
பெட்டி

Undo நிலைகளின் எண்ணிக்கையை 
இங்கு குறிப்பிடவும்

படம் 3.43  Undo நிலைகளின் எண்ணிக்கையை 
குறிப்பிடுகின்றது

உங்களால் Undo (செய்ததை நீக்கு) 
செய்யமுடியாத செயல்கள்
●	 காட்சியினை மாற்றுதல் (பெரிதாக்குதல் 

(200 ming), திரைஉருளால் (Scrolling) 
ப�ோன்றவை)

●	 க�ோப்பு செயல்பாடுகள் (க�ோப்பினை 
திறத்தல், சேமித்தல், க�ோப்பு இறக்கம் 
செய்தல் ப�ோன்றவை)

●	 ப�ொருளை தேர்ந்தெடுக்கும் செயல்பாடு.

Undo கட்டளையானது கடைசி செயலை 
ப�ொருத்து மாறுகின்றது.  எடுத்துக்காட்டாக, 
“Undo Fill” or “Undo Rotate”. செயலை 
Undo செய்ய இயலாவிட்டால�ோ அல்லது 
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சமயத்தில் மூட, Window > Close All 
என தேர்வு செய்யவும்.

எந்த முறையை பயன்படுத்தி நீங்கள் 
ஆவணத்தை மூட முயன்றாலும், நீங்கள் 
செய்த சமீபத்திய மாற்றங்களை சேமிக்க 
வேண்டுமா இல்லையா என்பதை 
தேர்ந்தெடுப்பதற்கான தூண்டியை 
காண்பிக்கும்.

பல க�ோப்புகளை மூடும் ப�ொழுது 
மாற்றங்கள் செய்யப்பட்ட ஒவ்வெரு 
க�ோப்பினையும் சேமிக்குமாறு Corel Draw 
தூண்டும்.

படம் 3.46  File பட்டியிலுள்ள Close விருப்பம்

படம் 3.47  Save Changes to உரையாடல் பெட்டி

படம் 3.48  Window பட்டியிலுள்ள Close All 
விருப்பம்.

Version List box
Choose a file format 

from the Save as type.
படம் 3.45  Save Drawing உரையாடல் பெட்டி

3. 7. 1	 ஏற்கனவே உள்ள 
வரைபடத்தை சேமித்தல்

ஏற்கனவே உள்ள ஆவணத்தை 
சேமிக்க செந்தர கருவிப்பட்டையிலுள்ள 
Save ப�ொத்தானை கிளிக் செய்யலாம் 
அல்லது File > Save (Ctrl+S)னை தேர்வு 
செய்யலாம்.  இது உங்களது மிக சமீபத்திய 
மாற்றங்களை உடனடியாக எந்த 
உரையாடல் பெட்டியையும் திறக்காமல் 
சேமிக்க உதவுகின்றது.

3.8  ஆவண க�ோப்புகளை மூடுதல்
ஒரு ஆவணத்தை மூட, கீழ்கண்ட 
செயகளில் ஒன்றை பயன்படுத்தலாம்.

1.	 உங்கள் ஆவணத்தின் சன்னல் 
திரையின் மேற்புற வலது மூலையில் 
உள்ள Close ப�ொத்தானை கிளிக் 
செய்யவும்.

	 (அல்லது)
2.	 File > Close அல்லது Window > Close 

Window தேர்வு செய்யலாம் அல்லது 
Ctrl+F4 என்பது கிளிக் செய்யவும்.

3.	 ஒன்றிற்கு மேற்பட்ட ஆவண 
க�ோப்புகளை திறந்திருந்தால், 
அனைத்து க�ோப்புகளை ஒரே 
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Tab சாவி க�ொண்டு ப�ொருள்களை 
தேர்ந்தெடுத்தல்.

1.	 செவ்வக (Rectangle) கருவி க�ொண்டு 
முதலில் மூன்று ப�ொருள்களை 
உருவாக்கவும் (உங்கள் 
விருப்பப்படி எத்தனை ப�ொருட்களை 
வேண்டுமானாலும் உருவாக்கலாம்).

2.	 Pick கருவியினை தேர்ந்தெடுக்க 
இடைவெளி ப�ொத்தானை 
(Spacebar) அழுத்தவும்.

3.	 நீங்கள் தேர்ந்தெடுக்க விரும்பும் 
ப�ொருளை சுற்றிலும் தேர்ந்தெடுப்பு 
பெட்டி (Selection box) த�ோன்றும் 
வரை Tab சாவியினை அழுத்தவும்.  
நீங்கள் Tab சாவியினை 
அழுத்தும் ப�ொழுது, கடைசியாக 
உருவாக்கப்பட்ட ப�ொருள் த�ொடங்கி 
முதலில் உருவாக்கிய ப�ொருள் 
ந�ோக்கி நகர்ந்து க�ொண்டே 
ப�ொருளை தேர்வு செய்கின்றது.

	 Shift + Tab சாவியினை அழுத்தும் 
ப�ொழுது முதலில் உருவாக்கப்பட்ட 
ப�ொருள் த�ொடங்கி கடைசியாக 
உருவாக்கப்பட்ட ப�ொருள் ந�ோக்கி 
நகர்ந்து க�ொண்டே ப�ொருளை 
தேர்வு செய்கின்றது.

பல ப�ொருள்களை தேர்ந்தெடுத்தல்
Pick கருவி மூலம், ஒரே நேரத்தில் நிறைய 
ப�ொருள்களை தேர்வு செய்யலாம். Pick 
கருவி க�ொண்டு பல ப�ொருள்களை தேர்வு 
செய்வதற்கான இரண்டு வழிகள்

1.	 Shift சாவியினை அழுத்திபிடித்தவாறு, 
நீங்கள் தேர்வு செய்ய விரும்பும் 
ஒவ்வொரு ப�ொருளின் மீதும் கிளிக் 
செய்யவும்.

	 இந்த வழியில் உங்கள் வரைபடம் 
சன்னல் திரையிலுள்ள எத்தனை 
ப�ொருட்களை வேண்டுமானாலும் 
நீங்கள் தேர்வு செய்யலாம்.

படம் 3.49  Window பட்டியிலுள்ள Close Window 
விருப்பம்.

9.  Corel Draw விட்டு வெளியேறுதல்
File பட்டியிலிருந்து Exit என 
தேர்ந்தெடுப்பதன் மூலம் Corel Drawன் 
நடப்பு அமர்வானது முடிவடைகின்றது.  
நீங்கள் க�ோப்பினை சேமித்தப்பின் 
ஏதேனும் மாற்றங்கள் செய்திருந்தால் 
வெளியேறுவதற்கு முன் க�ோப்பினை 
சேமிக்கும்படி Corel Draw தூண்டும் 
மாற்றங்களை சேமிக்க Yes என கிளிக் 
செய்ய வேண்டும்.

10.  ப�ொருள்களுடன் வேலை செய்தல்
ப�ொருள்களை தேர்ந்தெடுத்தல்
கருவிகளை (tools) க�ொண்டு நீங்கள் 
உருவாக்கும் வரைபடங்கள் ப�ொருட்கள் 
எனப்படும்.  எந்த ப�ொருளையும் தேர்வு 
செய்ய அந்த ப�ொருளின் மீது சுட்டியின் 
அம்புகுறியினை வைத்து கிளிக் செய்ய 
வேண்டும்.

சில நேரங்களில் உங்களது 
வரையும் சன்னல்திரையானது 
நிறையப்பொருள்களை க�ொண்டிருந்தால் 
pick கருவி மூலம் ஒரு ப�ொருளை 
தேர்ந்தெடுப்பது கடினமான செயலாகும்.  
அந்த நேரங்களில் விசைப்பலகையின் 
Tab சாவி க�ொண்டு ப�ொருளை 
தேர்ந்தெடுக்கலாம்.
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Marquee

படம் 3.51  செவ்வகம்

மூன்று ப�ொருட்கள் தேர்வு 
செய்யப்பட்டுள்ளன

படம் 3.52  மூன்று ப�ொருட்கள் தேர்வு 
செய்யப்பட்டுள்ளன

2.	 ஒவ்வொரு ப�ொருளாக 
தேர்ந்தெடுப்பதற்கு பதிலாக pick கருவி 
க�ொண்டு ப�ொருள்களை சுற்றிலும் 
ஒரு செவ்வகத்தை வரைவதன் 
மூலம் நிறைய ப�ொருட்களை தேர்வு 
செய்யலாம்.  Pick கருவி மூலம் 
நீங்கள் வரைந்த செவ்வகத்தால் 
சூழப்பட்டுள்ள ப�ொருட்கள் மட்டுமே 
தேர்வு செய்யப்படும்.

தேர்வு செய்யப்பட்ட 
ப�ொருளை சுற்றிலும் 

ஆறு கருப்பு சதுர 
கைப்பிடிகள் 

த�ோன்றுகின்றன

படம் 3.50  தேர்வு செய்யப்பட்ட ப�ொருளை 
சுற்றிலும் ஆறு கருப்பு சதுர கைப்பிடிகள் 

த�ோன்றுகின்றன

தேர்ந்தெடுக்க கீழ்கண்டவற்றை செய்யவும்
ஒரு ப�ொருளை தேர்வு செய்ய Pick கருவி க�ொண்டு ப�ொருளின் மீது கிளிக் செய்யவும்.
பல ப�ொருட்களை தேர்வு செய்ய Shift சாவியினை அழுத்தியவாறு தேர்வு செய்ய விரும்பும் 

ஒவ்வொரு ப�ொருளின் மீதும் கிளிக் செய்யவும்.
முதலில் உருவாக்கப்பட்ட ப�ொருள் த�ொடங்கி 
கடைசியாக உருவாக்கப்பட்ட ப�ொருள் ந�ோக்கி 
நகர்ந்து க�ொண்டே ஒரு ப�ொருளை தேர்வு 
செய்ய

நீங்கள் தேர்வு செய்ய விரும்பும் ப�ொருளை சுற்றிலும் 
தேர்ந்தெடுத்த பெட்டி (Selection box) த�ோன்றும் வரை 
Shift + Tab னை அழுத்தவும்.

கடைசியாக உருவாக்கப்பட்ட ப�ொருள் 
த�ொடங்கி முதலில் உருவாக்கப்பட்ட ப�ொருள் 
ந�ோக்கி நகர்ந்து க�ொண்டே ஒரு ப�ொருளை 
தேர்வு செய்ய

நீங்கள் தேர்வு செய்ய விரும்பும் ப�ொருளை சுற்றிலும் 
தேர்தெடுப்பு பெட்டி (Selection box) த�ோன்றும் வரை 
Tab-னை அழுத்தவும்.

XII CompTech_Tamil version CHAPTER 03.indd   121 12/01/2022   14:58:51

www.tntextbooks.in



பாடம் 03  க�ோரல்ட்ரா 2018122

தேர்ந்தெடுக்க கீழ்கண்டவற்றை செய்யவும்
அனைத்து ப�ொருட்களையும் தேர்வு செய்ய Edit > Select all > Objects தேர்வு செய்யவும்.
ஒரு த�ொகுதியிலுள்ள ஒரு ப�ொருளை தேர்வு 
செய்ய

Ctrl-னை அழுத்தியவாறு, Pick கருவியினை கிளிக் 
செய்து பின் த�ொகுதியிலுள்ள ப�ொருளை கிளிக் 
செய்யவும்.

பின்னலான த�ொகுதிக்குள் உள்ள ப�ொருளை 
தேர்வு செய்ய

Ctrl-னை அழுத்தியவாறும், Pick கருவியினை கிளிக் 
செய்து பின் நீங்கள் தேர்வு செய்ய விரும்பும் ப�ொருளை 
சுற்றிலும் தேர்ந்தெடுப்பு பெட்டி (Selection Box) த�ோன்றும் 
வரை ப�ொருளின் மீது கிளிக் செய்யவும்.

பிற ப�ொருட்களால் காட்சியிலிருந்து 
மறைக்கப்பட்ட ஒரு ப�ொருளை தேர்வு செய்ய

Alt –னை அழுத்தியவாறு, Pick கருவியினை 
கிளிக் செய்து, பின் நீங்கள் தேர்வு செய்ய விரும்பும் 
மறைக்கப்பட்ட ப�ொருளை சுற்றிலும் தேர்ந்தெடுப்பு பெட்டி 
(Selection box) த�ோன்றும் வரை எல்லாவற்றிற்கும் 
மேலுள்ள ப�ொருளை கிளிக் செய்யவும்.

பல மறைக்கப்பட்ட ப�ொருளை தேர்வு செய்ய Shift + Alt னை அழுத்தியவாறு, Pick கருவியினை 
கிளிக் செய்து பின் நீங்கள் தேர்வு செய்ய 
விரும்பும் மறைக்கப்பட்ட ப�ொருள்களை சுற்றிலும் 
தேர்ந்தெடுத்த பெட்டி (Selection box) த�ோன்றும் வரை 
எல்லாவற்றிற்கும் மேலுள்ள ப�ொருளை கிளிக் செய்யவும்.

ஒரு த�ொகுதியிலுள்ள மறைக்கப்பட்ட ஒரு 
ப�ொருளை தேர்வு செய்ய

Ctrl + Alt னை அழுத்தியவாறு, Pick கருவியினை 
கிளிக் செய்து பின் நீங்கள் தேர்வு செய்ய விரும்பும் 
மறைக்கப்பட்ட ப�ொருளை சுற்றிலும் தேர்ந்தெடுப்பு பெட்டி 
த�ோன்றும் வரை எல்லாவற்றிற்கும் மேலுள்ள ப�ொருளை 
கிளிக் செய்யவும். 

ப�ொருளின் தேர்வினை  நீக்குதல்  
(Deselecting objects)
ஒரு ப�ொருளின் தேர்வினை  நீக்க
●	 எல்லைக்கோடு (Outline) அல்லது 

உயர்த்தி காட்டுதல் பெட்டி (high lighting 
box) / குறிப்பான் (Marker) தவிர்த்து எங்கு 
வேண்டுமானாலும் கிளிக் செய்யலாம்.  
அதாவது வெற்றிடங்களில் (White 
spaces) கிளிக் செய்யவும்.

●	 ESC சாவியினை அழுத்தவும்.
●	 உயர்த்தி காட்டுதல் பெட்டி மறையும்.  இது 

எந்த ப�ொருளும் தேர்வு செய்யப்படவில்லை 
என்பதை குறிக்கின்றது.

பல ப�ொருட்களின் தேர்வினை நீக்குதல்:
●	 பல ப�ொருட்களின் தேர்வினை 

நீக்க ஏதாவது ஒரு வெற்றிடத்தில் 
ப�ொருட்களின் தேர்வு நீக்கப்பட்டு வரும்.

●	 ஒரு த�ொகுதியிலுள்ள ஒரு ப�ொருளின் 
தேர்வினை நீக்குதல்.

ஒரு குழுவிலுள்ள ஒரு ப�ொருளை தேர்வு 
செய்ததை நீக்குதல்.
பல தேர்வு செய்யப்பட்ட ப�ொருள்களில் ஒரு 
ப�ொருளை தேர்வு செய்ததை நீக்க Shift 
சாவியினை அழுத்தியவாறு ப�ொருளின் 
மீது கிளிக் செய்யவும்.

ப�ொருட்களை நகர்த்துதல்
ப�ொருட்களை நகர்த்த அதனை சுட்டி 
க�ொண்டு இழுத்து விடவும் அல்லது 
அவற்றை விசைப்பலகையிலுள்ள அம்புகுறி 
சாவிகளைக் க�ொண்டு தள்ளலாம் (Nudge)

சுட்டி க�ொண்டு ப�ொருட்களை நகர்த்துதல்
1.	 Pick கருவி க�ொண்டு தேவையான 

ப�ொருளை தேர்வு செய்யவும்.
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நகர்த்தும் ப�ொழுது சுட்டியின் வலது 
ப�ொத்தானை கிளிக் செய்யவும்.  
இப்பொழுது ஒரு நகலானது 
உருவாக்கப்படும்.  தற்பொழுது 
இழுக்கப்படும் ப�ொருளானது ஒரு 
நகலாக மாறும்.  மேலும் அசல் 
ப�ொருளானது எந்த மாற்றமுமின்றி 
அப்படியே இருக்கும்.  அம்புகுறியின் 
அருகிலுள்ள சிறிய + குறியீடு ஒரு 
நகலானது உருவாக்கப்பட்டுள்ளது 
என்பதை குறிக்கிறது.

குறிப்பு
வலது கிளிக் நுட்பத்தை பயன்படுத்தி ஒரு ப�ொருளை 
நகலெடுத்தல் என்பது நீங்கள் அந்த ப�ொருளை 
Pick கருவி க�ொண்டு வடிவத்தை மாற்றம் செய்யும் 
ப�ொழுது மட்டுமே பயன்படுத்த முடியும். 

Copy is being 
dragged.

படம் 3.53  வலது கிளிக் பயன்படுத்தி 
நகலெடுத்தல்

2.	 இடைவெளிபட்டை (SpaceBar) 
பயன்படுத்தி நகலெடுத்தல்

	 Pick கருவி க�ொண்டு ஒரு ப�ொருளின் 
வடிவத்தை மாற்றும் ப�ொழுது, சுழற்றும் 
ப�ொழுது அல்லது நகர்த்தும்பொழுது 
இடைவெளிப்பட்டை (Spacebar) 
யினை அழுத்தவும். இப்பொழுது 

2.	 ப�ொருளின் எல்லைக்கோடு 
பகுதியை சுட்டும் ப�ொழுது, சுட்டியை 
அழுத்தவும் அல்லது சுட்டியானது 
ப�ொருளின் நிரப்பட்ட பகுதியில் 
இருக்கும்பொழுது அழுத்தவும்.  
புள்ளிகளுடன் கூடிய உயர்த்தி 
காட்டு பெட்டி த�ோன்றும்.

3.	 இப்பொழுது அதனை தேவையான 
இடத்திற்கு நகர்த்தவும்.

4.	 ப�ொருளானது சரியான இடத்தில் 
வைத்தபிறகு சுட்டியை அழுத்துவதை 
விட்டு விடவும்.

படிப்படியாக தள்ளுவதன் மூலம் 
ப�ொருட்களை நகர்த்துல்
விசைப்பலகையிலுள்ள அம்பு குறி 
சாவிகளை க�ொண்டு நாம் தேர்வு செய்த 
ப�ொருட்களை சாவியின் மீதுள்ள அம்புகுறி 
காட்டும் திசையில் நகர்த்த அல்லது தள்ள 
முடியும்.

தள்ளுதல் (Nudge)
விசைப்பலகையிலுள்ள அம்புகுறி சாவிகளை 
பயன்படுத்தி தேர்வு செய்யப்பட்டதை படிப்படியாக 
நகர்த்தும் செயலே தள்ளுதல் (Nudge) எனப்படும்.

ப�ொருட்களை நகலெடுத்தல்
Edit பட்டியிலுள்ள Dupilicate அல்லது Clone 
கட்டளைகளை க�ொண்டு ப�ொருட்களை 
நகலெடுக்க முடியும்.  பிண்டோஸ் பிடி பலகை 
(Clipboard) யையும் நீங்கள் பயன்படுத்தலாம்.

நகலெடுத்தல் (Copying)
தேர்வு செய்யப்பட்ட ப�ொருட்களை 
நகலெடுக்க Corel Draw பல வழிகளை 
வழங்குகின்றது.

1.	 வலது கிளிக் பயன்படுத்தி 
நகலெடுத்தல்

	 Pick கருவி க�ொண்டு ஒரு 
ப�ொருளின் வடிவத்தை மாற்றும் 
ப�ொழுது, சுழற்றும் ப�ோது அல்லது 
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	 + சாவியை அழுத்திய பிறகு, 
உருவாகும் நகலானது தேர்வு 
செய்யப்பட்ட ப�ொருளாகிவிடும்.  
இதே முறையை பயன்படுத்தி 
நீங்கள் எத்தனை நகல்களை 
வேண்டுமானாலும் உருவாக்கலாம்.  
அதாவது உருவாக்கும் ஒவ்வொரு 
நகலும் அசல் ப�ொருளை (அல்லது 
நகல்) அதன் பின்னால் மறைக்கும் 
என்பதை கவனத்தில் க�ொள்ள 
வேண்டும்.

ப�ொருட்களை பிரதி எடுத்தல்  
(Duplication Objects)
தேர்வு செய்யப்பட்ட ப�ொருளை நகல் 
எடுத்தல்.

பட்டி பட்டையிலிருந்து Edit > 
Dupilicate என்பதை தேர்வு செய்யவும் 
அல்லது விசைப்பலகையில் Ctrl + D 
என்பதை அழுத்தவும்.

நகலானது அசல் ப�ொருளின் 
மேற்புற வலது புறத்திலிருந்து சற்று 
நகர்ந்து கீழ்கண்டவாறு த�ோன்றும்.  புதிய 
நகலானது தானாகவே தேர்வு செய்யப்பட்டு 
வரும்.

படம் 3.55  Edit பட்டியிலுள்ள Duplicate விருப்பம்

ஒரு நகல் உருவாகும். ஒவ்வொரு 
முறையும் இடைவெளி பட்டையை 
அழுத்தும் ப�ொழுது ஒரு நகலானது 
த�ோன்றும்.

	 இடைவெளி பட்டையை அழுத்தி 
பிடித்துக�ொண்டே இருக்கும் 
ப�ொழுது ப�ொளினுடைய பல 
நகல்கள் உருவாகிக்கொண்டே 
இருக்கும்.  இவ்வாறு இடைவெளி 
பட்டையை அழுத்தி க�ொண்டே 
இருப்பது விரைவாக அடுத்தடுத்து 
பல நகல்களை உருவாக்கும்.

	 படம் ஒவ்வொருமுறை இடைவெளி 
பட்டை அழுத்தும்பொழுது ஒரு 
நகலானது உருவாகும்

Each time the SPACEBAR is pressed, a 
copy is “dropped”.

படம் 3.54  இடைவெளிபட்டையை பயன்படுத்தல் 
ஒரு ப�ொருளை நகலெடுத்தல்

3.	 எண்வகை + சாவியினை 
அழுத்துவதன் மூலம் நகலெடுத்தல்

	 எண் வகை விசைப்பலகியிலுள்ள 
(Numeric Keypad) + சாவியினை 
அழுத்துவதன் மூலம் 
தேர்தெடுக்கப்பட்ட ப�ொருளுடைய 
நகலானது அதே இடத்தில் 
(ப�ொருளின் மீது அடுக்கி 
வைக்கப்படும்) அதாவது அசல் 
ப�ொருளின் மீது உருவாகும்.
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படம் 3.57  Edit பட்டியிலுள்ள Clone விருப்பம்

ப�ொருட்களை நீக்குதல் (Deleting Objects)
ஒரு ப�ொருளை நீக்க

1.	 ப�ொருளை தேர்வு செய்யவும்.
2.	 Edit>Delete என்பதை பட்டி 

பட்டையிலிருந்து தேர்வு செய்யவும் 
(அல்லது) விசைப்பலகையிலுள்ள Del 
/ Delete சாவியினை அழுத்தவும்.

	 நீக்கப்பட்ட ப�ொருளை மீண்டும் பெற, 
நீங்கள் Undo கட்டளை அல்லது 
Ctrl+Z னை பயன்படுத்த வேண்டும்.

ப�ொருட்களை குழுப்படுத்துதல் 
(Grouping and ungrouping object) 
மற்றும் குழுவாக்கத்தை நீக்குதல் Group 
Objects கட்டளை க�ொண்டு இரண்டு 
அல்லது அதற்கு மேற்பட்ட ப�ொருட்களை 
குழுவாகிடும் ப�ொழுது அவைகள் ஒரே 
அலகாக கருதப்படும்.

ஒரு குழு என்பது ஒரே அலகாக 
செயல்படும் அதாவது குழுவின் மீது 
செய்யப்படும் எந்த மாற்றங்களும் அந்த 
குழுவிலுள்ள அனைத்து ப�ொருட்களையும் 
பாதிக்கும்.

குழுவாக்கத்தை நீக்குதல் மூலம் 
குழுவாக்கப்பட்ட ப�ொருளை ப�ொருட்களின் 
கூறுகளாக பிரிக்கலாம்.  குழுவாக்கப்பட்ட 

படம் 3.56  ப�ொருளின் பிரதி

ப�ொருட்களை நகலி செய்தல்  
(Cloning Obejects)
தேர்வு செய்யப்பட்ட ப�ொருளின் நகலி 
(Clone) யை உருவாக்க Edit > Clone 
என்பதை பட்டி பட்டையிலிருந்து தேர்வு 
செய்யவும்.

நகலியானது அசல் ப�ொருளின் 
மேற்புற வலது புறத்திலிருந்து சற்று 
நகர்ந்து கீழ்கண்டவாறு த�ோன்றும்.  புதிய 
நகலானது தானாகவே தேர்வு செய்யப்பட்டு 
விடும்.

நகலி செய்தல் பிரதி எடுத்தலிருந்து 
வேறுபட்டதாகும்.  அசல் ப�ொருளின் மீது 
செய்யப்படும் அனைத்து மாற்றங்களும் 
நகலி மீதும் தானாகவே செயற்படுத்தப்படும்.

எடுத்துக்காட்டாக நீங்கள் அசல் 
ப�ொருளின் நிரப்பியை (Fill) மாற்றும் 
ப�ொழுது, நகலியினுடையட நிரப்பியும் 
மாறும்.
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2.	 பட்டி பட்டையிலிருந்து Object > 
Group > Ungroup Objects என்பதை 
தேர்வு செய்யவும் (அல்லது) 
விசைப்பலகையிலுள்ள Ctrl + U 
என்பதை அழுத்தவும் அல்லது 
Property பட்டையிலுள்ள Ungroup 
objects என்பதை கிளிக் செய்யவும்.

	 குழுவாக்கப்பட்ட ப�ொருளானது 
அதனுடைய ப�ொருட்களின் 
கூறுகளாக பிரியும்

படம் 3.59  ப�ொருள்களின் குழுவாக்கத்தை 
நீக்குதல்

தேர்வு செய்யப்பட்ட எந்த ப�ொருட்களையும் 
குழுவாக்க முடியும் இதனால் குழுக்களின் 
குழுவினை எளிதாக உருவாக்க முடியும்.  
குழுக்களுக்குள் உள்ள குழுக்கள் 
‘பின்னலான குழுக்கள்’ (nested group) 
என அழைக்கப்படும்.

பின்னலான குழுக்களின் குழுவாக்கத்தை 
நீக்குதல் (To ungroup a nested group)

1.	 Pick கருவி க�ொண்டு பின்னலான 
குழுவினை தேர்வு செய்யவும்.

2.	 பட்டி பட்டையிலிருந்து Object > 
Group > Ungroup All Objects னை 
தேர்வு செய்யவும்.  (அல்லது) Property 
பட்டையிலுள்ள Ungroup All Objects 
ப�ொத்தானை கிளிக் செய்யவும்.

ப�ொருளில் உள்ள சில குறிப்பிட்ட 
ப�ொருட்களில் மட்டும் மாற்றங்கள் 
செய்ய வேண்டியிருப்பின் இது மிகவும் 
பயனுள்ளதாக இருக்கும்.
குழு ப�ொருளை உருவாக்குதல்  
(To create a goup object)

1.	 Pick கருவி க�ொண்டு ப�ொருள்களை 
தேர்வு செய்யவும்.  (பல ப�ொருள்களை 
தேர்வு செய்ய Shift சாவியினை 
அழுத்தியவாறு தேர்வு செய்யவும்.

2.	 Object > Group > Group objects 
என்பதை தேர்வு செய்யவும் (அல்லது) 
Ctrl + G னை அழுத்தவும்.  தேர்வு 
செய்யப்பட்ட ப�ொருட்கள் ஒரே 
ப�ொருளாக குழுவாக்கப்படும்.

படம் 3.58  Object பட்டியிலுள்ள Group Objects 
விருப்பம்

குழுவாக்கத்தை நீக்குதல் (Ungrouping)
குழுவாக்கத்தை நீக்குதல் என்பது ஒரு 
குழுவிலுள்ள ப�ொருள்களுக்கிடையேயான 
உறவினை பிரிப்பதாகும்.

குழுவாக்கப்பட்ட ப�ொருளின் 
குழுவாக்கத்தை நீக்குதல்  
(To Ungroup a Group object)

1.	 Pick கருவி க�ொண்டு குழுவாக்கப்பட்ட 
ப�ொருளை தேர்வு செய்யவும்.
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2.	 Object > Combine கட்டளையை 
தேர்வு செய்யவும் (அல்லது) Ctrl + L 
னை அழுத்தவும்.  தேர்வு செய்யப்பட்ட 
ப�ொருள்கள் ஒரே ப�ொருளாக 
குழுவாக்கப்படும்.

Combine button

படம் 3.60  இரண்டு ப�ொருள்கள் (இடது) 
இணைக்கப்பட்டு ஒரு ப�ொருளை (வலது) 
உருவாக்குகின்றது.  இணைக்கப்படுவதற்கான 
முன் கடைசியாக தேர்வு செய்யப்பட்ட ப�ொருளின் 
பண்புகளை புதிய ப�ொருள் க�ொண்டிருக்கும்.

குறிப்பு
Ungroup Objects - ஒரு குழுவினை தனித்தனி 
ப�ொருள்களாக பிரிக்கின்றது அல்லது 
பின்னலான குழுவினை பல குழுக்களாக 
பிரிக்கின்றது.
Ungroup All Objects – ஒரு குழுவினை 
தனித்தனி ப�ொருள்களாக பிரிக்கின்றது மற்றும் 
பின்னலான குழுவிலுள்ள ப�ொருள்களையும் 
தனித்தனி ப�ொருள்களாக பிரிக்கின்றது.

ப�ொருட்களை இணைத்தல்
Combine கட்டளை மூலம் இரண்டு 
அல்லது அதற்கு மேற்பட்ட ப�ொருள்களை 
இணைக்க முடியும்.

Combine கட்டளை இரண்டு 
அல்லது அதற்கு மேற்பட்ட ப�ொருட்களை 
ஒரே ப�ொருளாக இணைக்கின்றது.  
இவ்வாறு இணைக்கப்பட்ட ப�ொருளானது 
ப�ொதுவான நிரப்பு மற்றும் எல்லை க�ோடு 
பண்புகூறுகளை க�ொண்டிருக்கும்.  
ப�ொருள்களை இணைத்தல் என்பது 
அவற்றை குழுவாக்குவதிலிருந்து 
வேறுபட்டதாகும்.  ப�ொருட்களை 
இணைத்தல் என்பது உண்மையில் 
இணைக்கப்பட்ட ப�ொருட்களின் வடிவத்தை 
மாற்றுவதாகும்.  இணைக்கப்பட்ட 
ப�ொருள்களை தனித்தனியாக பிரிக்க 
முடியும்.  இருப்பினும், ப�ொருட்களை 
அதன் முந்தைய வடிவம் மற்றும் நிரப்புக்கு 
மாற்றியமைக்க முடியாது.  ஆனால் 
ப�ொருட்கள் இணைக்கப்பட்ட பிறகு 
மேற்கொண்ட மாற்றங்களை தக்க வைக்க 
முடியும்.

ப�ொருட்களை இணைக்க  
(To Combine Objects)

1.	 Pick கருவி க�ொண்டு ப�ொருள்களை 
தேர்வு செய்யவும்.  (பல ப�ொருள்களை 
தேர்வு செய்ய, Shift சாவியினை 
அழுத்தியவாறு ப�ொருள்களை தேர்வு 
செய்யவும்)
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ப�ொருள்களை வெல்டிங்  
(Welding) செய்தல்
வெல்டிங் செய்வதன் மூலம் ஒழுங்கற்ற 
வடிவங்களை நீங்கள் உருவாக்க முடியும்.  
வெல்டிங் செய்யப்பட்ட ப�ொருட்கள் 
கடைசியாக தேர்வு செய்யப்பட்ட ப�ொருளின் 
எல்லைக�ோட்டினையும், நிரப்புதலையும் 
எடுத்து க�ொள்ளும்.  வெல்டிங் செய்யப்பட்ட 
ப�ொருட்களை மீண்டும் தனித்தனி 
ப�ொருட்களாக மாற்றியமைக்க Undo 
ப�ொத்தானை மட்டுமே பயன்படுத்த முடியும்.

Property பட்டை க�ொண்டு  
ப�ொருள்களை வெல்டிங் செய்ய

1.	 Pick கருவி க�ொண்டு (அல்லது) 
Shift சாவியினை அழுத்தியவாறு 
ப�ொருள்களை தேர்வு செய்யவும்.

2.	 Object > Shaping > Weld 
என்ற கட்டளையினை பட்டி 
பட்டையிலிருந்து தேர்வு செய்யவும் 
(அல்லது) Property பட்டையிலுள்ள 
Weld ப�ொத்தானை கிளிக் செய்யவும்.

3.	 ப�ொருள்கள் வெல்டிங் செய்யப்பட்டு, 
ஒரே எல்லைக�ோடு க�ொண்ட 
ப�ொருளாக மாறும்.

தேர்வு செய்யப்பட்ட ப�ொருள்களை 
Property பட்டையிலுள்ள Weldனை 
பயன்படுத்தி வெல்டிங் செய்யும் ப�ொழுது, 
வெல்டிங் செய்யப்பட்ட ப�ொருளானது 
மிக கீழே தேர்வு செய்யப்பட்ட ப�ொருளின் 
எல்லைகாடு மற்றும் நிரப்பு பண்புகளை 
எடுத்து க�ொள்ளும்.  பல தேர்வுகளை 
நீங்கள் பயன்படுத்தும் ப�ொழுது, வெல்டிங் 
செய்யப்பட்ட ப�ொருளானது நீங்கள் 
கடைசியாக தேர்வு செய்த செய்யப்பட்ட 
ப�ொருளானது நீங்கள் கடைசியாக தேர்வு 
செய்த ப�ொருளின் பண்புகளை எடுத்து 
க�ொள்ளும்.

இணைக்கப்ப்ட்ட ப�ொருளை  
வெவ்வேறாக பிரித்தல்

1.	 Pick கருவி க�ொண்டு இணைக்கப்பட்ட 
ப�ொருளை தேர்வு செய்யவும்.

2.	 Object > Break Curve Appart 
கட்டளையை தேர்வு செய்யவும். 
(அல்லது) Ctrl + K னை அழுத்தவும்.  
இணைக்கப்பட்ட ப�ொருளானது 
ப�ொருட்களின் கூறுகளாக 
வெவ்வேறாக பிரிக்கப்படும்.

Break apart button

படம் 3.61  Object பட்டியிலுள்ள Break Curve 
Aport விருப்பம்

ப�ொருட்கள் அதனுடைய பழைய 
நிரப்புதலுக்கு (Fill) மாற்றமுடியாது ஆனால் 

அவைகள் இணைக்கப்பட்ட ப�ொழுது 
செய்யப்பட்ட மாற்றங்கள் தக்க வைக்கப்படும்.

படம் 3.62  ப�ொருட்களின் கூறுகளாக 
வெவ்வேறாக பிரித்தல் (Breaking apart)

XII CompTech_Tamil version CHAPTER 03.indd   128 12/01/2022   14:58:53

www.tntextbooks.in



129பாடம் 03  க�ோரல்ட்ரா 2018

நீங்கள் உரையினை ஆவணத்தின் 
பக்கத்தில் நேரடியாகவ�ோ அல்லது 
உரைபெட்டி மூலம�ோ உள்ளீடு செய்ய 
முடியும்.  நீண்ட உரை த�ொகுதிகளுக்கு பத்தி 
உரையானது மிகவும் ப�ொருத்தமானதாகும்.  
எழுத்துகளுக்கு கலைத்திறன் க�ொண்ட 
விளைவுகளை சேர்க்க கலைத்திறனுள்ள 
உரை அதிக வசதிகளை வழங்குகின்றது.

கலைத்திறனுள்ள உரையினை  
சேர்த்தல் (Addingn Artistic Text)
பக்கத்தின் எந்த இடத்திலும் 
உரையினுடையட சிறு பகுதிகளை 
உருவாக்க கலைத்திறனுள்ள உரை 
உதவுகின்றது.  நீங்கள் அந்த உரைக்கு 
சிறப்பு விளைவுகளை உபய�ோகிக்கலாம் 
மற்றும் அதன் வடிவத்தை 
மாற்றியமைக்கலாம்.  உரையுடன் சிறப்பு 
விளைவுகளை உருவாக்கும் ப�ொழுது 
(எடுத்துக்காட்டாக உரையினை பாதையில் 
ப�ொருத்துதல் அல்லது கலத்தல் மற்றும் 
வெளியே தள்ளுதல் ப�ோன்ற) அதனை 
கலைத்திறனுள்ள உரையாக உள்ளீடு 
செய்ய வேண்டும்.
கலைத்திறனுள்ள உரையினை சேர்க்க

1.	 Text கருவியினை கிளிக் 
செய்ய வேண்டும்.  சுட்டியின் 
அம்புகுறியானது சிறிய A என மாறும்.

2.	 உங்கள் வரைபடத்தில் எங்கு 
உரை த�ோன்ற வேண்டும�ோ அந்த 
இடத்தில் சுட்டியை வைத்து கிளிக் 
செய்ய வேண்டும்.

3.	 செருகும் இடம் என அழைக்கப்படும் 
செங்குத்தான க�ோடு த�ோன்றும்.

4.	 உரையை தட்டச்சு செய்யவும்.
5.	 முடித்த பிறகு Pick கருவியினை 

கிளிக் செய்யவும்.
6.	 Pick கருவியினை நீங்கள் கிளிக் செய்யும் 

ப�ொழுது உங்கள் புதிய உரையானது 
எட்டு சிறிய சதுர கருப்பு கைப்பிடியுடன் 
(Handles) சூழப்பட்டிருக்கும்.

Weld Button

படம் 3.63  Object பட்டியிலுள்ள Weld விருப்பம்

படம் 3.64  வெல்டிங் செய்யப்பட்ட ப�ொருளானது 
கடைசியாக தேர்வு செய்யப்பட்ட ப�ொருளின் 

பண்புகளை எடுத்து க�ொள்ளும்.

11.  உரையுடன் வேலை செய்தல்
Corel draw உரையினை இரண்டு 
வழிகளில் வரையறுக்கின்றது.

1.	 கலைத்திறனுள்ள உரை (Artistic 
Text).

2.	 பத்தி உரை (Paragraph text)

XII CompTech_Tamil version CHAPTER 03.indd   129 12/01/2022   14:58:53

www.tntextbooks.in



பாடம் 03  க�ோரல்ட்ரா 2018130

நீங்கள் முழு த�ொகுதியையும் சட்டகத்தின் 
எல்லைக�ோட்டினை இழுப்பதன் மூலமும் 
அல்லது அதற்குள் உள்ள உரையினை 
Pick கருவி க�ொண்டு இழுப்பதன் மூலமும் 
நகர்த்த முடியும்.

பத்தி உரையின் சட்டகத்தின் 
கைப்பிடிகளை இழுப்பதன் மூலம் 
சட்டகத்தின் அளவு மாறும் ஆனால் அதனுள் 
உள்ள உரையின் அளவு மாறாது.
பத்தி உரையினை சேர்க்க

1.	 Text கருவியினை கிளிக் செய்யவும்.  
சுட்டியின் அம்புக்குறியானது சிறிய 
அளவு ‘A’ க�ொண்டதாக மாறும்.

2.	 சுட்டியின் அம்புகுறியினை பக்கத்தின் 
மீது எதிர் க�ோணத்தில் (Diagonally) 
ஒரு உரைபெட்டியினை வரைய 
இழுத்து விடவும்.

	 (சுட்டியின் இடது ப�ொத்தானை 
விடும்பொழுது விட்டு விட்டு மின்னும் 
செருகும் இடத்தை க�ொண்ட 
உரைபெட்டியானது திரையில் 
த�ோன்றும்).

3.	 இப்பொழுது உரையினை 
உரைபெட்டியில் தட்டச்சு செய்யவும்.  
முடித்தபிறகு Pick கருவியினை 
கிளிக் செய்யவும்.

Paragraph Text

படம் 3.66  ஆவணப் பக்கத்தில் பத்தி 
வரையினை சேர்த்தல்

Artistic Text

படம் 3.65  ஆவண பக்கத்தில் கலைத்திறனுள்ள 
உரையினை சேர்த்தல்

பத்தி உரையினை சேர்த்தல்  
(Adding Paragraph text)
பத்தி உரையானது விளம்பரத்திற்கு, சிற்றேடு 
(அ) பிரசுரங்கள் மற்றும் உரையினை 
அடிப்படையாக க�ொண்ட பயன்பாடுகள் 
பேன்றவற்றில் நீண்ட உரை த�ொகுதிகளை 
வடிவமைக்க உருவாக்கப்பட்டதாகும்.  
கலைத்திறனுள்ள உரையுடன் ஒப்பிடும் 
ப�ொழுது பத்தி உரையானது அதிக 
வடிவூட்டல் விருப்பங்களை வழங்குகின்றது.

எடுத்துக்காட்டாக நீங்கள் பத்தி 
உரையினை நெடுவரிசைகளாக, புல்லட் 
பட்டியல்களாக, த�ொகுதிகள் மற்றும் 
உள்தள்ளல் க�ொண்டவைகளாக மாற்ற 
முடியும்.

பத்தி உரையினை சேர்க்க, முதலில் 
நீங்கள் ஒரு சட்டத்தை (Frame) உருவாக்க 
வேண்டும்.  ஒரு தடவை உரையினை 
அந்த சட்டகத்திற்குள் வைத்த பிறகு 
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உரையினை பாதையில் ப�ொருத்துதல்
1.	 Pick கருவி மற்றும் Shift சாவி 

க�ொண்டு உரை ப�ொருளையும் 
மற்றும் இரண்டாவது ப�ொருளையும் 
தேர்வு செய்யவும்.

2.	 Text பட்டியிலிருந்து Fit + Text to path 
என்பதை தேர்வு செய்யவும்.

3.	 இரண்டாவது ப�ொருளின் பாதையின் 
வழி உரையானது மீண்டும் 
வரையப்படுகின்றது.

உரையினை சரியான இடத்தில் 
வைக்கும்பொழுது Delete கட்டளையினை 
க�ொண்டு பாதை ப�ொருளை (Path Object) 
நீங்கள் நீக்கலாம்.
பாதை ப�ொருளை (path Object) நீக்க

1.	 வடிவ (Shape) கருவியினை தேர்வு 
செய்து பாதை ப�ொருளின் மீது (Path 
object) கிளிக் செய்யவும்.

2.	 Pick கருவியினை தேர்வு செய்து 
பாதை ப�ொருளின் மீது கிளிக் 
செய்யவும்.

3.	 இப்பொழுது Delete சாவியினை 
அழுத்தவும்.  பாதை ப�ொருளானது 
நீக்கப்பட்டுவிடும்.

குறிப்பு
இன்னொரு எழுத்தின் மீது உரையினை 
ப�ொருத்த இலக்கு எழுத்தினை வளைந்த 
ப�ொருளாக (Curved Object) முதலில் நீங்கள் மாற்ற 
வேண்டும்.  இதற்கு Object பட்டியிலுள்ள Covert 
to curves என்ற கட்டளை பயன்படுகின்றது.

பாதையின் மீது நேரடியாக உரையினை 
உள்ளீடு செய்தல். (Entering Text Directly on 
to a path)
உரையினை வளைவு, செவ்வகம், 
நீள்வட்டம், வடிவங்கள் மற்றும் 
நட்சத்திரங்கள் ப�ோன்ற பலவகையான 
பாதைகளில் நேரடியாக உள்ளீடு செய்ய 
முடியும்.

வடிவ பாதையில் உரையினை 
ப�ொருத்துதல் (Fitting text to a path)
எந்த வடிவ பாதையிலும் உரை சரத்தை 
ப�ொருத்த Corel Draw அனுமதிக்கின்றது.  
அது நேர் அல்லது வளைந்த க�ோடு, ஒரு 
செவ்வகம், ஒரு நீள்வட்டம் அல்லது மற்றொரு 
எழுத்து அல்லது உரை சரம் என பல வடிவ 
பாதைகளாக இருக்கலாம்.  உரையினை 
பாதையில் ப�ொருத்துவதற்கு Text 
பட்டியிலிருந்து Fit text to path கட்டளையினை 
பயன்படுத்தவும்.  இந்த கட்டளையானது 
நீங்கள் உரை ப�ொருளையும் மற்றும் உரை 
அல்லாத ப�ொருளையும் ஒரே நேரத்தில் 
தேர்ந்தெடுக்கும் ப�ொழுது மட்டுமே 
கிடைக்கும்.

கீழ்க்கண்ட எடுத்துக்காட்டில் 
கட்டியுள்ளவாறு, இரண்டாவது ப�ொருளின் 
எல்லைக்கோட்டின் சுவட்டினை 
க�ொண்டு உரை சரமானது பாதையில் 
ப�ொருத்தப்பட்டுள்ளது.

Sta
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12.  பக்கத்தை அமைத்தல்
ஒவ்வொரு ஆவண பக்கத்திற்கும் 
அதற்கென்று தனியாக பக்க பண்புகள் 
உள்ளன.  ஆவணத்தின் தானமைவு 
அளவு, ஒற்றை வரி இடைவெளி, பக்க 
அளவு – Letter sized மற்றும் பக்க அமைவு 
– ப�ோர்ட்ரைட் (Portrait) ஆக இருக்கும்.  
ஆவணத்தின் தானமைவு அளவினை 
நீங்கள் மாற்ற விரும்பினால் இந்த 
பண்புகளில் எதை வேண்டுமானாலும் 
மாற்றி க�ொள்ளலாம்.

3 12. 1	 பக்கத்தின் அளவினை 
மாற்றுதல் (Changing page size)

பக்க அளவினை வரையறுக்க எளிதான 
வழி, வரையும் பரப்பின் வெற்று பகுதியில் 
கிளிக் செய்வதாகும்.  இவ்வாறு நீங்கள் 
செய்யும் ப�ொழுது பக்க அமைப்பு பண்பு 
பட்டை (Page layout property)களை 
இயங்கு நிலைக்கு மாறும்.  நீங்கள் இந்த 
பண்பு பட்டையை பயன்படுத்தி பக்கத்தின் 
அளவு, பக்கத்தின் அமைவு மற்றும் பிற 
பண்புகூறுகளை வரையறுக்க முடியும்.

பக்கத்தின் அளவினை மாற்றுதல்
1.	 ப�ொருளை தவிர்த்து வரையும் 

பரப்பில் ஏதேனும் ஒரு இடத்தில் 
கிளிக் செய்யவும்.

2.	 பண்பு பட்டையிலுள்ள பக்க அளவு 
பட்டியல் பெட்டியின் (Page size list 
box) கீழ்நோக்கிய அம்புகுறியை 
கிளிக் செய்யவும், பலவகையான 
பக்க அளவுகள் கீழ்விரி பட்டியலில் 
த�ோன்றும்.

3.	 நீங்கள் உங்கள் ஆவணத்திற்கு 
பயன்படுத்த விரும்பும் பக்க அளவின் 
மீது கிளிக் செய்யவும்.  நீங்கள் 
தேர்ந்தெடுத்த பக்க அளவானது 
உங்கள் ஆவணத்தின் மீது 
பயன்படுத்தப்படும்.

பாதையின் மீது நேரடியாக உரையினை 
உள்ளீடு செய்தல்

1.	 Pick கருவியினை பயன்படுத்தி 
பாதையினை தேர்வு செய்யவும்.

2.	 பட்டி பட்டையிலிருந்து Text > Fit Text 
to path என்பதை தேர்வு செய்யவும்.

3.	 உரையின் செருகுமிடத்தை இலக்கு 
வடிவத்தின் எல்லைக�ோட்டின் மீது 
நகர்த்தவும்.  அம்புகுறியானது Fit + 
text to path அம்புக்குறியாக மாறும்.

4.	 அதன் மீது கிளிக் செய்யவும்.
5.	 பாதையை ஒட்டி தட்டச்சு செய்யவும்.

Fit text to path pointer

படம் 3.67  Fit text to path அம்புகுறி

Type along the path.

படம் 3.68  பாதையை ஒட்டி தட்டச்சு செய்தல்
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3. 12. 2	 பக்கங்களை சேர்த்தல் (Inserting 
pages)

உங்கள் ஆவணத்திலுள்ள பக்கங்களை 
சேர்க்க, மாற்று பெயரிட மற்றும் நீக்க 
முடியும்.  உங்கள் ஆவணமானது மூன்று 
அல்லது அதற்கு மேற்பட்ட பக்கங்களை 
க�ொண்டிருப்பின், நீங்கள் த�ொடர்ச்சியான 
பக்கங்களை நீக்க முடியும்.
பக்கத்தை சேர்த்தல்

1.	 பட்டி பட்டையிலிருந்து Layout 
என்பதை கிளிக் செய்யவும்.

2.	 Insert Page மீது கிளிக் செய்யவும்.
3.	 Insert Page உரையாடல் பெட்டி 

த�ோன்றும்.
4.	 சேர்க்க வேண்டிய பக்கங்களின் 

எண்ணிக்கையை Insert page 
உரையாடல் பெட்டியில் தட்டச்சு 
செய்யவும்.

5.	 நடப்பு பக்கத்தை ப�ொறுத்து புதிய 
பக்கங்களை எங்கு சேர்க்க 
வேண்டும் என்பதை Before அல்லது 
After மீது கிளிக் செய்து குறிப்பிடவும்.

6.	 பல பக்கங்களை க�ொண்ட 
ஆவணங்களில், புதிய பக்க 
எண்ணை Existing Page பெட்டியில் 
தட்டச்சு செய்யவும்.  இது சார்ந்த 
பக்கத்தினை மாற்றுகின்றது.

	 Ok ப�ொத்தானை கிளிக் செய்யவும்.  
புதிய பக்கமானது உங்கள் 
ஆவணத்தில் சேர்க்கப்படும்.

படம் 3.71  Layout பட்டியிலுள்ள Insert page 
விருப்பம்

பக்க பரிமானங்கள் சூழல் பெட்டியினை 
(page dimensions spin box) பயன்படுத்தி 
பக்க அளவினை மாற்றுதல்.
பண்பு பட்டையிலுள்ள பக்க பரிமாணங்கள் 
சூழல் பெட்டியினை பயன்படுத்தி 
தனிப்பயன் பக்க அளவுகளை நீங்கள் 
வரையறுக்க முடியும்.

1.	 ப�ொருள் உள்ள இடத்தை தவிர்த்து, 
வரையும் பரப்பில் ஏதாவது ஒரு 
இடத்தில் கிளிக் செய்யவும்.

2.	 ஆவணத்திற்கு தேவையான அகலம் 
மற்றும் உயர அளவினை பக்க 
பரிமாணங்கள் சூழல் பெட்டிளில் 
தட்டச்சு செய்யவும்.

3.	 நீங்கள் குறிப்பிட்ட அகலம் மற்றும் 
உயர அளவிற்கு ஏற்றப்படி வரையும் 
பரப்பின் பக்க அளவு அமைக்கப்படும்.

Page type / size Current page

All pages

படம் 3.69  பக்க அளவினை மாற்றுதல்

Landscape

Portrait
Page dimensions  

spin boxes

படம் 3.70  பக்க பரிணாமங்கள் சூழல் 
பெட்டியினை பயன்படுத்தி பக்க அளவினை 

மாற்றுதல்
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படம் 3.73  Layout பட்டியிலுள்ள Rename Page 
விருப்பம்.

படம் 3.74  Rename page உரையாடல் பெட்டி

Page 3 is renamed 
as Line Art.

படம் 3.75 

படம் 3.72  Insert Page உரையாடல் பெட்டி

பக்கத்திற்கு மாற்று பெயரிடுதல்  
(Renaming a page)
உங்கள் ஆவணம் பல பக்கங்களை 
க�ொண்டதாக இருக்கலாம்.  ஒவ்வொரு 
பக்கத்திற்கும் தானமைவாக Page1, 
Page 2 என பெயர் ஒதுக்கப்படும்.  Page1 
என்ற பக்கத்தின் பெயரினை கிடைமட்ட 
உருளல் பட்டைக்கு (horizontal scroll bar) 
அருகில் காணலாம்.

இந்த பக்கத்தின் பெயருக்கும் 
நீங்கள் சேமித்த ஆவணத்தின் பெயருக்கும் 
அல்லது க�ோப்பின் பெயருக்கும் எந்த 
சம்பந்தமும் இல்லை.  நீங்கள் இந்த பக்க 
பெயர்களை அர்த்தமுள்ள பெயராக மாற்ற 
முடியும்.

பக்கத்திற்கு மாற்று பெயரிட
1.	 Layout என்பதை கிளிக் செய்யவும்.  

Layout பட்டி த�ோன்றும்.
2.	 Rename page என்பதை கிளிக் 

செய்யவும்.  Rename page 
உரையாடல் பெட்டி த�ோன்றும்.

3.	 பக்கத்தின் பெயரை Page name 
பெட்டியில் தட்டச்சு செய்யவும்.

4.	 Ok ப�ொத்தானை கிளிக் செய்யவும்.  
பக்கத்தின் பெயரானது இப்பொழுது 
மாற்றப்பட்டிருக்கும்.
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9.	 கடைசி பக்கத்தின் எண்ணை 
through to page தேர்வு பெட்டிக்கு 
அருகிலுள்ள பெட்டியில் தட்டச்சு 
செய்யவும்.

10.	Ok ப�ொத்தானை கிளிக் செய்யவும்.

படம் 3.76  Layout பட்டியிலுள்ள Delete page 
விருப்பம்

படம் 3.77  Delete page உரையாடல் பெட்டி

பக்கத்தினை நீக்குதல் (Deleting a page)
சில நேரங்களில் நீங்கள் உங்கள் 
ஆவணத்திலிருந்து ஒரு குறிப்பிட்ட 
பக்கத்தை நீக்க விரும்பலாம்.  இதனை 
உங்கள் ஆவணத்திலிருந்து பக்கங்களை 
நீக்குவதன் மூலம் செய்யலாம்.  நீங்கள் 
மூன்று பக்கங்களுக்கு மேலுள்ள பல பக்க 
ஆவணங்களில் வேலை செய்யும் ப�ொழுது, 
உங்களால் த�ொடர்ச்சியான பக்கங்களை 
நீக்க முடியும்.

ஒரு பக்கத்தை நீக்க
1.	 Layout மீது கிளிக் செய்யவும்.  Layout 

பட்டி த�ோன்றும்.
2.	 Delete Page மீது கிளிக் செய்யவும்.
3.	 Delete Page உரையாடல் பெட்டி 

த�ோன்றும்.
4.	 நீங்கள் நீக்க விரும்பும் பக்க 

எண்ணினை Delete page பெட்டியில் 
தட்டச்சு செய்யவும்.

5.	 Ok ப�ொத்தானை கிளிக் செய்யவும்.
6.	 அந்த பக்கமானது நீக்க பட்டிருக்கும்.
7.	 நீங்கள் பல பக்கங்களை அல்லது 

த�ொடர்ச்சியான பக்கங்களை நீக்க 
வேண்டியிருந்தால் முதல் பக்கத்தின் 
எண்ணை Delete page பெட்டியில் 
தட்டச்சு செய்யவும்.

8.	 Through to page என்ற தேர்வு 
பெட்டியினை கிளிக் செய்து 
தேர்ந்தெடுக்கவும்.

நினைவில் க�ொள்க

●	 Corel Draw என்பது பல்துறை வரைகலை பயன்பாடாகும்.  இது உயர் தர வெக்டர் 
விளக்கப்படங்கள், சின்னம் வடிவமைத்தல், பக்கம் வடிவமைத்தல் ஆகியவற்றை 
உருவாக்குகின்றது.

●	 வெக்டர் வரைகலையானது (Vector graphics) க�ோடுகள் மற்றும் வளைவுகள் க�ொண்டு 
உருவாக்கப்படுகின்றது.  இவைகள் கணிதத்திற்குரிய விளக்கங்களை க�ொண்டு 
உருவாக்கப்படுகின்றன.  இவ்வகையான வரைகலையானது சின்னங்கள் மற்றும் 
விளக்கப்படங்கள் (Logos and illustrations) ஆகியவற்றிற்கு ஏற்றவை ஆகும்.
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●	 பிட்மேப்ஸ் (Bitmaps) என்பது செவ்வகப்படம் (Raster images) என அழைக்கப்படுகின்றது.  இது 
பட புள்ளிகள் (Pixels) என அழைக்கப்படும் சிறிய சதுரங்களை க�ொண்டு உருவாக்கப்படுகின்றது.

●	 டாக்கர் (docker) என்பது குறிப்பிட்ட கருவி அல்லது பணிக்கான கட்டளைகள் மற்றும் 
அமைப்புகளை க�ொண்ட ஒரு சன்னல் திரையாகும்.

●	 Flyout என்பது த�ொடர்புடைய கருவிகள் அல்லது பட்டி தேர்வுகளின் த�ொகுதியினை திறக்கும் 
ஒரு ப�ொத்தானாகும்.

●	 கருவி பெட்டி (tool box) ப�ொத்தானின் கீழ்புறம் வலது மூலையிலுள்ள சிறிய அம்புகுறியானது.  
இந்த கருவி flyout-னை சார்ந்தது என்பதை குறிக்கின்றது.

●	 இரண்டு வகையான சுருள்கள் உள்ளன.  அவை 1. சமச்சீர் சுருள் (Symmetrical Spiral) 2. 
மடக்கை சுருள் (Logarithmic spiral).

●	 சமச்சீர் சுருளானது (Symmetrical Spiral).  சமமாக விரிவடைகின்றது.  ஆதனால் ஒவ்வொரு 
சுழற்சிக்கும் இடையேயான தூரமும் சமமாக இருக்கும்.

●	 மடக்கை சுருளானது (Logarithmic Spiral) சுழற்சிகளுக்கிடையே அதிகரிக்கும் அதிக தூரத்துடன் 
விரிவடைகின்றது.

●	 ஒரு கட்டம் (grid) என்பது செவ்வகங்களை க�ொண்ட த�ொகுப்பாகும்.  இதனை தனித்தனியாக 
பிரிக்க முடியும்.

●	 வண்ணத்தட்டில் (palette) நீங்கள் காணும் சிறிய சதுர வடிவிலான நிறம் wells என 
குறிப்பிடப்படுகின்றது.

●	 Corel Draw உரையினை இரு வழிகளில் வரையறுக்கின்றது.  கலைத்திறனுள்ள உரை 
மற்றும் பத்தி உரை.  நீங்கள் உரையினை நேரடியாக ஆவண பக்கத்தில�ோ அல்லது உரை 
பெட்டி மூலம�ோ உள்ளிட முடியும்.  பத்தி உரையானது நீண்ட உரை த�ொகுதிகளுக்கு மிகச் 
சரியாக ப�ொருந்தும்.  அதே சமயத்தில் கலைத்திறனுள்ள உரையானது எழுத்துக்களுக்கு 
கலைத்திறன் க�ொண்ட விளைவுகளை சேர்க்க அதிக வசதிகளை வழங்குகின்றது.

வினாக்கள்
பகுதி – அ 
	 I. 	�ச ரியான விடையைத் தேர்ந்தெடுத்து எழுதுக

1.	 _________ என்பது ஒரு வெக்டர் வரைகலை பயன்பாடாகும்.
	 அ) Pagemaker	 ஆ) photoshop	 இ) Corel Draw	 ஈ) Ms Word
2.	 வெக்டார் வரைகலையானது _________ க�ொண்டு உருவாக்கப்படுகின்ற.
	 அ) க�ோடுகள் மற்றும் வளைவுகள்	 ஆ) க�ோடுகள் மட்டும்
	 இ) படப்புள்ளி	 ஈ) இவையேதுமில்லை
3.	 _________ என்பவை செவ்வகப்படம் (raster image) என அழைக்கப்படுகின்றன.
	 அ) வெக்டார் வரைகலை	 ஆ) பிட்மேப்ஸ்
	 இ) க�ோடுகள்	 ஈ) இவையேதுமில்லை
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13.	_________ சாவி சர்மானம் தேர்வு 
செய்யப்பட்டட ப�ொருளின் பிரதியினை 
உருவாக்க உதவுகின்றது.

	 அ) Ctrl +D	 ஆ) Ctrl + C
	 இ) Ctrl + S	 ஈ) Ctrl + A
14.	இணைக்கப்பட்ட ப�ொருளினை 

தனித்தனியே பிரிக்க _________
னை அழுத்தவும்.

	 அ) Ctrl + K	 ஆ) Ctrl + C
	 இ) Ctrl + S	 ஈ) Ctrl + A
15.	இரண்டு அல்லது அதற்கு மேற்பட்ட 

ப�ொருட்களை இணைக்க _______
னை அழுத்தவும்.

	 அ) Ctrl + D	 ஆ) Ctrl + L
	 இ) Ctrl + S	 ஈ) Ctrl + A

பகுதி – ஆ 
II.	   �மூன்று வரிகளில் விடையளிக்கவும்  

1.	 Corel Draw எதற்காக 
பயன்படுத்தப்படுகின்றது?

2.	 Corel Drawவில் ஒரு புதிய 
ஆவணத்தை உருவாக்க 
படிநிலைகளை எழுதுக.

3.	 Corel Drawவில் டாக்கர் (Docker) 
என்றால் என்ன?

4.	 Corel Draw வினை த�ொடங்குவதற்கு 
என படிநிலைகளை எழுதுக.

5.	 Corel Draw வில் ஒரு ப�ொருள் 
என்றால் என்ன?

6.	 Corel Draw வில் பண்பு பட்டை 
(Property Bar) என்றால் என்ன?

7.	 Corel Draw வில் ரூலர் (Ruler) ஏன் 
பயன்படுத்தப்படுகின்றது.

8.	 Corel Draw வில் கலைத்திறனுள்ள 
ஊடக கருவி (Artistic Media tool) 
ஏன் பயன்படுத்தப்படுகின்றது?

9.	 ப�ொருட்களை குழுவாக்க 
படிநிலைகளை எழுதுக.

10.	குழுவாக்கப்பட்ட ப�ொருளின் 
குழுவாக்கத்தை நீக்க படிநிலைகளை 
எழுதுக.

4.	 _________ னை பயன்படுத்தி 
நீங்கள் வெக்டார் வரைகலையினை 
உருவாக்க முடியும்.

	 அ) Page Maker	 ஆ) Potoshop
	 இ) Corel Draw	 ஈ) MS-Word
5.	 செந்தர கருவிப்பட்டைக்கு (Stadard 

toolbar) அடுத்திருப்பது _________.
	 அ) பண்பு பட்டை
	 ஆ) தலைப்பு பட்டை
	 இ) பட்டி பட்டை
	 ஈ) நிலைமை பட்டை
6.	 எந்த கருவி ஒரு ப�ொருளினை தேர்வு 

செய்ய உதவுகின்றது?
	 அ) shape கருவி
	 ஆ) zoom கருவி
	 இ) Pick கருவி	
	 ஈ) Crop கருவி
7.	 வட்டத்தை வரைய அந்த கருவி 

உதவுகின்றது.
	 அ) Shape கருவி
	 ஆ) Ellipse கருவி
	 இ) Rectangle கருவி
	 ஈ) Crop கருவி
8.	 எத்தனை வகை சுருள்கள் உள்ளன?
	 அ) 5	 ஆ) 3	 இ) 2	 ஈ) 7
9.	 _________ சாவியானது Freehand 

கருவியினை தேர்வு செய்ய 
உதவுகின்றது.

	 அ) F2	 ஆ) F3	 இ) F4	 ஈ) F5
10.	Corel Drawவில் ஒரு ஆவணத்தை 

மூட _________ னை அழுத்த 
வேண்டும்.

	 அ) Ctrl + F4	 ஆ) Ctrl + F3
	 இ) Shift + F4	 ஈ) Alt + F4
12.	_________ சாவி ஒரு ப�ொருளை 

தேர்வு செய்ததை நீக்க உதவுகின்றது.
	 அ) ESC	 ஆ) Ctrl
	 இ) Shift	 ஈ) Delete
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9.	 ப�ொருட்களின் பிரதி மற்றும் 
ப�ொருட்களின் நகலியினை எவ்வாறு 
உருவாக்குவாய்?  இரண்டிற்கும் 
உள்ள வேறுபாட்டை எழுதவும்.

10.	ப�ொருள்களை வெல்டிங் 
செய்வதன் மூலம் என்ன பெற 
முடியும்?  ப�ொருள்களை வெல்டிங் 
செய்வதற்கான படிநிலைகளை 
எழுதுக.

பகுதி – ஈ 
IV.	  �ஒரு பக்க அளவில் 

விடையளிக்கவும்
1.	 சுருளினை (Spiral) வரைய 

படிநிலைகளை எழுதுக.
2.	 பலக�ோணங்களை (Polygon) யை 

படிநிலைகளை எழுதுக.
3.	 Corel Draw வில் எவ்வாறு ஒரு 

நட்சத்திரத்தை உருவாக்குவாய்?
4.	 கட்டங்களை (Grid) வரைய 

படிநிலைகளை எழுதுக.
5.	 பாதையில் உரையினை 

ப�ொருத்துதல் பற்றி விரிவாக எழுது.

பகுதி – இ 
III.  	� ஒரு பத்தியளவில் 

விடையளிக்கவும்  
1.	 வெக்டார் வரைகலைக்கும் 

பிட்மேப்ஸ் (Bitmaps) க்கும் இடையே 
உள்ள வேறுபாடுகள் யாவை?

2.	 Corel Draw வில் ஒரு செவ்வகத்தை 
வரைவதற்கு படிநிலைகளை 
எழுதுக.

3.	 Corel Draw வில் வட்டத்தை வரைய 
படிநிலைகளை எழுதுக.

4.	 இரண்டு வகையான சுருள்கள் 
என்பவை என்ன? விளக்குக.

5.	 Flyoutனுடைய எந்த கருவியானது 
நட்சத்திர கருவியினை 
க�ொண்டிருக்கும்?

6.	 Corel Draw வில் பிழைகளை சரி 
செய்ய என்ன செய்ய வேண்டும்?  
அதனை செய்வதற்கான 
விசைப்பலகை குறுக்கு வழி என்ன?

7.	 ஒரு க�ோட்டினை அம்புகுறியாக 
மாற்றுவதற்கு நீங்கள் என்ன 
செய்வீர்கள்?

8.	 ஒரு ப�ொருளுக்கு நிரப்பு 
வண்ணத்தையும் மற்றும் 
எல்லைக�ோட்டின் வண்ணத்தையும் 
எவ்வாறு குறிப்பிடுவாய்?

மாணவர் செயல்பாடு

●	 CorelDRAW வினை பயன்படுத்தி உங்களிடமுள்ள புகைப்படங்களை ஆக்கத்திறனுள்ள 
வழியில் இணைத்து வடிவமைக்கவும்.

●	 CorelDRAW னை பயன்படுத்தி உங்களுக்கு பிடித்த ப�ொருளின் செய்திதாள் 
விளம்பரத்தை உருவாக்கவும்.
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04பாடம்

பல்லூடகம் மற்றும் கணிப்பொறிப் பதிப்பகம்

 கற்றலின் ந�ோக்கங்கள்
●	 பல்லூடக சூழல்கள் முழுவதிலும் பயன்படுத்தக்கூடிய கருத்துருக்கள், நுட்பங்கள் மற்றும் 

செயல்முறைகள் ஆகியவற்றை மாணவர்கள் இந்த பாடத்தில் கற்றுக் க�ொள்வார்கள்.
●	 பல்லூடகக் கருவியான வரைகலை வழங்குதலை (Graphics Presentation) புரிந்து 

க�ொள்ளும் திறனைப் பெறுதல்
●	 வரைகலையைத் தருவித்தல் (Import Graphics), பல்வேறு கருவிகளைப் பயன்படுத்தி 

ப�ொருள்களை உருவாக்குதல், ப�ொருள்களுக்கு விளைவுகளைச் சேர்த்தல்.
●	 பல்வேறு பல்லூடக ஒலி மற்றும் ஒளி க�ோப்பு வடிவங்களைத் தெரிந்து க�ொள்ளுதல்.
●	 பல்லூடகத்தை உருவாக்கும் முறை மற்றும் அவர்களின் குழு நடவடிக்கைகள் பற்றிப் 

புரிந்து க�ொள்ளுதல்.

4.1  பல்லூடகம் – ஓர் அறிமுகம்
பல்வேறு வளங்களான நிழற் படம், 
உரை வரைகலை, ஒலி மற்றும் ஒளி 
ஆகியவற்றை ஒரு தளத்தில் இருந்து 
மற்றொரு தளத்திற்கு பயனர்கள் 
தரவை இணைத்து மாற்ற பல்லூடகம் 
அனுமதிக்கிறது.  தகவல்துறையில் 
பல்லூடகம் சமீபத்திய செறிவூட்டும் 
அனுபவமாக மாறி வருகிறது.  கடந்த பத்து 
ஆண்டுகளில் கணினி த�ொழில்நுட்பத்தின் 
வேகமான வளர்ச்சியானது கணக்கீடு, 
ப�ொழுதுப�ோக்கு மற்றும் கல்வி 
ஆகியவற்றின் மீது பெரும் மாற்றங்களைக் 
க�ொண்டு வந்துள்ளது.
கணினிமயமான துறையில் பெரிய 
சவால்கள் மற்றும் வாய்ப்புகளுடன் 
பல்லூடக த�ொழில்நுட்பங்கள் மற்றும் 

பயன்பாடுகளின் தனி வளர்ச்சி 
வழங்கப்பட்டுள்ளது. அதன் பயன்கள் 
மற்றும் பயன்பாடுகளின் அடிப்படையில், 
பயனர்களிடையே பல்லூடகம் மிகவும் 
பிரபலமாகி வருகிறது. பயனர்களுக்கு 
தகவல் வழங்கும் அடிப்படையில், பல்லூடக 
பயன்பாடுகள் முக்கிய பங்கு வசிக்கிறது.

படம் 4.1  பல்லூடகம் – ஓர் அறிமுகம்
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இது ஆகும்.  நிழற்படம், ஒலி, ஒளி மற்றும் 
வரைகலை ஆகியவற்றை பல்லூடகம் 
உள்ளடக்கியது என்றப�ோதிலும், 
பல்லூடகத்தில் பயன்படுத்தக் கூடிய 
அடிப்படைக் கூறு உரை ஆகும்.

படம் 4.3  உரை

நிலையான உரை (Static text)
ஒரு தலைப்பில�ோ அல்லது ஒரு வரியில�ோ 
அல்லது ஒரு பத்தியில�ோ, உரை அல்லது 
ச�ொல் மாறாமல் இருந்தால் அது நிலையான 
உரை ஆகும்.  படங்களை விளக்குவதற்கு 
படத்தோடு உரையும் க�ொடுக்கப்படுகிறது.  
நிலையான உரையில், ச�ொற்கள் 
தகவலை வழங்கும்.  அல்லது நிழற்படம் 
அல்லது ஒளிக்காட்சியை ஆதரிக்கிறது.

படம் 4.4  நிலையான உரை

மீ உரை (hypertext)
மீவுரை என்பது முனையம், உரை 
மற்றும் முனையங்களுக்கிடையேயான 
இணைப்பு ஆகியவற்றைக் 
க�ொண்டிருக்கும் அமைப்பாகும்.  இது 

4.2  பல்லூடக வரையறை
பல்லூடகம் (Multimedia) என்னும் ச�ொல் 
‘பல’ (Multi) மற்றும் ’ஊடகம்’ (Media) என 
இரண்டு ச�ொற்களை உள்ளடக்கியது.  
அதாவது, ஊடகங்களின் பல வடிவங்களை 
ஒன்றாக இணைக்கிறது.  சேமித்தல், 
தகவல் த�ொடர்பு, வழங்கல் மற்றும் உரை, 
ஒளி, நிழற்படம், வரைகலை மற்றும் 
ஒலி ஆகியவற்றின் உள்ளீடு / வெளியீடு 
ஊடாடுதல் ப�ோன்ற சேவைகளையும் 
வழங்குகிறது.
‘பல்லூடகம்’ என்ற கூறு இரண்டு 
ச�ொற்களைக் க�ொண்டுள்ளது.  ‘Multi’ 
மற்றும் ‘Medium’.  ‘Multi’ என்பது ‘பல’ எனக் 
குறிக்கப்படும்.  அதாவது இரண்டு அல்லது 
அதற்கு மேற்பட்டது ஆகும். ‘Media’ என்பது 
உரை, வரைகலை, நிழற் படம், ஒலி 
அசைவூட்டல் மற்றும் ஒளி ஆகிய பல வகை 
ஊடகங்களை ஒரே ஊடகத்தில் ஒரே 
தகவல் த�ொகுப்பில் ஒன்றிணைக்கிறது.

4.3  பல்லூடகத்தின் கூறுகள்
பல்லூடகம் உரை, நிழற்படம், ஒலி, 
ஒளி மற்றும் அசைவூட்டல் ஆகிய ஐந்து 
முக்கியக் கூறுகளைக் க�ொண்டுள்ளது.  
அவற்றைப் பற்றி கீழே விளக்கமாகக் 
க�ொடுக்கப்பட்டுள்ளது.

படம் 4.2  பல்லூடகத்தின் கூறுகள்

4. 3. 1	 உரை
பல்லூடகத்தின் அடிப்படைக் கூறு உரை 
ஆகும்.  மற்ற பிற நபர்களுடன் தகவல் 
த�ொடர்பிற்கான மிகவும் ப�ொதுவான வழி 
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வெக்டர் படங்கள் (Vector images) என 
இரு வகையில் உருவாக்கலாம்.

பிட்மேப் அல்லது செவ்வக படங்கள் (Bit map 
or Raster image)
கணினியில் படங்களைச் சேமிக்கும் 
ப�ொதுவான மற்றும் பரந்த வடிவம் பிட்மேப் 
அல்லது செவ்வக படமாகும்.  பிட்மேப் என்பது 
படப்புள்ளி (pixel) என்றழைக்கப்படும் 
சிறிய புள்ளிகளின் எளிய அணியாகும் 
(matrix).  இது செவ்வகப் படத்தை 
அல்லது பிட்மேப்பை வடிவமைக்கிறது.  
ஒவ்வொரு படப்புள்ளியும் இரண்டு 
அல்லது அதற்குமேற்பட்ட நிறங்களைக் 
க�ொண்டுள்ளது.  பிட்டுகளில் எவ்வளவு தரவு 
என்பதன் அடிப்படையைப் பயன்படுத்தி 
நிறங்களின் எண்ணிக்கையைத் 
தீர்மானித்து, நிறத்தின் ஆழத்தைத் 
தீர்மானிக்கலாம்.  எ.கா. ஒரு பிட்டுக்கு 
இரண்டு நிறங்கள், நான்கு பிட்டுகள் 
என்றால் பதினாறு நிறங்கள், எட்டு பிட்டுகள் 
என்றால் 256 நிறங்கள் மற்றும் பல.

வெக்டர் படங்கள் (Vector images)
வரையும் கூறுகளான அல்லது 
ப�ொருள்களான வரிகள், செவ்வகங்கள், 
வட்டங்கள் மற்றும் பல படங்களை 
உருவாக்குவது வெக்டர் படங்களின் 
அடிப்படையில் அமையும்.  படத்தைக் 
குறிக்க ஒப்பீட்டளவில் (Relatively) 
சிறிதளவு தரவு தேவைப்படும்.  அதன்மூலம் 

த�ொடர் வரிசையற்ற முறையில், 
உரையை அணுகுவதற்கு பயனர் 
பின்பற்ற தேவையான பாதையை (path) 
வரையறுக்கும்.  வேலை அமைப்பின் 
எழுத்தாளரே இந்த அமைப்பை 
உருவாக்கியவர் ஆவார்.  மிகவும் 
அதிநவீன மீவுரை அமைப்பில் தங்களின் 
ச�ொந்த பாதைகளை வரையறுக்க 
பயனருக்கு அனுமதியளிக்கிறது.  
மீவுரையில் கடந்து செல்ல பயனருக்கு 
நெகிழ்வுத்தன்மையையும் மற்றும் 
தேர்ந்தெடுப்பையும் (Choice) 
வழங்குகிறது.  பல்லூடகப் ப�ொருளில், 
தகவலைத் தெரிவிப்பதற்காக உரை 
பயன்படுகிறது.  நன்கு வடிவமைக்கப்பட்ட 
வாக்கியங்களையும், பத்திகளையும் 
பெறுவதற்காக உரையை ப�ொருத்தமான 
இடத்தில் வைக்க வேண்டும்.  
உரையின் வாசிப்புத்தன்மை உரையின் 
இடைவெளி மற்றும் நிறுத்தற்குறிகளைப் 
ப�ொறுத்ததாகும்.  மேம்படுத்தப்பட்ட 
எழுத்துருகள் மற்றும் பாணிகளுடன் 
(Styles) செய்தி த�ொடர்பு மிகவும் 
ப�ொருத்தமானதாகும்.

4. 3. 2	 படம் (Image)
பல்லூடகத்தில் படங்கள் முக்கியக் கூறாக 
செயல்படுகின்றன.  கணினியில் இந்த 
படங்களை பிட் மேப் (bitmap) அல்லது 
செவ்வக படம் (raster images) மற்றும் 

படம் 4.5  மீ உரை
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இருத்தல் வேண்டும்.  அசைவூட்டல் 
இரு அல்லது முப்பரிமாணங்களைக் 
க�ொண்டது.  திரையில் X மற்றும் Y 
அச்சுகளுக்கிடையேயான பரப்பில் இரு 
பரிமாண அசைவூட்டல் நிழற்படத்தை 
உயிர�ோட்டமாக க�ொண்டு வருகிறது.  
முப்பரிமாண அசைவூட்டத்தில் X, Y மற்றும் 
Z ஆகிய மூன்று அச்சுகளுக்கிடையே 
உயிர�ோட்டம் நடைபெறுகிறது.  
அசைவூட்டல் கருவிகள் மிகவும் 
சக்திவாய்ந்தவை மற்றும் திறமை 
வாய்ந்தவை ஆகும்.  இரண்டு வகையான 
அசைவூட்டல்களாவன:
பாதை அசைவூட்டல் (path animation) 
மற்றும் சட்டகம் அசைவூட்டல் (Frame 
animation).

பாதை அசைவூட்டல்
மாறாத பின்னணியைக் க�ொண்ட 
திரையில் ஒரு ப�ொருளை நகர்த்துவதை 
உள்ளடக்கியது பாதை அசைவூட்டல் 
ஆகும்.  எ.கா. பின்னணி அல்லது 
கதாபாத்திரத்தில் ஏதேனும் மாற்றங்களை 
செய்தாலும் தனை ப�ொருட்படுத்தாமல் 
கேலிச்சித்திர கதாபாத்திரம் திரை 
முழுவதும் நகர்த்தப்படும்.

படம் 4.7  அசைவூட்டல்

சட்டக அசைவூட்டல்
இந்த அசைவூட்டலில், பல ப�ொருட்கள் ஒரே 
சமயத்தில் நகர்வதற்கு அனுமதிக்கிறது 
மற்றும் பின்னணி அல்லது ப�ொருள்களும் 
மாறுகிறது.

படத்தைச் சேமிக்க குறைந்த அளவு 
நினைவகம் தேவைப்படும்.  இதுவே 
அதன் நன்மையாகும்.  குறுக்க 
நுட்பம் (Compression technique) 
படங்களின் க�ோப்பு அளவை குறைக்கப் 
பயன்படுகிறது.  அதாவது அதிக 
எண்ணிக்கையில் படங்களைச் 
சேமிக்கவும் வலைப்பின்னலிலுள்ள 
பயன்பாடுகளுக்கிடையே பரிமாற்றத்தை 
வேகப்படுத்தவும் பயன்படுகிறது.  இந்த 
ந�ோக்கத்திற்காக பயன்படுத்தப்படும் 
பல்வேறு குறுக்க வடிவமைப்புகாளவன:

GIF, TIFF மற்றும் JPEG

படம் 4.6  படங்கள்

4. 3. 3	 அசைவூட்டல் (Animation)
அசையா படங்களை (Still images) 
மிக விரைவாக காண்பிப்பதன் மூலம் 
அவற்றை த�ொடர்ச்சியான அசைவு 
ப�ோன்ற உணர்வை க�ொடுக்கும் செயலே 
அசைவூட்டல் ஆகும்.  அசைவூட்டலில், 
திரை ப�ொருள் என்பது ஒரு வெக்டர் 
படமாகும்.  எண் மாற்றத்தைப் பயன்படுத்தி 
ஒருங்கிணைப்புகளை (Coordinates) 
வரையறுக்க படத்துடன் அதன் பாதையின் 
இயக்கம் கணக்கிடப்படும்.

குறைந்தபட்ச சட்டக விகிதம் (Frame 
rate) 16 சட்டங்கள் விநாடி என இருந்தால் 
மென்மையான த�ோற்றத்தைக் க�ொடுக்கும்.  
இயற்கை த�ோற்றத்திற்கு குறைந்தபட்சம் 
விநாடிக்கு 25 சட்டகங்களாக 
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என்பதன் மூலம் மாதிரி விகிதம் 
வரையறுக்கப்படுகிறது.  அடிக்கடி 
மாதிரியினை எடுத்தும் அந்த மாதிரியைப் 
பற்றிய அதிக தரவுகளைச் சேமிக்கும் 
ப�ொழுதும், பதிவு செய்யப்பட்ட ஒலியின் 
சிறந்த தரம் மற்றும் தெரிவுத்திறன் 
ஆகியவற்றை மீண்டும் ஒலிக்கச் 
செய்யும்பொழுது பெறப்படுகிறது.

4. 3. 5	 ஒளிக்காட்சி
பதிவு செய்யப்பட்ட நிகழ்வு, காட்சி 
ப�ோன்றவற்றைக் காண்பித்தலை 
ஒளிக்காட்சி என்கிற�ோம்.   பல்லூடக 
பயன்பாடுகளில் தகவலைத் தெரிவிக்க 
சக்திவாய்ந்த வழி உட்பொதிந்த 
(embedding) ஒளிக்காட்சி ஆகும்.  ஒப்புமை 
(analog) ஒளிக்காட்சி மற்றும் இலக்க 
(digital) ஒளிக்காட்சி என ஒளிக்காட்சியை 
இரு வகைப்படுத்தலாம்.
ஒப்புமை ஒளிக்காட்சி
இவ்வகை ஒளிக்காட்சியில், கணினி 
சாரா ஊடகமான ஒளி நாடா, லேசர்வட்டு, 
படச்சுருள் ஆகியவற்றில் ஒளிக்காட்சி 
தரவுகள் சேமிக்கப்படுகின்றன.  மேலும் 
இந்த ஒளிக்காட்சியை கலப்பு (Composite) 
மற்றும் கூறு (Componant) ஒப்புமை 
ஒளிக்காட்சி என இரு வகைப்படுத்தலாம்.

கலப்பு ஒப்புமை ஒளிக்காட்சி 
அனைத்து ஒளிக்காட்சி கூறுகளான பிகாசம் 
(Brightness), நிறம் மற்றும் ஒத்திசைவு 
(Synchronization) ஆகியவை இணைந்து 
ஒரு சமிக்ஞை ஆகும்.  ஒளிக்காட்சியின் 
கூறுகளை இணைப்பதனால், கலப்பு 
ஒளிக்காட்சியின் தரமானது நிறக்கலவை, 
குறைந்த காட்சித் தெளிவு மற்றும் அதிக 
தலைமுறை (Generational) இழப்பு ப�ோன்ற 
விளைவுகளைத் தரும்.  இந்த பதிவு 
செய்யும் வடிவமானது, வாடிக்கையாளர் 
ஒப்புமை ஒளிக்காட்சி பதிவு நாடா 
வடிவமான Betamax மற்றும் VHS-ல் 
பயன்படுத்தப்பட்டது.

4. 3. 4	 ஒலி
ஒலி என்பது எந்தவ�ொரு ம�ொழியிலும் 
உள்ள அர்த்தமுள்ள பேச்சாகும்.  
பல்லூடகத்திலுள்ள ஒரு முக்கிய கூறான 
இது, இசையின் இன்பம், சிறப்பு தாக்கங்கள்  
ப�ோன்றவற்றை வழங்குகிறது.  டெசிபல் 
(decibels) என்பது ஒலி அளவின் (Volume) 
அளவீடு ஆகும்.  அதாவது ஒலியின் அழுத்த 
நிலையாகும்.

படம் 4.8  ஒலி

Musical Instrument Digital Indentifier (MIDI)
இது கணினிகள் மற்றும் மின்னனு 
கருவிகளுக்காக உருவாக்கப்பட்ட தரமான 
த�ொடர்பு கருவியாகும்.  பல்லூடகத்தில் 
இந்த கருவி நெகிழ்வானது (Flexible) 
மற்றும் செயல்திட்டங்களை இயற்ற 
எளிதானது.

ஒலி மற்றும் மென்பொருளை 
வரிசையாக த�ொகுக்கும் கருவிகள் MIDI-
க்கு தேவை.
இலக்க ஒலி (Digital Audio)
மாதிரி ஒலி என்பது இலக்க ஒலியாகும்.  
மாதிரி ஒலியை எடுத்து, ஒவ்வொரு 
nth ந�ொடிப்பொழுதையும் பிட்ட மற்றும் 
பைட்டுகளில் இலக்க தகவல்களாகச் 
சேமிக்கப்படுகிறது.  இந்த பதிவு செய்தலின் 
தரம் மாதிரி விகிதத்தைப் ப�ொறுத்து 
அமையும்.  எத்தனை முறை மாதிரிகள் 
எடுக்கப்படுகின்றன மற்றும் ஒவ்வொரு 
மாதிரியின் (பிட் ஆழம், தெளிவுத்திறன், 
மாதிரி அளவு) மதிப்பையும் குறிப்பிட 
எத்தனை எண்கள் பயன்படுகின்றன 
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BMP (Bitmap)
த�ொடக்கத்தில் இந்த வடிவமானது 
விண்டோஸ் 3.1-ல் பயன்படுத்தப்பட்டது.  
இது மிகவும் பெரியது மற்றும் குறுக்கமற்றது.  
எனவே, அதிக தெளிவுத்திறன் அல்லது 
பெரிய நிழற்படங்களுக்காக BMP 
பயன்படுத்தப்படுகிறது.

DIB (Device Independent Bitmap)
இந்த வடிவம் BMP-யை ஒத்ததாகும்.  இது 
க�ோப்புகளை பல்வேறு சாதனங்களில் 
காண்பிக்க அனுமதிக்கிறது.

GIF (Graphics Interchange Format)
GIF என்பது குறுக்கப்பட்ட நிழற்பட 
வடிவமாகும்.  பெரும்பாலான கனிணி 
வண்ண நிழற்படங்கள் மற்றும் 
பின்னணிகள் GIF க�ோப்புகளாகும்.  
குறைந்த அளவு வண்ணங்களைப் 
பயன்படுத்தும் வரைகலைக்கு 
இந்த க�ோப்பு வடிவம் மிகச்சிறந்த 
ப�ொருத்தமாகும்.  நிகழ்நிலை 
(Online) வண்ண புகைப்படங்களில் 
பயன்படுத்தப்படும் மிகவும் பிரலமான 
வடிவமாகும்.  GIF வடிவம், அதன் வண்ண 
மதிப்பை அடையாளம் காண்பதற்கு 
13-பிட் வண்ண தேடல் அட்டவணையைப் 
பயன்படுத்துகிறது.  இந்த வடிவம் பரவலாக 
ஆதரிக்கப்படுகிறது.

JPEG (Joint Photographic Experts Group)
JPEG அதிகபட்ச நிழற்பட குறுக்கத்தை 
அடைவதற்காக வடிவமைக்கப்பட்டுள்ளது.  
இது இழப்புடைய குறுக்க நுட்பத்தைப் 
பயன்படுத்துகிறது.  நிழற்படத்தை மீண்டும் 
கட்டமைக்கத் தேவைப்படும் தரவுகளில் 
சிலவற்றை இழப்பதே, இழப்புடைய 
குறுக்கமாகும்.  இது புகைப்படம், 
இயற்கை கலைவேலைப்பாடு மற்றும் 
அதைப்போன்ற ப�ொருள்களுடன் நன்றாக 
வேலை செய்யும்.  ஆனால் எழுத்துமுறை, 
உயிர�ோட்டமான வரைதல் அல்லது எளிய 

4.4  �பல்லூடகத்திற்கான க�ோப்பு 
வடிவங்கள்
பல்லூடக தரவுகளை உருவாக்கி, 

அதனை வழங்குவதற்கு பயன்படுத்தப்படும் 
நடப்பு க�ோப்பு வடிவங்களின் விளக்கம் 
பின்வருமாறு:

4. 4. 1	 உரை வடிவங்கள்
RTF
முதன்மை க�ோப்பு வடிவம் RTF 
(Rich Text Format) மைக்ரோசாப்ட் 
நிறுவனத்தால் 1987 ஆம் ஆண்டு 
பிரசுரிக்கப்பட்ட தயாரிப்புகளின் 
குறிப்புகள் மற்றும் குறுக்கு பணித்தள 
ஆவணங்களின் பரிமாற்றங்கள�ோடு 
அறிமுகப்படுத்தப்பட்டது.

Plain Text
Plain Text க�ோப்புகளை பல உரை 
பதிப்பான்களில் திறக்கலாம், படிக்கலாம் 
மற்றும் பதிப்பாய்வு செய்யலாம்.  Note pad 
(Windows), Gedit அல்லது nanp (UNIX, 
Linux) Text edit (Mac Os) ப�ோன்றவை 
ப�ொதுவாக பயன்படுகிறது.  பிற கணினி 
நிரல்களும் Plain Text-ஐ படிக்கவும் மற்றும் 
தருவிக்கவும் முடியும்.  மின்னஞ்சலை 
அனுப்புவதற்கான அசல் மற்றும் 
பிரபலமான வழி Plain Text ஆகும்.

4. 4. 2	 நிழற்பட வடிவங்கள்
TIFF (Tagged Image File format)
இந்த வடிவம் கணிப்பொறி பதிப்பக 
உலகில் (அதிக தரமான வெளியீடு) 
ப�ொதுவானது ஆகும்.  இது பெரும்பாலும் 
அனைத்து மென்பொருள் த�ொகுப்புகளை 
ஆதரிக்கிறது.  TIFF-ன் சமீபத்திய பதிப்புகள் 
நிழற்பட குறுக்கத்தை அனுமதிப்பத�ோடு, 
கணினிகளுக்கிடையே பெரிய 
க�ோப்புகளை அனுப்புவதற்கும் வசதியான 
வடிவமாகும்.
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MP3 (MPEG layer – 3 Format)
இசையை சேமிக்கவும் பதிவிறக்கம் 
செய்யவும் மிகவும் பிரபலமான வடிவம் 
MPEG Layer-3 வடிவமாகும்.  WAV 
க�ோப்புகளின் பத்தில் ஒரு பங்கு சமமான 
அளவுக்கு MP3 க�ோப்புகள் த�ோராயமாக 
குறுக்கப்படும்.

OGG
சிறந்த ஓட்டத்தினை அடைவதற்காக 
வடிவமைக்கப்பட்ட இலவச திறந்த மூல 
க�ொள்கலன் (Container) வடிவமாகும்.  இது 
உயர் இறுதி தர இலக்க பல்லூடகத்தில் 
சிறிது சிறிதாக மாறிவருகிறது.  தரத்தின் 
அடிப்படையில் இதை MP3 க�ோப்புகள�ோடு 
ஒப்பிடப்படும்.

AIFF (Audio Interchange File Formate)
Mac பயன்படுத்தும் WAV 
க�ோப்புகளைப்போல் Apple நிறுவனம் 
பயன்படுத்தும் தரமான ஒலி வடிவம் இது 
ஆகும்.

WMA (Windows Media Audio)
மிகவும் பிரபலமான VMA வடிவத்தின் 
உரிமையாளர் மைக்ரோ சாப்ட் ஆகும்.  
பதிப்புரிமை (Copy right) பாதுகாப்பிற்காக 
DRM (Digital Right Management) 
திறன்கள�ோடு வடிவமைக்கப்பட்டுள்ளது.

RA (Real Audio Format)
RA வடிவம் இணையத்தில் ஒலியின் 
ஓட்டத்திற்காக வடிவமைக்கப்பட்டதாகும்.  
இலக்க ஒலி வளங்களைப் ப�ொதுவாக 
கணினிக் க�ோப்புகளாக கணினியின் 
வன்வட்டு அல்லது CD / DVD-களில் 
சேமிக்கப்படுகிறது.  பலவகையான ஒலி 
க�ோப்பு வடிவங்கள் கிடைத்தப�ோதிலும் 
மிகவும் ப�ொதுவான வடிவங்களாவன: 
Wave க�ோப்புகள், (WAV), MPEG Layer-3 
க�ோப்புகள் (MP3), WMA மற்றும் RA.

கேலிச்சித்திரங்களில் குறைந்த அளவில் 
செயல்படும்.
TGA (Tagra)
இது அதிக தெளிவுத்திறன் 
நிழற்படங்களுக்கான முதல் பிரபலமான 
வடிவமாகும்.  பெரும்பான்மையான 
ஒளிக்காட்சி பிடிப்பு பலகைகள் TGA-வை 
ஆதரிக்கின்றன.

PNG (Portable Network Graphics)
இது குறைந்த இழப்பு, சிறியது 
மற்றும் நன்கு குறுக்கப்பட்டு செவ்வக 
நிழற்படங்களாக சேமிக்கப்படும் ஒரு 
நீட்டிப்பு க�ோப்பு வடிவமாகும்.  இது GIF-
க்கு மாற்றாக செயல்படுகிறது.  மற்றும் 
TIFF-ன் பல ப�ொதுவான பயன்களையும் 
மாற்றுகிறது.  நிகழ்நிலை பார்வையிடு 
பயன்பாடான உலகளாவிய வலையில் 
PNG நன்றாக வேலை செய்யும்.  சிறந்த 
திரையிடும் தேர்வுகளுடன் முழுவதுமாக 
ஒழுங்குபடுத்தப்பட்டுள்ளது.

படம் 4.9  நிழற்பட க�ோப்பு வடிவங்கள்

4. 4. 3	 இலக்க ஒலி க�ோப்பு வடிவங்கள்
WAV (Waveform Audio File Format)
இது விண்டோஸில் குறுக்கப்படாத 
ஒலி க�ோப்புகளைச் சேமிக்கும் மிகவும் 
பிரபலமான ஒலி க�ோப்பு வடிவமாகும்.  
குறைக்கப்பட்ட க�ோப்பின் அளவைப் 
பெறுவதற்காக MP3 ப�ோன்ற மற்ற க�ோப்பு 
வடிவங்களுக்கு மாற்றி அமைக்க முடியும்.
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அடிப்படை தரநிலையாகும்.  MPEG-4 
என்பது பல்லூடகம் மற்றும் கைப்பேசி 
வலைக்கான தரநிலையாகும்.  MPEG 
ஒலி மற்றும் ஒளி ப�ொருளடக்கத்தைத் 
தேடுவதற்கான தரநிலையாகும்.  2000-
ல் MPEG-21 ‘பல்லூடக கட்டமைப்பு’ பற்றிய 
ஆய்வைத் த�ொடங்கியது.  சுருக்கமாக, 
MPEG என்பது இலக்க ஒளிக்காட்சி மற்றும் 
ஒலி குறுக்கத்திற்கான தரநிலையாகும்.

4.5  பல்லூடகத்தை உருவாக்குதல்
4. 5. 1	 பல்லூடகத்தை உருவாக்கும் 

படிநிலைகள்
பல்லூடகத்தை உருவாக்குவதற்கு 
ப�ோதுமான நேரம் மற்றும் 
திறமையான திட்டமிடல் ஆகியவை 
தேவைப்படுகின்றன.  இது திட்டப்பணி 
சுமூகமாக த�ொடரவும் மற்றும் தகவல் 
இலக்கு பார்வையாளர்களைச் 
சென்றடையவும் உறுதி செய்கிறது.  
சிக்கலான பல்லூடக திட்டங்களை 
உருவாக்குவதற்கான படிநிலைகள் 
பின்வருமாறு.

1.	 கருத்துரு பகுப்பாய்வு மற்றும் 
திட்டமிடல்

	 பல்லூடகத்தை உருவாக்கும் 
செயலானது கருத்துருவை 
த�ொடக்கப்புள்ளியாக க�ொண்டு 
த�ொடங்குகிறது.  கருத்துரு பகுப்பாய்வு 
ப�ொருத்தமான கருப்பொருள், வரவு-
செலவு திட்டம் மற்றும் தேர்வு செய்த 
கருப்பொருளின் ப�ொருளடக்கத்தின் 
இருப்பு ஆகியவற்றை அடையாளம் 
காண்கின்றது.  கூடுதலாக, 
பதிப்புரிமை பிரச்சனைகளையும் 
இந்தபடிநிலையில் கருத்தில் 
க�ொள்ளப்படுகிறது.

2.	 திட்ட வடிவமைப்பு
	 ஒருமுறை கருப்பொருளை இறுதி 

செய்தப்பிறகு, பல்லூடகத்தின் 

படம் 4.10  இலக்க ஒலி க�ோப்பு வடிவங்கள்

4. 4. 4	 இலக்க ஒளிக்காட்சி க�ோப்பு 
வடிவங்கள்

AVI (Audio / Video Interleave)
இது ஒரு விண்டோஸிற்கான ஒரு 
ஒளிக்காட்சி க�ோப்பு வவைமாகும்.  இங்கு, 
ஒலி மற்றும் படத்தின் கூறுகளைக் 
க�ோப்பில் மாற்று நெடுவரிசை த�ொகுப்பில் 
(interleave chunk) சேமிக்கப்படுகிறது.

MPEG (Moving Picture Experts Group)
MPEG என்பது இலக்க ஒளிக்காட்சி மற்றும் 
ஒலி குறுக்கத்தை ISO (International 
Standards Organization) குழுவினரால் 
உருவாக்கப்படும் ஒரு தரநிலை ஆகும்.  இந்த 
குழுவினர் மற்றும் MP3 ஆகியவற்றுக்கு 

படம் 4.11  இலக்க ஒளிக்காட்சி க�ோப்பு வடிவங்கள்
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ப�ொறுப்புகளையும் செய்யும் 
உறுப்பினர்களை க�ொண்டது.

6.	 வன்பொருள் / மென்பொருள் 
தேர்ந்தெடுத்தல்

	 ப ய ன ்பாட்   டி னை  
உருவாக்குவதற்கும், அதனை 
மீண்டும் செயல்படுத்துவதற்கும் 
ப�ொருத்தமான கருவிகள் அனைத்து 
பல்லூடக பயன்பாடுகளுக்கும் 
தேவை.  வன்பொருளானது 
தேர்ந்தெடுத்த வேகமான 
மையச்செயலகம், RAM மற்றும் 
பெரிய திரையகம், பதிவுகளைச் 
சேமிக்க தேவையான வட்டுகள் 
ஆகியவற்றை உள்ளடக்கியது.  
ப�ொருத்தமான மென்பொருள் 
மற்றும் க�ோப்பு வடிவங்களைத் 
தேர்ந்தெடுத்தல் என்பது 
உருவாக்கப்படும் திட்டப் பணிக்கு 
கிடைக்கும் நிதியைப் ப�ொறுத்தாகும்.

7.	 ப�ொருளடக்கத்தை வரையறுத்தல்
	 ப�ொருளடக்கம் என்பது 

ப�ொருளடக்க வல்லுநரால் பல்லூடக 
வடிவமைப்பாளருக்கு வழங்கப்படும் 
தகவல்கள் (Stuffed) ஆகும்.  
இந்த தகவல்களைக் க�ொண்டு 
உருவாக்கிய பயன்பாட்டில் பல்லூடக 
வடிவமைப்பாளர் விவரித்தல், 
புல்லட்கள், வரைபடங்கள் மற்றும் 
அட்டவணைகள் ப�ோன்றவற்றை 
தயார் செய்கிறார்.

8.	 கட்டமைப்பை தயார் செய்தல்
	 விரிவான கட்டமைப்பில் அனைத்து 

படிநிலைகளும் அடுத்தடுத்து வரும் 
செயல்பாட்டிற்கான நேர அளவு 
பற்றிய தகவல்களைக் கண்டிப்பாக 
க�ொண்டிருக்க வேண்டும்.  இந்த 
கட்டமைப்பு செயல்பாடுகள், 
ஒவ்வொரு செயல்பாட்டிற்குமான 
ப�ொறுப்பாளர் மற்றும் ஒவ்வொரு 

திட்டத்திற்கான ந�ோக்கங்கள், 
குறிக்கோள்கள் மற்றும் 
செயல்பாடுகள் ஆகியவை 
வ டி வ மைக்கப்ப      டு கி ன ்ற ன .  
ப�ொதுவான கூற்றுகள் குறிக்கோள் 
எனப்படும்.  திட்டத்தில் உள்ள 
குறிப்பிட்ட கூற்றுகள் ந�ோக்கங்கள் 
எனப்படும்.  ந�ோக்கத்தை 
செயல்படுத்துவதற்கு த�ொடர்ச்சியான 
செயல்களை நிகழ்த்துவதைச் 
செயல்பாடுகள் என்கிற�ோம்.  இந்த 
செயல்பாடுகள், திட்டவடிவமைப்பு 
படிநிலைக்கு பங்களிப்பை 
வழங்குகிறது.

3.	 முன் – உருவாக்குதல் (Pre 
– Production)

	 திட்டமிடல் மற்றும் வடிவமைத்தலின் 
அடிப்படையில் திட்டத்தை 
உருவாக்குவது தேவையானது 
ஆகும்.  முன் உருவாக்குதலின் 
படிநிலைகள் பின்வருமாறு.

4.	 வரவு – செலவு திட்டமிடல்
	 ஆல�ோசகர்கள், வன்பொருள், 

மென்பொருள், பயணம், தகவல் 
த�ொடர்பு மற்றும் பிரசுரித்தல் ப�ோன்ற 
ஒவ்வொரு நிலையிலும் அனைத்து 
பல்லூடக திட்டங்களுக்கும் வரவு 
– செலவு திட்டம் த�ோராயமாகக் 
கணக்கிடப்படுகிறது.

5.	 பல்லூடகத்தை உருவாக்கும் குழு
	 உயர்ந்த பல்லூடக திட்டத்தை 

உருவாக்கும் குழுவிற்கு அந்த 
குழுவின் ஒட்டு ம�ொத்த முயற்சி 
தேவை.  இந்த குழுவானது 
ஸ்கிரிப்ட் எழுத்தாளர், தயாரிப்பு 
மேலாளர், பதிப்பாசிரியர், 
வரைகலை வடிவமைப்பாளர், 
பல்லூடக வடிவமைப்பாளர் 
மற்றும் வலை வல்லுநர் ப�ோன்ற 
பல்வேறு பதவிகளையும் மற்றும் 
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திட்டத்தை முழுவதுமாக ச�ோதித்தல் 
வேண்டும்.  இவை அனைத்தும் 
சரியான இடத்தில் உள்ளதா 
என்பதை உறுதி செய்வதன் மூலம் 
வெளியீட்டிற்கு பிறகு நேரக்கூடிய 
த�ோல்வியைத் தவிர்க்க முடியும்.  
இது வலை சார்ந்ததாக இருந்தால், 
இதன் செயல்பாட்டினை வெவ்வேறு 
உலவிகளான Internet Explorer, 
Chrome, Mozilla மற்றும் Netscape 
Navigator ஆகியவற்றைக் 
க�ொண்டு ச�ோதிக்கலாம்.  LAN-
ல் உள்ள பல்லூடக பயன்பாடாக 
இருந்தால், சேவையகத்தில் 
ச�ோதனை ந�ோக்கத்திற்காக 
நிறுத்தி வைக்கப்பட வேண்டும்.  
ச�ோதனை செயல்பாடுகள் 
முடிந்த பிறகு, திட்டமான 
சரியாக பரிந்துரைக்கப்பட்டுள்ள 
ம ா ற்ற  ங ்கள�ோ    டு 
இணைக்கப்படுகிறது.

செயல்பாட்டிற்குமான த�ொடக்க 
/ முடிவு நேரம் ஆகியவற்றை 
வரையறுக்கிறது.

9.	 உருவாக்குதல்
	 பல்லூடக பயன்பாட்டில் முன் – 

உருவாக்குதல் செயல்பாட்டிற்கு 
பிறகு, இந்த படிநிலை த�ொடங்குகிறது.  
இது பின்னணி இசையைத் 
தேர்ந்தெடுத்தல், ஒலிப்பதிவு ப�ோன்ற 
செயல்பாடுகளை உள்ளடக்கியது.  
OCR மென்பொருளைக் க�ொண்டு 
உரையானது இணைக்கப்படுகிறது.  
படங்கள் இலக்க கேமராவைக் 
க�ொண்டு படம் பிடிக்கப்படுகிறது.  
ஒளிக்காட்சியினை பதிவு செய்து, 
த�ொகுத்து மற்றும் குறுக்கப்படுகிறது.  
இப்பொழுது மாதிரி திட்டம் தயார் 
நிலையில் உள்ளது.

10.	ச�ோதித்தல்
	 திட்டத்தை பிரமாண்டமாக 

உருவாக்குவதற்கு முன், மாதிரி 

Conceptual Analysis and 
Planning

Conceptual Analysis and 
Planning

Defining the Content

Preparing the StructureProject Design

Pre Production Production

Testing

Documentation & Delivering the 
Multimedia Product

Budgeting

Multimedia Production Team

Hardware/Software Selection

படம் 4.12 
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1.	 தயாரிப்பு மேலாளர்
	 பல்லூடக உருவாக்குதலில், குறித்த 

நேரத்தில் முழு தரத்துடன் பல்லூடக 
திட்ட உருவாக்கத்தை வரையறுப்பது 
மற்றும் ஒருங்கிணைப்பது தயாரிப்பு 
மேலாளரின் பங்கு ஆகும்.  தயாரிப்பு 
மேலாளர் என்பவர் த�ொழில்நுட்ப 
திறன்கள், நன்கு திட்டம் வரைதல், 
கலந்துரையாடல் திறன்கள் மற்றும் 
வரவு – செலவு மேலாண்மை 
திறன்கள் ஆகியவற்றில் 
நிபுணத்துவம் பெற்றவராக 
இருத்தல் வேண்டும்.  மேலும், 
மனித வள மேலாண்மையில் 
அனுபவம் வாய்ந்தவராகவும் 
திறமையான குழுத் தலைவராக 
செயல்படுபவராகவும் இருத்தல் 
வேண்டும்.

2.	 ப�ொருளடக்க வல்லுநர்
	 ப�ொருளடக்க வல்லுநர் என்பவர் 

ஏற்கனவே திட்டமிடப்பட்ட 
பயன்பாட்டின் ப�ொருளகத்தைப் 
பற்றிய அனைத்து ஆராய்ச்சி 
செயல்பாடுகளையும் செய்வதற்கு 
ப�ொறுப்பானவர் ஆவார்.  
நிரல் ப�ொருளடக்கமானது 
திட்டத்தகவல்கள், வரைகலை, 
தரவு ஆகியவற்றைப் பல்லூடக 
உருவாக்குதல் மூலம் 
வழங்கப்படுவதைக் குறிக்கிறது.

3.	 ஸ்கிரிப்ட் எழுத்தாளர்
	 ஒளிக்காட்சி மற்றும் படச்சுருள் 

ஸ்கிரிப்ட்கள் த�ொடர்ச்சியான 
வரிசையிலுள்ள நிகழ்வுகளைக் 
குறிக்கும்.  ஸ்கிரிப்ட் எழுத்தாளர் 
கருத்துருக்களை முப்பரிமான 
சூழல்களில் காட்சிப்படுத்துகிறார்.  
தேவை ஏற்படின், நிரல் மீது மெய்நிகர் 
உண்மை ஒருங்கிணைப்பைப் 
பயன்படுத்தலாம்.

11.	ஆவணப்படுத்துதல்
	 அனைத்து பல்லூடக திட்டங்களிலும் 

ஆவணப்படுத்துதல் என்பது 
கட்டாயம் ஆகும்.  கணிப்பொறி 
தேவையில் த�ொடங்கி ச�ோதித்தல் 
முடியும் வரை அனைத்து மதிப்புமிக்க 
தகவல்களையும் ஆவணப்படுத்துதல் 
க�ொண்டிருக்கும்.  த�ொழில்நுட்ப 
உதவி மற்றும் பரிந்துரைகள் மற்றும் 
குறிப்புரைகளை அனுப்புவதற்கு 
த�ொடர்பு விவரங்கள், மின்னஞ்சல் 
முகவரி மற்றும் த�ொலைபேசி எண்கள் 
ஆகியவை வழங்கப்படுகின்றன.

12.	பல்லூடக திட்டத்தை வழங்குதல் 
(Delivering)

	 பல்லூடக பயன்பாடுகள் CD / DVD-
களில் அல்லது இணைய தளத்தில் 
சிறப்பாக வழங்குகிறது.  உண்மையில் 
இணையத்தின் மூலம் வழங்கும்போது 
அலைக்கற்றை சிக்கல்கள் (bandwidth 
problem), ஒலி மற்றும் ஒளியினை 
இயக்க அதிக அளவில் தேவைப்படும் 
துணைக் கருவிகள் மற்றும் 
நீண்ட பதிவிறக்க நேரல் ப�ோன்ற 
சவால்களைச் சந்திக்க நேரிடுகிறது.  
இறுதியாக, இரண்டு ஊடகங்கள் 
CD-ROM / DVD மற்றும் இணையம் 
ஆகியவற்றை ஒன்றிணைத்து மிகவும் 
திறமையான முறையில் பல்லூடக 
பயன்பாடு வழங்கப்படுகிறது.

4. 5. 2	 பல்லூடகத்தை உருவாக்கும் 
குழு

பல்லூடக உருவாக்கத்தில் அதிகபட்ச 
பலனை உயர்தர திறமையுடன் பெறும் 
வகையில் குழு உறுப்பினர்களை 
மேலாண்மை செய்வது கட்டாயமாகும்.  
நல்ல தரமான உயர்ந்த பல்லூடக 
உருவாக்க பயன்பாட்டிற்கு பின்வரும் 
உறுப்பினர்களைக் க�ொண்ட வல்லுநர் 
குழு தேவைப்படுகிறது.
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பல்லூடக நிகழ்த்துதலில் கையாளத் 
தேவைப்படுபவரே ஒலி மற்றம் 
ஒளிக்காட்சி வல்லுநர் ஆவார்.  
பதிவு செய்தல், ஒலி விளைவுகளை 
பதிப்பாய்வு செய்தல் மற்றும் 
இலக்கமாக்கல் ஆகியவற்றுக்கு 
இவரே ப�ொறுப்பானவர் ஆவர்.

8.	 கணினி நிரலர்
	 கணினி நிரலர் ப�ொருத்தமான 

ம�ொழியில் குறிமுறை அல்லது 
ஸ்கிரிப்ட் வரிகளை எழுதுகிறார்.  
இந்த ஸ்கிரிப்ட்கள் வழக்கமாக சிறப்பு 
செயல்பாடுகளை உருவாக்கும்.  
அதாவது ஒளிக்காட்சி திரையின் 
அளவு மற்றும் வடிவத்தைக் 
க�ொடுப்பதற்கான மென்பொருளை 
உருவாக்குதல், புறக்கருவிகளைக் 
கட்டுப்படுத்துதல் ப�ோன்றவை ஆகும்.

9.	 வலை வல்லுநர்
	 ஒரு இணைய வலைப்பக்கத்தை 

உருவாக்கி அதை பராமரிப்பது 
வலை வல்லுநரின் ப�ொறுப்பாகும்.  
பல்லூடக நிகழ்த்துதலை 
வலைப்பக்கமாக மாற்றுகிறார்கள்.  
ஆல�ோசனைக்கு தயாராக இருக்கும் 
இறுதிப் பல்லூடக உருவாக்கம், 
முழு குழுவின் கூட்டு முயற்சியாகும்.  
த�ொடக்கத்தில், தயாரிப்பு மேலாளர் 
திட்ட ப�ொருளடக்கத்தை அடையாளம் 
காணும்போது, வலை வல்லுநர் 

4.	 உரை பதிப்பாளர் (Text Editor)
	 பல்லூடக உருவாக்குதலின் 

ப�ொருளடக்கம் எப்பொழுதும் 
தருக்கரீதியான ஓட்டமாக இருத்தல் 
வேண்டும்.  உரை எபப�ொழுதும் 
கட்டமைப்பாகவும் சரியான 
இலக்கணத்தோடும் இருக்க 
வேண்டும்.  உரை மற்றும் விவரித்தல் 
பயன்பாட்டின் ஒருங்கிணைந்த 
பகுதியாகும்.

5.	 பல்லூடக வடிவமைப்பாளர்
	 பல்லூடக வடிவமைப்பாளர் 

பல்லூடகத்தின் அனைத்து 
அடிப்படைத் த�ொகுதிகளான 
வரைகலை, உரை, ஒலி, இசை, 
ஒளிக்காட்சி, புகைப்படம் மற்றும் 
படைப்பாக்க மென்பொருளைப் 
பயன்படுத்தி அசைவூட்டல் 
ப�ோன்றவற்றை ஒருங்கிணைப்பார்.

6.	 கணினி வரைகலைகலைஞர்
	 நிரலின் வரைகலை கூறுகளான 

பின்னணி, புல்லட்கள், 
ப�ொத்தான்கள், பாடப்பதிப்பாய்வு, 
3-D ப�ொருள்கள், அசைவூட்டல் 
மற்றும் சின்னங்கள் ஆகியவற்றைக் 
கையாளும் பங்கினை கணினி 
வரைகலை கலைஞர் வகிக்கிறார்.

7.	 ஒலி மற்றும் ஒளிக்காட்சி வல்லுநர்
	 எடுத்துரைத்தல் மற்றும் 

சேமிக்கப்பட்ட ஒளிக்காட்சிகளைப் 

Production manager Content specialist Script writer Text editor 

Web master
computer programmer

Audio and video specialistComputer graphic artistMultimedia architect

படம் 4.13  பல்லூடக உருவாக்க குழு

XII CompTech_Tamil version CHAPTER 04.indd   150 12/01/2022   15:33:03

www.tntextbooks.in



151பாடம் 04  பல்லூடகம் மற்றும் கணிப்பொறிப் பதிப்பகம்

பங்கு ஆற்றுகின்றது.  இது 
மாணவர்களை, அசைவூட்டல் 
(Animation) மூலம் பல்வேறு 
கருத்துருக்களை (Concepts) பற்றி 
ஆய்வு செய்யவும், மற்றும் கற்று 
க�ொள்ளவும் அனுமதிக்கின்றது.  
மாணவர்கள் ஆசிரியர்கள் மற்றும் 
பெற்றோர் ஆகிய�ோர் இந்த பல்லூடக 
வழிக் கற்றல் முறையையும் 
மற்றும் பல்லூடக கற்றல் 
ப�ொருட்களையும் விரும்புகின்றனர்.  
பல கல்வியாளர்கள், பல்லூடகம், 
புதிய வழிகளில் வகுப்பறையில் 
சிந்திப்பதை அறிமுகப்படுத்தியுள்ளது 
என்பதனை ஏற்று க�ொள்கின்றனர்.  
ஜெர்மனியிலுள்ள GMU ஆனது 
பல்லூடக வழி கற்பித்தல் மற்றம் 
கற்றல் அமைப்பிறிகு MODOLO என 
பெயரிட்டுள்ளது.  இது இணையத்தை 
தழுவிய சூழல் க�ொண்டு 
உருவாக்கப்பட்டு மாற்றதக்க 
மற்றும் பரவலாகப்பட்ட கற்றல் 
சூழலை வழங்குவதை ந�ோக்கமாக 
க�ொண்டுள்ளது.

	     இந்தியாவில், மின் வழிகற்றல் 
(e-learning) த�ொலைதூர வழி 
கற்றல் (distance learning), 
மெய்நிகர் கற்றல் (Virtual learning) 
ப�ோன்றவற்றை கற்பித்தல் மற்றும் 
கற்றலுக்காக பல்வேறு வழிகளில் 
பல்லூடகம் பயன்படுத்தப்படுகின்றது.  
நாட்டிலுள்ள கல்வி துறையில் 
மெய்நிகர் வகுப்பறைகள் பயனுள்ள 
முறையில் உருவாக்குவதற்கான 
சேவைகளை வழங்க EDUSAT 
(Educational Statellite) என்ற 
செயற்கை க�ோளானது இந்தியாவில் 
செலுத்தப்பட்டுள்ளது.

2.	 ப�ொழுதுப�ோக்கு (Entertainment)
	 ப�ொழுதுப�ோக்கு த�ொழில் துறையில் 

குறிப்பிடத்தக்க முன்னேற்றத்திற்கு 

இணைய சேவைகள் மூலம் 
பரவலான சமூக அணுகுதலை 
வழங்கிறார்.

4.6  இணையத்தில் பல்லூடகம்
இணையம் மற்றும் பல்லூடகத்தின் 
ஒருங்கிணைப்போடு, முக்கிய 
பயன்பாடுகள் உருவாக்கப்பட்டுள்ளன.  
எடுத்துக்காட்டாக, வரைபடம் மற்றும் 
ஊடகங்கள் நிறைந்த வலைப்பதிவு (blogs) 
மற்றும் பிற, அமெரிக்காவில் இணையம் 
மற்றும் பல்லூடகத்தின் பயன்கள் பற்றிய 
விரிவான ஆய்வு நடத்தப்பட்டது.  அதில் 
55 மில்லியன் நுகர்வோர்கள் ஒவ்வொரு 
மாதமும் இணையத்தைப் பயன்படுத்தி 
வான�ொலி மற்றும் ஒளிக்காட்சி 
சேவைகளைப் பெறுகிறார்கள்.  
இணையத்தில் மிகவும் பரவலாக 
பயன்படுத்தப்படும் பல்லூடக வளம் 
நிழற்படம் ஆகும்.  முகநூல் (facebook) 
ப�ோன்ற சமூக வலைத்தளங்கள், 
பல்லூடக நிறைந்த ப�ொருளடக்கத்தை 
நிகழ்நிலையில் பரிமாற வழிவகை 
செய்கிறது.

4.7  பல்லூடகப் பயன்பாடுகள்
பல்லூடகமானது, தகவல் த�ொழில்நுட்பத் 
துறையில் வேகமாக வளர்ந்து வரும் ஒரு 
துறையாகும்.  பல்லூடகம் என்பது ஒரு 
பயன்பாடாகும்.  இது வரை, நிழற்படம், 
ஒலி, அசைவூட்டம் மற்றும் ஒளிக்காட்சி 
ப�ோன்ற பல ஊடக கூறுகளை சேர்த்து 
ஒரே பணித்தளத்தில் பயன்படுத்துகின்றது.  
முக்கியமாக, ப�ொழுதுப�ோக்கு மற்றும் 
கல்வி ஆகிய துறைகளில் பல்லூடகமானது 
பெரும் அளவு பயன்படுத்தப்படுகின்றது.

1.	 கல்வி (Education)
	 பாரம்பரிய கற்பித்தல் முறைக்கு 

பதிலாக சிறந்த மாற்று முறையினை 
வழங்குவதில் பல்லூடகம் முக்கிய 
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பல்லூடக த�ொடர்புகளை மிகவும் 
பயனுள்ளதாக உருவாக்குகின்றன.

4.	 மருத்துவ சேவைகள் (Medical 
Services)

	 பல்லூடகத்தின் வளர்ச்சியினால் 
மருத்துவ சேவைகளும் 
வியத்தகு முறையில் வளர்ச்சி 
அசைந்துள்ளன.  மருத்துவ 
மாணவர்கள் உண்மையாக 
அறுவை சிகிச்சை செய்வதற்கு முன் 
உருவாக்கப்படுத்துல் (Simulation) 
மூலம் அறுவை சிகிச்சை முறைகளை 
பற்றி பயிற்சி செய்கின்றனர்.  
சிறிய இலக்க கேமராக்கள் மனித 
உடலில் செருகப்பட்டு உடலின் 
உட்பகுதியானது காட்சியாகக் 
காண்பிக்கப்படுகின்றது.  இதன் 
மூலம் மருத்துவ பயிற்சியாளர்கள் 
உடலினை வெட்டி ச�ோதிக்காமல் 
உடலின் உட்பகுதிகளை பார்க்க 
முடிகின்றது.

5.	 ப�ொது இடங்கள் (Public Places)
	 த�ொழில் கண்காட்சி, நூலகங்கள், 

இரயில் நிலையங்கள், 
அருங்காட்சியம், பெரிய 
கடைகள், விமான நிலையங்கள், 
உணவகங்கள் மற்றும் கண்காட்சி 
ப�ோன்ற ப�ொது இடங்களில் 
பல்லூடகமானது தானியங்கு 
சேவை வழங்கி (Kiosks) வடிவத்தில் 
பயன்படுத்தப்படுகின்றது.  இது 
வ ா டி க்கை   ய ா ள ர ்க ளு க் கு 
தகவல்களை வழங்கி உதவுகின்றது.  
தானியங்கு சேவை வழங்கியில் 
Kiosks-ல் வழங்கப்பட்ட 
தகவல்களானது அசைவூட்டம், 
ஒளிக்காட்சி, அசையா படங்கள், 
வரைகலை, வரைபடம், படங்கள், 
ஒலி மற்றும் உரை க�ொண்டு 
மேம்படுத்தப்பட்டுள்ளது.  வங்கிகள் 
தானியங்கு சேவை வழங்கிகளை 

பல்லூடக த�ொழில்நுட்பம் 
முக்கிய காரணமாகும்.  இந்த 
த�ொழில் நுட்பமானது வான�ொலி, 
த�ொலைக்காட்சி, ஆன்லைன் 
விளையாட்டு, தேவைப்படும் 
ஒளிக்காட்சி ப�ோன்ற அனைத்து 
வகையான ப�ொழுதுப�ோக்கு 
அம்சங்களில் தேவைப்படுகின்றது.

	   தேவைப்ப  டும் ஒளிக்காட்சி 
அல்லது தேவைப்படும் 
திரைப்படத்தை வீடுகளில் உள்ள 
த�ொலைக்காட்சி பெட்டிக்கு 
தனிப்பட்ட முறையில் வழங்குவது 
ஒரு சேவையாகும்.  திரைப்படங்கள் 
மைய சேவையகத்தில் சேமிக்கப்பட்டு 
த�ொடர்பு வலையமைப்பின் 
மூலம் அனுப்படுகின்றது.  
த�ொடர்பு வலையமைப்பில் 
இணைக்கப்பட்டுள்ள செட்-டாப் 
பாக்ஸ் (Set Top Box) ஆனது இலக்க 
தகவல்களை ஒப்புமை தகவல்களாக 
மாற்றி த�ொலைக்காட்சி பெட்டிக்கு 
உள்ளீடு செய்கின்றது.

3.	 வணிக அமைப்பு (Business Systems)
	 பல்லூடக வணிகப் பயன்பாடுகள் 

வழங்குதல், பயிற்சி, இணைய 
நெறிமுறை ப�ோன்றவற்றை 
உள்ளடக்கியது.  சந்தைபடுத்துதல் 
மற்றும் விளம்பர நிறுவனங்கள் 
அசைவூட்ட த�ொழில்நுட்பத்தை 
வியாபார முன்னேற்றத்திற்காக 
பயன்படுத்துகின்றனர்.

	     பணியாளர் அடையாளத்தை (ID) 
உருவாக்குவதில் பல்லூடகமானது.  
ப�ொதுவாக பயன்படுத்தப்படுகின்றது.  
பல்லூடகத்தை வழங்குவதற்கு அதிக 
தெளிவு திறன் க�ொண்ட படவீழ்த்தி 
(Projectors) தேவை.  புளுடூத் 
Bluetooth) மற்றும் தனிப்பட்ட இலக்க 
உதவியாளர் (Personal Digital Assitat) 
ஆகியவை வணிகத்திற்கான 
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153பாடம் 04  பல்லூடகம் மற்றும் கணிப்பொறிப் பதிப்பகம்

விமான நிலையங்கள் மற்றும் பிற 
ப�ொது இடங்களில் திசைகள் மற்றும் 
சில அவசியமான தகவல்களை 
பயனருக்கு வழங்க உதவுகின்றது.  
நூலகங்களில் தானியங்கி 
சேவை வழங்கி (Kiosks) யானது 
வழக்கமாக நுழைவாயிலுக்கு 
அருகே வைக்கப்பட்டிருக்கும்.  இது 
அறிவிப்புகளை காண்பிக்கவும், 
பட்டியல்கள் நூலக பயனரிடமிருந்து 
வரும் குறிப்புகள் மற்றும் 
ஆல�ோசனைகளை படிக்கவும் 
மற்றும் நூலகத்தின் செயல்பாடுகள், 
நிகழ்வுகள் பற்றிய தகவல்களையும் 
வழங்க உதவுகின்றது.

2.	 வலை ஒளிபரப்பு மற்றும் ஒளிக்காட்சி 
கலந்துரையாடல் (Webcasting and 
video conferencing)

	 நிகழ் நேர நிகழ்ச்சிகளை 
இணையத்தின் மூலம் நேரடியாக 
ஒளிபரப்பு செய்வது வலை 
ஒளிபரப்பு எனப்படும்.  ஒளிக்காட்சி 
கலந்துரையாடல் என்பது வெவ்வேறு 
இடங்களில் உள்ள இரண்டிற்கும் 
மேற்பட்ட பங்காளர்களுக்கிடையே 
கலந்துரையாடலை நடத்தி அதனை 
ஒலி மற்றும் ஒளி தரவுகளை கணினி 
வலையமைப்பு மூலம் அனுப்பும் ஒரு 
செயலாகும்.

3.	 பயனரை ஒருமுகப்படுத்தும் திட்டம் 
(User Orientation Program)

	 பல்லூடகத்தின் ஊடாடும் 
செயல்பாடு காரணமாக 
பள்ளிகூடங்கள், கல்லூரிகள் 
மற்றும் பல்கலைகழகங்களில் 
உள்ள நூலகங்களுக்கு பயிற்சி 
அளிப்பதில் பல்லூடகம் முக்கிய 
பங்கு ஆற்றுகின்றது.  மேலும் இது 
பேராசிரியர்களுக்கு கருத்தாழமிக்க 
பாடங்களில் பயிற்சி அளிக்க 
உதவுகின்றது.

kiosks ATM இயந்திர வடிவில் 
பயன்படுத்துகின்றன.

6.	 பல்லூடகக் கலந்துரையாடல் 
(Multimedia Conferencing)

	 பல்லூடகக் கலந்துரையாடல் அல்லது 
ஒளிக்காட்சி கலந்துரையாடல் 
என்பது ஒரு அமைப்பாகும்.  இதில் 
பங்கேற்கும் பயனர்கள் வெவ்வேறு 
இடங்களிலிருந்தாலும் ஒரே 
அறையில் அமர்ந்து ஆல�ோசிப்பதை 
ப�ோன்று நேருக்கு நேராக 
கலந்துரையாட முடியும்.

4.8  �நூலகங்கள், தகவல் மையங்கள் 
மற்றும் ஆவணகாப்பகங்கள் 
(Libranics, Information Centers and 
Archives)

நூலகத்தின் முதன்மையான பணியானது, 
பயனருக்கு தகவல்களை ஒழுங்குபடுத்தி, 
சேகரித்து, பாதுகாத்து வழங்குவதை 
குறிக்கின்றது.  தகவல்களை பயனுள்ள 
வகையில் கையாள்வதற்காக பல 
நுட்பங்கள் மற்றும் த�ொழில்நுட்பங்கள் 
பயன்படுத்தப்படுகின்றன.

பல்லூடக தானியங்கு 
சேவை வழங்கி (kiosks), பயனரை 
ஒருமுகப்படுத்தும் நிகழ்ச்சிகள் ப�ோன்ற 
பல்வேறு செயல்பாடுகளில் பல்லூடக 
த�ொழில் நுட்பமானது நூலகங்களால் 
பயன்படுத்தப்படுகின்றது.  நூலகங்களில் 
உள்ள பல்லூடக த�ொழில்நுட்ப 
பயன்பாடுகள் பற்றிய விரிவான 
விவரங்கள் பின்வருமாறு.

1.	 பல்லூடக தானியங்கு சேவை 
வழங்கி  (Multimedia Kiosks)

	 தானியங்கு சேவை வழங்கி (Kiosk) 
என்பது பயனர்கள் த�ொடுதிரை 
(Touch Screen) மூலம் தகவல்களை 
பெற அனுமதிக்கும் ஒரு பல்லூடக 
கணிப்பொறியாகும்.  இது ப�ொதுவாக 
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நினைவில் க�ொள்க

5.	 இலக்க பல்லூடக நூலகங்கள் (Digital 
Multimedia Libraries)

	 இலக்க வடிவத்தில் உள்ள 
தகவலானது இலக்க நூல்கள், 
ஸ்கேன் செய்யப்பட்ட நிழற்படங்கள், 
வரைகலை மற்றும் இலக்க 
முறைக்கப்பட்ட ஒலி-ஒளி பதிவுகள் 
ஆகியவற்றை உள்ளடக்கியது.  
த�ொடக்கத்தில் இலக்க நூலக 
திட்டமானது (digital library) உரை 
வடிவத்திலான தரவினை மட்டுமே 
அடிப்படையாகக் க�ொண்டிருந்தது.  
பிறகு இது பிற பல்லூடகக் 
கூறுகளான நிழற்படங்கள், 
ஒலி மற்றும் ஒளிக்காட்சி 
பதிவுகள் ஆகிய அனைத்தையும் 
அடிப்படையாக க�ொண்டு இலக்க 
நூலகத்தின் த�ொகுப்பின் கீழ் 
ஒருங்கிணைக்கப்பட்டது.

4.	 உள்ளமைவு பல்லூடக வளங்கள் 
உருவாக்கம் மற்றும் மின் பதிப்பகம் 
(In-house Production of Multimedia 
Resources and E-Publishing)

	 பெரும்பான்மையான நூலகங்கள் 
உள்ளமைவாக பல்லூடக வளங்களை 
பெரிய அமைப்புக்கு சேவை 
வழங்குவதற்காக உருவாக்குகின்றன.  
CD / DrD மற்றும் அதனை எழுதும் 
சாதனங்களின் அறிமுகமானது 
ஆவணங்களை சேமித்தல் (or) 
பெறுவதில் நூலகங்கள் சந்திக்கும் 
சில பிரச்சனைகளுக்கு தீர்வினை 
கண்டுள்ளன.  CD எழுதும் சாதனத்துடன் 
கூடிய பல்லூடக கருவிகள் 
பல்வேறு மூலங்களிலிருந்து வரும் 
தகவல்களை பதிப்பித்தலை எளிதாக்கி 
உள்ளன.  இது நூலக பயனர்களுக்கு 
பயன்படுத்துவதற்கு எளிதாகவும் ஏற்றுக் 
க�ொள்ளக்கூடிய வகையிலும் உள்ளது.

●	 பல்வேறு வளங்களான நிழற்படம், உரை, வரைகலை, ஒளிக்காட்சி, ஒலி மற்றும் ஒளி ஆகியவற்றை 
ஒன்றிணைத்து, தரவுகளை ஒற்றைத்தளத்திற்கு மாற்ற பயனர்களுக்கு பல்லூடகம் அனுமதி அளிக்கிறது.

●	 பல்லூடகம் 5 முக்கிய கூறுகளைக் க�ொண்டுள்ளது.  அவை உரை, நிழற்படம், ஒலி, ஒளிக்காட்சி மற்றும் 
அசைவூட்டல்.

●	 மாறாத உரை என்பது தலைப்பில�ோ அல்லது ஒரு வரியில�ோ அல்லது ஒரு பத்தியில�ோ மாறாமல் 
இருக்கும் உரை அல்லது ச�ொல் ஆகும்.

●	 மீவுரை என்பது முனையங்கள், உரை மற்றும் முனையங்களுக்கு இடையேயான இணைப்புகள் 
ஆகியவற்றைக் க�ொண்டிருக்கும் அமைப்பாகும்.  வரிசையற்ற முறையில் உரையை அணுகுவதற்கு 
பின்பற்றத் தேவையான பாதையைப் பயனருக்கு வரையறுக்கிறது.

●	 நிழற்படங்கள் பல்லூடகத்தின் முக்கிய கூறாக செயல்படுகிறது.  இந்த நிழற்படங்கள் கணினியில் 
பிட்மேப் அல்லது செவ்வக படங்கள் மற்றும் வெக்டார் படங்கள் என இருமுறைகளில் உருவாக்கலாம்.

●	 அசைவூட்டல் என்பது அசையா நிழற்படங்களை மிக விரைவாக காட்சிப்படுத்தும் செயலாகும்.  அவை 
த�ொடர்ச்சியாக இயங்குவதைப் ப�ோன்ற உணர்வைத் தருகின்றன.  அசைவூட்டலில் திரைப�ொருள் 
என்பது ஒரு வெக்டார் படம் ஆகும்.

●	 ஒலி என்பது எந்த ம�ொழியிலும் உள்ள அர்த்தமுள்ள பேச்சு ஆகும்.  மிகவும் முக்கியமான கூறான இது, 
இசையின் இன்பம், சிறப்பு விளைவுகள் ப�ோன்றவற்றை வழங்கும்.

●	 MIDI என்பது கணினிகள் மற்றும் மின்னணு கருவிகளுக்காக உருவாக்கப்பட்டட தரநிலை த�ொடர்பு 
கருவி ஆகும்.

●	 ஒளிக்காட்சி, ஒப்புமை மற்றும் இலக்க ஒளிக்காட்சி என இரு வகைப்படுத்தலாம்.
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பல்லூடகம் பல்வேறு வளங்களான உரை, நிழற்படம், வரைகலை, ஒளிக்காட்சி, ஒலி மற்றும் 
ஒளி ஆகியவற்றை ஒன்றிணைத்து, தரவுகளை ஒற்றைத் தளத்திற்கு மாற்ற 
பயனர்களுக்கு பல்லூடகம் அனுமதி அளிக்கிறது.

பிட்மேப் அல்லது செவ்வக 
படங்கள்

கணினியில் படங்களை ப�ொதுவான மற்றும் விரிவான வடிவத்தில் சேமிப்பது 
செவ்வக அல்லது பிட்மேப் படங்கள் ஆகும்.

வெக்டார் படங்கள் படங்களைக் குறிப்பதற்கு ஒப்பீட்டளவில் குறைந்த அளவு தரவு தேவைப்படுகிறது.  
அதனால் அதை சேமிக்க குறைந்த அளவு நினைவகம் தேவைப்படுகிறது.

அசைவூட்டல் அசைவூட்டல் என்பது அசையா நிழற்படங்களை மிக விரைவாக காட்சிப்படுத்தும் 
செயலாகும்.  அவை த�ொடர்ச்சியாக இயங்குவதைப் ப�ோன்ற உணர்வைத் 
தருகின்றன.  அசைவூட்டலில் திரைப�ொருள் என்பது ஒரு வெக்டார் படம் ஆகும்.

பாதை அசைவூட்டல் நிலையான பின்னணியைக் க�ொண்ட திரையில் ஒரு ப�ொருளை நகர்த்துவதை 
உள்ளடக்கியது.  எ.கா. கேலிச்சித்திர பாத்திரம் திரை முழுவதும் நகருகிறது.  
பின்னணி அல்லது பாதிப்பதில் எந்த மாற்றம் இருந்தாலும் இது த�ொடரும்.

MIDI கணினிகள் மற்றும் மின்னணு கருவிகளுக்காக உருவாக்கப்பட்ட தரநிலை த�ொடர்பு 
கருவியாகும்.

பகுதி – அ 
	 I. 	�ச ரியான விடையைத் தேர்ந்தெடுத்து எழுதுக

1.	 _________ என்பத ஒன்றிற்கு மேற்பட்ட ஊடக வகையான உரை, தரைகலை, 
ஒளிக்காட்சி, அசைவூட்டல் மற்றும் ஒலி ஆகியவற்றில் ஏதேனும் ஒரு வகைப் 
பயன்பாட்டைக் குறிக்கும்.

	 அ) நிறைவேற்றப்படும் க�ோப்பு	 ஆ) கணினி பதிப்பகம்
	 இ) பல்லூடகம்	 ஈ) மீவுரை
2.	 பல்லூடகத்தின் குறைபாடுகளில் ஒன்று அதனுடைய _________
	 அ) விலை	 ஆ) ஒத்துப்போதல்	 இ) பயன்பாடு	   ஈ) சார்பியல்பு
3.	 விரிவாக்கம் JPEG
	 அ) Joint Photo exports gross	 ஆ) Joint Photographic experts group
	 இ) Joint processor experts group	  ஈ) Joint Photographic expression group
4.	 பல்லூடகத்தை உருவாக்க நமக்கு தேவையானவை: வன்பொருள், மென்பொருள் 

மற்றும் _________
	 அ) வலையமைப்பு	 ஆ) CD இயக்கி	 இ) நல்ல ய�ோசனை	 ஈ) நிரலாக்க திறன்
5.	 சரியான ஒன்றைத் தேர்ந்தெடுத்து பின்வருவனவற்றை ப�ொருத்துக.

	 1. உரை	 -	 TGA
	 2. நிழற்படம்	 -	 MIDI

	 3. ஒலி	 -	 MPEG
	 4. ஒளி	 -	 RTF

	 அ) 1, 2, 3, 4	 ஆ) 2, 3, 4, 1	 இ) 4, 1, 2, 3	 ஈ) 3, 4, 1, 2

வினாக்கள்
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5.	 வரையறு – அசைவூட்டல் மற்றும் 
அதன் சிறப்ப்ம்சம்.

6.	 நிழற்பட க�ோப்பு வடிவங்களைப் 
பட்டியலிடுக.

7.	 ஒலி க�ோப்பு வடிவங்களைப் 
பட்டியலிடுக.

8.	 ஒளிக்காட்சி க�ோப்பு வடிவங்களைப் 
பட்டியலிடுக.

9.	 வரையறு – பல்லூடக உருவாக்கம்.
10.	பல்லூடக உருவாக்க குழு 

உறுப்பினர்களை பட்டியலிடுக.
பகுதி – இ 
III.  	� ஒரு பத்தியளவில் 

விடையளிக்கவும்  
1.	 பல்லூடக கூறுகளை சுருக்கமாக 

விவரி.
2.	 அசைவூட்டலின் சிறப்பம்சங்கள் 

மற்றும் த�ொழில் நுட்பங்களை 
விவரிக்கவும்.

3.	 உருவாக்க குழு உறுப்பினர்களின் 
பணிகள் மற்றும் ப�ொறுப்புகளைப் 
பற்றி எழுதுக.

4.	 பல்லூடகத்தில் உள்ள பல்வேறு 
க�ோப்பு வடிவங்கள் பற்றி 
விவரிக்கவும்.

பகுதி – ஈ 
IV.	  �ஒரு பக்க அளவில் 

விடையளிக்கவும்
1.	 பல்லூடக செயல்கள் பற்றி விரிவாக 

விளக்கவும்.
2.	 அசைவூட்டல் நுட்பங்கள் பற்றி 

விரிவாக விளக்கவும்.
3.	 அசைவூட்டல் திரைப்பட துறையில் 

உள்ள வாய்ப்புகள் பற்றி 
கண்டறியவும்.

4.	 பல்லூடக உருவாக்க குழுவின் 
பணிகள் மற்றும் ப�ொறுப்புகள் 
விரிவாக எழுதவும்.

5.	 பல்லூடக க�ோப்பில் உள்ள 
வெவ்வேறு க�ோப்பு வடிவங்களை 
விவரிக்கவும்.

6.	 பின்வருவனவற்றில் ப�ொருந்தாத 
ஒன்றைக் கண்டுபிடிக்கவும்.

	 அ) TIFF	 ஆ) BMP
	 இ) RTF	 ஈ) JPEG
7.	 _________ என்பது அசையா 

நிழற்படங்களை த�ொடர்ச்சியான 
இயக்கமாக காட்சிப்படுத்தும் செயல்.

	 அ) உரை வடிவம்
	 ஆ) ஒலி
	 இ) MP3
	  ஈ) அசைவூட்டல்
8.	 இணையத்தின் மூலம் நிகழ்நேர 

நிகழ்ச்சிகளை நேரடியாக 
ஒளிப்பரப்புவதை _________ 
என்கிற�ோம்.

	 அ) வலை ஒளிப்பரப்பு
	 ஆ) வலை த�ொகுப்பாளர்
	 இ) தரவு கையாளுதல்
	  ஈ) இவற்றில் ஏதும் இல்லை
9.	 GIF பயன்படுத்தும் வண்ண தேடல் 

அட்டவணை _________
	 அ) 8 பிட்	 ஆ) 8KB
	 இ) 8 MB	   ஈ) 8GB
10.	RTF க�ோப்பு வடிவத்தை 

அறிமுகப்படுத்தியது _________
	 அ) TCS	 ஆ) Micorsoft
	 இ) Apple	   ஈ) IBM

பகுதி – ஆ 
II.	   �மூன்று வரிகளில் விடையளிக்கவும்  

1.	 வரையறு – பல்லூடகம் மற்றும் 
அதன் சிறப்பம்சம்.

2.	 பல்லூடக கூறுகளைப் பட்டியலிடுக.
3.	 பல்லூடகத்தில் உரை (Text) 

கூறினை வகைப்படுத்துக.
4.	 பல்லூடகத்தில் நிழற்பட கூறினை 

வகைப்படுத்துக.
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05பாடம்

அட�ோப் ஃப்ளாஷ் ப்ரொப்பஷனல் CS6

 கற்றலின் ந�ோக்கங்கள்
●	 ப்ளாஷ் மற்றும் அதன் பயன்களை அறிந்து க�ொள்ளுதல்
●	 ஒரு புதிய ஆவணத்தை உருவாக்குதல்
●	 பணித்தளம் மற்றும் அதில் பயன்படும் கருவிகளை பற்றி அறிந்து க�ொள்ளுதல்
●	 வண்ணங்களுடன் வேலை செய்தல்
●	 சின்னங்களை உருவாக்குதல்.

5.1  �அட�ோப்ஃப்ளாஷ் ப்ரொப்பஷ்னல் 
CS6 அறிமுகம்

அட�ோப் ஃப்ளாஷ் ப்ரொப்பஷ்னல் CS6 
என்பது ஒரு மென்பொருள் ஆகும்.  
இது அசைவூட்டங்களை உருவாக்க 
பயன்படுகிறது.  இது பல்வேறு 
கருவிகளைக் க�ொண்டுள்ளது.  அவை 
அடிப்படை ப�ொருள்களை வரையவும் 
மற்றும் காட்சிகளை உருவாக்கவும் 
பயன்படுகிறது.  இது அட�ோப் நிறுவனத்தால் 
உருவாக்கப்பட்டுள்ளது.

படம் 5.1  அட�ோப் ஃப்ரொப்பஷனல் CS6 
த�ொடக்கத்திரை

5.2  �ஃப்ளாஷ் CS6 –யை பயன்படுத்தும் 
பயனாளர்கள்

பின்வரும் பயனாளர்கள் ஃப்ளாஷ்-யை 
பெரும்பாலும் பயன்படுத்துகின்றனர்.
●	 வரைகலை வடிவமைப்பாளர்கள் 

(Graphic Designers)
●	 அசைவூட்டங்களை 

உருவாக்குபவர்கள் (Animators)
●	 வலைப்பக்க வடிவமைப்பாளர்கள் 

(Web Designers)
●	 வலைப்பக்கத்தை உருவாக்குபவர்கள் 

(Web Developers)

5.3  �ஃப்ளாஷ் மூலம் பின்வருவற்றை 
நீங்கள் உருவாக்க முடியும்

●	 வலை பயன்பாடுகள் (Web Applications)
●	 விளம்பரங்கள் (Advertisements)
●	 வலைப்பக்கக் கூறுகள் (Web Page 

Components)
●	 விளக்கக் காட்சிகள் (Presentations)
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5.5  �ஒரு புதிய ஆவணத்தை 
உருவாக்குதல்

1.	 ஃப்ளாஷ்-ல் நீங்கள் வரைவதற்கு 
(அ) அசைவூட்டம் செய்வதற்கு 
முன்பு முதலில் நீங்கள் ஒரு புதிய 
ஆவணத்தை உருவாக்க வேண்டும்.  
வரவேற்பு திரையிலிருந்தோ 
(welcome screen) (அ) திரையின் 
மேற்பகுதியில் உள்ள File 
பட்டியிலிருந்தோ ஒரு புதிய 
ஆவணத்தை உருவாக்க முடியும்.

	 ஃப்ளாஷ்-ல் உள்ள வரவேற்பு 
திரை க�ோப்புகளை உருவாக்கவும், 
திறக்கவும் உதவும் ஒரு த�ொடக்கப் 
பகுதியாக உள்ளது.  முதலில் 
ஃப்ளாஷ் –யை த�ொடங்கும் ப�ோது (அ) 
ஒரு பயன்பாட்டை திறக்கும் ப�ோது 
எந்த ஆவணங்களும் இல்லாதப�ோது 
இது த�ோன்றும்.

	 வரவேற்புத்திரையின் 
மையத்திலுள்ள create new 
நெடுவரிசையில் இருக்கும் 
ActionScript 3.0-யை கிளிக் 
செய்யவும்.

●	 விளையாட்டுகள் மற்றும் 
அசைவூட்டப்படங்கள் (Games and 
Movies)

●	 கைபேசிகளுக்கான உள்ளடக்கம் 
(Content for Mobile Phone)

5.4  ஃப்ளாஷ்-யை த�ொடங்குதல்
அட�ோப்ஃப்ளாஷ் ப்ரொப்பஷனல் CS6 யை 
த�ொடங்க start > All programs > Adobe 
Flash professional CS6 – யை தேர்வு 
செய்யவும்.

படம் 5.2  ஃப்ளாஷ் த�ொடங்கும் சன்னல் திரை

File Menu Welcome Screen

Click on
ActionScript 3.0

படம் 5.3  ஒரு புதிய ஆவணத்தை உருவாக்குதல்
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2.	 ஒரு புதிய ஆவணத்தை File பட்டியிலிருந்து உருவாக்க file → New–யை 
தேர்ந்தெடுத்தால் New Document உரையாடல் பெட்டி த�ோன்றும்.  அதில் General 
தத்தலின் கீழ் உள்ள ActionScript 3.0 –யை தேர்ந்தெடுத்து OK ப�ொத்தானை கிளிக் 
செய்தால் ஒரு புதிய ஆவணம் உருவாகும்.

படம் 5.4  பட்டி படம் 5.5  ஒரு புதிய ஆவணம் உரையாடல் பெட்டி

தற்போது உங்கள் பணித்தளம் பின்வரும் படத்தைப் ப�ோன்று த�ோன்றும்.

படம் 5.6  ஒரு அடிப்படையான பணித்தளம்

ஃப்ளாஷ்-ல் Actionscript என்பது ஃப்ளாஷ் அசைவூட்டத்திற்கான ஒரு அடிப்படை நிரலாக்க 
ம�ொழியாகும்.  இதனுடைய தற்போதைய நடப்பு பதிப்பு ActionScript 3.0 ஆகும்.
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5.6  ஃப்ளாஷ் பணித்தளம்
ஃப்ளாஷ் பணித்தளமானது நீங்கள் ஃப்ளாஷ் பயன்பாடுகளை உருவாக்கி அதில் நீங்கள் 
வேலை செய்வதற்குத் தேவையான பல்வேறு விதமான கருவிகளையும் மற்றும் பிற 
கூறுகளையும் க�ொண்டுள்ளது.

5.6.1	 ஃப்ளாஷ் சன்னல் திரை கூறுகள் (அ) பகுதிகள்
ஃப்ளாஷ் சன்னல் திரை நான்கு பகுதிகளாக (அ) கூறுகளாக பிரிக்கப்பட்டுள்ளது. 

அவை
1.	 பணித்தளம் மற்றும் ஒட்டுப்பலகை 

(Stage and paste Board)
2.	 காலக்கோடு (Timeline) 

3.	 கருவிகள் பலகம் (Tools Panel)
4.	 Property Inspector

Pasteboard

Pa
ste

bo
ar

d

Pa
ste

bo
ar

d

Stage

Property  
Inspector

Timeline

To
ols

 pa
ne

l

Pasteboard

படம் 5.7  ஃப்ளாஷ் சன்னல் திரை கூறுகள் (அ) பகுதிகள்

5.6.2	பணித்தளம் மற்றும் 
ஒட்டுப்பலகை (பணிப்பகுதி) (The 
Stage and Pasteboard (work 
area)

உங்கள் பணித்தளத்தின் நடுவில் 
உள்ள செவ்வக வெள்ளைப் பகுதி 
மேடை (Stage) என அழைக்கப்படுகிறது.  
அசைவுப் படத்திற்கான அசைவூட்டங்கள், 
ப�ொருட்கள் மற்றும் காட்சிகள் ஆகியவற்றை 

உருவாக்க, பதிப்பிக்க இருத்திவைக்க  
மற்றும்  இயக்க இந்த மேடை உதவுகிறது. 

ஃப்ளாஷ் மேடையானது 
பார்வையாளர்கள் ஒரு திரையரங்கில் 
ஒரு திரைப்படத்தைப் பார்ப்பது ப�ோல 
சலனப் படத்தை (Movie) காட்டுகிறது. இங்கு 
படம் என்ற ச�ொல்லானது ஃப்ளாஷ் மூலம் 
உருவாக்கப்பட்ட சலனப்படத்தை குறிக்கிறது.
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காலக்கோடு சட்டகங்கள் 
(Frames) மற்றும் அடுக்குகளை (Layers) 
க�ொண்டுள்ளது. Flash சலனப்படங்களில்  
சட்டகங்கள் மூலம் நேரம் அளவிடப்படுகிறது. 
சட்டகங்கள் தனித்தனியாக நேரத்தின் 
சிறு பகுதிகளாக இருக்கின்றது.  நீங்கள் 
ஃப்ளாஷ் பணித்தளத்தின் உள்ளடக்கத்தை 
பல சட்டகங்களுக்கு மாற்றமுடியும்.

காலக்கோட்டில் உள்ள சிவப்பு 
நிற செங்குத்துக் க�ோடு ப்ளே ஹெட் 
(Play Head) என அழைக்கப்படுகிறது.  
சலனப்படம் இயக்கப்படும் (அ) ஓடும் 
ப�ோது காலக்கோடுவில் உள்ள ப்ளே 
ஹெட் ஆனது சட்டகத்தில் நகரும்.  
ஒரு சட்டகத்தின் உள்ளடக்கத்தை 
காண்பிக்க வேண்டும் என்றால் நீங்கள் 
பிளே ஹெட்டை காலக்கோட்டில் அந்த 
சட்டகத்திற்கு நகர்த்த வேண்டும்.

அடுக்குகள் உங்கள் சலனப்படத்தில் 
கலைப்படைப்பை ஒருங்கிணைக்க 
உதவுகிறது. ஃப்ளாஷ் பணித்தளத்தில் 
த�ோன்றும் ஒவ்வொரு அடுக்கும் வெவ்வேறு 
விதமான படங்களை க�ொண்டு இருக்கும்.  
காலக்கோட்டில் மற்றொரு அடுக்கில் உள்ள 
ப�ொருள்களை பாதிக்காமல் ஒரு அடுக்கில் 
நீங்கள் ப�ொருள்களை வரையலாம் மற்றும் 
பதிப்பிக்கலாம்.

அடுக்கு விருப்பம் (Layer Option) 
பணிக்குறியின் கீழ் உள்ள அடுக்குகளில் 
உள்ள புள்ளிகளை (Dots) கிளிக் 
செய்வதன் மூலம் நீங்கள் அடுக்குகளின் 
உள்ளடக்கத்தை மறைக்கலாம், மூடலாம் 
(அ) காட்டலாம்.

காலக்கோடு என்பது சலனப்படத்தை 
உருவாக்கும் ஒவ்வொரு சட்டகம், அடுக்கு 
மற்றும் காட்சியின் பதிவு ஆகும். அடுக்குகள் 
மற்றும் சட்டகங்களை பயன்படுத்தி 
இது சலனப்படத்தின் உள்ளடக்கத்தை 
கட்டுப்ப்டுத்தி மற்றும் ஒருங்கிணைக்கிறது.

இது திரையில் த�ோன்றும் உரை, 
படம், ஒலி-ஒளி காட்சிகள் ப�ோன்றவற்றை 
க�ொண்டுள்ளது.  நீங்கள் பணித்தளத்தின் 
அளவை தேவைக்கேற்ப மாற்றிக்கொள்ள 
முடியும்.  க�ொடாநிலையாக பணித்தளத்தின் 
நிறமானது வெள்ளை நிறத்தில் த�ோன்றும்.  
நீங்கள் பணித்தளத்தின் பின்னணி 
நிறத்தை விரும்பும் வண்ணத்தில் மாற்ற 
முடியும்.  அதற்கு Document settings 
உரையாடல் பெட்டியை பயன்படுத்தி அதில் 
Modify → Document –யை தேர்வு செய்தோ 
(அ) Ctrl + J கட்டளையை பயன்படுத்திய�ோ 
பின்னணி நிறத்தை மாற்றலாம். மேடையை 
நாம் தேவைக்கேற்ப சிறியதாகவ�ோ மற்றும் 
பெரியதாகவ�ோ மாற்றிக்கொள்ளலாம்.  
நீங்கள் மேடையில் ப�ொருள்களை 
வைப்பதற்கு கிரிட் (Grid), கைட்ஸ் (Guides), 
மற்றும் ரூலர்கள் (Rulers) பயன்படுகின்றன.

ஃப்ளாஷ்-ல் பணித்தளத்தை 
சுற்றியுள்ள சாம்பல் நிற பகுதி ஒட்டுப்பலகை 
(Pasteboard) எனப்படும். இந்த ஒட்டு 
பலகையில் நீங்கள் ப�ொருள்களை 
உருவாக்கவும், பதிப்பிக்கவும் முடியும்.  
ஆனால் இவற்றை இறுதி சலனப்படத்தில் 
காண இயலாது.  மேடையின் உள்ளே 
இருக்கும் வரைகலை ப�ொருட்களை 
மட்டுமே இறுதி அசைவூட்டப்படத்தில் 
காண முடியும். நீங்கள் ஃபிளாஷ்-ல் 
சலனப்படத்தை உருவாக்கி வெளியிடும் 
ப�ோது மேடையானது உங்கள் படத்தின் 
உண்மையான அளவை பிரதிபலிக்கும்.

5.6.3	காலக்கோடு (Time Line)
காலக்கோடு என்பது ஃப்ளாஷ்-ன் மிக 
முக்கியமான கூறுகளில் ஒன்றாகும்.  
இது பணித்தளப் பகுதியின் கீழே 
அமைந்துள்ளது.  இது ஒவ்வொரு 
உறுப்பின் த�ோற்றத்தையும் மற்றும் 
அசைவூட்டத்தையும் தெளிவாக காட்ட 
பயன்படுகிறது.
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5. 6. 4	 ஃப்ளாஷ் கருவிகள் பலகம்  
(The Flash Tools Panel)

ஃப்ளாஷ் கருவிகள் பலகம் நீங்கள் 
மேடையில் வரைகலையை உருவாக்க, 
தேர்ந்தெடுக்க (அ) பதிப்பிக்கத் தேவையான 
கருவிகளை க�ொண்டுள்ளது.  கருவிகள் 
பலகத்தின் மேல் இருக்கும் ரட்டை 
அம்புக்குறியானது பலகத்தை பிரித்து 
பணிக்குறிகளை மட்டும் பார்வையிட 
அல்லது பலகத்தை விரிவாக்கம் செய்து, 
எல்லா கருவிகளையும் பார்வையிடப் 
பயன்படுகிறது.  க�ொடாநிலையாக 
கருவிப்பட்டையானது திரையின் 
வலது புறத்தில் இருக்கும்.  
அடைப்புக்குறிகளுக்குள் இருக்கும் 
ஒற்றை பெரிய எழுத்து இந்த கருவிகளை  
தேர்ந்தெடுப்பதற்கான விசைப்பலகை 
குறுக்கு வழி ஆகும்.
கருவிபலகத்தை பயன்படுத்துதல்
கருவிப் பலகம் கருவிகளின் த�ொகுப்பை 
க�ொண்டுள்ளது. கருவியின் மீது 
சுட்டெலியின் சுட்டியை நகர்த்தும் 
ப�ோது அக்கருவியின் பெயர் த�ோன்றும்.  
கருவி பலகத்தில் உள்ள சில கருவிகள் 
கூடுதலான விருப்பங்களை (Options)-யை 
க�ொண்டுள்ளன.  அவை நீங்கள் 

Show or Hide All Layers

Frame rate Elapsed time (seconds)

Layer Name

Current frame
Playhead
Lock or Unlock All Layers

படம் 5.8  காலக்கோடு

மாற்றி அமைத்து பயன்படுத்த அனுமதி 
அளிக்கிறது.  உதாரணமாக தூரிகை கருவி 
(Brush Tool)ல் அளவை மாற்றுதல் மற்றும் 
தூரிகையின் தலைப்பகுதியை (Brush 
Head) வடிவத்தை மாற்றுதல் ப�ோன்ற 
கூடுதலான விருப்பங்கள் உள்ளன.  
கருவிகளை தேர்ந்தெடுக்கும் ப�ோது அதன் 
விருப்பங்கள் கருவி பலகத்தின் விருப்ப 
பகுதியில் இருக்கும்.

Selection கருவி (V)
இந்த கருவி ஒரு ப�ொருள் (அ) ஒரு ப�ொருளின் 
பகுதியாகிய வெளிக்கோடு மற்றும் 
உட்பரப்பு (Stroke & Fill)  ஆகியவற்றைத் 
தேர்ந்தெடுக்க பயன்படுகிறது. இதன் 
மூலம் மறு வடிவம் மற்றும் மறு அமைவு 
ப�ோன்ற செயல்களை ப�ொருளின் மீது 
செய்யலாம். தேர்ந்தெடுக்கும் கருவியில் 
பின்வரும் விருப்பங்களும் இருக்கும்.  
அதாவது ப�ொருள்களை சீரமைத்தல் (align 
objects), க�ோடுகளை சரி செய்தல் (smooth 
line) மற்றும் க�ோடுகளை நேராக்குதல் 
Straightens Line).

Sub Selection கருவி (A)
இந்த கருவி ஒரு ப�ொருளை 
தேர்ந்தெடுக்க, இழுக்க, மீள் வடிவமைக்க 
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Free Transform கருவி (Q)
இது ப�ொருள்களை சுழற்ற, அளவிட, 
வளைக்க மற்றும் உருக்குலைக்க 
பயன்படுகிறது.
Gradient Transform கருவி (F)
இந்த கருவியின் மூலம் உட்பரப்பின் அளவு, 
திசை மற்றும் மையத்தை சரி செய்வதன் 
மூலம் gradient Fill-ஐ மாற்றமுடியும்.   
Free மற்றும் Gradient டிரான்ஸ்பார்ம் 

பயன்படுகிறது.  வரைகலை வெக்டர் 
என்பது க�ோடுகள் மற்றும் வளை 
க�ோடுகள் ஒரு நங்கூர புள்ளியில் 
(Anchor Points) இணைக்கப்பட்டிருக்கும் 
என்பது நாம் அறிந்த ஒன்றாகும்.  (இதில் 
ஒவ்வொன்றும் ஒரு பகுதி ஆகும்).  ஒரு 
ப�ொருளை தேர்ந்தெடுக்கும் ப�ோது இந்த 
கருவி நங்கூரப் புள்ளிகளைக் காட்டும். 
இது அந்த ப�ொருளை நீங்கள் பதிப்பித்து 
பயன்படுத்திக் க�ொள்ள அனுமதிக்கும்.

படம் 5.9  கருவிகள் பலகம்
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Rectangle Tool (R) 
இது செவ்வகம் வரையப் பயன்படுகிறது. 
Shift அழுத்திப்பிடிப்பதன் மூலம் சதுரம் 
வரையலாம். 

3D Translation கருவி (G)
இது மேடையில் முப்பரிமாண வெளியில் 
சலனப் படத்துண்டுகளை (Movie Clips) 
நகர்த்துவதன் மூலம் முப்பரிமாண 
விளைவுகளை உருவாக்கப் பயன்படுகிறது. 
3D Rotation மற்றும் 3D Translation 
கருவிகள், கருவி பலகத்தில் ஒரே 
பணிக்குறியில் குழுவாக்கப்பட்டிருக்கும்

Oval கருவி (O)
இது நீள்வட்ட வடிவங்களை வரைவதற்கு 
பயன்படுகிறது.  சரியான வட்டத்தை 
வரைவதற்கு Shift விசையை அழுத்திப் 
பிடிக்க வேண்டும்.

பிரிமிட்டிவ் செவ்வகம் மற்றும் 
நீள்வட்டம்
இது ப�ொருள்களை பண்புகளுடன் 
வரைவதற்கு பயன்படுகிறது.  அதாவது 
பண்புகள் பலகத்தை (Properties Panel) 
பயன்படுத்தி மூலை விட்டங்களின் ஆரம் 
(அ) உள் ஆரத்தை மாற்ற முடியும்.

Poly Star கருவி
இது பல க�ோணம் மற்றும் நட்சத்திரங்களை 
வரைய பயன்படுகிறது.  செவ்வகம், 
நீள்வட்டம், பிரிமிட்டிவ் செவ்வகம் மற்றும் 
Poly Star கருவிகள் எல்லாம் ஒரே கருவியில் 
த�ொகுக்கப்பட்டு கருவி பலகத்தில் உள்ளது.

Pencil கருவி
இது தற்போக்காக (freehand) க�ோடுகள் 
மற்றும் வடிவங்களை வரையப் 
பயன்படுகிறது.  பென்சில் முறை (Mode) 
விருப்பத்தில் உள்ள பட்டி பின்வரும் 
கட்டளைகளை காட்டும்.

கருவிகள் இரண்டும் த�ொகுக்கப்பட்டு ஒரே 
பணிக்குறியில் கருவி பலகத்தில் உள்ளது.  
த�ொகுக்கப்பட்ட கருவிகள் க�ொண்ட 
பட்டியை பார்க்க, பட்டியை திறக்கும் 
வரை கருவி பணிக்குறியை கிளிக் செய்ய 
வேண்டும்.

3D Rotation கருவி (W)
இது மேடையில் முப்பரிமாண வெளியில் 
சலனப் படத்துண்டுகுகளை (Movie 
Clips) சுழற்றுவதன் மூலம் முப்பரிமாண 
விளைவுகளை உருவாக்க பயன்படுகிறது.

Lasso கருவி (L)
சாதாரணமாக ஒரு ப�ொருளைச் சுற்றி 
வரைவதன் (Freehand) மூலம், இது 
ப�ொருள்களை தேர்ந்தெடுப்பதற்கு 
(அ) ப�ொருளின் ஒரு பகுதியை 
தேர்ந்தெடுப்பதற்கு பயன்படுகிறது.

Pen கருவி (P)
இது நங்கூரப் புள்ளிகள் எனப்படும். த�ொடர் 
புள்ளிகளை உருவாக்குவதன் மூலம் 
க�ோடுகள் மற்றும் வளைக�ோடுகளை 
வரைவதற்கு பயன்படுகிறது.   இந்த புள்ளிகள் 
தானாகவே இணைக்கப்படுகின்றது.  
நங்கூர புள்ளிகளை சேர்க்க, நீக்க, 
மற்றும் மாற்ற பயன்படும் மற்ற கருவிகள் 
அனைத்தும் இந்த Pen கருவியில் 
த�ொகுக்கப்பட்டுள்ளன.

Text கருவி (T)
இது உரையை உருவாக்க மற்றும் 
பதிப்பிக்க பயன்படுகிறது.

Line கருவி (N)
இது நேர்கோடுகளை வரைவதற்குப் 
பயன்படுகிறது.  நீங்கள் செங்குத்து, கிடை 
மட்ட மற்றும் 450 மூலைவிட்ட க�ோடுகளை 
வரைவதற்கு Shift விசையை அழுத்திப் 
பிடிக்க வேண்டும்.
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கருவி (Bind Tool) Bone கருவி (Bone Tool) 
ஒன்றுடன் ஒன்று இணைக்கப்பட்டு ஒரே 
த�ொகுப்பில் உள்ளன.
Paint Bucket கருவி (K)
இது மூடிய பகுதிகளில் வண்ணங்களை 
க�ொண்டு நிரப்ப பயன்படுகிறது.

Ink bottle கருவி (S)
ஒரு ப�ொருளின் வெளிக்கோட்டின் தடிமன் 
மற்றும் க�ோட்டின் வண்ணம் ப�ோன்ற 
பண்புகளை மாற்றப் பயன்படுகிறது.  Ink 
bottle கருவி Paint Bucket கருவி ஒன்றுடன் 
ஒன்று இணைக்கப்பட்டு ஒரே த�ொகுப்பில் 
உள்ளன.

Eye dropper கருவி (I)
இது வெளிக்கோடு, உட்பரப்பு மற்றும் 
உரையின் பண்புகளை தேர்ந்தெடுக்கப் 
பயன்படுகிறது.  எனவே இதன் மூலம் 
இவற்றை ஒரு ப�ொருளிலிருந்து மற்றொரு 
ப�ொருளுக்கு நகலெடுக்க முடியும்.

Eraser கருவி (E)
இது க�ோடுகள் மற்றும் உட்பரப்புகளை (Fill) 
அழிக்கப் பயன்படுகிறது.

Hand கருவி (H)
இது மேடையை நகர்த்த பயன்படுகிறது.  
ஒட்டுபலகையில் எங்கு வேண்டுமானாலும் 
பணித்தளத்தை இழுத்து நகர்த்தலாம்.

Zoom கருவி (Z)
இது மேடைப் பகுதியை பெரிதாக மாற்றப் 
பயன்படுகிறது.  இது மேடையில் ஒரு 
பகுதியில் கிளிக் செய்வதன் மூலம் அதனை 
பெரிதாக்கலாம். Alt விசையை அழுத்திப் 
பிடித்து மேடையில் கிளிக் செய்தால் 
அதனை சிறிதாக்கலாம்.
Stroke Color கருவி
இது வரையப்பட்ட ப�ொருள்களின் 
வெளிக்கோட்டின் நிறத்தை மாற்றி 
அமைக்கப் பயன்படுகிறது.

●	 Straighten	-நேர்க்கோட்டினை 
வரைவதற்கு,

●	 Smooth – வளை க�ோட்டினை 
வரைவதற்கு

●	 Ink - அளவுக�ோலற்ற வரைபடங்களை 
எந்த மாற்றமும் இன்றி வரைய

Brush கருவி (B)
இது தூரிகைகள் ப�ோன்ற க�ோடுகள் (Paint) 
வரைவதற்கு பயன்படுகிறது.
Spray Brush கருவி
இது வண்ணங்கள் மற்றும் பாங்குகளை 
(Pattern) ப�ொருள்களின் மீது தெளிக்க 
பயன்படுகிறது.  புள்ளிகள் தெளிப்பானின் 
(spray) க�ொடாநிலை முறை ஆகும்.  
இருப்பினும் நீங்கள் க�ொடி ப�ோன்ற 
வரைகலை சின்னங்களை பயன்படுத்த 
வேண்டுமென்றால் நீங்கள் பாங்குகளை 
உருவாக்க வேண்டும்.  Brush மற்றும் 
Spray Brush கருவிகள் எல்லாம் ஒரே 
கருவியில் த�ொகுக்கப்பட்டு உள்ளன.
Deco கருவி
இது வடிவியல் வடிவங்களை (geometric 
patterns) வரைகலை வடிவங்களாக 
மாற்றவ�ோ அல்லது  கலைடாஸ்கோப் 
விளைவுகள் (Effects) ப�ோன்று 
உருவாக்கவ�ோ பயன்படுகிறது.
Bone கருவி
இது இணைப்புகளைக் க�ொண்ட 
ப�ொருட்களை அசைவூட்டம் செய்ய 
பயன்படுகிறது. உதாரணமாக நீங்கள் 
ஒன்றொட�ொன்று த�ொடர்புடைய 
ப�ொருள்களை இணைத்துப் பயன்படுத்த 
முடியும்.  அதாவது கைகள் மற்றும் கால்களை 
இணைத்து ஒரு கதாபாத்திரத்தை 
உருவாக்கி அசைவூட்டம் க�ொடுக்கலாம்.
Bind கருவி
இரண்டு ப�ொருள்களை (Character 
animations) இணைக்கும் ப�ோது 
அவற்றிற்கிடையே நிலவும் உறவுகளை 
சரிசெய்யப் பயன்படுகிறது.  (தனிப்பட்ட 
பைன்ட் உறவுகளை சரி செய்ய).  Bind 
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மற்ற பலகங்களைப் ப�ோல property 
inspector யும் Windows பட்டியைப் 
பயன்படுத்தி த�ோன்றச் செய்யவ�ோ அல்லது 
மறையச் செய்யவ�ோ முடியும்.

படம் 5.11  property inspector

5.7  Flash பயன்பாடுகள்
ப்ளாஷ் (Flash) உதவியுடன் உரை, படம், 
வீடிய�ோ மற்றும் ஒலி ஆகியவற்றை 
உங்களது திட்டத்திற்காக (project) 
ஒன்றணைக்க முடியும்.  மேலும் 
அசைவூட்டங்கள் மற்றும் பயன்பாட்டு 
இடைமுகங்களை உருவாக்க முடியும்.  
Flash மூலம் நீங்கள் உருவாக்கும் எந்த 
உள்ளடக்கமும் பயன்பாடு (Application) 
என்று அழைக்கப்படுகிறது.

5.8  ப்ளாஷில் வரைதல்
அட�ோப் ப்ளாஷ் புர�ொஃபஷனல் CS6 திசை 
அடிப்பைடையிலான வடிவங்கள் (shapes), 
பாதைகள் (paths), நிறங்கள் (colors) மற்றும் 
பாங்குகள் (pattern) ப�ோன்றவற்றை 
உருவாக்க உதவும் சக்திவாய்ந்த 
கருவிகளைக் க�ொண்டுள்ளது.  ப்ளாஷ் 
பிக்சல் மற்றும் பிட்மேப் படங்களுடன் 
வேலை செய்ய முடிந்த ப�ோதிலும, 
ப்ளாஷிலுள்ள வரை கருவிகள் (drawing 
tools) வெக்டர் அடிப்படையிலான 
கலை வேலைப்பாடுகளை (Art work) 
உருவாக்குகிறது.

Fill Color கருவி
இது வரையப்பட்ட ப�ொருள்களின் 
உட்பரப்பின் வண்ணத்தை மாற்றப் 
பயன்படுகிறது.
Black and White கருவி
இது வெளிக்கோட்டின் வண்ணத்தை 
கருப்பு நிறமாகவும் மற்றும் உட்பரப்பின் 
(Fill) வண்ணத்தை வெள்ளை நிறமாகவும் 
அமைக்கப் பயன்படுகிறது.
Swap Colors கருவி
இது வெளிக்கோடு மற்றும் உட்பரப்பு 
வண்ணத்தை இடமாற்றம் செய்ய 
பயன்படுகிறது.

5. 6. 5	 பண்பு ச�ோதிப்பான்  
(Property inspector)

இது க�ொடாநிலையாக Flash 
பணியிடத்தின் வலது பக்கத்தில் 
த�ோன்றும்.  இது நூலகப்பலகத்துடன் 
இணைக்கப்பட்டிருக்கும்.  இது 
தேர்ந்தெடுக்கப்பட்ட ப�ொருளின் பண்புகள் 
மற்றும் விருப்பங்களைக் காட்டுவத�ோடு 
அவற்றை மாற்றவும் அனுமதிக்கிறது.  
ப�ொருள் (object) என்பது உரையாகவ�ோ, 
படமாகவ�ோ, க�ோடாகவ�ோ அல்லது வேறு 
வடிவமாகவ�ோ இருக்கலாம்.

படம் 5.10  property inspector மற்றும் 
நூலகப்பலகம்
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5.8.1	 Line கருவி
இந்த கருவி பணித்தளத்தில் ஒரு நேர்கோட்டை வரையப் பயன்படுகிறது.

Line tool ஐப் பயன்படுத்துவதற்கு கீழ்க்காணும் படிகளைப் பின்பற்றவும்.
1.	 கருவிப் பலகத்திலுள்ள (tool panel) Line tool கிளிக் செய்யவும்.
2.	 Property Inspector பலகத்திலிருந்து விரும்பும் க�ோட்டின் நிறம், தடிமன் மற்றும் 

வகையைத் தேர்ந்தெடுக்கவும்.
3.	 சுட்டியை பணித்தளத்திற்குக் க�ொண்டு வரவும்.
4.	 ஒரு க�ோட்டை வரைவதற்கு பணித்தளத்தின் மீது கிளிக் செய்து இழுக்கவும்.

படம் 5.12  க�ோடு

நீங்கள் ஃப்ளாஷில் வேலை செய்யும் ப�ோது ஆவணத்தை உருவாக்குகிறீர்கள்.  நீங்கள் 
உங்கள் வேலைகளை ஒரு Flash க�ோப்பாச் சேமிக்கலாம். இப்பொழுது உங்களது 

ஆவணம் சேமிக்கப்படுகிறது.  இது ப�ோட்டோஷாப் ப�ோன்ற அட�ோப் தயாரிப்புகளுக்குப் ப�ொருத்தமாக 
உள்ளது.  இது அந்த பயன்பாட்டில் உருவாக்கப்பட்ட word ஆவணத்தைப் பயன்படுத்துகிறது.  மேலும், 
ப்ளாஷ் (Stage), காலக்கோடுகள் (timeline), சட்டகங்கள் (fames), அசைவூட்டங்கள் (animation) மற்றும் 
பலவற்றைக் க�ொண்ட திரைப்பட உருவகத்தைப் பயன்படுத்துவதால், ப்ளாஷில் செய்யப்படும் வேலை 
சலனப்படம் (movie) எனப்படுகிறது.  ஆகவே ப்ளாஷ் ஆவணம் என்பதும் ப்ளாஷ் சலனப்படம் என்பதும் 
ஒரே ப�ொருள் க�ொண்டவையே.
சலனப்படம்/திரைப்படம் என்பது சிறிய மற்றும் எளிமையான கணினித் திரையில் ம�ோதி திரியும் 
பந்தாகவ�ோ அல்லது சிக்கலான முழுநீள ஊடாடல் சாகச கணினி விளையாட்டாகவ�ோ இருக்க முடியும்.
கணினி விளையாட்டுகள், கல்வி த�ொடர்பான மென்பொருட்கள், நிகழ்நேர விளம்பரங்கள் மற்றும் 
தயாரிப்பு விளக்கங்கள் ப�ோன்ற தயாரிப்புகள் (products) பயன்பாடுகளைக் (application) குறிக்கின்றன.  
ஒரு பயன்பாடு ப�ொதுவாக பல ப்ளாஷ் ஆவணங்கள் அல்லது இணைக்கப்பட்ட சலனப்படங்களைக் 
க�ொண்டிருக்கிறது.

ஆவணங்கள், சலனப்படங்கள் மற்றும் பயன்பாடுகள்
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படம் 5.14  நீள் வட்டம் மற்றும் வட்டம்

5. 8. 3	 Rectangle கருவி
இந்த கருவி செவ்வம் மற்றும் சதுரம் 
வரையப் பயன்படுகிறது.

செவ்வகம் வரைவதற்கு 
கீழ்க்காணும் படிகளைப் பின்பற்றவும்
கருவிப் பலகத்திலிள்ள Rectangle Tool (R) 
ஐக் கிளிக் செய்யவும்.

1.	 Property Inspector பலகத்திலிருந்து 
செவ்வகத்திற்குத் தேவையான 
அமைப்புகளைத் (settings) 
தேர்ந்தெடுக்கவும்.

2.	 மேடையில் செவ்வகம் வரைய 
வேண்டிய இடத்திற்கு சுட்டியைக் 
க�ொண்டு வரவும்.  செவ்வகம் 
வரைவதற்கு சுட்டியின் இடது 
ப�ொத்தானை அழுத்திக் க�ொண்டே 
இழுக்கவும்.

3.	 தேவையான அளவில் 
செவ்வகத்தைப் பெற்ற பின் சுட்டியின் 
ப�ொத்தானை விட்டுவிடவும்.

	 சுட்டியின் ப�ொத்தானை அழுத்திக் 
க�ொண்டு இழுக்கும் ப�ோது (dragging) 
shift ப�ொத்தானை அழுத்திப் 
பிடிப்பதன் மூலம் Rectangle tool ஐப் 
பயன்படுத்தி சதுரம் (square) வரைய 
முடியும்.

5. 8. 2	 Oval கருவி
இந்த கருவியைப் பயன்படுத்தி வட்டம் 
மற்றும் நீள்வட்டம் வரையலாம்.

நீள்வட்டம் வரைய பின்வரும் 
படிகளைப் பின்பற்றவும்.

1.	 கருவிப்பலகத்திலுள்ள Oval Tool (O) 
ஐ கிளிக் செய்யவும்

2.	 Property Inspector பலகத்திலிருந்து 
விரும்பும் நீள்வட்டத்தின் நிறம், 
தடிமன், வகை மற்றும் உட்பரப்பு 
வண்ணம் (fill color) ஆகியவற்றைத் 
தேர்ந்தெடுக்கவும்.

3.	 மேடையில் நீள்வட்டம் வரைய 
வேண்டிய இடத்திற்கு சுட்டியைக் 
க�ொண்டு வரவும்.  இப்பொழுது 
சுட்டி கூட்டல் குறியாக (+) மாறும்.  
நீள்வட்டம் வரைவதற்கு சுட்டியின் 
இடது ப�ொத்தானை அழுத்திக் 
க�ொண்டே இழுக்கவும்.

4.	 தேவையான அளவில் 
நீள்வட்டத்தைப் பெற்ற பிறகு 
சுட்டியின் ப�ொத்தானை விட்டு 
விடவும்.

	 சுட்டியின் ப�ொத்தானை அழுத்திக் 
க�ொண்டு இழுக்கும் ப�ோது (dragging) 
shift ப�ொத்தானை அழுத்திப் 
பிடிப்பதன் மூலம் oval tool ஐப் 
பயன்படுத்தி வட்டம் (circle) வரைய 
முடியும்.

படம் 5.13  கருவிப்பலகத்திலுள்ள oval tool
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2.	 Rectangle options பகுதியில் செவ்வக 
முனை ஆர மாற்றியில் கிளிக் 
செய்யவும்.

3.	 செவ்வக முனை ஆரத்திற்கு 0 
முதல் 999 வரையிலான மதிப்பை 
உள்ளட்டு OK கிளிக் செய்யவும்.

4.	 பணித்தளத்தில் வளைந்த முனை 
செவ்வகம் வரைய வேண்டிய 
இடத்திற்கு சுட்டியைக் க�ொண்டு 
வரவும்.  இதனை வரைவதற்கு 
சுட்டியின் இடது ப�ொத்தானை 
அழுத்திக் க�ொண்டே இழுக்கவும்.

5.	 தேவையான அளவில் வளைந்த 
முனை செவ்வகம் கிடைத்த உடன் 
சுட்டியின் ப�ொத்தானை விட்டு 
விடவும்

படம் 5.15  செவ்வகம் மற்றும் சதுரம்

Rectangle கருவியைப் பயன்படுத்தி 
வளைந்த முனைகளைக் க�ொண்ட 
செவ்வகமும் வரைய முடியும்.  இவ்வகைச் 
செவ்வகம் வரைய கீழ்க்கண்ட படிகளைப் 
பின்பற்றுக.

1.	 கருவிப்பலகத்திலுள்ள Rectangle 
tool (R) ஐக் கிளிக் செய்யவும்.

படம் 5.16  வளைந்த முனைகளைக் க�ொண்ட செவ்வகம்
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5. 8. 4	 Polystar கருவி
இந்த கருவி பலக�ோணம் (Polygons) மற்றும் நட்சத்திரம் (Star) வரையப் பயன்படுகிறது.  
எனவே இதன் பெயர் Polystar என்றானது.  பலக�ோணத்தின் பக்கங்களின் எண்ணிக்கை 
அல்லது ஒரு நட்சத்திரத்தின் புள்ளிகளின் எண்ணிக்கை 3 முதல் 32 வரை வேறுபடுகிறது.

Poly star கருவியைப் பயன்படுத்த, கீழ்க்காணும் படிகளைப் பின்பற்றவும்.
1.	 Rectangle Tool ப�ொத்தானிலுள்ள கீழிறங்கு அம்புக் குறியைக் கிளிக் செய்யவும்.  

த�ோன்றும் துணைப்பட்டியில் Poly star Tool என்பதைத் தேர்வு செய்யவும்.
2.	 Property Inspector பலகத்திலிருந்து இந்த வடிவத்திற்கு தேவையான அமைப்புகளைத் 

(Settings) தேர்ந்தெடுக்கவும்.
3.	 Property Inspector பலகத்திலுள்ள Option ப�ொத்தானை கிளிக் செய்யவும்.
	 அ) �Style கீழிறங்கு பட்டிப் பெட்டியிலிருந்து Polygon அல்லது star என்பதைக் கிளிக் 

செய்யவும்.
	 ஆ) �பலக�ோணத்தின் பக்கங்களின் எண்ணிக்கை அல்லது நட்சத்திரப் புள்ளிகளின் 

எண்ணிக்கையைக் குறிக்க 3 முதல் 32 வரையிலான எண்ணை உள்ளிடவும்.
	 இ) �Style பட்டிப்பெட்டியிலிருந்து star தேர்ந்தெடுக்கப்பட்டால், பிறகு star point size 

உரைப்பட்டியில் 0 மற்றும் 1, ஆகியவற்றுக்கு இடையிலான மதிப்பை உள்ளிட 
வேண்டும.  0 என்ற மதிப்பு நட்சத்திரம் அதிகபட்ச ஆழத்துடன் உருவாக்கப்பட 
வேண்டும் என்பதைக் குறிக்கிறது. 1 என்ற மதிப்பு நட்சத்திரம் குறைந்தபட்ச 
ஆழத்துடன் உருவாக்க வேண்டும் என்பதைக் குறிக்கிறது.

	 OK ப�ொத்தானைக் கிளிக் செய்யவும்.
4.	 பணித்தளத்தில் கிளிக் செய்து இழுப்பதன் மூலம் தேவையான வடிவத்தை 

வரையலாம்.

படம் 5.17  கருவிப்பலகத்திலுள்ள Poly star Tool
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படம் 5.18  பலக�ோணம் (Polygon)

படம் 5.19  நட்சத்திரம்

5.9  Eraser Tool
இந்த கருவி சாதாரண அழிப்பானைப் 
ப�ோலவே ப�ொருட்கள் அல்லது பரப்புகளை 
அழிக்கப் பயன்படுகிறது.  Eraser Tool 
ஐத் தேர்ந்தெடுக்கும் ப�ோது Eraser mode 
modifier, Faucet modifier மற்றும் Eraser 
shape modifier ஆகியவை விருப்பப் 
பகுதியில் த�ோன்றும்.

Eraser mode modifier பயனருக்கு 
தேவையான அழிக்கும் முறையைத் 
தேர்ந்தெடுக்க உதவுகிறது. இந்த பணிக்குறி 
கீழ்க்காணும் ஐந்து விருப்பங்களைக் 
க�ொண்டுள்ளது.
Erase Normal: இது மேடையில் உள்ள 
அனைத்தையும் அழிக்கிறது.
Erase Fills: இந்த முறை ஒரு ப�ொருளைச் 
சுற்றியுள்ள வெளிக்கோட்டை விடுத்து 
உட்பரப்பை மட்டும் அழிக்கிறது.
Erase Lines: இந்த முறை உட்பரப்பை 
விடுத்து சுற்றியுள்ள வெளிக்கோட்டை 
மட்டும் அழிக்கிறது.
Erase selected Fills: இது தேர்ந்தெடுக்கப்பட்ட 
பரப்பு மற்றும் க�ோடுகளை மட்டும் 
அழிக்கிறது.
Erase Inside: இது அழிப்பானால் த�ொடப்படும் 
ப�ொருளின் பரப்பை அழிக்கிறது. இதில் 
வெளிக்கோடுகள் அழிக்கப்படுவதில்லை.  
நீங்கள் வெற்றுப்புள்ளியில் கிளிக் செய்தால் 
எதுவும் அழிக்கப்படுவதில்லை.
Faucet: இதுவும் வெளிக்கோடுகள் 
மற்றும் உட்ப்பரப்புகளை ஒரே கிளிக்கில் 
அழிக்கிறது. இதற்காக நாம் அழிப்பானை 
ப�ொருட்களின் மீது கிளிக் செய்து இழுக்கத் 
(drag) தேவையில்லை.
Eraser shape modifier அழிப்பானின் 
வடிவம் மற்றும் அளவைத் தேர்ந்தெடுக்க 
உதவுகிறது.

Erase கருவியை கீழே 
விவரிக்கப்பட்டுள்ள படி பல்வேறு 
வழிகளில் பயன்படுத்த முடியும்.

மேடையில் உள்ள அனைத்தையும் 
வேகமாக அழிக்க, கருவிப் பலகத்திலுள்ள 
Erase Toolஐ இருமுறை கிளிக் செய்யவும்.
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படம் 5.22  Eraser shape modifier

உட்பரப்புகள் அல்லது வெளிக்கோடுகள் 
நீக்குதல்.
கீழே உள்ள படிகளைப் பின்பற்றவும்

1.	 கருவிப்பலகத்திலுள்ள Erase Tool 
ஐக் கிளிக் செய்யவும்

2.	 Option பகுதியில் Faucet modifier 
கிளிக் செய்யவும்.

3.	 அழிக்க வேண்டிய க�ோடு அல்லது 
வண்ணப்பகுதியை (filled Area) 
கிளிக் செய்யவும்.

இழுப்பதன் மூலம் அழிக்க, பின்வரும் 
படிகளைப் பின்பற்றவும்

1.	 கருவிப் பலகத்திலுள்ள Erase Tool 
ஐக் கிளிக் செய்யவும்.

2.	 Eraser mode modifier மற்றும் 
Eraser shape modifier இல் 
தேவையான, விருப்பங்களில் கிளிக் 
செய்யவும்.  பயனர் Faucet modifier 
தேர்ந்தெடுக்கப்படவில்லை என்பதை 
உறுதிப்படுத்தக் க�ொள்ள வேண்டும்.

3.	 நீக்க வேண்டிய பகுதியில் சுட்டியை 
வைத்து இழுக்க வேண்டும்.

Eraser Shape

Faucet

Eraser Tool

Eraser Mode

படம் 5.20  கருவிப்பலகத்திலுள்ள Erase Tool

படம் 5.21  Eraser mode modifier
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5.11  �(Flash) ப�ொருட்களைத் 
தேர்தெடுத்தல்

Flash மேடையில் எந்தவ�ொரு ப�ொருளையும் 
பதிப்பிக்கும் முன், அதனைத் தேர்ந்தெடுக்க 
வேண்டும்.  Flash ப�ொருட்களைத் 
தேர்ந்தெடுப்பதற்கு பல்வேறு வழிகளை 
வழங்குகிறது.

5. 11. 1	 Selection Tool ஐப் 
பயன்படுத்தித் தேர்ந்தெடுத்தல்

ஒரு ப�ொருளைத் தேர்ந்தெடுப்பதற்கு 
Selection tool ன் மீது கிளிக் செய்ய 
வேண்டும்.  (கருவிப்பலகத்திலுள்ள 
கருமை நிற அம்புக்குறி), பிறகு அந்த 
ப�ொருளின் மீது கிளிக் செய்ய வேண்டும்.

அந்த ப�ொருள் ஓரக்கோடு (outline) 
எதையும் பெற்றிருக்கவில்லை எனில், 
Selection tool ஐப் பயன்படுத்தி கிளிக் 
செய்யவும், இப்பொழுது அந்தப் ப�ொருள 
தேர்ந்தெடுக்கப்படும்.

ஓரக்கோடு 
இல்லாத ப�ொருள்

படம் 5.24  ஓரக்கோடு மற்றும் இல்லாத ப�ொருள்

அந்த ப�ொருள் வெளிக்கோடு மற்றும் 
உட்பரப்பைப் பெற்றிருந்தால், உட்பரப்பை 
(fill) மட்டும் தேர்ந்தெடுக்க அதன் மீது கிளிக் 
செய்யவும்.  இப்பொழுது வெளிக்கோடு 
தேர்ந்தெடுக்கப்படாமல் விடப்பட்டிருக்கும்.  
வெளிக்கோடு மற்றும் உட்பரப்பு 
இரண்டையும் தேர்ந்தெடுக்க, அதன் மீது 
இரட்டை கிளிக் செய்ய வேண்டும்.

5.10  Text tool
இது பணித்தளத்தில் உரையைச் 
சேர்ப்பதற்குப் பயன்படுகிறது.  Text tool 
ஐப் பயன்படுத்துவதற்கு, கீழ்க்கண்ட 
படிகளைப் பின்பற்ற வேண்டும்.

1.	 கருவிப் பலகத்திலுள்ள Text tool ஐக் 
கிளிக் செய்யவும்.

2.	 Property Inspector பலகத்தில் 
விரும்பிய எழுத்து (font), எழுத்து 
அளவு, நிறம், பாங்கு (pattern), எழுத்து 
இடைவெளி, மற்றும் இசைவு ப�ோன்ற 
உரைக்கான விருப்பங்களைத் 
தேர்வு செய்ய வேண்டும்.

3.	 உரையைத் தட்டச்சு செய்ய, கீழ் 
உள்ள படிநிலைகளில் ஏதாவது 
ஒன்றைப் பின்பற்றவும்.

மேடையில் கிளிக் செய்து தட்டச்சு செய்யவும்.  
இது தட்டச்சு செய்யப்படும் உரைக்கு 
தகுந்தாற் ப�ோல் உரைப்பெட்டியை 
விரிவடையச் செய்கிறது.

மேடையில் கிளிக் செய்து இழுப்பதன் 
மூலம் ஒரு செவ்வகம் வரையவும்.  இது 
குறித்த அளவுள்ள உரைப்பெட்டியை 
உருவாக்குகிறது.  இப்பொழுது Text Boxல் 
உரையை உள்ளிடவும்.  உரையானது 
தானாகவே உரைப்பெட்டியின் 
அகலத்திற்குள் மடிந்து விடுகிறது.

படம் 5.23  Text tool ஐப் பயன்படுத்தி 
உரையைத் தட்டச்சு செய்தல்
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The object has an 
outline and a fill.

Only the fill is 
selected

Both the fill and the 
outline are selected.

படம் 5.25  ஓரக்கோடுடன் ப�ொருள்

முழுப் ப�ொருளையும் தேர்ந்தெடுக்க, 
Selection tool ஐப் பயன்படுத்தி Selection Box 
ஐப் உருவாக்க வேண்டும.  ஒரு முனையில் 
கிளிக் செய்து அதன் எதிர்முனையை 
ந�ோக்கி இழுக்க வேண்டும்.  தேர்ந்தெடுக்க 
வேண்டிய ப�ொருள் அல்லது ப�ொருட்கள் 
முழுவதும் Selection Box க்குள் 
உள்ளடக்கப்பட்டுள்ளதா என்பதை உறுதி 
செய்து க�ொள்ளவும்.

படம் 5.26  ஒரு ப�ொருளுக்கான Selection Box

படம் 5.27  முழுப�ொருள்களுக்கான Selection Box

வெளிக்கோட்டை மட்டும் 
தேர்ந்தெடுக்க, தேர்ந்தெடுக்கும்  கருவி 
மூலம் வெளிக்கோட்டை கிளிக் செய்யவும்

படம் 5.28  வெளிக்கோட்டை மட்டும் 
தேர்ந்தெடுப்பது

வெளிக்கோடு பல ப�ொருள்களாக 
இருந்தால், முழு வெளிக்கோட்டையும் 
தேர்ந்தெடுக்க அதை இரட்டை கிளிக் 
செய்யவும்.

பல இணைக்கப்படாத 
ப�ொருள்களைத் தேர்ந்தெடுக்க, ஒரு 
ப�ொருளைத் தேர்ந்தெடுத்து, பின்னர் Shift 
விசையை அழுத்திக்கொண்டு கூடுதல் 
ப�ொருள்களையும் தேர்ந்தெடுக்கவும். 
இவ்வாறு நீங்கள் Shift விசையை க�ொண்டு 
தேர்ந்தெடுக்கும் ப�ோது ஏற்கனவே 
தேர்ந்தெடுக்கப்பட்ட ப�ொருள்களுடன் 
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இழுக்கவும். நீங்கள் இழுக்கும் 
ப�ோது Flash ஒரு தேர்வு பகுதி 
உருவாக்குகிறது. Lasso 
தேர்ந்தெடுப்பை முடிக்க நீங்கள் 
த�ொடங்கிய இடத்தின் அருகில் சுட்டி 
ப�ொத்தானை விடுவிக்கவும்.

படம் 5.30 

(2)  Point-to-point தேர்வு செய்தல்
Lasso கருவி ப�ொருள்களின் point-to-
point  வகையில் தேர்வு செய்வதற்கும் 
பயன்படுத்தலாம். அத்தகைய தேர்வை 
உருவாக்க, இந்த வழிமுறைகளைப் 
பின்பற்றவும்.

1.	 கருவிகள் பலகத்தில் உள்ள Lass 
கருவியைக் கிளிக் செய்க.

2.	 விருப்பங்கள் பகுதியில் இருந்து 
Polygon Mode modifier ஐ கிளிக் 
செய்யவும்.

3.	 நீங்கள் தேர்வு செய்தலைத் 
த�ொடங்க, மேடையில் தேர்வு 
த�ொடங்க வேண்டிய புள்ளியில் 
கிளிக் செய்யவும்.

4.	 தேர்ந்தெடுக்கப்பட வேண்டிய 
ப�ொருளைச் சுற்றி க�ோடு வரைய 
(Outline) அந்த ப�ொருளை சுற்றி  
பணித்தளத்தில் த�ொடர்ந்து கிளிக் 
செய்யவும்.

5.	 தேர்ந்தெடுப்பை முடிக்க இரட்டை 
கிளிக் செய்யவும்.

நீங்கள் தேர்வு செய்த ப�ொருட்களையும் 
சேர்க்கலாம்.மேலும் எத்தனை 
ப�ொருட்களை வேண்டுமானாலும் தேர்வு 
செய்து க�ொள்ளலாம்.

படம் 5.29

தேர்ந்தெடுத்த அனைத்து 
ப�ொருட்களையும் கைவிட வெற்றுப் 
பகுதியில் கிளிக் செய்யவும். நீங்கள் பல 
ப�ொருள்களை தேர்ந்தெடுத்த பின் ஒரு 
ப�ொருளைத் கைவிட விரும்பினால், Shift 
ஐ அழுத்திக் க�ொண்டு அந்த ப�ொருளை 
கிளிக் செய்யவும்.

5. 11. 2	 Lasso கருவி க�ொண்டு தேர்வு 
செய்தல்

(1)  Freehand தேர்வு செய்தல்
Lasso கருவி தற்போக்காக வரைவதன் 
மூலம் ப�ொருட்களை தேர்ந்தெடுப்பதற்குப் 
பயன்படுத்தப்படுகிறது.

Lasso கருவியை பயன்படுத்த இந்த 
வழிமுறைகளைப் பின்பற்றவும்.

1.	 கருவிகள் பலகத்தில் உள்ள Lass 
கருவியைக் கிளிக் செய்க

2.	 Lasso freehand முறையில் தேர்வு 
செய்ய, Polygon Mode modifier 
தேர்ந்தெடுக்கப்படவில்லை என்பதை 
உறுதிப்படுத்தவும்.

3.	 மேடையில் எங்கு வேண்டுமானாலும் 
கிளிக் செய்து, நீங்கள் தேர்ந்தெடுக்க 
விரும்பும் ப�ொருட்களை சுற்றி 
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Polygon 
Mode

படம் 5.31  Point-to-point தேர்வு செய்தல்

5.12  Zoom கருவி
இந்த கருவி மேடையின் எந்த 
பகுதியையும் (zoom in) பெரிதாக்குவதற்கு 
மற்றும் (zoom out) சிரிதாக்குவதற்கு 
பயன்படுத்தப்படுகிறது. இவ்வாறு, zoom 
கருவி ப�ொருளின் காட்சி அளவை 
மாற்றுகிறது. ப�ொருட்களை பெரிதாக்க 
அல்லது சிறிதாக்க  விருப்பத்தேர்வுகள் 
பகுதியில் உள்ள  Enlarge அல்லது Reduce 
modifiers கிளிக் செய்க.

Zoom Tool

Enlarge

Reduce

படம் 5.32

5.13  Hand கருவி
மேடை பெரிதாக இருக்கும் ப�ோது, நீங்கள் 
முழு மேடையையும் ஒரே நேரத்தில் பார்க்க 
முடியாது. Hand கருவி உருப்பெருக்க 
அளவை மாற்றியமைக்காமல்  ப�ொருட்களை 
பார்க்க மேடையை நகர்த்த உதவுகிறது. 
இது மேடையில் ப�ொருளின் ஒரு பகுதியை 
மட்டும் நெருக்கமாக பார்க்க உதவுகிறது. 

Hand கருவியைப் பயன்படுத்த, 
இந்த வழிமுறைகளைப் பின்பற்றவும்.

1.	 கருவிகள் பலகத்தில் உள்ள Hand 
கருவியைக் கிளிக் செய்க.

2.	 மேடையை விரும்பிய பகுதிக்கு  
கிளிக் செய்து இழுக்கவும். Hand 
கருவி மேடையை மட்டும் நகர்த்தும்; 
ப�ொருட்களை அல்ல என்பதை 
நினைவில் க�ொள்க.

3.	 சுட்டியின் ப�ொத்தானை விட்டுவிடவும்.
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5.14  �Flash அசைவுப்படம் உருவாக்குதல்
Frame–by-Frame  அசைவுப்படம்
ஒரு frame-by-frame அசைவுப்பட மாதிரியை உருவாக்க கீழ்கண்ட படிகளை பின்பற்றவும்

1.	 உரை கருவியைத் தேர்ந்தெடுத்து உரையை தட்டச்சு செய்க. எடுத்துக்காட்டாக ‘Save 
Trees - Save Earth’.

படம் 5.33  உரையைத் தட்டச்சு செய்ய உரை கருவியைப் பயன்படுத்துதல்

2.	 உரையைத் தேர்ந்தெடுத்து Modify > Convert to Symbol (அல்லது) F8 செயல்பாட்டு 
விசையை அழுத்தி அதை சின்னமாக மாற்றவும். Convert to Symbol உரையாடல் 
பெட்டி த�ோன்றும். சின்னத்தின் பெயரை தட்டச்சு (எடுத்துக்காட்டாக Save Trees) 
செய்து OK ப�ொத்தானை அழுத்தவும். உரை சின்னமாக சேமிக்கப்படும்.

படம் 5.34  Modify பட்டியில் உள்ள Convert to symbol தேர்வு
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படம் 5.35  Convert to symbol உரையாடல் பெட்டி

3.	 நூலகப் பலகத்தில் புதிய சின்னம் த�ோன்றும். நூலகம் திறக்கப்படவில்லை என்றால் 
Window > Library யை தேர்ந்தெடுக்கவும்

4.	 காலக்கோட்டில் Layer 1 ன்  Frame 15  ஐ கிளிக் செய்யவும்.

படம் 5.36  Layer 1 ன்  Frame 15 ஐ தேர்வு செய்தல்

5.	 Insert > Timeline > Frame என்பதை தேர்வு செய்யவும்.

படம் 5.37  காலக்கோட்டில் Frames சேர்க்கப்பட்டது

6.	 Frame 15 தெரிவு செய்யப்பட்டிருக்கும் ப�ோது Insert> Timeline> Keyframe 
என்பதைத் தேர்ந்தெடுக்கவும். ஒரு Keyframe ஆனது, ப�ொருளின் சில பண்புகளை 
வெளிப்படையாக மாற்ற உதவும் ஒரு சட்டகம்  ஆகும். இந்த புதிய Keyframe ல், 
வண்ண கீற்றில் (Color tab) உள்ள drop-down பட்டியலைத் தேர்ந்தெடுப்பதன் மூலம் 
உரையின் நிறத்தை மாற்றுவீர்கள்.

படம் 5.38  frame 15 இல் ஒரு keyframe  சேர்த்தல்
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7.	 இதேப�ோல், நான்கு அல்லது ஐந்து keyframes களை சேர்த்து ஒவ்வொரு keyframe 
இன் உரை வண்ணத்தையும் மாற்றுக.

படம் 5.39  Frame 30, 45 இல் ஒரு keyframe  யை சேர்க்கிறது

8.	 சலனப்படம் அல்லது அசைவுப்படத்தை இயக்க Frame1 இல் Playhead ஐ வைத்து, Flash 
Play இல் Control> Test Movie>in Flash Professional யை தேர்வு செய்யவும்.

படம் 5.40  Test Movie தேர்வு செய்தல்
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நினைவில் க�ொள்க

படம் 5.41  Test Movie சாளரம்

9.	 Test Movie சாளரத்தை மூடவும்

●	 Adobe Flash Professional CS6 அனிமேஷன்களை உருவாக்க பயன்படும் மென்பொருள். 
அடிப்படை ப�ொருட்களை வரையவும்  காட்சிகளை உருவாக்கவும் பயன்படுத்தக்கூடிய 
கருவிகள் உள்ளன. இது (Adobe) அட�ோப் நிறுவனத்தால் உருவாக்கப்பட்டுள்ளது

●	 பணியிடத்தின் நடுவில் உள்ள வெள்ளை செவ்வக பகுதி மேடை (Stage) என்று 
அழைக்கப்படுகிறது

●	 (Timeline) காலக்கோடு என்பது Flash-ன் மிக முக்கியமான கூறுகளில் ஒன்றாகும். 
இது மேடைக்கு கீழே அமைந்துள்ளது. இது ஒவ்வொரு உறுப்பு த�ோற்றத்தையும் 
அனிமேஷனையும் குறிக்க பயன்படுத்தப்படுகிறது.

●	 க�ொடா நிலையாக உங்கள் ஃப்ளாஷ் பணியிடத்தின் வலது பக்கத்தில் Property 
Inspector த�ோன்றுகிறது.அது (Library Panel) நூலகக் குழுவுடன் இணைக்கப்பட்டுள்ளது

●	 ஃப்ளாஷ் மூலம் உரை, படங்கள், வீடிய�ோ மற்றும் (Projects) திட்டங்களுக்கு ஒலி 
மற்றும் உருவாக்கங்கள் மற்றும் பயன்பாட்டு இடைமுகங்களை ஒருங்கிணைக்க 
முடியும். ஃப்ளாஷ் மூலம் உருவாக்கபடும் எந்தவ�ொரு உள்ளடக்கமும் ஒரு பயன்பாடு 
என்று அழைக்கப்படுகிறது.

பாடம் 05  அட�ோப் ஃப்ளாஷ் ப்ரொப்பஷனல் CS6180
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பகுதி – அ 
	 I. 	� சரியான விடையைத் 

தேர்ந்தெடுத்து எழுதுக
1.	 Adobe Flash நிரல் மூலம் நீங்கள் 

எதனை உருவாக்க முடியும்?
	 அ) அனிமேஷன்கள்
	 ஆ) வலை பயன்பாடுகள்
	 இ )விளையாட்டு
	 ஈ) மேலே உள்ள அனைத்தும்
2.	 Flash பணியிட மையத்தின் நடுவில் 

உள்ள பெரிய வெள்ளை செவ்வக 
வடிவம் ---

	 அ) மேடை
	 ஆ) காலக்கோடு
	 இ). திரை
	 ஈ). பண்புகள்
3.	 ஒரு புதிய Flash ஆவணத்தை 

எவ்வாறு உருவாக்குவாய்?
	 அ) Insert → New
	 ஆ) Ctrl+W
	 இ) File → New
	 ஈ) Ctrl+D
4.	 க�ொடாநிலை பணித்தளத்தின் 

நிறம் வெள்ளை. இதை மாற்ற 
---- தேர்ந்தெடுக்கவும்.

	 அ) Modify → Document Properties
	 ஆ) Modify → Document
	 இ) Edit → Document
	 ஈ) Edit → Document Properties
5.	 Flash க�ோப்புகள் ---- எனவும் 

அழைக்கப்படுகிறது.
	 அ) Flash Guides	 ஆ) Flash Movies	
	 இ) Flash Rulers	 ஈ) Flash Timeline

வினாக்கள்

6.	 கவனத்தை ஈர்க்கும் வகையிலான 
பதாகைகளை (Banner) ---- மூலம்  
உருவாக்கலாம்.

	 அ) Access
	 ஆ) Word
	 இ) Flash
	 ஈ) Excel
7.	 Flash க�ோப்பின் க�ொடாநிலை 

விரிவாக்கம் ---
	 அ) .shw
	 ஆ) .doc
	 இ) .xls
	 ஈ) .fla
8.	 Flashல் நீங்கள் உருவாக்கும் எந்த 

உள்ளடக்கமாயினும் அது --- என்று 
அழைக்கப்படுகிறது.

	 அ) வரைகலை
	 ஆ) இடைமுகம்
	 இ) அசைவுப்படம்
	 ஈ) பயன்பாடு
9.	 நீங்கள் துரிகையை பயன்படுத்தி 

வரைவது ப�ோன்று க�ோடுகைள 
வரைய உதவும் கருவி

	 அ) Brush Tool	 ஆ) Lasso Tool
	 இ) Text Tool	 ஈ) Zoom Tool

10.	கீழ்கண்ட எந்த கருவி, கருவிப் 
பலகத்தில் ஒரே குழுவில் 
இடம்பெறவில்லை

	 அ) Rectangle Tool
	 ஆ) Oval Tool
	 இ) Line Tool
	 ஈ) PolyStar Tool
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5.	 Flash க�ோப்புகள் தானாகவே ---- 
விரிவுடன் உருவாகும்.

பகுதி – ஆ 
II.	   �மூன்று வரிகளில் விடையளிக்கவும்  

1.	 Flash என்பது என்ன?
2.	 Adobe ProfessionalFlash CS6ஐ  

த�ொடங்க தேவையான 
படிநிலைகளை எழுதுக.

3.	 காலக்கோட்டின் (Time line) ன் 
தேவை என்ன?

பகுதி – இ 
III.  	� ஒரு பத்தியளவில் 

விடையளிக்கவும்  
1.	 கீழ்கண்ட செயல்களை செய்ய 

உதவும் கருவிகளை கூறுக.
	 அ. க�ோடு வரைதல்
	 ஆ. தற்போக்கு உருவம் வரைதல்
	 இ. நீங்கள் வரைந்தவற்றை அழித்தல்
2.	 Zoom கருவி மற்றும் Hand கருவி 

வேறுபாடுகளைக் கூறுக.

பகுதி – ஈ 
IV.	  �ஒரு பக்க அளவில் 

விடையளிக்கவும்
1.	 Flash சன்னல்திரையில் 

பயன்படுத்தும் கூறுகளை விவரி.
2.	 Tools பலகத்தில் காணப்படும் 

கருவிகள் சிலவற்றை விவரி.

11.	Ovalகருவியை பயன்படுத்தி 
எவ்வாறு ஒரு வட்டத்தை 
வரையலாம﻿்?

	 அ) �Ctrl விசையை அழுத்தி வைத்துக் 
க�ொண்டே.

	 ஆ) �Alt விசையை அழுத்தி வைத்துக் 
க�ொண்டே.

	 இ) �P விசையை அழுத்தி வைத்துக் 
க�ொண்டே.

	 ஈ) �Shift விசையை அழுத்தி வைத்துக் 
க�ொண்டே.

12.	எந்த கருவி ஒரு வரைபடத்தின் 
குறிப்பிட்ட பகுதியை பெரிதாக்கி 
காட்டும்.

	 அ) The Free Transform Tool
	 ஆ) The Rectangle tool
	 இ) The Zoom tool
	 ஈ) The Selection tool

II க�ோடிட்ட இடங்களை நிரப்புக
1.	 பணித்தளத்தில் --------

-- கருவியை பயன்படுத்தி ஒரு 
நேர்கோட்டை வரையலாம்.

2.	 ஒரு வட்டம் வரைய Oval கருவியை 
கிளிக் செய்து ---- விசையை 
அழுத்தி க�ொண்டே நகர்த்த 
வேண்டும்.

3.	 நீங்கள் ---- கருவி மூலம் சதுரம் 
வரைய முடியும்.

4.	 சாதாரன அழிப்பான் ப�ோன்று 
ப�ொருட்களை அழிப்பதற்கு 
----- உதவுகிறது.

பாடம் 05  அட�ோப் ஃப்ளாஷ் ப்ரொப்பஷனல் CS6182
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06பாடம்

ஆட்டோகேட் 2016

 கற்றலின் ந�ோக்கங்கள்
●	 ஆட்டோகேடை த�ொடங்குவது எப்படி?
●	 புதிய வரைபடத்தை த�ொடங்குவது எப்படி?
●	 பயனர் இடைமுகம் மற்றும் வரைபட பகுதி, பணிக்குறி, பட்டிப்பட்டைகள், கருவிப்பட்டைகள், 

கட்டளை வரி, நிலைமைப்பட்டை ப�ோன்ற அதன் பல்வேறு பகுதிகள்
●	 கட்டளை வரியில் கட்டளையைக் க�ொடுப்பது எப்படி?
●	 பட்டிப்பட்டையலிருந்து கட்டளையைக் க�ொடுப்பது எப்படி?
●	 க�ோடுகள் வரைவது எப்படி?
●	 வரைபடத்தை முதன் முதலில் சேமிப்பது எப்படி?
●	 ஒரு வரைபடத்தை மூடுவது எப்படி?
●	 ஆட்டோகேடிலிருந்து வெளியேறுவது எப்படி?

6.1  ஆட்டோகேட் 2016 ஓர் அறிமுகம்
ஆட்டோகேட் என்பது கணினி உதவியுடன் 
வடிவமைப்பு செய்வதற்கான (CAD – 
Computer Aided Design) வணிகரீதியான 
வரைவு மென் ப�ொருளாகும். இது 
ஆட்டோடெஸ்க் (Autodesk, Inc.) 
நிறுவனத்தால் உருவாக்கப்பட்டு 
விற்பனை செய்யப்படுகிறது.

ஆட்டோகேட் மென்பொருளானது 
உற்பத்தி, கட்டடம், சிவில் மேப்பிங் 
உள்ளிட்ட பல்வேறு த�ொழிற்துறைகளில் 
உள்ள கட்ட்டக் கலைஞர்கள், CAD த�ொழில் 
நுட்ப வல்லுநர்கள், வடிவமைப்பாளர்கள், 
ப�ொறியாளர்கள், திட்ட மேலாளர்கள், 

CAD / IT மேலாளர்கள் ப�ோன்றவர்களால் 
பயன்படுத்தப்படுகிறது.

படம் 6.1
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படம் 6.3 

6.3  ஆட்டோகேடின் த�ொடக்கத்திரை
திரைமுகப்பில் உள்ள Auto CAD 2016 
– English பணிக்குறியை இருமுறை 
கிளிக் செய்தவுடன் ஆட்டோகேட் 2016 
இன் த�ொடக்கத் திரை த�ோன்றும்.  
புதிய வரைபடக் க�ோப்பை உருவாக்க, 
த�ொடக்கத் திரையில் Start Drawing 
என்பதைக் கிளிக் செய்ய வேண்டும்.

6.2  ஆட்டோகேட் 2016 ஐ த�ொடங்குதல்
ஆட்டோகேட் 2016 ஐ த�ொடங்க, 
திரைமுகப்பில் உள்ள Auto CAD 2016 – 
English பணிக்குறியை இருமுறை கிளிக் 
செய்ய வேண்டும்.  (அல்லது) Start > All 
Programs > Autodesk > AutoCAD 2016 > 
AutoCAD 2016 – English என்ற வரிசையில் 
கிளிக் செய்ய வேண்டும்.

படம் 6.2  திரைமுகப்பில் உள்ள Auto CAD 2016 
– English பணிக்குறி

படம் 6.4  ஆட்டோகேட் 2016இன் த�ொடக்கத் திரை

St
ar

t D
ra

w
in

g

XII CompTech_Tamil version CHAPTER 06.indd   184 12/01/2022   15:00:17

www.tntextbooks.in



185பாடம் 06  ஆட்டோகேட் 2016

6.4  �ஆட்டோகேட் 2016இன் இடைமுகம் (Auto CAD 2016 interface)
ஆட்டோகேட் 2016 இன் இடைமுகமானது ரிப்பன்களையும், பயன்பாட்டுப் பட்டிகளையிம் 
அடிப்படையாகக் க�ொண்டது.  இந்த இடைமுகத்தின் முக்கியமான அம்சம் வரைகலைப் 
பகுதியின் அளவு பெரியதாக இருக்கும்.

Ribbon

DRAWING AREA

In-Canvas Controls

Start Tab

File Tab

Title BarQuick Access 
Toolbar

Application Button

ViewCube

Navigation Bar

Workspace  
Switching  

menu
Status Bar

User Coordinate System

Command Line

படம் 6.5  ஆட்டோகேட் 2016 இல் Drafting & Annotation பணித்தளத்தின் திரைக்கூறுகள்

6. 4. 1	 பயன்பாட்டுப் பட்டி (Application 
Menu)

சிவப்பு நிறத்தில் உள்ள பயன்பாட்டுப் 
ப�ொத்தானைக் (A) கிளிக் செய்தால், 
பயன்பாட்டுப் பட்டி த�ோன்றும்.  
இந்த பட்டியானது, புதிய க�ோப்பை 
உருவாக்குதல், ஏற்கனவே உள்ள 
க�ோப்பைத் திறத்தல், நடப்புக் க�ோப்பை 
சேமித்தல், நடப்பு க�ோப்பை வேற�ொரு 
பெயரில், வேறு க�ோப்புறையில் சேமித்தல், 
வேறு க�ோப்பு வடிவத்தில் சேமித்தல், 
நடப்புக் க�ோப்பை அச்சிடுதல் ப�ோன்ற 

க�ோப்பு த�ொடர்புடைய கட்டளைகளைக் 
க�ொண்டிருக்கும்.

Application 
Button

படம் 6.6  பயன்பாட்டுப் ப�ொத்தான்
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பயன்பாட்டுப் பட்டியில், சமீபத்தில் 
நாம் பயன்படுத்திய க�ோப்புகள் இருக்கும்.  
சமீபத்தில் பயன்படுத்திய க�ோப்புகளை 
எவ்வாறு காட்ட வேண்டும் என்பதை 
பயன்பாட்டுப் பட்டியிலுள்ள ப�ொத்தானைக் 
கிளிக் செய்து தேர்ந்தெடுக்கலாம்.

படம் 6.9 

படம் 6.10 

சமீபத்தில் பயன்படுத்திய 
க�ோப்புகளை என்னும் ப�ொத்தானைக் 
கிளிக் செய்து வரிசைப்படுத்தலாம்.

Search bar

படம் 6.7  பயன்பாட்டுப் பட்டி

பயன்பாட்டுப் பட்டியின் மேல் 
பகுதியில் தேடல் பட்டை (Search bar) 
இடம்பெற்றிருக்கும். இந்தப் பட்டை 
கட்டளைகளைத் தேடுவதற்குப் 
பயன்படுகிறது.  இதில் ஏதேனும் ஒரு 
முக்கியச் ச�ொல்லை தட்டச்சு செய்தால், 
அது த�ொடர்புடைய கட்டளைகளின் 
பட்டியலைக் காட்டும்.
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படம் 6.8  பயன்பாட்டுப் பட்டியிலுள்ள Search 
பட்டை
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187பாடம் 06  ஆட்டோகேட் 2016

6. 4. 2	 தலைப்புப் பட்டை (Title bar)
தலைப்புப் பட்டையானது Autodesk AutoCAD 2016 என்னும் மென்பொருளின் பெயரையும், 
தற்போதைய வரைபடத்தின் பெயரையும் (Drawing1.dwg) க�ொண்டிருக்கும்.

படம் 6.11  தலைப்புப் பட்டை

6. 4. 3	 விரைவு அணுகல் கருவிப்பட்டை (Quick Access Toolbar)
இந்த கருவிப்பட்டை, சன்னல் திரையின் இடது மேல் ஓரத்தில் சிவப்பு நிற ப�ொத்தானை 
அடுத்துக் காணப்படும்.  இந்தப் பட்டை Workspace மற்றும் Undo/Redo கட்டளைகளுக்கும், 
பயன்பாட்டுப் பட்டையில் உள்ள அனைத்து க�ோப்புக் கட்டளைகளுக்கும் பணிக்குறிகளைக் 
க�ொண்டிருக்கும்.

New	 Open	 Save	 Save as	 Plot	 Undo	 Redo	 Arrow

படம் 6.12  விரைவு அணுகல் கருவிப்பட்டை

இந்த பட்டையின் இறுதியிலுள்ள 
அம்புக்குறியைக் கிளிக் செய்வதன் மூலம் 
விரையு அணுகல் கருவிப்பட்டையைத் 
தனிப்பயனாக்கலாம் (customize) 
அம்புக்குறியைக் கிளிக் செய்யும் ப�ோது 
படத்தில் காட்டியுள்ளவாறு பட்டியல் 
த�ோன்றும்.

விரைவு அணுகல் 
க ரு வி ப ்ப ட ்டையைத்     
தனிப்பயனாக்குவதன் மூலம் 
கட்டளைகளை சேர்க்கவும், நீக்கவும் 
முடியும். Show Menu Bar என்பதைக் கிளிக் 
செய்து பட்டிப்பட்டையை சேர்க்க முடியும்.

படம் 6.13  விரைவு அணுகல் கருவிப்பட்டையைத் 
தனிப்பயனாக்குதல்
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6. 4. 4	 ரிப்பன் (Ribbon)
ஆட்டோகேட் 2016 சன்னல் திரையின் மேல் பகுதியிலுள்ள தலைப்புப் பட்டைக்கு கீழே 
உள்ள பகுதி ரிப்பன் ஆகும்.  இந்த ரிப்பன் இரண்டு பகுதிகளை உடையது.  

Ribbon Tab

Ribbon Panel
படம் 6.14  முழு ரிப்பன் இடைமுகம்

ரிப்பனின் Home த�ொகுதியில் Draw, Modify, Annotation, Layers ப�ோன்ற பேனல்கள் 
இருக்கும்.  Draw, Modify ப�ோன்ற சில பேனல்கள் திரையில் காண்பிப்பதைவிட அதிக 
ப�ொத்தான்களைக் க�ொண்டிருக்கும்.  மேலும் பல குருவிகளைக் காண்பிக்கும் வகையில் 
இந்தப் பேனல்களை விரிவாக்க முடியும்.  பேனல் தலைப்பின் வலது புறத்தில் உள்ள 
அம்புக்குறியைக் கிளிக் செய்து பேனலை விரிவாக்க முடியும்.  இது கூடுதல் கருவுகளையும் 
கட்டுப்பாடுகளையும் க�ொண்டிருக்கும்.  சுட்டியை மற்றொரு பேனலுக்கு நகர்த்தினால�ோ 
அல்லது கிளிக் செய்தாலே விரிவாக்கப்பட்ட பேனல் தானமைவாக மூடிவிடும்.  
விரிவாக்கப்பட்ட பேனலை அப்படியே வைத்திருக்க, பேனலின் கீழ் இடது ஓரத்தில் உள்ள 
Push பணிக்குறியைக் கிளிக் செய்ய வேண்டும்.

Click to Expand

Home tab

படம் 6.15  விரிவாக்கப்பட்ட Draw பேனல்

சில கட்டளைகள் பல விருப்பங்களைக் க�ொண்டிருக்கும்.  படத்தில் காட்டியுள்ள படி, ஒரு 
ப�ொத்தானைக் கிளிக் செய்தால் அதில பல விருப்பங்கள் இருக்கும்.  இந்த விருப்பங்களை 
எளிதில் அணுக முடியும்.
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படம் 6.16  கூடுதல் விருப்பங்களுடன் கூடிய ப�ொத்தான்கள்

ரிப்பன்கள் எளிமையான உதவி வசதிகளைக் க�ொண்டுள்ளது.  ஒரு ப�ொத்தானின் மீது 
சுட்டியை வைக்கும் ப�ோது, சிறிய உதவித் திரை த�ோன்றும்.

படம் 6.17  சிறிய உதவித் திரை

ஒரு ப�ொத்தானின் மீது சுட்டியை நீண்ட நேரம் வைத்திருக்கும் ப�ோது, ஆட்டோகேட் அந்தப் 
ப�ொத்தானைப் பற்றிய விரிவான உதவித் திரையை காண்பிக்கும்.
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படம் 6.18  விளக்கத்துடன் கூடிய உதவித் திரை

பேனல்கள் docked மற்றும் floating என இருநிலைகளைக் க�ொண்டுள்ளன.  ரிப்பனில் 
உள்ள பேனல்கள் அனைத்தும் அதன் த�ொகுதியைப் ப�ொறுத்து, தானமைவாக docked 
நிலையில் இருக்கும்.  வரைபடப் பகுதியில் பேனலை கிளிக் செய்து இழுத்து விடுவதன் 
மூலம் அதை நிலைக்கு மாற்ற முடியும்.

பேனலை பழைய நிலைக்கு திரும்பச் செய்ய, மேல் வலது ஓரத்தில் உள்ள சிறிய 
அம்புக் குறி ப�ொத்தானைக் கிளிக் செய்ய வேண்டும்.

படம் 6.19  Draw பேனல்

பேனல் floating நிலையில் இருக்கும் ப�ோது அதன் ஓரியன்டேசனை (orientation) மாற்றிக் 
க�ொள்ள முடியும்.
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படம் 6.20

இதை வலது புறமாகவ�ோ அல்லது கீழ் புறமாகவ�ோ விரிவாக்க முடியும்.

	

படம் 6.21  வலது புறமாக விரிவாக்கப்பட்ட பேனல்

படம் 6.22  கீழ் புறமாக விரிவாக்கப்பட்ட பேனல்

ரிப்பன் காட்சிமுறையை மாற்றுதல்
ரிப்பனின் மேல்பகுதியில் உள்ள சிறிதாக்குப் ப�ொத்தானை கிளிக் செய்வதன் மூலம் அதன் 
காட்சிமுறையை மாற்ற முடியும்.  ரிப்பன் கீழே காட்டப்பட்டுள்ளவாறு மூன்று விதமாக்க் 
காட்சியளிக்கும்.
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1.	 முதல் முறையாக சிறிதாக்குப் ப�ொத்தானை கிளிக் செய்யும் ப�ோது ரிப்பன் த�ொகுதிகள் 
மற்றும் பேனல் ப�ொத்தான்களுடன் காட்சியளிக்கும்.  இப்பொழுது பேனல் ப�ொத்தானின் 
மீது சுட்டியை நகர்த்தினால், அந்த பேனலில் உள்ள அனைத்துக் கருவிகளும் தெரியும்.

Panel button
படம் 6.23  பேனல்களாக சிறிதாக்கப்பட்ட ரிப்பன்

2.	 இரண்டாவது முறையாக சிறிதாக்குப் ப�ொத்தானை கிளிக் செய்யும் ப�ோது, பேனல் 
ப�ொத்தான்கள் பேனல் தலைப்புகளாக மாறும்.  இப்பொழுது சுட்டியை பேனல் 
தலைப்புகளின் மீது நகர்த்தினால் அதற்குரிய கருவிகளைக் காட்டும்.

Panel title
படம் 6.24  பேனல் தலைப்புகளாக சிறிதாக்கப்பட்ட ரிப்பன்

3.	 மூன்றாவது முறையாக சிறிதாக்குப் ப�ொத்தானை கிளிக் செய்யும் ப�ோது, பேனல் 
தலைப்புகள் பேனல் த�ொகுதிகளாக மாறும்.  இப்பொழுது சுட்டியை பேனல் தலைப்பின் 
மீது நகர்த்தும் ப�ோது எந்த மாற்றமும் ஏற்படாது.  ரிப்பனில் உள்ள த�ொகுதியைக் கிளிக் 
செய்தால் தற்காலிகமாக முழு பேனலையும் காண்பிக்கும்.  சுட்டியை பேனலைவிட்டு 
வெளியே நகர்த்தியவுடன் அது மறைந்து விடும்.

Panel Tab
படம் 6.25 பேனல் த�ொகுதிகளாக சிறிதாக்கப்பட்ட ரிப்பன்

4.	 சிறிதாக்கு ரிப்பன் ப�ொத்தானின் பட்டியில் உள்ள Cycle through All என்ற விருப்பம் 
தேர்வு செய்யப்பட்டிருப்பதை உறுதி செய்து க�ொண்டு, சிறிதாக்கு ப�ொத்தானை 
நான்காவது முறை கிளிக் செய்ய வேண்டும்.  இப்பொழுது ரிப்பன் இடைமுகம் 
முழுவதுமதாக திரும்பப் பெறப்படும்.

படம் 6.26  சிறிதாக்கப்பட்ட ரிப்பன் ப�ொத்தானின் பட்டி
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படம் 6.27  முழுமையான ரிப்பன் இடைமுகம்

6. 4. 5	 Start த�ொகுதி
Start த�ொகுதியைக் கிளிக் செய்தவுடன், ஆட்டோகேட் 2016 இன் த�ொடக்கத் திரை 
மறுபடியும் த�ோன்றும்.  அதன் மூலம் புதிய வரைபடத்தைத் த�ொடங்குதல், ஏற்கனவே உள்ள 
வரைபடத்தை திறத்தல் ப�ோன்ற செயல்களைச் செய்யவும்.

படம் 6.28  Start த�ொகுதி

6. 4. 6	 File த�ொகுதி
ரிப்பனுக்கு கீழே File த�ொகுதி பட்டை உள்ளது.  திறக்கப்படும் ஒவ்வொரு க�ோப்பிற்கும் 
ஒரு த�ொகுதி உருவாக்கப்படும்.  File த�ொகுதியின் மலம் ஒரு வரைபடக் க�ோப்பிலிருந்து 
மற்றொரு வரைபடக் க�ோப்பிற்கு எளிதாக தாவிச் செல்ல முடியும்.

File த�ொகுதிப் பட்டையின் இறுதியில் உள்ள கூட்டல் (+) குறியைக் கிளிக் செய்வதன் 
மூலம் புதிய வரைபடக் க�ோப்பை உருவாக்க முடியும்.

ரிப்பனின் கீழ்ப்பகுதியில் File த�ொகுதிப்பட்டை அமைந்துள்ளது.  இந்த பட்டையில் 
வரைபடங்கள் உருவாக்கப்பட்ட வரிசை முறையில் த�ொகுதிகள் அமைந்திருக்கும்.  சுட்டி 
மூலம் கிளிக் செய்து இந்த வரிசை முறையை மாற்ற முடியும்.  இதற்கு த�ொகுதியின் மீது 
சுட்டியின் இடது ப�ொத்தானைக் கிளிக் செய்து இழுத்து தேவையான இடத்தில் விட 
வேண்டும்.

அனைத்து File த�ொகுதிகளும் சாம்பல் நிறத்தில் இருக்கும். நடப்பு File த�ொகுதி வெளிர் 
சாம்பல் நிறத்திலும், மற்ற த�ொகுதிகள் அடர் சாம்பல் நிறத்திலும் இருக்கும்.

ஒரு File த�ொகுதியின் மீது சுட்டியை வைக்கும் ப�ோது, இரண்டு செயல்கள் 
நடைபெறுகின்றன.
●	 அந்த க�ோப்பின் பாதை (path) File த�ொகுதியின் மேலே த�ோன்றும்.
●	 அந்த க�ோப்பின் மாதிரியும், வடிவமைப்பும் File த�ொகுதியின் கீழே த�ோன்றும்.
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படம் 6.29  File த�ொகுதி பட்டை

File த�ொகுதியில் உள்ள க�ோப்புப் பெயரில் த�ோன்றும் நட்சத்திர குறியீடு, அந்தக் க�ோப்பில் 
மாற்றம் செய்யப்பட்டுள்ளது என்பதையும், அது சேமிக்கப்பட வேண்டும் என்பதையும் 
குறிக்கிறது.
●	 File த�ொகுதியில் க�ோப்புப் பெயருக்கு அருகில் உள்ள மூடு ப�ொத்தானைக் (X) கிளிக் 

செய்து அந்த்த் த�ொகுதியை மூடலாம்.
●	 பயனர் விரும்பினால் File த�ொகுதிப் பட்டையை மூட முடியும்.  அதற்கு ரிப்பனில் உள்ள 

View த�ொகுதியைக் கிளிக் செய்து த�ோன்றும் Interface பேனலில் உள்ள File tab 
ப�ொத்தானைக் கிளிக் செய்தால் File த�ொகுதி பட்டை மூடப்படும்.

படம் 6.30  File த�ொகுதிப் ப�ொத்தான்

6. 4. 7	 வரைபடப் பகுதி
திரையின் பெருமளவுப் பகுதி வரைபடப் பகுதி (Drawing Area) ஆகும்.  இதில் 
ப�ொருள்களையும், முப்பரிமாண வரைகலைகளையும் எளிதாக வரைய முடியும்.

படம் 6.31  வரைபடப் பகுதி

6. 4. 8	 கட்டளை சாளரம் (Command Window)
பயன்பாட்டு சாளரத்தின் அடிப்பகுதியில், நிலைமைப் பட்டைக்கு (Status bar) மேலாக 
கட்டளை சாளரம் அமைந்திருக்கும்.  இந்தச் சாளரத்தில் ப�ொதுவாக மூன்று உரை வரிகள் 
காணப்படும்.  முதல் இரண்டு வரிகள், இதற்கு முன் பயன்படுத்திய கட்டளைகளைக் காட்டும்.  
கடைசி வரியானது கட்டளை வரி ஆகும்.  கட்டளைச் சாளரம் த�ோன்றாவிட்டல் Ctrl + 9 
என்னும் விசைகளை அழுத்தி த�ோன்றச் செய்யலாம்.
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கட்டளை வரியில் செருகும் புள்ளி உள்ள இடத்தில் கட்டளைகளை உள்ளிட முடியும். இது 
Command: prompt என அழைக்கப்படும்.

கட்டளையின் முதல் எழுத்தை தட்டச்சு செய்தவுடன், அந்த எழுத்தில் த�ொடங்கும் 
அனைத்துக் கட்டளைகளின் பட்டியல் த�ோன்றும்.

குறிப்பு
கட்டளை வரியில் மதிப்புகளை உள்ளிட்டவுடன் நுழைவு விசையை அழுத்த வேண்டும்.
இந்தச் சாளரத்தை கிளிக் செய்து இழுத்து திரையில் எங்கு வேண்டுமானாலும் வைக்கலாம்.  
அளவையும் மாற்றலாம்.

Command history Command Line

படம் 6.32  கட்டளைச் சாளரம்

கட்டளையை உள்ளிடும் ப�ோது சிறிய எழுத்தில�ோ, பெரிய எழுத்தில�ோ அல்லது இரண்டும் 
கலந்தோ க�ொடுக்க முடியும்.  கட்டளை வரியில் தட்டச்சு செய்யும் ப�ொழுது பிழை ஏற்பட்டால், 
BACKSPACE விசை மூலம் அழித்துவிட்டு சரி செய்யலாம்.

ESC விசையை எந்த நேரத்தலும் அழுத்த முடியும்.  ஒரு செயல் செயல்பாட்டில் இருக்கும் 
ப�ொழுது ESC விசையை அழுத்தினால், அது அக்கட்டளையை முடிவுக்குக் க�ொண்டு வரும்.

ஆட்டோகேடில் முன்னதாகப் பயன்படுத்திய கட்டளையைத் திரும்பவும் பயன்படுத்த 
வேண்டுமெனில், Command: prompt இல் நுழைவு விசை (ENTER) அல்லது இடைவெளி 
விசையை (spacebar) அழுத்த வேண்டும்.  மாறாக சுட்டியை வலது கிளிக் செய்வதன் மூலம் 
த�ோன்றும் பட்டியில், Repeat என்னும் விருப்பத்தை தேர்ந்தெடுக்கலாம்.
சமீபத்திய உள்ளீடு (Recent input)
‘Command’: prompt இல் நாம் கடைசியாக தட்டச்சு செய்த 20 கட்டளைகளை, ஆட்டோகேட் 
நினைவில் க�ொண்டிருக்கும். இந்த கட்டளைகளுக்கு “Recent Input” என்று பெயர்.

கட்டளைகளின் பட்டியலைக் காண விரும்பினால் சுட்டியை வலது கிளிக் செய்து 
வரும் பட்டியில் Recent input என்பதைக் கிளிக் செய்ய வேண்டும்.  ஆட்டோகேட் இதற்கு 
முன் பயன்படுத்திய கட்டளைகளையும், ஆயத் த�ொலைவு உள்ளீடுகளையும் (Coordinate 
Inputs) துணைப்பட்டியலில் காட்டும்.

படம் 6.33  சமீபத்திய உள்ளீடுகள் மற்றும் அதன் துணைப்பட்டியல்
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2D Wheel

Zoom Extents

Orbit

Pan

படம் 6.35  உலவுதல் பட்டை

6. 4. 11	 நிலைமைப் பட்டை (Status Bar)
கட்டளை வரிக்கு கீழே நிலைமைப் 
பட்ட இருக்கும்.  சாளரத்தின் கீழ் வலது 
மூலையில் உள்ள பட்டை பயன்பாட்டு 
நிலைமைப் பட்டை (Application Status 
Bar) ஆகும்.

இது எளிமையாக படம் 
வரைவதற்குத் தேவையான பல 
ப�ொத்தான்களைக் க�ொண்டுள்ளது.  
இதன் மீது கிளிக் செய்து ON அல்லது OFF 
செய்யலாம்.

6. 4. 9	 UCS பணிக்குறி
வரைபடப் பகுதியின் கீழ் இடது மூலையில் 
உள்ள L வடிவ க�ோட்டிற்கு UCS பணிக்குறி 
என்று பெயர்.  UCS என்பது “User Coordinate 
system” என்பதன் குறுக்கமாகும்.
●	 முப்பரிமாண வரைபடங்களுக்கு UCS 

பணிக்குறி பெரிதும் பயன்படுகிறது.
●	 	இருபரிமாண வரைபடங்களுக்கு UCS 

பணிக்குறி தேவைப்படுவதில்லை.  
அப்பொழுது UCSICON கட்டளை மூலம் 
அதை நீக்கிவிடலாம்.  கீழ்க்கண்டவாறு 
கட்டளையின் பெயரைத் தட்டச்சு 
செய்து என்பதைத் தட்டச்சு off செய்ய 
வேண்டும.

●	 Command: ucsicon (ENTER விசையை 
அழுத்தவும்)

●	 Enter an option [ON / OFF / All / Noorigin 
/ Origin / Properties] <ON>: off (ENTER 
விசையை அழுத்தவும்)

UCS Icon

படம் 6.34  UCS பணிக்குறி

6. 4. 10	 உலவுதல் பட்டை (Navigation Bar)
உலவுதல் பட்டையானது வரைபடப் 
பகுதியில் இருக்கும்.  இது உலவுதலுக்கான 
கருவிகளைக் க�ொண்டிருக்கும்.

குறிப்பு
ஆட்டோகேட் 2016 இல் சன்னலின் கீழ்ப்புறத்தில 
நிலைமைப்பட்டை த�ோன்றவில்லை எனில், 
கட்டளை வரியில் STATUSBAR என தட்டச்சு 
செய்து நுழைவு விசையை அழுத்தவும்.  பிறகு 
மதிப்பு 1 என உள்ளிட்டு நுழைவு விசையை 
அழுத்தவும்.  இப்பொழுது நிலைமைப் பட்டை 
சன்னல் திரையின் கீழ்ப்புறத்தில் த�ோன்றும். 
Command: STATUSBAR
Enter the new value for STATUSBAR <0>:1
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தானமைவாக சில ப�ொத்தான்கள் மறைக்கப்பட்டிருக்கும்.  கீழ் வலது மூலையில் உள்ள 
Customization ப�ொத்தானைக் கிளிக் செய்து வரும் பட்டியில் உள்ள விருப்பங்களைத் 
தேர்ந்தெடுத்து, மேலும் பல ப�ொத்தான்களை நிலைமைப் பட்டையில் த�ோன்றச் செய்யலாம்.

Status Bar Application 
Status Bar

படம் 6.36  ஆட்டோகேட் 2016-நிலைமைப் பட்டை

Clean  
screen

Workspace  
Switching

Isometric Drafting 
ISODRAFT

Customization  
button

Drawing 
Coordinates

Restrict cursor to specified 
angles Polar Tracking (F10)

Restrict cursor orthogonally 
orthomode (F8)

Dynamic Input DYNMODE

Snap mode  
SNAPMODE(F9)

Display drawing Grid 
GRIDMODE (F7)

Model or Paper space
படம் 6.37  ஆட்டோகேட் 2016-பயன்பாட்டு நிலைமைப் பட்டை

வரைபட ஆயத்தொலைவுகள் (Drawing Coordinates)
ஆட்டோகேட் 2016 இல் டிராயிங் க�ோஆர்டினேட் ப�ொத்தான் தானமைவாக 
மறைக்கப்பட்டிருக்கும்.  கஸ்டமைஷேசன் பட்டியைப் (Customization menu) பயன்படுத்தி 
அதைக் காண்பிக்க முடியும்.  சுட்டியை வரைப்படப் பகுதியல் நகர்த்தும் ப�ோது, இது 
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ஆர்த்தோ மேடு (Ortho Mode – F8)
ஆர்த்தோ ம�ோடு ப�ொத்தானைக் 
கிளிக் செய்வதன் மூலம் அதை ON 
அல்லது OFF செய்யலாம்.  ஆர்த்தோ 
ம�ோடு தேர்ந்தெடுக்கப்பட்டிருந்நதால் 
செங்கோண வடிவில் மட்டுமே க�ோடுகளை 
வரைய முடியும்.  அதாவது செங்குத்தாக 
அல்லது கிடைமட்டமாக மட்டுமே 
க�ோடுகளை வரைய முடியும்.  ஆர்த்தோ 
ம�ோடை ON அல்லது OFF செய்வதற்கு 
விசைப்பலகையில் F8 விசையைப் 
பயன்படுத்த வேண்டும்.

ப�ோலார் டிராக்கிங் (Polar Tracking – F10)
ப�ோலார் டிராக்கிங் ப�ொத்தானைக் கிளிக் 
செய்வதன் மூலம் அதை ON அல்லது 
OFF செய்யலாம்.  ப�ோலார் டிராக்கிங் ON 
செய்திருந்தால், க�ோட்டின் திசை மற்றும் 
நீளம் பற்றிய சிறு குறிப்பு டிகிரி மற்றும் 
அலகுகளில் த�ோன்றும்.  5, 10, 15, 23, 
30, 45, அல்லது 90 டிகிரிகள் ப�ோன்ற 
க�ோண அதிகரிப்புகளுடன் க�ோடுகளை 
வரைய முடியும்.  ப�ோலார் டிராக்கிங்கை 
அல்லது செய்வதற்கு விசைப்பலகையில் 
F10 விசையைப் பயன்படுத்த வேண்டும்.

பணித்தளம் (Workspace)
பணித்தளம் என்பது வரைபடப் பகுதியின் 
இடம் மற்றும் த�ோற்றம், அனைத்துவித 
பட்டிகள், ப�ொத்தான்கள், ப�ொத்தான் 
த�ொகுதிகள் அடங்கிய ஒரு முழுமையான 
பயனர் இடைமுகம் ஆகும்.  ஆட்டோகேடின் 
அம்சங்கள் மற்றும் திறன்களை எந்த 
நேரத்திலும் பெறுவதற்கான ஒரு 
தனித்துவமான அமைப்பு பணித்தளம் 
ஆகும்.  ஆட்டோகேடில் பலவிதமான 
பணித்தளங்கள் உள்ளன.  ஒரு 
பணித்தளத்திலிருந்து மற்றொரு 
பணித்தளத்திற்கு எளிதாக மாற முடியும்.  
ஏற்கனவே உள்ள பணித்தளத்தை 
மாற்றி அமைக்க முடியும.  ஒரு குறிப்பிட்ட 

வரைபட ஆயத் த�ொலைவு புள்ளிகளைக் 
காட்டும்.  இது தேவையில்லையெனில், 
அந்தப் ப�ொத்தான் மீது கிளிக் செய்து OFF 
செய்யலாம்.

மாடல் (MODEL)
வரைபடம் வரைவதற்காக மாடல் 
பகுதியில் பணிபுரியும் ப�ொழுது, மாடல் 
(MODEL) ப�ொத்தான் தானமைவாகத் 
தேர்ந்தெடுக்கப்பட்டிருக்கும்.

கிரிட் ம�ோடு (GRIDMODE – F7)
கிரிட் ம�ோடு ப�ொத்தான் 
தேர்ந்தெடுக்கப்பட்டிருந்தால், டிராயிங் 
கிரிட் ON செய்யப்பட்டு திரையில் 
கட்டங்கள் தெரியும்.  கட்டங்களை 
மறைக்கவும் காண்பிக்கவும் (OFF or ON) 
விசைப்பலகையில் F7 ப�ொத்தானைப் 
பயன்படுத்த வேண்டும்.

ஸ்நாப் ம�ோடு (SNAPMODE – F9)
ஸ்நாப் ம�ோடு ப�ொத்தானைக் கிளிக் 
செய்தால், ஸ்நாப் ம�ோடு ON ஆகும்.  ஸ்நாப் 
ம�ோடு ON இல் இருந்தால் சுட்டியை 
நகர்த்தும் ப�ோது சுட்டுக்குறி ஒரு ஸ்நாப் 
ம�ோடியிலிருந்து மற்றொரு ஸ்நாப் 
ம�ோடிற்குத் தாவும்.  ஸ்நாப் ம�ோடை ON 
மற்றும் OFF செய்வதற்கு F9 விசையைப் 
பயன்படுத்த வேண்டும்.

டைனமிக் இன்புட் (Dynamic Input – F12)
டைனமிக் இன்புட்டை ON அல்லது OFF 
செய்வதற்கு நிலைமைப் பட்டையிலுள்ள 
டைனமிக் இன்புட் ப�ொத்தானைக் கிளிக் 
செய்ய வேண்டும்.  டைனமிக் இன்புட் 
ம�ோடு ON செய்யப்பட்டிருந்தால், சுட்டியை 
நகர்த்தும் ப�ோது x, y ஆயத் த�ொலைவு 
புள்ளிகளைக் காட்டும் டைனமிக் இன்புட் 
ம�ோடை ON அல்லது OFF செய்வதற்கு 
விசைப்பலகையில் F12 விசையைப் 
பயன்படுத்த வேண்டும்.
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படம் 6.38  Workspace Switching ப�ொத்தான்
ஆட்டோகேட் 2016 இல் மூன்று 

பணித்தளங்கள் உள்ளன.  அவையாவன 
Drafting & Annotation, 3D Basics, 
மற்றும் 3D Modeling ஆகும். இவற்றில் 
Drafting & Annotation பணித்தளம் 
தானமைவாக செயல்பாட்டில் இருக்கும்.  
இந்த பணித்தளத்தில் இருபரிமாண 
வரைபடங்களை எளிதாக வரைய முடியும்.

வேலைக்கான அல்லது ஒரு பயனரின் 
தேவைப்கேற்ப பணித்தளத்தை 
அமைத்துக் க�ொள்ள முடியும். 

பணித்தளம் ஒன்றிலிருந்து 
மற்றொன்றுக்கு மாறுதல் (Workspace 
Switching)
ஆட்டோகேட் 2016 இல் நிலைமைப் 
பட்டையின் வலது புறத்தில உள்ள 
Workspace Switching ப�ொத்தானைப் 
பயன்படுத்தி ஒரு பணித்தளத்திலிருந்து 
மற்றொரு பணித்தளத்திற்கு மாறலாம்.  
Workspace Switching ப�ொத்தானைக் 
கிளிக் செய்தால், அதிலுள்ள அனைத்துப் 
பணித்தளங்களின் பட்டியல்களைக் 
காட்டும்.  அதில் நாம் செயலாக்க வேண்டிய 
பணித்தளத்தை தேர்ந்தெடுத்துக் 
க�ொள்ளலாம்.

படம் 6.40  மூன்று விதமான பணித்தளங்கள்

படம் 39  Workspace switching பட்டி

குறிப்பு
மேல் இடது மூலையில் Workspace கீழிறங்குப் 
பட்டி த�ோன்றவில்லை எனில், விரைவு அணுகல் 
கருவிப்பட்டைக்கு அடுத்துள்ள கீழ்நோக்கிய 
அம்புக்குறியைக் கிளிக் செய்ய வேண்டும்.  
த�ோன்றும் பட்டியில் Workspace என்பதைக் 
கிளிக் செய்ய வேண்டும்.  பிறகு விரைவு 
அணுகல் கருவிப்பட்டையில் Workspace 
கீழிறங்குப் பட்டி த�ோன்றும்.

மேல் இடது மூலையிலுள்ள Workspace கீழிறங்குப் பட்டியின் மூலமாக பணித்தளங்கள் 
ஒன்றிலிருந்து மற்றொன்றிற்கு எளிதாக மாற முடியும்.
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படம் 6.43  கிளீன் ஸ்கிரீன் (Clan Screen)

தனிப்பயனாக்குதல் (Customization)
ஆட்டோகேட் சன்னல் திரையின் 
கீழ்ப்பகுதியில் காணப்படும் 
நி ல ை மை  ப ்ப ட ்டை  யி லு ள்ள  
ப�ொத்தான்களை தனிப்பயனாக்க முடியும்.  
Customization ப�ொத்தானைக் கிளிக் 
செய்தவுடன் ஒரு பட்டி திறக்கும்.  அதில் 
நிலைமைப்பட்டையில் காண்பிக்கப்பட 
வேண்டிய உறுப்களைத் தேர்ந்தெடுக்க 
வேண்டும்.

Customization button

படம் 6.44  Customization பட்டி

படம் 6.41  விரைவு அணுகல் கருவிப்பட்டைக்கு 
அடுத்துள்ள கீழ்நோக்யி அம்புக்குறி

படம் 6.42  Workspace கீழிறங்குப்பட்டி

கிளீன் ஸ்கிரீன் (Clean Screen)
கிளீன் ஸ்கிரீன் ப�ொத்தான் ஆனது 
ரிப்பன் ப�ோன்ற பெரும்பாலான 
இடைமுக்க்கூறுகளை மறைத்து, 
தற்போதைய வரைபடத்தில கவனம் செல்லும் 
படி வரைபடப் பகுதியைப் பெரிதாக்கிக் 
காட்டும்.  இந்தப் ப�ொத்தான் திரையின் கீழ் 
வலது மூலையில் காணப்படும். திரையின் 
முந்தைய நிலையைப் பெறுவதற்கு கிளீன் 
ஸ்கிரீன் ப�ொத்தானை மறுபடியும் கிளிக் 
செய்ய வேண்டும்.

XII CompTech_Tamil version CHAPTER 06.indd   200 12/01/2022   15:00:36

www.tntextbooks.in



201பாடம் 06  ஆட்டோகேட் 2016

6. 4. 12	 பட்டிப்பட்டை (Menu Bar)
பட்டிப்பட்டை தானமைவாகத் திரையில் தெரியாது.  பட்டிப்பட்டையைக் காண்பிக்க, விரைவு 
அணுகல் கருவிப்பட்டையிலுள்ள அம்புக்குறியைக் கிளிக் செய்ய வேண்டும்.  அப்பொழுது 
த�ோன்றும் பட்டியில் Show Menu Bar என்பதைத் தேர்ந்தெடுக்க வேண்டும்.  பிறகு த�ோன்றும் 
பட்டிப்பட்டையில் நமக்குத் தேவையான கட்டளைகளைத் தேர்ந்தெடுக்கலாம்.

படம் 6.45  Show Menu Bar தேர்வு

Menu Bar

படம் 6.46  பட்டிப்படை
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6.5  �செயல்பாட்டு விசைகள் (Function 
Keys)

குறிப்பிட்ட கட்டளைகளை விரைவாக 
செயல்படுத்த செய்ல்பாட் விசைத் 
த�ொகுப்புகளை ஆட்டோகேட் வழங்குகிறது.  
ஆட்டோகேட் 2016இல் உள்ள செயல்பாட்டு 
விசைகள் கீழே க�ொடுக்கப்பட்டுள்ளது.

செயல்பாட்டு 
விசைகள் 
(Function 

Keys)

ஆட்டோகேட் 2016 இல் 
வரையறுக்கப்பட்டுள்ள 
செயல்பாடுகள்

F1 ஆன்லைன் உதவி பெற

F2 கட்டளைச் சாளரத்தை ON 
மற்றுடம் OFF செய்ய

F3 OSNAPஐ ON மற்றும் OFF 
செய்ய

F4 Tabletஐ ON மற்றும் OFF 
செய்ய

F5 Isoplanesஇல் Right, Left 
மற்றும் Top ஆகியவற்றில் 
ஒன்றிலிருந்து 
மற்றொன்றுக்கு மாற

F6 Dynamic UCSஐ ON மற்றும் 
OFF செய்ய

F7 Grid ஐ ON மற்றும் OFF 
செய்ய

F8 Ortho Modeஐ ON மற்றும் 
OFF செய்ய

F9 Snap Modeஐ ON மற்றும் 
OFF செய்ய

F10 Polar Trackingஐ On மற்றும் 
OFF செய்ய

F11 Objects Snap Trackingஐ 
ON மற்றும் OFF செய்ய

F12 Dynamic Inputஐ ON மற்றும் 
OFF செய்ய

6. 4. 13	 கருவிப்பட்டை (Toolbar)
கருவிப்பட்டை தானமைவாகத் திரையில் 
தெரியாது.  ஒரு கருவிப்பட்டையைக் 
காண்பிக்க் Tools> Toolbars> Auto CAD 
என்ற் வரிசையில் கிளிக் செய்ய வேண்டும்.  
கருவிப்பட்டைகளின் பட்டியல் திரையில் 
த�ோன்றும்.

படம் 6.47  கருவிப்பட்டைகளின் பட்டியல்

அதில் தேவையான 
கருவிப்பட்டையைக் கிளிக் செய்ய 
வேண்டும்.  கீழே உள்ள படம் Draw 
கருவிப்பட்டையைக் காட்டுகிறது.

படம் 6.48  Draw கருவிப்பட்டை

XII CompTech_Tamil version CHAPTER 06.indd   202 12/01/2022   15:00:39

www.tntextbooks.in



203பாடம் 06  ஆட்டோகேட் 2016

6.6  �கட்டளை வரி இடைமுகத்தில் செயல்படுதல்
கட்டளை வரி இடைமுகமானது, முன்னியல்பாக வரைபடப் பகுதியின் கீழ்ப்பகுதியில் 
காணப்படும்.  இது ஆட்டோகேடுடன் த�ொடர்பு க�ொள்வதற்கான முதன்மை வழிமுறையை 
வழங்குகிறது.  நீங்கள் என்ன செய்ய விரும்புகிறீர்கள் என்பதை மென்பொருளுக்குக் கூற 
இந்த இடைமுகம் உதவுகிறது.  உங்களிடமிருந்து தேவையான தகவலைப் பெறுவதற்கு 
அட்டோகேட் இந்த இடைமுகத்தைப் பயன்படுத்துகிறது.

படம் 6.49  கட்டளை வரி இடைமுகம்

6.7  �ஆட்டோகேடில் புதிய 
வரைபடத்தைத் த�ொடங்குதல்

6. 7. 1	 லைன் டூலைப் பயன்படுத்தி 
வரைதல்

1.	 விரைவு அணுகல் 
கருவிப்பட்டையிலுள்ள New 
ப�ொத்தானைக் கிளிக் செய்ய 
வேண்டும்.

படம் 6.50  விரைவு அணுகள் 
கருவிப்பட்டையிலுள்ள New ப�ொத்தான்

	 ஆட்டோகேட் Select Template 
உரையாடல் பெட்டியைத் திரையில் 
த�ோன்றும்.

2.	 அதில் முன்வடிவமைத்தக் க�ோப்பான 
acad.dwt என்பதைத் தேர்ந்தெடுத்து 
Open ப�ொத்தானைக் கிளிக் செய்ய 
வேண்டும்.

படம் 6. 51  Select Template உரையாடல் பெட்டி

3.	 லைன் (LINE) கட்டளையை 
கீழ்க்கண்ட வழிகளில் 
செயல்படுத்தலாம்.

	 a) �Draw பேனலில் உள்ள லைன் 
டூல் பணிக்குறியைக் கிளிக் 
செய்யலாம்.

	 		  (அல்லது)
	 b) �பட்டிப்பட்டையில் Draw>Line 

என்பதைக் கிளிக் செய்யலாம்.  
(அல்லது)

	 c) �கட்டளை வரியில் LINE 
கட்டளையை உள்ளிடலாம்.  எ.கா. 
LINE <R>
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4.	 கீழ்க்கண்ட ஆட்டோகேட் ப்ராம்ட் 
(Auto CAD Prompts) த�ோன்றும்.

	 Specify first point: (க�ோட்டின் முதல் 
புள்ளியைக் குறிப்பிட, சுட்டி மூலம் 
திரையில் ஏதேனும் ஒரு இடத்தில் 
கிளிக் செய்ய வேண்டும்).

	 Specity next point pr [Undo]: 
இரண்டாவது புள்ளியைக் குறிப்பிட, 
சுட்டியை நகர்த்தி மற்றொரு 
இடத்தில் கிளிக் செய்ய வேண்டும்).

	 Specify next point of [Undo]: 
(மூன்றாவது புள்ளியைக் குறிப்பிட 
வேண்டும்).

	 Specify next point or [Close/Undo]: 
(லைன் டூலிலிருந்து வெளியேற 
ENTER விசையை அழுத்த 
வேண்டும்).

	 இப்பொழுது படத்தில் 
காட்டியுள்ளவாறு க�ோடு வரைபடப் 
பகுதியில் த�ோன்றும்.

படம் 6.52  Draw பேனலில் உள்ள லைன் டூல் 
பணிக்குறி

படம் 6. 53  கட்டளை வரி

First Point 
(Starting Point)

Next Point 
(Third Point)

Next Point 
(Second Point)

படம் 6.54  லைன் டூல் மூலமாக க�ோடுகள் வரைதல்
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கட்டளை வரியில் C எனத் தட்டச்சு செய்து 
நுழைவு விசையை அழுத்த வேண்டும்.

	 Command : LINE
	 Specify fist point: சுட்டி மூலம் முதுல் 

புள்ளியைக் கிளிக் செய்க.
	 Specify next point or [Undo]: சுட்டி 

மூலம் இரண்டாவது புள்ளியைக் 
கிளிக் செய்க.

	 Specify next point or [Undo]: சுட்டி 
மூலம் மூன்றாவது புள்ளியைக் 
கிளிக் செய்க.

	 Specify next point or [Close/Undo]: 
C எனத் தட்டச்சு செய்து நுழைவு 
விசையை அழுத்த வேண்டும்.  (இது 
மூன்றாவது புள்ளியையும் முதல் 
புள்ளியையும் இணைக்கிறது).

படம் 6.55  Close விருப்பத்தைப் பயன்படுத்தி 
க�ோடுகளை வரைதல்

திரையில் காணப்படும் வரைபடம் 
தன்னிச்சையான அளவுகளுடன் (Arbitrary 
Size) வரையப்பட்ட முக்கோணமாகும்.  
சரியான பரிமாணங்களைக் க�ொண்டு 
ப�ொயியல் வரைபடங்கள் தயாரிப்பதற்கு 
ஆயத்தொலைவு அமைப்புகள் (Coordinate 
Systems) பயன்படுகின்றன.

6. 7. 2	 ஆயத்தொலைவு அமைப்புகள் 
(Coordinate Systems)

ஆட்டோகேடில் ஒரு புள்ளியின் இருப்பிடம் 
கார்ட்டீசியன் ஆயத்தொலைவுகளின் 

குறிப்பு
சுட்டியைக் கிளிக் செய்து க�ோட்டின் முதல் 
புள்ளியைக் குறிப்பிட்டவுடன், அந்தப் 
புள்ளிக்கும் சுட்டுக்குறியின் தற்போதைய 
இடத்திற்கும் இடையே ரப்பர் பேண்டு 
க�ோடு உருவாகிறது.

லைன் டூலைக் க�ொண்டு க�ோடுகள் 
வரையும் ப�ோது, கட்டளை வரியில் Close 
மற்றும் Undo விருப்பங்கள் த�ோன்றுகிறது.

Undo விருப்பம்
ஒரு க�ோடு வரையும் ப�ோது முடிவுப் 
புள்ளியைத் தவறாகக் குறிப்பிட்டுவிட்டால், 
Undo கட்டளை மூலம் கடைசியாகக் 
குறிப்பிட்ட புள்ளியை நீக்கிவிட்டு, முந்தைய 
கட்டத்திற்குச் செல்லலாம்.  இந்தக் 
கட்டளையை பலமுறை பயன்படுத்த 
முடியும்.  இந்த விருப்பத்தைப் பயன்படுத்த, 
Specify next point or [Undo] கட்டளை 
வரியில் Undo அல்லது U எனத் தட்டச்சு 
செய்ய வேண்டும்.  சுட்டியை வலது கிளிக் 
செய்து த�ோன்றும் பட்டியலில் உள்ள Undo 
விருப்பத்தைத் தேர்ந்தெடுத்தும் இதைச் 
செய்யலாம்.

Close விருப்பம்
லைன் டூலைப் பயன்படுத்தி 
த�ொடர்ச்சியான இரண்டு க�ோடுகளை 
வரைந்த பின் கட்டளை வரியில் Close 
விருப்பம் த�ோன்றுவதைக் காணலாம்.  
(மூன்று புள்ளிகளைத் தேர்ந்தெடுக்கும் 
வரை Close விருப்பம் கட்டளை வரியில் 
த�ோன்றாது.)

இரண்டு அல்லது அதற்கு மேற்பட்ட 
த�ொடர்ச்சியான க�ோடுகளை வரையும் 
ப�ோது, Close விருப்பமானது முதல் 
க�ோட்டின் த�ொடக்கப் புள்ளியையும், 
கடைசி க�ோட்டின் முடிவுப் புள்ளியையும் 
இணைக்கப் பயன்படுகிறது.  முடிவுப் 
புள்ளியை சுட்டியைக் கிளிக் செய்து 
குறிப்பிட்டால், வரைபடத்தை முடிக்க 
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அல்லது இடது புறமாக அந்தப் புள்ளி 
எவ்வளவு த�ொலைவில் உள்ளது 
என்பதைக் குறிக்கிறது.  இப்பொழுது 
P என்ற புள்ளியிலருந்து Y அச்சிற்கு 
செங்குத்தாக ஒரு க�ோடு வரைய 
வேண்டும்.  அது Y அச்சை ஒரு புள்ளியில் 
வெட்டும்.  வெட்டும் அப்புள்ளிக்கும் 
ஆதீப்புள்ளிக்கும் இடையே உள்ள தூரம் P 
என்ற புள்ளியின் Y ஆயத்தொலைவு ஆகும்.  
இது P(y) என்று அழைக்கப்படுகிறது.  Y 
ஆயத்தொலைவானது, ஆதிப்புள்ளிக்கும் 
மேலாக அல்லது கீழாக Y அச்சின் 
வழியாக எவ்வளவு த�ொலைவில் உள்ளது 
என்பதைக் குறிக்கிறது.  கிடைமட்ட மற்றும் 
செங்குத்துக் க�ோடுகளின் வெட்டும் புள்ளி P 
என்ற புள்ளியின் ஆயத்தொலைவுகளைக் 
குறிக்கிறது.  இது P(x, y) என்று 
அழைக்கப்படுகிறது.  ஒரு புள்ளியானது 
ஆயப்புள்ளிக்கு வலப்புறமாக அமைந்தால், 
அதன் X ஆயத்தொலைவு நேர்மறையான 
மதிப்பைப் பெறும்.  மாறாக, அப்புள்ளி 
ஆயப்புள்ளிக்கு இடப்புறமாக அமைந்தால், 
அதன் X ஆயத்தொலைவு எதிர்மறையான 
மதிப்பைப் பெறும்.  ஒரு புள்ளியானது 
ஆயப்புள்ளிக்கு மேல் புறமாக அமைந்தால், 
அதன் Y ஆயத்தொலைவு ந�ோமறையான 
மதிப்பைப் பெறும்.  மாறாக, அப்புள்ளி 
ஆயப்புள்ளிக்கு கீழ்ப்புறமாக அமைந்தால், 
அதன் Y ஆயத்தொலைவு எதிர்மறையான 
மதிப்பைப் பெறும்.

அடிப்படையில் குறிப்பிடப்படுகிறது.  இந்த 
முறையில் ஒரு கார்ட்டீசியன் தளத்தில் 
உள்ள ஒவ்வொரு புள்ளியும் ஒரு ஜ�ோடி 
எண்களால் குறிப்பிடப்படுகின்றன.  
தளத்தில் உள்ள ஒரு புள்ளியைக் குறிப்பிட, 
ஒன்றுக்கொன்று செங்குத்தான இரண்டு 
க�ோடுகளை எடுத்துக் க�ொள்ள வேண்டும்.  
கிடைமட்டக் க�ோடு X அச்சு என்றும், 
செங்குத்துக் க�ோடு Y அச்சு என்றும் 
அழைக்கப்படுகிறது.  X மற்றும் Y அச்சுக்கள் 
XY தளத்தை நான்கு கால்பகுதிகளாகப் 
பிரிக்கின்றன.  இந்த இரண்டு அச்சுகளும் 
வெட்டுகின்ற புள்ளி ஆதிப்புள்ளி (origin) 
என்றும், அந்தத் தளம் XY கார்ட்டீசியன் 
தளம் என்றும் அழைக்கப்படும்.

ஆ தி ப் பு ள் ளி யி னு ட ை ய 
ஆயத்தொலைவுகள் X = 0, Y = 0 ஆகும்.  
XY தளத்திலுள்ள ஒரு புள்ளியைக் 
குறிப்பிட ஆதிப்புள்ளியை ஆதாராமாக 
எடுத்துக் க�ொள்ள வேண்டும்.  இப்பொழுது 
P என்ற புள்ளியை எடுத்துக் க�ொள்வோம்.  
அப்புள்ளியிலிருந்து X அச்சை வெட்டும்படி 
ஒரு செங்குத்துக் க�ோடு வரைய 
வேண்டும்.  ஆதிப்புளிக்கும் X அச்சை 
வெட்டும் புள்ளிக்கும் இடையே உள்ள 
கிடைமட்டத் த�ொலைவு P என்ற புள்ளியின் 
X ஆயத்தொலைவு ஆகும்.  இது P(x) என்று 
அழைக்கப்படுகின்றது.

X ஆயத்தொலைவானது, 
ஆதிப்புள்ளியிலிருந்து வலது புறமாக 

2. Second point.

1. First point.

4. Close 
(drawn by 
AutoCAD)

3. Third point.
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(0, 0) ப�ொறுத்து அமையும்.  எடுத்துக்காட்டாக, 
ஒரு புள்ளியின் ஆயத்தொலைவுகள் X = 
4 மற்றும் Y = 3 எனில், அப்புள்ளியானது 
ஆயப்புள்ளியிலிருந்து கிடைமட்டமாக 
4 அலகுகளும் (X அச்சில் உள்ள தூரம்), 
செங்குத்தாக 3 அலகுகளும் (Y அச்சில் 
உள்ள தூரம்) க�ொண்ட த�ொலைவில் 
இருக்கும்.  இந்தப் புள்ளி (4, 3) கீழே 
உள்ள படத்தில் காட்டப்பட்டுள்ளது.  
இந்த அமைப்பில், புள்ளிகளை கட்டளை 
வரியில் க�ொடுக்கும் ப�ோது X மற்றும் Y 
ஆயத்தொலைவுகளை காற்புள்ளி மூலம் 
பிரிக்க வேண்டும்.

படம் 6.57  தனித்த ஆயத்தொலைவு அமைப்பு

தனித்த ஆயத்தொலைவு 
அமைப்பைப் பயன்படுத்தி (50, 50) மற்றும் 
(150, 50) என்ற புள்ளிகளுக்கு இடையே 
ஒரு க�ோடு வரைதல்.

Command: LINE 
Specify first point: 50, 50
Specify next point or [Undo]: 150, 50
Specify next point or [Undo]:  (Enter 
விசையை அழுத்த வேண்டும்).

படம் 6.56  கார்ட்டீசியன் ஆயத்தொலைவு 
அமைப்பு

ஆட்டோகேட் மென்பொருளில் 
ஆயப்புள்ளியானது முன்னியல்பாக 
வரைபடப் பகுதியின் கீழ் இடது மூலையில் 
அமைந்திருக்கும்.

ஒரு புள்ளியை XY தளத்தில் 
அமைப்பதற்கு ஆட்டோகேட் கீழ்க்காணும் 
ஆயத்தொலைவு அமைப்புகளைப் 
பயன்படுத்துகிறது.

1.	 தனித்த ஆயத்தொலைவுகள் 
(Absolute coordinates)

2.	 ஒப்பீட்டு அயத்தொலைவுகள் 
(Relative Coordinates)

3.	 துருவ ஆயத்தொலைவுகள் (Polar 
coordinates)

4.	 நேரடித் த�ொலைவு உள்ளீடு (Direct 
distance entry)

ஒரு புள்ளியின் இடத்தைக் குறிப்பதற்கு 
கட்டளை வரியைப் பயன்படுத்துவதாக 
இருந்தால் மேலே உள்ள ஏதேனும் 
ஒரு ஆயத்தொலைவு அமைப்புகளைப் 
பயன்படுத்த வேண்டும்.
தனித்த ஆயத்தொலைவு அமைப்பு 
(Absolute Coordinate System)
தனித்த ஆயத்தொலைவு அமைப்பில், 
புள்ளிகளின் இருப்பிடம் ஆயப்புள்ளிகளைப் 
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தனித்த ஆயத்தொலைவு அமைப்பைப் 
பயன்படுத்தி ஒரு படம் வரைதல்.
கீழே உள்ள அட்டவணையில் 
தனித்த ஆயத்தொலைவு புள்ளிகள் 
க�ொடுக்கப்பட்டுள்ளன.

Point Coordinates
1 3, 1
2 3,6
3 4, 6
4 4, 2
5 5, 2
6 6, 3
7 7, 3
8 7, 1

(3, 6) (4, 6)

(6, 3) (7, 3)

(4, 2) (5, 2)

(3, 1) (7, 1)

Starting Point Ending Point

1.	 Drafting & Annotation 
பணித்தளத்திலில் acad.dwt என்ற 
முன்வடிவமைத்தக் க�ோப்பைக் 
க�ொண்டு ஒரு புதிய க�ோப்பை 
த�ொடங்கவும்.

2.	 கட்டளை வரியில் LINE என தட்டச்சு 
செய்ய வேண்டும்.

(150,50)(50,50)

படம் 6.58  தனித்த ஆயத்தொலைவு அமைப்பைப் 
பயன்படுத்தி வரைபடம் வரைதல்

தனித்த ஆயத்தொலைவு அமைப்பு 
முறையில் (50, 50), (150,, 50), (100, 
100) என்ற புள்ளிகளுக்கிடையே 
Line கட்டளையைப் பயன்படுத்தி ஒரு 
முக்கோணம் வரைதல்.
Command: LINE

Specify first point: 50, 50

Specify next point or [Undo]: 150, 50

Specify next point or [Undo]: 100, 100↵

Specify next point or [Close / Undo]: C↵

(100, 100)

(50,50) (150,50)

படம் 6.59  தனித்த ஆயத்தொலைவு அமைப்பைப் 
பயன்படுத்தி வரைபடம் வரைதல்
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கட்டளை வரித்தொடர்கள் கீழே க�ொடுக்கப்பட்டுள்ளன.
Command: LINE
Specify first point: 3, 1↵
Specify next point or [Undo]: 3,6↵
Specify next point or [Undo]: 4, 6↵
Specify next point or [Close / Undo]: 4, 2↵
Specify next point or [Close / Undo]: 5, 2↵
Specify next point or [Close / Undo]: 6, 3↵
Specify next point or [Close / Undo]: 7, 3↵
Specify next point or [Close / Undo]: 7, 1↵
Specify next point or [Close / Undo]: C↵

படம் 6.60  தனித்த ஆயத்தொலைவு அமைப்பைப் பயன்படுத்தி வரைபடம் வரைதல்

ஒப்பீட்டு ஆயத்தொலைவு அமைப்பு (Relative Coordinate System)
இரண்டு வகையான ஒப்பீட்டு ஆயத்தொலைவுகள் உள்ளன.  அவையாவன,

1.	 ஒப்பீட்டு செவ்வக ஆயத்தொலைவுகள் (Relative Rectangular Coordinates)
2.	 ஒப்பீட்டு துருவ ஆயத்தொலைவுகள் (Relative Polar Coordinates)
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Command: LINE↵
Specify first point: 1, 1↵
Specify next point or [Undo]: @ 4, 0↵
Specify next point or [Undo]: @ 0, 3↵
Specify next point or [Close / Undo]: 
@-4, 0↵
Specify next point or [Close / Undo]: 
@-4, 0↵
Specify next point or [Close / Undo]: @0, 
- 3↵
Specify next point or [Close / Undo]: ↵

(@0,3)(@-4,0)

(@4,0)(1,1)

படம் 6.62  ஒப்பீட்டு செவ்வக 
ஆயத்தொலைவுகளைப் பயன்படுத்தி க�ோடுகள் 

வரைதல்

குறிப்பு
அளவீடுகள் அல்லது புள்ளிகள், ஆயப்புள்ளியிலிருந்து 
மேல் புறமாக அல்லது வலது புறமாக அமைந்தால் 
அது நேர்ம எண்ணாகவும், கீழ்ப்புறமாக அல்லது 
இடது புறமாக அமைந்தால் எதிர்ம எண்ணாகவும் 
அளவிடப்படும்.

ஒப்பீட்டு செவ்வக ஆயத்தொலைவு 
அமைப்பைப் பயன்படுத்தி 100 அலகுகள் 
உடைய ஒரு சதுரம் வரைதல்.
Command: LINE↵
Specify first point: 70, 70↵
Specify next point or [Undo]: @ 100, 0↵
Specify next point or [Undo]: @ 0, 100↵
Specify next point or [Close / Undo]: @ 
- 100, 0↵
Specify next point or [Close / Undo]: C↵

ஒப்பீட்டு செவ்வக ஆயத்தொலைவுகள் (@ X 
distance, Y distance)
ஒப்பீட்டு செவ்வக ஆயத்தொலைவு அமைப்பில் 
ஒரு புள்ளியின் இருப்பிடமானது, அதற்கு 
முந்தைய புள்ளியைப் ப�ொறுத்து அமையும்; 
ஆயப்புள்ளியைப் ப�ொறுத்து அமைவதில்லை.  
இம்முறையில் ஆயத்தொலைவு மதிப்புகளை 
உள்ளிடுவதற்கு, டைனமிக் இன்புட்டின் 
நிலையை (ON or OFF) ச�ோதிக்கவும். 
டைனமிக் இன்புட் ON நிலையில் 
இருந்தால், தானமைவாக ஒப்பீட்டு 
செவ்வக ஆயத்தொலைவு அமைப்பைப் 
பயன்படுத்தி வடிவம் வரையப்படும்.  இந்த 
வகையில் X ஆயத்தொலைவு மதிப்பிற்கும் 
Y ஆயத்தொலைவு மதிப்பிற்கும் இடையில் 
காற்புள்ளி (,) இட வேண்டும்.

டைனமிக் இன்புட் OFF நிலையில் 
இருந்தால், ஆயத்தொலைவு மதிப்புகளுக்கு 
முன்னால் @ குறியீடு இட வேண்டும்.  எனவே, 
ஒப்பீட்டு செவ்வக ஆயத்தொலைவு அமைப்பைப் 
பயன்படுத்தி வடிவம் வரையப்படும்.

எடுத்துக்காட்டாக, ஒப்பீட்டு செவ்வக 
ஆயத்தொலைவு அமைப்பைப் பயன்படுத்தி, 
கீழ் இடது மூலையிலுள்ள (1, 1) என்ற 
புள்ளியைக் க�ொண்டு 4 அலகுகள் நீளமும், 3 
அலகுகள் அகலமும் க�ொண்ட ஒரு செவ்வகம் 
வரைவதற்கு கீழ்க்கண்ட கட்டளை 
வரிகளைப் பயன்படுத்த வேண்டும்.

படம் 6.61  ஒப்பீட்டு செவ்வக 
ஆயத்தொலைவுகளைப் பயன்படுத்தி க�ோடுகள் 

வரைதல்
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1.	 Drafting & Annotation பணித்தளத்தில் 
acad.dwt என்ற முன்வடிவமைத்தக் 
க�ோப்பைக் க�ொண்டு ஒரு புதிய 
க�ோப்பை த�ொடங்கவும்.

1.	 கட்டளை வரியில் LINE என தட்டச்சு 
செய்ய வேண்டும்.

	 கட்டளை வரித்தொடர்கள் கீழே 
க�ொடுக்கப்பட்டுள்ளன.

Command: LINE↵

Specify first point: 3, 1↵

Specify next point or [Undo]: @ 4, 0↵

Specify next point or [Undo]: @ 0, 1↵

Specify next point or [Close / Undo]: @ - 1, 0↵

Specify next point or [Close / Undo]: @ 1, 1↵

Specify next point or [Close / Undo]: @ 0, 2↵

Specify next point or [Close / Undo]: @ - 1, 0↵

Specify next point or [Close / Undo]: @ - 1, -1↵

Specify next point or [Close / Undo]: @ - 1, 1↵

Specify next point or [Close / Undo]: @ - 1, 0↵

Specify next point or [Close / Undo]: @ 0, - 2↵

Specify next point or [Close / Undo]: @ 1, -1↵

Specify next point or [Close / Undo]: @ - 1, 0↵

Specify next point or [Close / Undo]: @ 0, - 1↵

Specify next point or [Close / Undo]: ↵

(@-100,0) (@0, 100)

(70,70) (@100,0)

படம் 6.63  ஒப்பீட்டு செவ்வக 
ஆயத்தொலைவுகளைப் பயன்படுத்தி ஒரு சதுரம் 

வரைதல்

ஒப்பீட்டு செவ்வக ஆயத்தொலைவுகளைப் 
பயன்படுத்தி ஒரு படம் வரைதல்.  கீழே 
உள்ள அட்டவணையில் ஆயத்தொலைவு 
புள்ளிகள் க�ொடுக்கப்பட்டுள்ளன.

Point Coordinates
1 3, 1
2 @4,0
3 @0,1
4 @-1,0
5 @1,1
6 @0,2
7 @-1,0
8 @-1,-1
9 @-1,1
10 @-1,0
11 @0,-2
12 @1,-1
13 @-1,0
14 @0,-1
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(@5 < 30)

(1,1)

படம் 6.65  ஒப்பீட்டு ப�ோலார் 
ஆயத்தொலைவுகளைப் பயன்படுத்தி ஒரு படம் 

வரைதல்

குறிப்பு
ஒப்பீட்டு ப�ோலார் ஆயத்தொலைவு 
அமைப்பில், க�ோணமானது கிடைமட்ட 
அச்சை (X அச்சை) பூஜ்ஜியம் டிகிரியாகக் 
க�ொண்டு அளவிடப்படுகிறது.  க�ோணமானது 
நேர்ம எண்ணாக இருந்தால் கடிகார 
திசைக்கு எதிராகவும், எதிர்ம எண்ணாக 
இருந்தால் கடிகார திசையிலும் 
அளவிடப்படுகிறது.

1800

 900 

) 
) 

300

00

-300

2700

படம் 6.66  ப�ோலார் ஆயத்தொலைவுகள்

படம் 6.64  ஒப்பீட்டு செவ்வக 
ஆயத்தொலைவுகளைப் பயன்படுத்தி ஒரு படம் 

வரைதல்

ஒப்பீட்டு ப�ோலார் ஆயத்தொலைவு 
அமைப்புகள் (Relative Polar 
Coordinates (@distance < angle))
ஒப்பீட்டு ப�ோலார் ஆயத்தொலைவு 
அமைப்பில் ஒரு புள்ளியின் இருப்பிடமானது, 
அப்புள்ளிக்கும், தற்போதைய புள்ளிக்கும் 
இடைப்பட்ட த�ொலைவையும், X அச்சைப் 
ப�ொறுத்து இரண்டு புள்ளிகளுக்கும் 
இடையேயான க�ோண அளவைப் 
ப�ொறுத்தும் அமையும்.

ஒப்பீட்டு ப�ோலார் ஆயத்தொலைவு 
அமைப்பைப் பயன்படுத்தி (1, 1) என்ற 
புள்ளியைத் த�ொடக்கப் புள்ளியாகக்  
க�ொண்டு 5 அலகுகள் நீளமும், 30 டிகிரி 
க�ோண அளவும் க�ொண்ட ஒரு க�ோடு 
வரைதல்.

Command: LINE↵

Specify first point: 1, 1↵

Specify next point or [Undo]: @ 5 < 30↵

Spcify next point or [Undo]: ↵ (Press 
ENTER to complete the drawing)
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Specify next point or [Close / Undo]: @ 
25 < 90↵
Specify next point or [Close / Undo]: @ 
15 < 180↵
Specify next point or [Close / Undo]: @ 
25 < 270↵
Specify next point or [Close / Undo]: @ 
45 < 180↵
Specify next point or [Close / Undo]: @ 
25 < 90↵
Specify next point or [Close / Undo]: @ 
15 < 180↵
Specify next point or [Close / Undo]: @ 
25 < 270↵
Specify next point or [Close / Undo]: C↵

படம் 6.67  ஒப்பீட்டு ப�ோலார் 
ஆயத்தொலைவுகளைப் பயன்படுத்தி ஒரு படம் 

வரைதல்

நேரடித் த�ொலைவு உள்ளீடு (Direct 
Distance Entry)
ஆட்டோகேடில் ஒரு க�ோடு 
வரைவதற்கு எளிமையான வழி நேரத் 
த�ொலைவு உள்ளீட்டு முறையைப் 
பயன்படுத்துவதாகும்.  இந்த முறையில் 
க�ோடு வரைவதற்கு நிலைமைப் 
பட்டையில் டைனமிக் இன்புட் 
தேர்ந்தெடுக்கப்பட்டுள்ளதை உறுதி 
செய்து க�ொள்ள வேண்டும்.  அடுத்து, 

ஒப்பீட்டு ப�ோலார் ஆயத்தொலைவுகளைப் 
பயன்படுத்தி ஒரு படம் வரைதல்.  கீழே 
உள்ள அட்டவணையில் ஆயத்தொலைவு 
புள்ளிகள் க�ொடுக்கப்பட்டுள்ளன.

Point Coordinates
1 2,3
2  @100<0
3 @25<120
4 @25<90
5 @15<180
6 @25<270
7 @45<180
8 @25<90
9 @15<180
10 @25<270

@15<180

@25<270

@25<90

@45<180

@15<180

@25<270

@25<90

@25<120

2, 3 @100<0

1.	 Drafting & Annotation பணித்தளத்தில் 
acad.dwt என்ற முன்வடிவமைத்தக் 
க�ோப்பைக் க�ொண்டு ஒரு புதிய 
க�ோப்பை த�ொடங்குதல்.

2.	 கட்டளை வரியில் LINE என தட்டச்சு 
செய்ய வேண்டும்.

	 கட்டளை வரித்தொடர்கள் கீழே 
க�ொடுக்கப்பட்டுள்ளன.

Command: LINE↵
Specify first point: 2, 3↵
Specify next point or [Undo]: @ 100 < 0↵
Specify next point or [Undo]: 2 25 < 120↵
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6. 7. 3	 வட்டம் வரைதல்
Ribbon: Home > Draw > Circle drop-down> 
Center, Radius
Toolbar: Draw > Circle
Menu Bar: Draw > Circle
Command: CIRCLE or C

சர்க்கிள் டூலைப் (Circle tool) 
பயன்படுத்தி ஒரு வட்டம் வரைய முடியும்.  
வட்டம் வரைய ஆறு விதமான கருவிகளைப் 
பயன்படுத்த முடியும்.  இந்தக் கருவிகள் 
அனைத்தும் ரிப்பனில் உள்ள Draw பேனலில் 
ஒரு குழுவாக இருக்கும்.  இந்தக் கருவிகளைப் 
பார்க்க, Draw பேனலில் சர்க்கிள் டூலுக்கு 
அடுத்துள்ள கீழ் ந�ோக்கிய அம்புக்குறியைக் 
கிளிக் செய்ய வேண்டும்.  படம் 6.69 
இல் உள்ளபடி அனைத்துக் கருவிகளும் 
கீழிறங்கு பட்டியலாகக் காட்டப்படும்.  Draw 
பேனலில் நாம் கடைசியாகத் தேர்ந்தெடுத்த 
கருவி காட்டப்பட்டிருக்கும்.  மேலும் Draw 
கருவிப்பட்டையில் சர்க்கிள் டூலைத் 
தேர்ந்தெடுக்கலாம் அல்லது கட்டளை 
வரியில் C என தட்டச்சு செய்யலாம்.

படம் 6.69  Draw பேனலில் உள்ள சர்க்கிள் டூல்

மையப்புள்ளியையும், ஆரத்தின் 
அளவையும் க�ொடுத்து வட்டம் வரைதல்

1.	 ரிப்பனில் Home > Draw > Circle > 
Center, Radius என்ற வரிசையில் 
கிளிக் செய்யவும்.

2.	 மையப்புள்ளியை குறிப்பிட, 
வரைகலை சன்னல் திரையில் 

லைன் டூலைத் தேர்ந்தெடுக்க வேண்டும்.  
இப்பொழுது த�ொடக்கப்புள்ளியை 
உள்ளிடத் தூண்டும்.  உரைப்பெட்டியில் 
ஆயத்தொலைவு மதிப்பை உள்ளிட்டு 
நுழைவு விசையை அழுத்த வேண்டும்.  
பின்னர் அடுத்தப் புள்ளியை உள்ளிடத் 
தூண்டும்.  இப்பொழுது க�ோட்டின் சரியான 
நீளத்தையும், சுட்டுகுறியின் தற்போதைய 
நிலையைப் ப�ொறுத்து, அதன் க�ோண 
அளவையும் உள்ளிட வேண்டும்.

உ ர ை ப ்பெட்   டி க ளு க் கி ட ையே   
மாறுவதற்கு TAB விசையை பயன்படுத்த 
வேண்டும்.  இந்த முறையில் க�ோடுகள் 
வரையும் ப�ோது, ஆர்த்தோ ம�ோடு ON இல் 
இருந்தால் X அல்லது Y அச்சில் மட்டுமே 
சுட்டுக்குறியை நகர்த்த முடியும்.  டைனமிக் 
இன்புட் தேர்ந்தெடுக்கப்படவில்லை எனில் 
க�ோட்டின் நீளத்தை கட்டளை வரியில் 
உள்ளிட வேண்டும்.  எனவே, விருப்பமான 
க�ோண அளவில் சுட்டுக்குறியை வைத்து, 
கட்டளை வரியில் நீளத்தை உள்ளிட்டு 
நுழைவு விசையை அழுத்த வேண்டும்.

படம் 6.68  நேரடித் த�ொலைவு உள்ளீடு 
முறையைப் பயன்படுத்தி க�ோடு வரைதல்

LINE Specify first point: Start point
Specify next point or [Undo]: Position the 
cursor and then enter distance.
Specify next point or [Undo]: Position the 
cursor and then enter distance.
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Specify diameter of circle : 
விட்டத்தின் அளவை தட்டச்சு செய்யவும்.
மையப்புள்ளி (20, 20) மற்றும் விட்டம் 40 
அலகுகள் உடைய ஒரு வட்டம் வரைதல்
Command: CIRCLE↵
Specify center point for circle or [3P/2P/
Ttr (tan tan radius)]: 20, 20↵
Specify radius of circle or [Diameter] < 
20.0000>: D↵
Specify diameter of circle <40.0000> 40↵

படம் 6.71  மையப்புள்ளி (20, 20) மற்றும் விட்டம் 
40 அலகுகள் உடைய ஒரு வட்டம்

6. 7. 4	 செவ்வகம் வரைதல்
வடிவமைப்பாளர்கள் பயன்படுத்தும் 
அடிப்படை வடிவங்களில் ஒன்று 
செவ்வகம் ஆகும்.  லைன் கட்டளையைப் 
பயன்படுத்தியும் செவ்வகம் வரைய 
முடியும்.  ஆனால் அதில் சில குறைபாடுகள் 
உள்ளன.  எடுத்துக்காட்டாக, க�ோண 
அளவுகள் 90 டிகிரி உள்ளனவா என 
சரிபார்க்க வேண்டும்.  மேலும் ஒவ்வொரு 
க�ோடும் தனித்தனி ப�ொருளாக இருக்கும்.  
ஒரு க�ோட்டின் மீது கிளிக் செய்தால் அந்த 
க�ோடு மட்டுமே தேர்வு செய்யப்படும்.  
மற்ற க�ோடுகள் தேர்வு செய்யப்படாது.  
ஆகையால் ஆட்டோகேட் 2016இல் உள்ள 
RECTANG கட்டளை, சரியான க�ோண 
அளவுகளுடன் ஒரு செவ்வகத்தை ஒரே 
ப�ொருளாக வரைய வழி வகுக்கிறது.  

ஆர்பிட்டரி பாய்ன்ட்டை (Arbitrary 
Point) தேர்ந்தெடுக்கவும்.

3.	 ஆரத்தின் அளவை உள்ளிட்டு 
நுழைவு விசையை அழுத்தவும்.

மையப்புள்ளி (100, 100) மற்றும் ஆரம் 20 
அலகுகள் உடைய ஒரு வட்டம் வரைதல்
Command : CIRCLE↵
Specify center point for circle of [3P / 2P / 
Ttr (tan tan radius)]: 100, 100↵
Specify radius of circle or [Diameter]: 20↵

படம் 6.70  மையப்புள்ளி (100, 100) மற்றும் ஆரம் 
20 அலகுகள் உடைய ஒரு வட்டம்

மையப்புள்ளியையும், விட்டத்தின் 
அளவையும் க�ொடுத்து வட்டம் வரைதல்

1.	 ரிப்பனில் Home > Draw > Circle > 
Center, Diameter என்ற வரிசையில் 
கிளிக் செய்யவும்.  (அல்லது) கட்டளை 
வரியில் CIRCLE அல்லது C என 
தட்டச்சு செய்யவும்.

2.	 கட்டளை வரியில் கீழ்க்கண்ட 
செய்திகள் த�ோன்றும்.

Specify center point for circle or [3P/2P/Ttr 
(tan tan radius)]: 
திரையில் ஏதேனும் ஒரு புள்ளியில் 
சுட்டியின் இடது ப�ொத்தானைக் கிளிக் 
செய்யவும் அல்லது மதிப்பை உள்ளிடவும்.
Specify radius of circle of [Diameter]: 
விட்டத்தை உள்ளிட D எனத் தட்டச்சு 
செய்யவும்.

XII CompTech_Tamil version CHAPTER 06.indd   215 12/01/2022   15:00:42

www.tntextbooks.in



பாடம் 06  ஆட்டோகேட் 2016216

மூலைவிட்ட புள்ளிகள் (20, 30) மற்றும் 
(150,, 160) க�ொண்ட ஒரு செவ்வகம் 
வரைதல்
Command: RECTANGLE↵
Specify first corner point or [Chamfer/
Elevation/Fillet/Thickness/Width]: 20, 30↵
Specify other corner point of [Area/
Dimensions/Rotation]: 150, 160↵

(150, 160)

(20,30)

படம் 6.73  மூலைவிட்ட புள்ளிகள் (20, 30) 
மற்றும் (150, 160) க�ொண்ட ஒரு செவ்வகம்

6. 7. 5	 வட்டவில் வரைதல்  
(Drawing Arc)

Ribbon: Home > Draw > Arc drop-down 
(or)

Command: ARC or A
வட்டவில் என்பது வட்டத்தின் ஒரு 
பகுதியாக வரையறுக்கப்படுகிறது.  
ஆட்டோகேட் 2016இல் ஆர்க் கீழிறங்கு 
பட்டிப் பெட்டியிலுள்ள கருவிகளைப் 
பயன்படுத்தி வட்டவில் வரையப்படுகிறது.  
வட்டவில் வரைய 11 விதமான ஆர்க் 
கருவிகள் உள்ளன.  இந்தக் கருவிகள் 
ரிப்பனில் உள் Draw பேனலில் ஒரு 
குழுவாக அமைக்கப்பட்டிருக்கும்.  நமக்குத் 

இந்த RECTANG கட்டளையைப் 
பயன்படுத்தி வரையப்பட்ட செவ்வகத்தின் 
எந்தவ�ொரு இடத்திலும் கிளிக் செய்து முழு 
செவ்வகத்தையும் தேர்ந்தெடுக்க முடியும்.

சுட்டுக்குறியின் மூலம் செவ்வகத்தின் 
முனைகளைத் தேர்ந்தெடுத்து செவ்வகம் வரைதல்

1.	 Command: RECTANG (அல்லது) REC 
(நுழைவு விசையை அழுத்தவும்).

2.	 கட்டளை வரியில் கீழ்க்கண்டவாறு 
த�ோன்றும்.

	 RECTANGLE
	 Specify first corner point or [Chamfer/

Elevation/Fillet/Thickness/Width]:
	 செவ்வகத்தின் முதல் முனை (P1) 

வரைய வேண்டிய இடத்திற்கு 
சுட்டுக்குறியை நகர்த்தி சுட்டியின் 
இடது ப�ொத்தானைக் கிளிக் செய்யவும்.

3.	 கட்டளை வரியில் கீழ்க்கண்டவாறு 
த�ோன்றும்.

	 Specify other corner point or [Area / 
Dimensions / Rotatio]:

	 செவ்வகத்தின் முதல் முனையிலிருந்து 
சுட்டியை மூலைவிட்டம் வழியாக 
நகர்த்தி, மறுமுனையில் (P2) 
சுட்டியின் இடது ப�ொத்தானைக் கிளிக் 
செய்யவும்.

	 இப்பொழுது செவ்வகம் 
வரையப்பட்டிருக்கும்.

படம் 6.72  ஒரு செவ்வகம்
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P3
X

P2 X

X
P1

படம் 6.75  மூன்று புள்ளிகளைப் பயன்படுத்தி 
வட்டவில் வரைதல்

6.8  �ப�ொருள்களை அழித்தல்  
(Erasing objects)

சில சமயங்களில் வரையப்பட்ட 
ப�ொருள்களிலிருந்து தேவையில்லாத 
ப�ொருள்களை நீக்க வேண்டியிருக்கும்.  
ப�ொருள்களை நீக்க உரேஸ் டூலைப் 
(Erase tool) பயன்படுத்தலாம்.  இந்த 
டூலை கையால் வரைந்த க�ோடுகளை 
அழிக்கப் பயன்படும் இரப்ப (Eraser) ப�ோல 
பயன்படுத்தலாம்.

Erase கட்டளை வரைபடக் க�ோப்பில் 
உள்ள ப�ொருள்களை நீக்குவதற்குப் 
பயன்படுகிறது.

ஒரு ப�ொருளை அழிக்க,
1.	 Home tab > Modify pael > Erase tool 

என்பதைக் கிளிக் செய்து ERASE 
கட்டளையைத் தேர்ந்தெடுக்கவும்.  
(அல்லது) கட்டளை வரியில் ERASE 
அல்லது E என தட்டச்சு செய்யவும்.

தேவையான கருவியைக் கிளிக் செய்து 
வட்டவில் வரையலாம்.

Home த�ொகுதியிலுள்ள Draw 
பேனலில் கடைசியாகப் பயன்படுத்திய 
ஆர்க் டூல் காணப்படும்.

படம் 6.74  11 வகையான ஆர்க் டூல்கள்

மூன்று புள்ளிகளைக் குறிப்பிட்டு வட்டவில் 
வரைதல்
P1, P2 மற்றும் P3 ஆகிய மூன்று புள்ளிகளைப் 
பயன்படுத்தி வட்டவில் வரைதல்.

Command: ARC↵
Specify start point of arc or [Center]: 
(Pick P1) ↵
Specify second point of arc or [Center/
End]: (Pick P2) ↵
Specify end point of arc: (Pick P3) ↵
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ப�ொருள்களை அழிக்கும் மூன்று விதமான 
வழிமுறைகள்
வரைபடத்தில் இருக்கும் ப�ொருள்களை 
மூன்று விதமாக அழிக்கலாம்.

வழிமுறை 1
Erase கட்டளையை முதலில் 
தேர்ந்தெடுத்து, பின்னர் அழிக்க வேண்டிய 
ப�ொருள்களைத் தேர்ந்தெடுக்க வேண்டும்.
நுழைவு விசையை அழுத்தினால் 
தேர்ந்தெடுக்கப்பட்டட ப�ொருள்கள் 
மறைந்துவிடும்.

வழிமுறை 2
அழிக்க வேண்டிய ப�ொருள்களைத் 
தேர்ந்தெடுக்க வேண்டும்.
பிறகு Delete விசையை அழுத்த வேண்டும்.

படம் 6.77  Delete விசை மூலம் ப�ொருள்களை 
அழித்தல்

வழிமுறை 3
1.	 அழிக்க வேண்டிய ப�ொருள்களைத் 

தேர்ந்தெடுக்க வேண்டும்.
2.	 சுட்டியின் வலது ப�ொத்தானைக் 

கிளிக் செய்ய வேண்டும்.
3.	 த�ோன்றும் குறுக்கு வழிப் பட்டியில் 

Erase என்பதைக் கிளிக் செய்யவும்.

குறிப்பு
அழித்த ப�ொருளைத் திரும்பக் க�ொண்டு 
வர வேண்டுமெனில், விரைவு அணுகல் 
கருவிப்பட்டையில் உள்ள Undo என்பதைக் 
கிளிக் செய்ய வேண்டும்.

	 இப்பொழுது செருகும் புள்ளி crosshair 
லிருந்து சிறிய சதுரமாக மாறியிருக்கும்.  
இது pickbox என்று அழைக்கப்படும்.  
இதன் த�ோற்றம் திரையில் உள்ள ஒரு 
ப�ொருளைத் தேர்ந்தெடுக்கத் தயாராக 
உள்ளது என்பதைக் காட்டுகிறது.  
மேலும் கட்டளை வரியும் ப�ொருளைத் 
தேர்ந்தெடுக்கக் கூறும்.

2.	 அழிக்க வேண்டிய ப�ொருளின் 
மீது pickboxஐ வைத்து கிளிக் 
செய்ய வேண்டும்.  ப�ொருளுடைய 
க�ோட்டின் தடிமன் வெளிர் சாம்பல் 
நிறத்திற்கு மாறும்.

3.	 அழிக்க வேண்டிய அனைத்துப் 
ப�ொருள்களையும் த�ொடர்ந்து 
தேர்ந்தெடுக்கலாம்.  கட்டளை 
நிறைவேற்றப்படும் வரை 
தேர்ந்தெடுக்கப்பட்டட ப�ொருள்கள் 
வெளிர் சாம்பல் நிறத்தில் இருக்கும்.

4.	 நுழைவு விசையை அழுத்த 
வேண்டும் அல்லது சுட்டியை வலது 
கிளிக் செய்து  Erase என்பதைத் 
தேர்ந்தெடுக்க வேண்டும்.  
இப்பொழுது தேர்ந்தெடுத்த 
ப�ொருள்கள் அழிக்கப்பட்டு Erase 
கட்டளை முடிவு பெறும்.

Pickbox

a light gray line weight

படம் 6.76  ப�ொருள்களை அழித்தல்
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படம் 6.80  Plot உரையாடல் பெட்டி

4.	 Printer/plotter பகுதியில் 
Name கீழிறங்குப்பட்டியில் 
அச்சுப்பொறியைத் தேர்ந்தெடுக்க 
வேண்டும்.

5.	 Plot Area பகுதியில் What to 
plot கீழிறங்குப்பட்டியில் Extents 
என்பதைத் தேர்ந்தெடுக்க வேண்டும்.  
இந்த விருப்பம் முழு வரைபடமும் 
அச்சிடப்படுவதை உறுதி செய்கிறது.

6.	 வரைபடத்தை தாளின் மையத்தில் 
அச்சிட, Plot Offset பகுதியில் Center 
the plot என்னும் தேர்வுப்பெட்டியில் 
கிளிக் செய்ய வேண்டும்.

7.	 Plot Scale பகுதியில்  Fit to Paper 
என்னும் தேர்வுபெட்டியில் கிளிக் 
செய்ய வேண்டும்.  இது தாளின் 
அளவைய�ோ அல்லது வரைபடத்தின் 
அளவைய�ோ ப�ொருட்படுத்தாமல், 
வரைபடத்தை தாளில் ப�ொருந்துமாறு 
அச்சிடும்.

8.	 இப்பொழுது இந்த உரையாடல் 
பெட்டியின் விருப்பங்கள் படத்தில் 
காட்டப்பட்டுள்ளவாறு த�ோன்றும்.

9.	 வரைபடம் தாளில் சரியான அளவில் 
அச்சிடப்படுமா என்பதை Preview 
ப�ொத்தானைக் கிளிக் செய்து 
தெரிந்து க�ொள்ளலாம்.  இதன் மூலம் 
பிழைகளைக் கண்டறிந்து தாள்கள் 
வீணாவதைத் தடுக்கலாம்.

படம் 6.78  குறுக்கு வழிப் பட்டியின் மூலம் 
ப�ொருள்களை அழித்தல்

6.9  வரைபடத்தை அச்சிடுதல்
வரைபடத்தை அச்சிட PLOT கட்டளை 
பயன்படுகிறது.

1.	 சிவப்பு நிற A பணிக்குறியைக் 
கிளிக் செய்து, Print என்பதைத் 
தேர்ந்தெடுக்க வேண்டும்.

2.	 த�ோன்றும் துணைப்பட்டியில் Plot 
என்பதைக் கிளிக் செய்ய வேண்டும்.

3.	 ஆட்டோகேட் பல விருப்பங்களுடன் 
கூடிய Plot உரையாடல் பெட்டியைக் 
காட்டும்.

படம் 6.79  பயன்பாட்டுப் பட்டி
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படம் 6.82  Save Drawing As உரையாடல் பெட்டி

ஆட்டோகேட்ட 2016இல் உள்ள் க�ோப்பு 
வகைகள்
சேமிக்கப்பட்ட அனைத்து வரைபடங்களும் 
க�ோப்புகள் என அழைக்கப்படும்.

ஆட்டோகேட் 2016இல் பல 
வகையான க�ோப்பு வகைகள் உள்ளன.
●	 .dwg: AutoCAD 2016 drawing
●	 .dws: AutoCAD 2016 Drawing Standard
●	 .dwt: AutoCAD 2016 Template Drawing 

template file
●	 ஆட்டோகேட் 2016இல் வரைந்த 

வரைபடங்களை, அதற்கு முந்தய 
பதிப்புகளிலும் சேமிக்க முடியும்.

6.11  வரைபடக் க�ோப்புகளை மூடுதல்
ஆட்டோகேடிலிருந்து வெளியேறாமல் 
தற்போதைய வரைபடக் க�ோப்பை மட்டும் 
மூட முடியும்.  அதற்கு பயன்பாட்டுப் பட்டியில் 
Close > Current Drawing என்பதைக் கிளிக் 
செய்ய வேண்டும்.  (அல்லது) கட்டளை 
வரியில் CLOSE எனத் தட்டச் செய்ய 
வேண்டும்.

தற்போது திறந்திருக்கும் க�ோப்பை 
அல்லது திறந்திருக்கும் அனைத்து 
க�ோப்புகளையும் மூட,
●	 பயன்பாட்டுப் ப�ொத்தானைக் கிளிக் 

செய்ய வேண்டும்.  இப்பொழுது 
பயன்பாட்டுப் பட்டி த�ோன்றும்.

10.	அச்சு முன்னோட்டத்திலிருந்து (Print 
preview) வெளியேற ESC விசையை 
அழுத்த வேண்டும்.  (அல்லது) மூடு 
ப�ொத்தானைக் (X) கிளிக் செய்ய 
வேண்டும்.

11.	Plot உரையாடல் பெட்டியில் OK 
ப�ொத்தானைக் கிளிக் செய்து 
வரைபடத்தை அச்சிடலாம்.

6.10  வரைபடத்தை சேமித்தல்
ஆட்டோகேடில் நீங்கள் செய்த வேலையை 
சேமிக்க,

1.	 விரைவு அணுகல் கருவிப்பட்டையில் 
உள்ள Save ப�ொத்தானைக் கிளிக் 
செய்ய வேண்டும்.

2.	 வரைபடம் இதுவரை 
சேமிக்கப்படவில்லை எனில், Save 
Drawing As உரையாடல் பெட்டி 
த�ோன்றும்.ஹ

3.	 அதில் File name உரைப்பெட்டியில் 
வரைபடத்திற்கான பெயரைக் 
க�ொடுத்து Save ப�ொத்தானைக் 
கிளிக் செய்யவும்.

படம் 6.81  விரைவு அணுகள் கருப்பட்டையிலுள்ள 
Save ப�ொத்தான்
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6.12  �ஆட்டோகேடிலிருந்து 
வெளியேறல்

உங்கள் வேலையை சேமித்து 
ஆட்டோகேடிலிருந்த வெளியேற,

1.	 ஆட்டோகேட் சன்னல் திரையில் 
மேல் வலது மூலையிலுள்ள மூடுட 
ப�ொத்தானைக் (X) கிளிக் செய்ய 
வேண்டும்.

X 
button

படம் 6.85  ஆட்டோகேட் சன்னல் திரையில் மேல் 
வலது மூலையிலுள்ள மூடு ப�ொத்தான் (X)

2.	 திறந்திருக்கும் க�ோப்புகளில் ஏதேனும் 
மாற்றம் செய்யப்பட்டிருந்தால், 
ஆட்டோகேட் அதை சேமிக்க வேண்டுமா 
அல்லது சேமிக்காமல் மூட வேண்டுமா 
என்பதை கீழ்க்கண்ட உரையாடல் 
பெட்டியில் உள்ளதைப் ப�ோன்று 
வினா எழுப்பும்.  உங்கள் வேலையை 
சேமிக்க Yes ப�ொத்தானைக் கிளிக் 
செய்ய வேண்டும்.

படம் 6.86

3.	 ஏற்கனவே சேமிக்கப்படாத புதிய 
வரைபடமாக இருந்தால், ஆட்டோகேட் 
Save Drawing As என்னும் 
உரையாடல் பெட்டியைத் திரையில் 
காட்டும்.  பின்னர் க�ோப்பை சேமித்து 
ஆட்டோகேடிலிருந்து வெளியேறும்.

●	 அதில் Close என்பதைக் கிளிக் செய்து 
வரும் துணைப்பட்டியில், தற்போதையக் 
க�ோப்பை மட்டும் மூட Current Drawing 
என்பதையும், திறந்திருக்கும் அனைத்து 
க�ோப்புகளையும் மூட All Drawings 
என்பதையும் கிளிக் செய்ய வேண்டும்.

படம் 6.83  Close ப�ொத்தான்

திறந்திருக்கும் க�ோப்புகளில் 
ஏதேனும் மாற்றம் செய்யப்பட்டிருந்தால், 
ஆட்டோகேட் அதை சேமிக்க வேண்டுமா 
அல்லது சேமிக்காமல் மூட வேண்டுமா 
என்பதை கீழ்க்கண்ட உரையாடல் 
பெட்டியில் உள்ளதைப் ப�ோன்று வினா 
எழுப்பும்.

படம் 6.84
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வரைபடத்தைக் கைவிட்டு 
ஆட்டோகேடிலிருந்து வெளியேற,

1.	 மூடு ப�ொத்தானைக் (X) கிளிக் செய்ய 
வேண்டும்.

2.	 ஆட்டோகேட் வரைபடத்தை சேமிக்க 
வேண்டுமா என வினா எழுப்பும்.  
உங்கள் வரைபடத்தை சேமிக்காமல் 
மூடுவதற்கு No ப�ொத்தானைக் கிளிக் 
செய்ய வேண்டும்.  ஆட்டோகேட் 
உங்கள் வேலையை வட்டில் பதிவு 
செய்யாமல் வெளியேறும்.படம் 6.87  Save Drawing As உரையாடல் பெட்டி

�Autodesk, Inc. என்பது ஒரு அமெரிக்க பன்னாட்டு மென்பொருள் நிறுவனம் ஆகும்.  
இந்நிறுவனம் கட்டடக்கலை, ப�ொறியியல், கட்டுமானம், உற்பத்தி, ஊடகங்கள் மற்றும் 
ப�ொழுதுப�ோக்கு த�ொழில்கள் ப�ோன்றவற்றிற்கு மென்பொருள் சேவைகளை வழங்குகிறது.  
இது கலிப�ோர்னியாவிலுள்ள சான் ரபேல் (San Rafael, California) என்னுமிடத்தை 
தலைமையிடமாகக் க�ொண்டுள்ளது.

ஆட்டோகேடில் ஒரே வகையான கட்டளைகள் குழுவாக்கப்பட்டு பேனல்களாக வைக்கப்பட்டுள்ளன.

கீழிறங்கும் பட்டி என்பது கட்டளைகளின் பட்டியல் ஆகும்.  இது ஒரு ப�ொத்தானைய�ோ அல்லது 
பட்டியிலுள்ள உறுப்புகளைய�ோ தேர்ந்தெடுக்கும் ப�ோது த�ோன்றுகிறது.

நினைவில் க�ொள்க

●	 ஆட்டோகேட் என்பது கணினி உதவியுடன் வடிவமைப்பு செய்வதற்கான CAD – Computer – Aided 
Design) வணிகரீதியான வரைவு மென்பொருளாகும்.  இது ஆட்டோடெஸ்க் (Autodesk, Inc.) நிறுவனத்தால் 
உருவாக்கப்பட்டு விற்பனை செய்யப்படுகிறது.

●	 திரையின் பெருமளவுப் பகுதி வரைபடப் பகுதி (Drawing Area) ஆகும்.  இதில் ப�ொருள்களை வரைய 
முடியும்.

●	 கட்டளைகளை உள்ளிடுவதற்குப் பயன்படும் Command prompt வரைபடப் பகுதியின் கீழ்ப்பகுதியிலுள்ள 
கட்டளைச் சாளரத்தில் உள்ளது.

●	 பணித்தளம் என்பது ரிப்பன், கருவிப்பட்டைகள், பட்டிப்பட்டைகள் மற்றும் சன்னல் திரை பேலட்டுகள் 
ப�ோன்றவற்றைக் க�ொண்ட ஒரு தனிப்பயனாக்கப்பட்ட அமைப்பாகும்.

●	 லைன் (LINE) கட்டளையை கீழ்க்கண்ட வழிகளில் செயல்படுத்தலாம்.
1.	 Draw பேனலில் உள்ள லைன் டூல் பணிக்குறியைக் கிளிக் செய்யலாம்.  (அல்லது)
2.	 பட்டிப்பட்டையில் Draw > Line என்பதைக் கிளிக் செய்யலாம்.  (அல்லது)
3.	 கட்டளை வரியில் LINE கட்டளையை உள்ளிடலாம்.  எ.கா) LINE <R>
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●	 லைன் டூலைப் பயன்படுத்தி த�ொடர்ச்சியான இரண்டு க�ோடுகளை வரைந்த பின் கட்டளை வரியில் 
Close விருப்பம் த�ோன்றுவதைக் காணலாம்.  இரண்டு அல்லது அதற்கு மேற்பட்ட த�ொடர்ச்சியான 
க�ோடுகளை வரையும் ப�ோது, Close விருப்பமானது முதல் க�ோட்டின் த�ொடக்கப் புள்ளியையும், கடைசி 
க�ோட்டின் முடிவுப் புள்ளியையும் இணைக்கப் பயன்படுகிறது.  முடிவுப் புள்ளியை சுட்டியைக் கிளிக் 
செய்து குறிப்பிட்டால், வரைபடத்தை முடிக்க கட்டளை வரியில் C எனத் தட்டச்சு செய்து நுழைவு 
விசையை அழுத்த வேண்டும்.

●	 ஒரு க�ோடு வரையும் ப�ோது முடிவுப் புள்ளியைத் தவறாகக் குறிப்பிட்டுவிட்டால், Undo கட்டளை மூலம் 
கடைசியாகக் குறிப்பிட்ட புள்ளியை நீக்கிவிட்டு, முந்தைய கட்டத்திற்குச் செல்லலாம்.  இந்த விருப்பத்தைப் 
பயன்படுத்த, கட்டளை வரியில் Undo அல்லது U எனத் தட்டச்சு செய்து நுழைவு விசையை அழுத்த 
வேண்டும்.

●	 ஒரு கட்டளையைத் தவிர்க்க அல்லது அக்கட்டளையிலிருந்து வெளியேற, விசைப்பலகையில் ESC 
(Escape) விசையை அழுத்த வேண்டும்.

●	 ERASE கட்டளையை கீழ்க்கண்ட வழிகளில் பயன்படுத்தலாம்.
1.	 Modify கருவிப்பட்டையிலுள்ள ERASE பணிக்குறியைக் கிளிக் செய்யலாம்.
2.	 பட்டிப்பட்டையில் Modify > Erase என்பதைத் தேர்ந்தெடுக்கலாம்.
3.	 கட்டளை வரியில் ERASE <R> என்னும் கட்டளையை உள்ளிலுக்கலாம்.

 
 

Left click சுட்டியின் இடது ப�ொத்தானை அழுத்துதல்
Click சுட்டியின் இடது ப�ொத்தானை அழுத்துதல்
Double Click சுட்டியின் இடது ப�ொத்தானை இருமுறை அழுத்துதல்
Right Click சுட்டியின் வலது ப�ொத்தானை அழுத்துதல்
Drag சுட்டுக்குறியை ப�ொருளின் மீது வைத்து, சுட்டியின் இடது ப�ொத்தானைக் கிளிக் செய்து 

இழுத்து ப�ொருளை புதிய இடத்திற்கு நகர்த்துதல்.

Enter விசைப்பலகையில் எழுத்துக்கள் மற்றும் எண்களை உள்ளிடுதல்.
Pick சுட்டுக்குறியை ப�ொருளின் மீது வைத்து, சுட்டியின் இடது ப�ொத்தானைக் கிளிக் 

செய்தல்.
Return விசைப்பலகையில் நுழைவு விசையை அழுத்துதல்.  இந்த விசை ↵ (Enter) என்னும் 

குறியீடு மூலம் குறிப்பிடப்படும்.  பல நேரங்களில் சுட்டியை வலது கிளிக் செய்து 
கிடைக்கும் முடிவை இதன் மூலம் பெறலாம்.

Dialog box அமைப்புகளை மாற்றுவதற்கு ஆட்டோகேடில் த�ோன்றும் சாளரம்.
Drop down menu பட்டிப்பட்டையில் ஏதேனும் ஒரு பெயரைக் கிளிக் செய்தால் கீழே த�ோன்றும் பட்டியல்.
Tooltip கருவிப்பட்டையிலுள்ள ஒரு கருவியின் மீது சுட்டுக்குறியை வைக்கும்போது த�ோன்றும் 

ஒரு சிறு உரை.
Prompts கட்டளைச் சாளரத்தில் உள்ள ஒரு கருவி தேர்ந்தெடுக்கப்பட்டால், இந்தச் செயலை 

செய்ய வேண்டும் என பயனருக்குக் தெரிவிக்கும் உரை.
Object வரைபடத்தின் ஒரு பகுதியை ஒரு தனிப் ப�ொருளாகக் கருதலாம்.  எடுத்துக்காட்டாக, 

லைன் டூலைக் க�ொண்டு வரையப்படும் ஒரு க�ோடு ஒரு ப�ொருளாகும்.  பாலிலைன் 
டூலைக் க�ொண்டு வரையப்படும் ஒரு செவ்வகம் ஒரு ப�ொருளாகும்.  ஆர்க் டூலைக் 
க�ொண்டு வரையப்படும் ஒரு வட்டவில் ஒரு ப�ொருளாகும்.
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6.	 UCS என்பது எதன் குறுக்கம்?
	 அ) User Coordinate System
	 ஆ) User Currency System
	 இ) User Control System	
	 ஈ) User Computer System
7.	 கட்டங்களை (grid) காண்பிக்கவும், 

மறைக்கவும் (ON or OFF) 
விசைப்பலகையில் எந்த செயல்பாட்டு 
விசையை அழுத்த வேண்டும்?

	 அ) F1	 ஆ) F2	 இ) F3	 ஈ) F7

பகுதி – ஆ 
II.	� மூன்று வரிகளில் விடையளிக்கவும்  

1.	 ஆட்டோகேடை எவ்வாறு 
த�ொடங்குவாய்?

2.	 ரிப்பனில் உள்ள அனைத்துப் 
ப�ொத்தான்களையும் எப்படி 
மறைப்பாய்?

3.	 ரிப்பனில் உள்ள ஒரு ப�ொத்தான் 
மீது சுட்டுக்குறியை நிறுத்தும் ப�ோது 
என்ன த�ோன்றும்?

4.	 UCS பணிக்குறியை எவ்வாறு 
நீக்குவாய்?

5.	 OSNAPஐ ON மற்றும் OFF செய்வதற்கு 
எந்த செயல்பாட்டு விசையைப் 
பயன்படுத்த வேண்டும்?

6.	 லைன் (LINE) கட்டளையைப் 
பயன்படுத்தும் ப�ோது 
பலக�ோணத்தை முடிக்கப் பயன்படும் 
விரைவான வழிமுறையைக் கூறு.

7.	 லைன் கட்டளை மற்றும் ரெக்டாங்கல் 
கட்டளையைப் பயன்படுத்தி 
செவ்வகம் வரையும் ப�ோது ஏற்படும் 
நடைமுறை சிக்கல்களைக் கூறு.  
ஏன் ஒன்றை விட்டு மற்றொன்றைப் 
பயன்படுத்த வேண்டும்?

பகுதி – அ 
	 I. 	� சரியான விடையைத் 

தேர்ந்தெடுத்து எழுதுக
1.	 ஆட்டோகேட் என்பது _________ 

மென்பொருளாகும்.
	 அ) DTP
	 ஆ) �Computer-aided design (CAD) 

and drafting
	 இ) Text Editing
	 ஈ) Video Editing
2.	 ஆட்டோகேட் 2016ஐ உருவாக்கி 

விற்பனை செய்யும் நிறுவனம் 
_________

	 அ) Microsoft Corporation
	 ஆ) Adobe, Inc.
	 இ) Autodesk, Inc.
	 ஈ) Sun
3.	 சிவப்பு நிற “A” ப�ொத்தானைக் 

கிளிக் செய்தால் த�ோன்றும் பட்டி 
_________

	 அ) Application	 ஆ) Edit
	 இ) Layout	 ஈ) Window
4.	 பயன்பாட்டுப் பட்டியின் மேல் 

பகுதியில் த�ோன்றும் பட்டை எது?
	 அ) Menu	 ஆ) Search
	 இ) Toolbar	 ஈ) Title
5.	 கட்டளைச் சாளரம் 

த�ோன்றவில்லையெனில் எந்த 
விசைப்பலகை குறுக்குவழிகளைப் 
பயன்படுத்த வேண்டும்?

	 அ) Ctrl + 1	 ஆ) Ctrl + 9
	 இ) Ctrl + 8	 ஈ) Ctrl + 7

வினாக்கள்
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2.	 விசைப்பலகை மூலம் LINE, 
CIRCLE மற்றும் ERASE ப�ோன்ற 
கட்டளைகளை எவ்வாறு விரைவாக 
உள்ளிடலாம்?

3.	 LINE கட்டளையில் உள்ள Undo 
தேர்வின் பயன்களை எழுதுக.

4.	 வட்டங்களை உருவாக்கும் 
பின்வரும் முறைகளை சுருக்கமாக 
விவரி.

5.	 Centre and radius
6.	 Centre and diameter

பகுதி – ஈ 
IV.	  �ஒரு பக்க அளவில் 

விடையளிக்கவும்
1.	 ஆட்டோகேட் இடைமுகத்தைப் பற்றி 

விவரி.
2.	 கட்டளைச் சாளரம் பற்றி விவரி.
3.	 ரெக்டாங்கல் ப�ொருளைப் பற்றி 

எழுதுக.  ஆட்டோகேடில் செவ்வகம் 
வரைவதற்கான வழிமுறைகளைக் 
கூறு.

8.	 ஆட்டோகேடில் ஒரு கட்டளை 
செயல்பாட்டில் இருக்கும் 
ப�ோது அதிலிருந்து எவ்வாறு 
வெளியேறலாம்?

9.	 ஆர்க் மற்றும் சர்க்கிள் ப�ொத்தான்கள் 
எந்த ரிப்பன் கன்ட்ரோல் பேனலில் 
உள்ளன?

10.	ERASE கட்டளையை உள்ளிட்ட 
பின், ஆட்டோகேட் டஉங்களை 
என்ன செய்யச் ச�ொல்கிறது?

11.	இதுவரை சேமிக்காத க�ோப்பை 
முதல் முறையாக சேமிக்கும் ப�ொழுது, 
பயன்பாட்டுப் பட்டிப்பட்டையிலிருந்து 
Save அல்லது Save As… என்பதைக் 
கிளிக் செய்தால் என்ன த�ோன்றும்?

12.	ஆட்டோகேடில் ஒரு க�ோப்பை 
திறப்பதற்கான விரைவான வழி 
என்ன?

13.	ஆட்டோகேடிலிருந்து எவ்வாறு 
வெளியேறலாம்?

பகுதி – இ 
III.  	� ஒரு பத்தியளவில் 

விடையளிக்கவும்  
1.	 ப�ொருள்களை உருவாக்குவதற்கான 

ஏதேனும் மூன்று கட்டளைகளைக் 
கூறு.
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செய்முறை
கணினி த�ொழில்நுட்பம்
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பேஜ்மேக்கர் - ஆவணத்தை வடிவமைத்தல்

01
செய்முறை

வினா
	 (a) �பேஜ்மேக்கரைத் திறந்து கீழ்க்கண்ட அளவுகளுடன் கூடிய ஒரு புதிய ஆவணத்தை 

உருவாக்கவும்.
	 	ப க்க அளவு - A4
	 	ப க்கங்களின் எண்ணிக்கை - 4
	 	மே ல் பக்க ஓரம் 1.25 அங்குலம் மற்ற பக்கங்கள் 0.75 அங்குலம்

	 (b) �கீழ்க்கண்ட உரையை உள்ளிடவும்.
	 	 HAPPINESS
	 	� Happiness is often confused with fun, good living, and riches. Sometimes fun is 

equated with happiness. Fun is what we experience while doing an activity, whereas 
happiness is a residual and long-lasting feeling. The path to happiness is long and full 
of challenges. Happiness requires life-long pursuit.

	 (c) �HAPPINESS என்னும் தலைப்பிற்கு எழுத்து வகையின் அளவு 18 புள்ளிகள், எழுத்து 
வகை Arial, தடிமன், மைய இசைவு ஆகிய வடிவூட்டல்களைச் செய்க.

	 (d) �பத்திக்கு கீழ்க்கண்ட வடிவூட்டல்களைச் செய்க.
	 	 (a) Font	 - 	 Arial
	 	 (b) Font size	 -	 12
	 	 (c) Alignment 	 – 	 Justified
	 	 (d) Leading 	 –	 20

	 (e) ஆவணத்தை ‘happiness’  என்ற பெயரில் சேமிக்க.	  

z_XII CompTech_Tamil version Practicals.indd   227 12/01/2022   15:44:18

www.tntextbooks.in



செய்முறை228

செய்முறை
1.	 Start > All Programs > Adobe > PageMaker 7.0 > Adobe PageMaker 7.0 

என்ற வரிசையில் கிளிக் செய்து ஒரு புதிய பேஜ்மேக்கர் ஆவணத்தைத் திறக்கவும். 
படத்தில் காட்டியுள்ளவாறு அட�ோப் பேஜ்மேக்கர் சன்னல் திரை த�ோன்றும்.

 ந�ோக்கம்
பேஜ்மேக்கரைத் திறந்து க�ொடுக்கப்பட்ட அளவுகளுடன் கூடிய ஒரு புதிய ஆவணத்தை 
உருவாக்குதல்
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229செய்முறை

2.	 பட்டிப்பட்டையில் File > New என்பதைக் கிளிக் செய்யவும். (அல்லது) Ctrl + N என்னும் 
விசைப்பலகை குறுக்கு வழியைப் பயன்படுத்தவும். இது Document Setup உரையாடல் 
பெட்டியைத் திறக்கும்.

●	 Page Size கீழிறங்கு பட்டிப்பெட்டியில் கிளிக் செய்து A4 என்னும் பக்க அளவைத் 
தேர்ந்தெடுக்கவும்.

●	 Number of pages  உரைப்பெட்டியில் 4 என உள்ளிடவும்.
●	 ஓரங்களின் அளவை கீழ்க்கண்டவாறு மாற்றவும்.
	 Inside 	 –	 0.75 inches
	 Outside 	 –	 0.75 inches
	 Top	 –	 1.25 inches
	 Bottom	 –	 0.75 inches
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செய்முறை230

3.	 OK  ப�ொத்தானை கிளிக் செய்யவும். படத்தில் காட்டியுள்ளவாறு Untitled – 1 என்ற 
பெயரில் புதிய ஆவணம் திரையில் த�ோன்றும்.

4.	 டெக்ஸ்ட் டூலைக் கிளிக் செய்து ஒரு உரைத்தொகுதியை உருவாக்கவும். பிறகு கீழே 
க�ொடுக்கப்பட்டுள்ள உரையை தட்டச்சு செய்யவும்.

	 HAPPINESS
	 Happiness is often confused with fun, good living, and riches. Sometimes fun is 

equated with happiness. Fun is what we experience while doing an activity, whereas 
happiness is a residual and long-lasting feeling. The path to happiness is long and full 
of challenges. Happiness requires life-long pursuit.
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5.	 டெக்ஸ்ட் டூலைக் க�ொண்டு ‘HAPPINESS’ என்பதைத் தேர்ந்தெடுக்கவும். Character 
Control Palette மூலம் எழுத்து வகை Arial, எழுத்து வகையின் அளவு 18 புள்ளிகள், 
Leading  22 என மாற்றவும். Bold ப�ொத்தானைக் கிளிக் செய்யவும். பிறகு மைய 
இசைவிற்கு Shift + Ctrl + C என்னும் சாவி சேர்மானத்தை அழுத்தவும். 
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6.	 டெக்ஸ்ட் டூலைக் க�ொண்டு பத்தியைத் தேர்ந்தெடுக்கவும். Character Control Palette 
மூலம் எழுத்து வகை Arial, எழுத்து வகையின் அளவு 12 புள்ளிகள், Leading 20 என 
மாற்றவும். பிறகு நேர்த்தி இசைவிற்கு Shift + Ctrl + J என்னும் சாவி சேர்மானத்தை 
அழுத்தவும்.
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7.	 ஆவணத்தை ‘happiness’ என்ற பெயரில் சேமிக்க
	 விசைப்பலகையில் Ctrl + S என்பதை அழுத்தவும் அல்லது பட்டிப்பட்டையில் File > 

Save என்பதைக் கிளிக் செய்யவும். Save publication உரையாடல் பெட்டி த�ோன்றும். 
File name உரைப்பெட்டியில் ‘happiness’ என தட்டச்சு செய்து Save ப�ொத்தானைக் 
கிளிக் செய்யவும்.

வெளியீடு

HAPPINESS
Happiness is often confused with fun, good living, and riches. Sometimes fun is 

equated with happiness. Fun is what we experience while doing an activity, whereas 

happiness is a residual and long-lasting feeling. The path to happiness is long and 

full of challenges. Happiness requires life-long pursuit.

முடிவு
எதிர்பார்க்கப்பட்ட முடிவு கிடைத்தது.
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பேஜ்மேக்கர் - அறிவிப்புப் பலகையை 
உருவாக்குதல்

02

வினா
பேஜ்மேக்கரைப் பயன்படுத்தி கீழ்க்கண்ட மாணவர் அறிவிப்புப் பலகையை உருவாக்கு.

 ந�ோக்கம்
பேஜ்மேக்கரைப் பயன்படுத்தி மாணவர் அறிவிப்புப் பலகையை உருவாக்குதல்.

செய்முறை
1.	 Start > All Programs > Adobe > PageMaker 7.0 > Adobe PageMaker 7.0   

என்ற வரிசையில் கிளிக் செய்து ஒரு புதிய பேஜ்மேக்கர் ஆவணத்தைத் திறக்கவும். 
2.	 பட்டிப்பட்டையில் File > New என்பதைக் கிளிக் செய்யவும். (அல்லது) Ctrl + N என்னும் 

விசைப்பலகை குறுக்கு வழியைப் பயன்படுத்தவும். இது Document Setup உரையாடல் 
பெட்டியைத் திறக்கும்.

3.	 OK ப�ொத்தானை கிளிக் செய்யவும். இப்பொழுது Untitled – 1 என்ற பெயரில் புதிய 
ஆவணம் திரையில் த�ோன்றும்.

4.	 ரெக்டாங்கல் டூலைப் பயன்படுத்தி 100 mm x 100 mm அளவுள்ள பெட்டியை வரைய 
வேண்டும். அதில் சியான் (Cyan) நிறத்தை நிரப்பவும். tint மதிப்பை 25 சதவீதமாக 
மாற்றவும். இப்பொழுது பெட்டி கீழ்க்கண்டவாறு த�ோன்றும்.

செய்முறை
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5.	 இதேப�ோன்று 100 mm x 15 mm அளவுள்ள மற்றொரு பெட்டியை வரைய வேண்டும். 
அதில் கருப்பு (black) நிறத்தை நிரப்பவும். இந்தப் பெட்டியை சியான் (Cyan) நிறம் 
நிரப்பப்பட்ட பெட்டியின் மேல்பகுதியில் வைக்கவும். இப்பொழுது பெட்டி கீழ்க்கண்டவாறு 
த�ோன்றும்.
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6.	 டெக்ஸ்ட் டூலைக் கருப்பு நிறப் பெட்டியின் இடது ஓரத்திலிருந்து வலது ஓரம் வரை 
கிளிக் செய்து இழுக்க வேண்டும். பின்னர் அதில் “ Student Notice Board” என்று 
தட்டச்சு செய்ய வேண்டும்.

	 எழுத்தின் நிறமும் பெட்டியின் நிறமும் ஒன்றாக (கருப்பாக) இருக்கும். உரையை 
தட்டச்சு செய்து முடித்தவுடன் Ctrl + A  என்னும்  விசைப்பலகை குறுக்கு வழி மூலம் 
உரையை தேர்ந்தெடுக்கவும்.

	 Character Control palette மூலம் எழுத்தின் அளவை 20 புள்ளிகளாக மாற்றவும். Bold 
பணிக்குறியைக் கிளிக் செய்யவும். Reverse ப�ொத்தானைக் கிளிக் செய்தால் உரை 
வெள்ளை நிறமாக மாறும். உரையை மைய இசைவு செய்ய Shift + Ctrl + C என்னும் 
விசைப்பலகை குறுக்கு வழியைப் பயன்படுத்தவும். இப்பொழுது மாணவர் அறிவிப்புப் 
பலகை கீழ்க்கண்டவாறு திரையில் த�ோன்றும்.

வெளியீடு

முடிவு
எதிர்பார்க்கப்பட்ட முடிவு கிடைத்தது.
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வினா
பேஜ்மேக்கரைப் பயன்படுத்தி கீழ்க்கண்ட விசிட்டிங் கார்டை உருவாக்கு.

 ந�ோக்கம்
பேஜ்மேக்கரைப் பயன்படுத்தி க�ொடுக்கப்பட்டுள்ள விசிட்டிங் கார்டை உருவாக்குதல்.

செய்முறை
	 1.	 Start > All Programs > Adobe > PageMaker 7.0 > Adobe PageMaker 7.0   

என்ற வரிசையில் கிளிக் செய்து ஒரு புதிய பேஜ்மேக்கர் ஆவணத்தைத் திறக்கவும். 
படத்தில் காட்டியுள்ளவாறு அட�ோப் பேஜ்மேக்கர் சன்னல் திரை த�ோன்றும்.

பேஜ்மேக்கர் - விசிட்டிங் கார்டை உருவாக்குதல்

03
செய்முறை
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2.	 பட்டிப்பட்டையில் File > New என்பதைக் கிளிக் செய்யவும். (அல்லது) Ctrl + N என்னும் 
விசைப்பலகை குறுக்கு வழியைப் பயன்படுத்தவும். இது Document Setup உரையாடல் 
பெட்டியைத் திறக்கும்.
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3.	 OK  ப�ொத்தானை கிளிக் செய்யவும். படத்தில் காட்டியுள்ளவாறு Untitled – 1 என்ற 
பெயரில் புதிய ஆவணம் திரையில் த�ோன்றும்.

4.	 இப்பொழுது அளவீடுகளை Inches லிருந்து Millimetersக்கு மாற்றவும். 
	 பட்டிப்பட்டையில் File > Preferences > general  என்ற கட்டளையைக் கிளிக் செய்யவும். 

(அல்லது) விசைப்பலகையில் Ctrl + K என்பதை அழுத்தவும். இப்பொழுது Preferences 
உரையாடல் பெட்டி த�ோன்றும்.

	 அதில் Measurements மற்றும் Vertical ruler கீழிறங்கு பட்டிப்பெட்டியில் Millimeters  
என்பதைத் தேர்ந்தெடுக்கவும்.
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5.	 கருவிப் பெட்டியிலிருந்து ரெக்டாங்கல் டூலைத் தேர்ந்தெடுத்து செவ்வகம் வரையவும்.
6.	 Control Palette இல் width  95 mm  எனவும் height  55 mm எனவும் மாற்றவும்.  
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7.	 கருவிப்பெட்டியில் டெக்ஸ்ட் டூலை கிளிக் செய்யவும். தட்டச்சு செய்ய வேண்டிய 
உரையின் எல்லையைக் குறிப்பிட செவ்வகத்தின் இடது மூலையிலிருந்து வலது 
மூலை வரை கிளிக் செய்து இழுக்கவும்.

8.	 நபரின் பெயரை உள்ளிட்டு, அதை டெக்ஸ்ட் டூல் மூலம் தேர்ந்தெடுக்கவும். Control 
Palette மூலம் தேவையான எழுத்து வகை மற்றும் எழுத்தின் அளவைக் க�ொடுக்கவும். 
பின்னர் வலது புறமாக சிறிது நகர்த்தவும்.
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9.	 படிநிலை 7 ஐ மறுபடியும் செய்யவும். நிறுவனத்தின் பெயரை உள்ளிட்டு, அதை 
டெக்ஸ்ட் டூல் மூலம் தேர்ந்தெடுக்கவும். Control Palette மூலம் தேவையான எழுத்து 
வகை மற்றும் எழுத்தின் அளவைக் க�ொடுக்கவும். பின்னர் வலது புறமாக சிறிது 
நகர்த்தவும். முதல் எழுத்தை டெக்ஸ்ட் டூல் மூலம் தேர்ந்தெடுத்து எழுத்து வகையின் 
அளவை பெரிதாக்கவும்.
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10.	படிநிலை 7 ஐ மறுபடியும் செய்யவும். நிறுவனத்தின் முகவரியை உள்ளிட்டு, அதை 
டெக்ஸ்ட் டூல் மூலம் தேர்ந்தெடுக்கவும். Control Palette மூலம் தேவையான எழுத்து 
வகை மற்றும் எழுத்தின் அளவைக் க�ொடுக்கவும். பின்னர் வலது புறமாக சிறிது 
நகர்த்தவும்.

வெளியீடு

முடிவு
எதிர்பார்க்கப்பட்ட முடிவு கிடைத்தது.
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வினா
பேஜ்மேக்கரைப் பயன்படுத்தி கீழ்க்கண்ட லேபிளை (Label) உருவாக்கு.

 ந�ோக்கம்
பேஜ்மேக்கரைப் பயன்படுத்தி க�ொடுக்கப்பட்டுள்ள லேபிளை (Label) உருவாக்குதல்.

செய்முறை
1.	 Start > All Programs > Adobe > PageMaker 7.0 > Adobe PageMaker 7.0   என்ற 

வரிசையில் கிளிக் செய்து ஒரு புதிய பேஜ்மேக்கர் ஆவணத்தைத் திறக்கவும்.  
2.	 பட்டிப்பட்டையில் File > New என்பதைக் கிளிக் செய்யவும். (அல்லது) Ctrl + N என்னும் 

விசைப்பலகை குறுக்கு வழியைப் பயன்படுத்தவும். இது Document Setup உரையாடல் 
பெட்டியைத் திறக்கும்.

3.	 OK  ப�ொத்தானை கிளிக் செய்யவும். இப்பொழுது Untitled – 1 என்ற பெயரில் புதிய 
ஆவணம் திரையில் த�ோன்றும்.

பேஜ்மேக்கர் -  
ஒரு லேபிளை (Label) உருவாக்குதல்

04
செய்முறை

z_XII CompTech_Tamil version Practicals.indd   244 12/01/2022   15:44:20

www.tntextbooks.in



245செய்முறை

4.	 பிறகு அளவீடுகளை Inches லிருந்து Millimeters க்கு மாற்ற வேண்டும். 
	 பட்டிப்பட்டையில் File > Preferences > general  என்ற கட்டளையைக் கிளிக் செய்யவும். 

(அல்லது) விசைப்பலகையில் Ctrl + K என்பதை அழுத்தவும். இப்பொழுது Preferences 
உரையாடல் பெட்டி த�ோன்றும்.

அதில் Measurements மற்றும் Vertical ruler கீழிறங்கு பட்டிப்பெட்டியில் Millimeters  என்பதைத் 
தேர்ந்தெடுக்கவும்.

5.	 கருவிப்பெட்டியிலிருந்து ரெக்டாங்கல் டூலைத் தேர்ந்தெடுத்து செவ்வகம் வரையவும்.
6.	 Control Palette இல் width  100 mm எனவும் height  40 mm எனவும் மாற்றவும்.  
7.	 பட்டிப்பட்டையில் Element > Rounded corners என்பதைக் கிளிக் செய்யவும்.
8.	 Rounded corners உரையாடல் பெட்டியிலிருந்து தேவையான வடிவத்தைத் 

தேர்ந்தெடுக்கவும். இப்பொழுது வட்டமுனை செவ்வகம் த�ோன்றும்.
9.	 கருவிப்பெட்டியில் டெக்ஸ்ட் டூலைக் கிளிக் செய்து, செவ்வகத்திற்குள் ஒரு 

உரைத்தொகுதியை உருவாக்கவும்.
10.	Name : என்பதைத் தட்டச்சு செய்து நுழைவு விசையை அழுத்தவும்.
	 STD :  என்பதைத் தட்டச்சு செய்து நுழைவு விசையை அழுத்தவும்.
	 Section : என்பதைத் தட்டச்சு செய்து நுழைவு விசையை அழுத்தவும்.
	 School : என்பதைத் தட்டச்சு செய்து நுழைவு விசையை அழுத்தவும்.
	 Subject :  என்பதைத் தட்டச்சு செய்து நுழைவு விசையை அழுத்தவும்.
11.	டெக்ஸ்ட் டூலைக் க�ொண்டு உரை முழுவதையும் தேர்ந்தெடுக்கவும்.
12.	பட்டிப்பட்டையில் Type > Indents / Tabs என்பதைக் கிளிக் செய்யவும். (அல்லது) 

விசைப்பலகையில் Ctrl + I என்பதை அழுத்தவும். 
13.	வலது tab ஐ 90 mm அளவில் ப�ொருத்தவும்.  leader ப�ொத்தானைக் கிளிக் செய்து வரும் 

பட்டியலில் புள்ளிக்கோட்டைத் தேர்ந்தெடுக்கவும். பின்னர் Apply ப�ொத்தானைக் 
கிளிக் செய்யவும்.
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14.	இப்பொழுது தேவையான லேபிள் உருவாக்கப்பட்டிருக்கும்.

வெளியீடு

முடிவு
எதிர்பார்க்கப்பட்ட முடிவு கிடைத்தது.
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 ந�ோக்கம்
என்வலப் டூலைப்(Envelope tool)  பயன்படுத்தி க�ொடுக்கப்பட்டுள்ள உரையை உருவாக்குதல்.

க�ோரல்ட்ரா - என்வலப் டூலைப்(Envelope tool)  
பயன்படுத்தி உரையின் வடிவத்தை மாற்றுதல்

05
செய்முறை

வினா
க�ோரல்ட்ராவைப் பயன்படுத்தி கீழே க�ொடுக்கப்பட்டுள்ள உரையை உருவாக்கு.

செய்முறை
1.	 Start >All Programs > CorelDRAW Graphics Suite 2018 > CorelDRAW 2018 என்ற 

வரிசையில் கிளிக் செய்து க�ோரல்ட்ராவைத் திறக்கவும். 
2.	 Welcome Screen சன்னல் திரையில் New Document ப�ொத்தானைக் கிளிக் செய்யவும். 
3.	 இப்பொழுது Create a New Document உரையாடல் பெட்டி த�ோன்றும். 
4.	 அதில்  Ok ப�ொத்தானைக் கிளிக் செய்யவும். 
5.	 டெக்ஸ்ட் டூலைக் கிளிக் செய்யவும். ( அல்லது) விசைப்பலகையில் F8 

விசையைஅழுத்தவும். 
6.	 “DesktopPublishing” என்னும் உரையைத் தட்டச்சு செய்யவும்.
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7.	 Pick டூலைக் கிளிக் செய்து உரையைத் தேர்ந்தெடுக்கவும்.

8.	 என்வலப் டூலில் கிளிக் செய்யவும்.

9.	 மேல் மையப் புள்ளியை மேல் ந�ோக்கி  நகர்த்தவும். அதே ப�ோன்று கீழ் 
மையப்புள்ளியையும் மேல் ந�ோக்கி  நகர்த்தவும். உரையானது கீழே 
காட்டப்பட்டுள்ளவாறு மாறும். 
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வெளியீடு

முடிவு
எதிர்பார்க்கப்பட்ட முடிவு கிடைத்தது.
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 ந�ோக்கம்
எலிப்ஸ் டூலைப் பயன்படுத்திக் க�ொடுக்கப்பட்டுள்ள படத்தை உருவாக்குதல்.

க�ோரல்ட்ரா - எலிப்ஸ் டூலைப்  
பயன்படுத்தி படம் வரைதல்

06
செய்முறை

வினா
க�ோரல்ட்ராவைப் பயன்படுத்தி கீழே க�ொடுக்கப்பட்டுள்ள படத்தை உருவாக்கு.

செய்முறை
1.	 Start > All Programs > CorelDRAW Graphics Suite 2018 > CorelDRaw 2018 என்ற 

வரிசையில் கிளிக் செய்து க�ோரல்ட்ராவைத் திறக்கவும்.
2.	 Welcome Screen சன்னல் திரையில் New Document ப�ொத்தானைக் கிளிக் செய்யவும். 
3.	 இப்பொழுது Create a New Document உரையாடல் பெட்டி த�ோன்றும். 
4.	 அதில்  Ok ப�ொத்தானைக் கிளிக் செய்யவும். 
5.	 எலிப்ஸ்  டூலைக் கிளிக் செய்யவும். ( அல்லது) விசைப்பலகையில் F7 விசையை 

அழுத்தவும்.
6.	 ஒரு வட்டத்தை வரையவும். 
7.	 அந்த வட்டத்தை நகலெடுத்து ஒட்டவும். 	
8.	 முன்னால் உள்ள வட்டத்தை சிறிது வலது புறமாக  நகர்த்தவும். 
9.	 அந்த வட்டத்தை தேர்ந்தெடுத்து வெள்ளை நிறத்தால்  நிரப்பவும். 
10.	பின்னால் உள்ள வட்டத்தைத் தேர்ந்தெடுத்து %70 கருப்பு நிறத்தால்  நிரப்பவும். 
11.	டெக்ஸ்ட் டூலைப் பயன்படுத்தி 75 எனத் தட்டச்சு செய்து, எழுத்தின் அளவை 

அதிகரிக்கவும். 
12.	அதை படத்தில் காட்டப்பட்டுள்ளவாறு வட்டத்தில் ப�ொருத்தவும். 
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வெளியீடு

முடிவு
எதிர்பார்க்கப்பட்ட முடிவு கிடைத்தது.
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வினா
கீழே உள்ள அட்டவணையில் க�ொடுக்கப்பட்டுள்ள புள்ளிகளுக்கு தனித்த ஆயத்தொலைவு 
அமைப்பைப் பயன்படுத்தி ஒரு படம் வரைக

Point Coordinates
1 55,100
2 120, 100
3 120, 70
4 230, 70
5 230, 100
6 295, 100
7 295, 210
8 275, 235
9 80, 235
10 55, 210

ஆட்டோகேட் - தனித்த ஆயத்தொலைவு 
அமைப்பைப் பயன்படுத்தி படம் வரைதல்

07
செய்முறை
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செய்முறை
1.	 திரையிலுள்ள AutoCAD 2016-English பணிக்குறியை இருமுறை கிளிக் செய்து 

ஆட்டோகேட் 2016ஐ திறக்கவும். (அல்லது) 
	 Start >All Programs > Autodesk > AutoCAD 2016 > AutoCAD 2016-English என்ற 

வரிசையில் கிளிக் செய்து ஆட்டோகேட் 2016ஐ திறக்கவும்.
2.	 Drafting&Animation பணித்தளத்திலிருந்து முன்வடிவமைக்கப்பட்ட க�ோப்பான acad.

dwt என்பதை கிளிக் செய்து ஒரு புதிய க�ோப்பை உருவாக்கவும். 
3.	 உலவுதல் பட்டையிலிருந்து Zoom All டூலைத் தேர்ந்தெடுக்கவும்.
4.	 நிலைமைப் பட்டையிலுள்ள Grid ஐ OFF செய்யவும். 
5.	 டைனமிக் இன்புட் ம�ோடை OFF செய்யவும். 
6.	 ரிப்பனில்  Home > Draw > Line என்ற வரிசையில் கிளிக் செய்யவும். (அல்லது) கட்டளை 

வரியில் LINE அல்லது L எனத் தட்டச்சு செய்யவும். கீழே க�ொடுக்கப்பட்டுள்ளவாறு 
கட்டளை வரியில் புள்ளிகளை தட்டச்சு செய்யவும்.  

Command: LINE↵
Specify first point: 55,100↵
Specify next point or [Undo]: 120,100↵
Specify next point or [Undo]: 120,70↵
Specify next point or [Close/Undo]: 230,70↵
Specify next point or [Close/Undo]: 230,100↵
Specify next point or [Close/Undo]: 295,100↵
Specify next point or [Close/Undo]: 295,210↵
Specify next point or [Close/Undo]: 275,235↵
Specify next point or [Close/Undo]: 80,235↵
pecify next point or [Close/Undo]: 55,210↵
Specify next point or [Close/Undo]: C↵

7.	 Line-example1.dwg என்ற பெயரில் க�ோப்பை சேமிக்கவும். 

 ந�ோக்கம்
அட்டவணையில் க�ொடுக்கப்பட்டுள்ள புள்ளிகளுக்கு தனித்த ஆயத்தொலைவு அமைப்பைப் 
பயன்படுத்தி ஒரு படம் வரைதல்.
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வெளியீடு

முடிவு
எதிர்பார்க்கப்பட்ட முடிவு கிடைத்தது.
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வினா
கீழே உள்ள அட்டவணையில் க�ொடுக்கப்பட்டுள்ள புள்ளிகளுக்கு ஒப்பீட்டு செவ்வக 
ஆயத்தொலைவு அமைப்பைப் பயன்படுத்தி ஒரு படம் வரைக

Point Coordinates
1 100,100
2 @50,0
3 @0,20
4 @100,0
5 @0,-20
6 @50,0
7 @0, 120
8 @-50,0
9 @0,-20
10 @-100,0
11 @0,20

12 @-50,0

ஆட்டோகேட் - ஒப்பீட்டு செவ்வக ஆயத்தொலைவு 
அமைப்பைப் பயன்படுத்தி படம் வரைதல்

08
செய்முறை
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 ந�ோக்கம்
அட்டவணையில் க�ொடுக்கப்பட்டுள்ள புள்ளிகளுக்கு ஒப்பீட்டு செவ்வக ஆயத்தொலைவு 
அமைப்பைப் பயன்படுத்தி ஒரு படம் வரைதல்.

செய்முறை
1.	 திரை முகப்பிலுள்ள AutoCAD -2016English பணிக்குறியை இருமுறை கிளிக் செய்து 

ஆட்டோகேட் 2016ஐ திறக்கவும். (அல்லது) 
	 Start >All Programs > Autodesk > AutoCAD 2016 > AutoCAD 2016-English என்ற 

வரிசையில் கிளிக் செய்து ஆட்டோகேட் 2016ஐ திறக்கவும்.
2.	 Drafting&Animation பணித்தளத்திலிருந்து முன்வடிவமைக்கப்பட்ட க�ோப்பான acad.

dwt என்பதை கிளிக் செய்து ஒரு புதிய க�ோப்பை உருவாக்கவும். 
3.	 உலவுதல் பட்டையிலிருந்து Zoom All டூலைத் தேர்ந்தெடுக்கவும்.
4.	 நிலைமைப் பட்டையிலுள்ள Grid ஐ OFF செய்யவும். 
5.	 டைனமிக் இன்புட் ம�ோடை OFF செய்யவும். 
6.	 ரிப்பனில்  Home > Draw > Line என்ற வரிசையில் கிளிக் செய்யவும். (அல்லது) கட்டளை 

வரியில் LINE அல்லது L எனத் தட்டச்சு செய்யவும். கீழே க�ொடுக்கப்பட்டுள்ளவாறு 
கட்டளை வரியில் புள்ளிகளை தட்டச்சு செய்யவும்.  

Command: LINE↵
Specify first point: 100,100 ↵

Specify next point or [Undo]: @50,0 ↵

Specify next point or [Undo]: @0,20 ↵
Specify next point or [Close/Undo]: @100,0 ↵
Specify next point or [Close/Undo]: @0,-20 ↵
Specify next point or [Close/Undo]: @50,0 ↵
Specify next point or [Close/Undo]: @0,120 ↵
Specify next point or [Close/Undo]: @-50,0 ↵
Specify next point or [Close/Undo]: @0,-20 ↵
Specify next point or [Close/Undo]: @-100,0 ↵
Specify next point or [Close/Undo]: @0,20 ↵
Specify next point or [Close/Undo]: @-50,0 ↵
Specify next point or [Close/Undo]: c ↵

7.	 Line-example2.dwg என்ற பெயரில் க�ோப்பை சேமிக்கவும். 
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257செய்முறை

வெளியீடு

முடிவு
எதிர்பார்க்கப்பட்ட முடிவு கிடைத்தது.
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செய்முறை258

வினா
கீழே உள்ள அட்டவணையில் க�ொடுக்கப்பட்டுள்ள புள்ளிகளுக்கு ஒப்பீட்டு துருவ 
ஆயத்தொலைவு அமைப்பைப் பயன்படுத்தி ஒரு படம் வரைக

Point Coordinates 

1 50,50
2 @110<0
3 @20<90
4 @80<120
5 @30<180
6 @80<240

ஆட்டோகேட் - ஒப்பீட்டு துருவ ஆயத்தொலைவு 
அமைப்பைப் பயன்படுத்தி படம் வரைதல்

09
செய்முறை

 ந�ோக்கம்
அட்டவணையில் க�ொடுக்கப்பட்டுள்ள புள்ளிகளுக்கு ஒப்பீட்டு துருவ ஆயத்தொலைவு 
அமைப்பைப் பயன்படுத்தி ஒரு படம் வரைதல்.

செய்முறை
1.	 திரை முகப்பிலுள்ள AutoCAD -2016English பணிக்குறியை இருமுறை கிளிக் செய்து 

ஆட்டோகேட் 2016ஐ திறக்கவும். (அல்லது) 
	 Start >All Programs > Autodesk > AutoCAD 2016 > AutoCAD 2016-English என்ற 

வரிசையில் கிளிக் செய்து ஆட்டோகேட் 2016ஐ திறக்கவும்.
2.	 Drafting&Animation பணித்தளத்திலிருந்து முன்வடிவமைக்கப்பட்ட க�ோப்பான acad.

dwt என்பதை கிளிக் செய்து ஒரு புதிய க�ோப்பை உருவாக்கவும். 
3.	 உலவுதல் பட்டையிலிருந்து Zoom All டூலைத் தேர்ந்தெடுக்கவும்.
4.	 நிலைமைப் பட்டையிலுள்ள Grid ஐ OFF செய்யவும். 
5.	 டைனமிக் இன்புட் ம�ோடை OFF செய்யவும். 
6.	 ரிப்பனில்  Home > Draw > Line என்ற வரிசையில் கிளிக் செய்யவும். (அல்லது) கட்டளை 

வரியில் LINE அல்லது L எனத் தட்டச்சு செய்யவும். கீழே க�ொடுக்கப்பட்டுள்ளவாறு 
கட்டளை வரியில் புள்ளிகளை தட்டச்சு செய்யவும்.  
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259செய்முறை

Command: LINE↵
Specify first point: 50,50↵
Specify next point or [Undo]: @110<0↵
Specify next point or [Undo]: @20<90↵
Specify next point or [Close/Undo]: @80<120↵
Specify next point or [Close/Undo]: @30<180↵
Specify next point or [Close/Undo]: @80<240↵
Specify next point or [Close/Undo]: C↵

7.	 Line-example3.dwg என்ற பெயரில் க�ோப்பை சேமிக்கவும். 

வெளியீடு

முடிவு
எதிர்பார்க்கப்பட்ட முடிவு கிடைத்தது.
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செய்முறை260

வினா
தனித்த ஆயத்தொலைவு அமைப்பைப் பயன்படுத்தி கீழே க�ொடுக்கப்பட்டுள்ள படத்தை 
வரைக.
புள்ளிக்கோடுகளுக்கிடையே உள்ள த�ொலைவு 1 அலகு எனக் க�ொண்டு படத்தில் 
க�ொடுக்கப்பட்ட புள்ளிகளின் தனித்த ஆயத்தொலைவுகளை கீழே க�ொடுக்கப்பட்டுள்ள 
அட்டவணையில் முதலில் குறிக்கவும். பிறகு இந்தப் புள்ளிகளைக் க�ொண்டு படத்தை 
வரையவும்.

Point Coordinates 
1 2, 1
2
3
4
5
6
7
8
9

ஆட்டோகேட் - தனித்த ஆயத்தொலைவு 
அமைப்பைப் பயன்படுத்தி படம் வரைதல்

10
செய்முறை
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261செய்முறை

Point Coordinates 
1 2, 1
2 2,5
3 7, 5
4 7,4
5 4, 4
6 3,3
7 4,2
8 7,2
9 7,1

செய்முறை
1.	 திரை முகப்பிலுள்ள AutoCAD -2016English பணிக்குறியை இருமுறை கிளிக் செய்து 

ஆட்டோகேட் 2016ஐ திறக்கவும். (அல்லது) 
	 Start >All Programs > Autodesk > AutoCAD 2016 > AutoCAD 2016-English என்ற 

வரிசையில் கிளிக் செய்து ஆட்டோகேட் 2016ஐ திறக்கவும்.
2.	 Drafting&Animation பணித்தளத்திலிருந்து முன்வடிவமைக்கப்பட்ட க�ோப்பான acad.

dwt என்பதை கிளிக் செய்து ஒரு புதிய க�ோப்பை உருவாக்கவும். 
3.	 உலவுதல் பட்டையிலிருந்து Zoom All டூலைத் தேர்ந்தெடுக்கவும்.
4.	 நிலைமைப் பட்டையிலுள்ள Grid ஐ OFF செய்யவும். 
5.	 டைனமிக் இன்புட் ம�ோடை OFF செய்யவும். 
6.	 ரிப்பனில்  Home > Draw > Line என்ற வரிசையில் கிளிக் செய்யவும். (அல்லது) கட்டளை 

வரியில் LINE அல்லது L எனத் தட்டச்சு செய்யவும். கீழே க�ொடுக்கப்பட்டுள்ளவாறு 
கட்டளை வரியில் புள்ளிகளை தட்டச்சு செய்யவும்.  

Command: LINE↵
Specify first point: 2,1↵
Specify next point or [Undo]: 2,5↵
Specify next point or [Undo]: 7,5↵
Specify next point or [Close/Undo]: 7,4↵
Specify next point or [Close/Undo]: 4,4↵

 ந�ோக்கம்
அட்டவணையில் க�ொடுக்கப்பட்டுள்ள புள்ளிகளுக்கு தனித்த ஆயத்தொலைவு அமைப்பைப் 
பயன்படுத்தி ஒரு படம் வரைதல்.

z_XII CompTech_Tamil version Practicals.indd   261 12/01/2022   15:44:21

www.tntextbooks.in



செய்முறை262

Specify next point or [Close/Undo]: 3,3↵
Specify next point or [Close/Undo]: 4,2↵
Specify next point or [Close/Undo]: 7,2↵
Specify next point or [Close/Undo]: 7,1↵
Specify next point or [Close/Undo]: C↵

7.	 Line-example4.dwg என்ற பெயரில் க�ோப்பை சேமிக்கவும். 

வெளியீடு

முடிவு
எதிர்பார்க்கப்பட்ட முடிவு கிடைத்தது.
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கல்வி ஆல�ோசகர்
முனைவர் ப�ொன். குமார்
இணை இயக்குனர் ( பாடத்திட்டம் )
மாநிலக் கல்வியியல் ஆரய்ச்சி மற்றும் பயிற்சி நிறுவனம்,
சென்னை - 600 006

பாட ஒருங்கிணைப்பாளர்
உ. ஆர்த்தி
பட்டதாரி ஆசிரியை,
அரசு மகளிர் மேல்நிலைப்பள்ளி,
மதுராந்தகம், காஞ்சிபுரம்.

புத்தக வடிவமைப்பாளர்
ஆர�ோக்கியம் பெலிக்ஸ்
பிளாக்பெர்ட் வடிவம் மற்றும் பிரிண்ட்ஸ்,
சென்னை.

தரக்கட்டுபாடு
காமாட்சி பாலன் ஆறுமுகம்

தட்டச்சர்
இரா. ம�ோகானாம்பாள்
வேளச்சேரி, சென்னை.

அட்டை வடிவமைப்பாளர்
கதிர் ஆறுமுகம்
சென்னை.

விரைவுக் குறியீட்டு மேலாண்மைக் குழு
இரா. ஜெகநாதன், இடைநிலைஆசிரியர்,  
ஊராட்சி ஒன்றிய நடுநிலைப்பள்ளி, கணேசபுரம், 
ப�ோளூர், திருவண்ணாமலை.

வ.பத்மாவதி, பட்டதாரிஆசிரியர்,
அரசினர்உயர்நிலைப்பள்ளி, வெற்றியூர்,  
திருமானூர், அரியலூர்.

ம.முருகேசன், பட்டதாரி ஆசிரியர் 
ஊராட்சி ஒன்றிய நடுநிலைப்பள்ளி, 
பெத்தவேளாண்கோட்டகம்,
முத்துப்பேட்டை, திருவாரூர்.

ஒருங்கிணைப்பு
ரமேஷ் முனிசாமி

பாடநூல் வல்லுநர்கள்
திருமதி சசிகலா, 
இணைப்பேராசிரியர், இராணி மேரி கல்லூரி
சென்னை

திரு. அமுதன்
உதவி பேராசிரியர் மற்றும் இணை புல முதல்வர்
பாண்டிச்சேரி ப�ொறியியல் கல்லூரி, பிள்ளைச்சாவடி,
பாண்டிச்சேரி.

பாட மேலாய்வாளர்கள்
திருமதி. ஆர்த்தி
இணைப்பேராசிரியர், தகவல் த�ொழில்நுட்பதுறை
R.M.K  ப�ொறியியல் கல்லூரி, கவரைப்பேட்டை, 
திருவள்ளூர்.

திரு. எம். முரளி
த�ொழில்நுட்ப ஆல�ோசகர்,
காக்னிசென்ட் டெக்னாலஜி,
துரைப்பாக்கம், சென்னை.

ஆங்கிலவழி பாட நூல் ஆசிரியர்கள்

திரு. R. சேதுராமன்
துணை பேராசிரியர்,
கணினி அறிவியல் & ப�ொறியியல் துறை,
சத்யபாமா அறிவியல் & த�ொழில்நுட்ப நிறுவனம்,
சென்னை.

திரு. எம். சிவக்குமார்
அரசு மேல்நிலைப்பள்ளி,
சிறுகாம்பூர், திருச்சி.

A. சங்கீதா
அரசு மேல்நிலைப்பள்ளி,
இராஜன்தாங்கல், திருவண்ணாமலை.

T. முருகாம்பாள்
அரசு மேல்நிலைப்பள்ளி,
ச�ோமராசன்பேட்டை, திருச்சி.

திரு. அழகப்பன், 
துறைத்தலைவர், ICAT Design & Multimedia கல்லூரி
மயிலாப்பூர், சென்னை

திருமதி. பாலபிரியா
துறைத்தலைவர், ICAT Design & Multimedia கல்லூரி
மயிலாப்பூர், சென்னை

ம�ொழிபெயர்ப்பாளர்கள்
இராணி வேளாங்கன்னி
ஜெய்கோபால் கர�ோடியா
அரசு பெண்கள் மேல்நிலைப்பள்ளி
நங்கநல்லூர், சென்னை.

C. ஸ்ரீதேவி
அரசு முன் மாதிரி மேல்நிலைப்பள்ளி
திருவல்லிக்கேணி, ச�ொன்னை – 5.

K.V. மஞ்சுளா
சென்னை மேல்நிலைப்பள்ளி,
சூளைமேடு, சென்னை.

A. G. கலைவாணி
சென்னை பெண்கள் மேல்நிலைப்பள்ளி,
பெரம்பூர், சென்னை – 11.

திரு. எஸ். வெங்கடாச்சலபெருமாள்
அரசு மேல்நிலைப்பள்ளி, மானூர், திருநெல்வேலி.

திரு. ஜி. சுரேஷ்குமார்
அரசு ஆண்கள் மேல்நிலைப்பள்ளி,
திருமங்கலம், மதுரை.

திரு. எம்.கணேஷ்
அரசு பெண்கள் மேல்நிலைப்பள்ளி,
மாத்தூர், கிருஷ்ணகிரி.

திரு. ஜெ.சுந்தர்
அரசு மேல்நிலைப்பள்ளி,
க�ொசவன்புதூர், வேலூர்.

கணினி த�ொழில்நுட்பம் - மேல்நிலை இரண்டாம் ஆண்டு
நூலாசிரியர்கள் மற்றும் மேலாய்வாளர்கள்

இந்நூல் 80 ஜி.எஸ்.எம். எலிகண்ட் மேப்லித்தோ தாளில் 
அச்சிடப்பட்டுள்ளது. ஆப்செட் முறையில் அச்சிட்டோர்:
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குறிப்புகள்
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